# Contents

Before You Use Your Dell Machine .................................................. 21
  Applicable Models ........................................................................... 21
  Definitions of Notes ......................................................................... 21
  Important Note ................................................................................. 22

1 Introduction to Your Dell Machine ................................................. 25
  Control Panel Overview ................................................................. 25
    Dell E515dn/Dell E515dw ............................................................... 25
    Dell E514dw .................................................................................... 28
    Dell Printer Hub (Windows® Only) ................................................ 30

2 Paper Handling ............................................................................. 33
  Load Paper ....................................................................................... 33
    Load and Print using the Paper Tray .............................................. 33
    Load and Print Paper in the Manual Feed Slot .............................. 36
      Load and Print Plain Paper, Thin Paper, Recycled Paper and Bond Paper in the Manual Feed Slot .... 36
      Load and Print on Thick Paper and Labels in the Manual Feed Slot . 38
      Load and Print on Envelopes in the Manual Feed Slot ................ 40
  Paper Settings ................................................................................. 42
    Change the Paper Size .................................................................... 43
    Change the Paper Type ................................................................... 43
    Set the Check Size ......................................................................... 43
  Unscannable and Unprintable Areas. ................................................. 44
  Using Special Paper .......................................................................... 44
  Load Documents .............................................................................. 45
    Load Documents in the Automatic Document Feeder (ADF) .......... 45
    Load Documents on the Scanner Glass ......................................... 46

3 Print ............................................................................................... 51
Before Printing .................................................................................................................. 51
Print from Your Computer (Windows®) .............................................................................. 51
  Basic Printing Methods (Windows®) .................................................................................. 51
    Print a Document (Windows®) .......................................................................................... 52
    Print Preview (Windows®) .................................................................................................. 53
    Change the Paper Size (Windows®) .................................................................................... 53
    Change the Orientation of Your Print (Portrait or Landscape) (Windows®) ............... 54
    Print Multiple Copies of the Same Document (Windows®) ............................................. 55
    Change the Media Type (Windows®) .................................................................................. 55
    Change the Resolution (Windows®) ................................................................................... 56
    Change the Print Settings (Windows®) ............................................................................. 56
    Improve Gray Printing (Windows®) .................................................................................. 57
    Improve Pattern Printing (Windows®) .............................................................................. 58
    Improve Thin Line (Windows®) ........................................................................................ 58
    Print More Than One Page on a Single Sheet of Paper (N in 1) (Windows®) ............. 58
    Print as a Poster (Windows®) ........................................................................................... 59
    Print on Both Sides of the Paper (Windows®) ................................................................. 60
    Print as a Booklet (Windows®) .......................................................................................... 62
    Change the Paper Source (Windows®) .............................................................................. 65
Advanced Printing Methods (Windows®). ......................................................................... 65
    Print in Toner Save Mode (Windows®) ............................................................................ 66
    Scaled Print (Windows®) .................................................................................................. 67
    Reverse Print (Windows®) ................................................................................................ 67
    Add a Watermark to the Printed Document (Windows®) .................................................. 68
    Print the Date, Time and PC Login User Name on the Document (Header-Footer Print) (Windows®) .................................................................................................................. 69
    Use a Macro from Your Computer (Windows®) ............................................................... 69
    Adjust the Print Density (Windows®) .............................................................................. 70
    Reduce Paper Curl (Windows®) ........................................................................................ 71
    Improve Toner Fixing (Windows®) .................................................................................... 71
    Skip Blank Page (Windows®) ........................................................................................... 72
Contents

4 Scan .................................................. 95

Before Scanning ........................................ 95

Configure Network Scanning for Windows® .............. 95
Configure Network Scanning for Macintosh .............. 97

Scan Using the Scan Button on Your Dell Machine ........ 97

Scan Photos and Graphics ................................ 98
Save Scanned Data to a Folder as a PDF File ............ 99

Web Services for Scanning on Your Network (Windows Vista® SP2 or greater, Windows® 7 and Windows® 8) ... 99
Scan Using Web Services from the Dell Machine (Windows Vista® SP2 or greater, Windows® 7 and Windows® 8) ............................................... 100
Configure Scan Settings for Web Services .................. 100

Change Scan Button Settings from ControlCenter (Macintosh) ................................................. 101

Scan from Your Computer (Windows®) ....................... 104

Scan from Your Computer (Macintosh) ..................... 104

Scan Using ControlCenter (Macintosh) .................... 104
Scan Documents and Photos Using ControlCenter (Macintosh) .................................................. 105
Save Scanned Data to a Folder as a PDF File Using ControlCenter (Macintosh) .............................. 106
Scan Both Sides of an ID Card Using ControlCenter .......... 106
Scan to E-mail Attachment Using ControlCenter (Macintosh) .................................................. 107
Scan to an Editable Text File (OCR) Using ControlCenter (Macintosh) ..................................... 109
Scan Using TWAIN-Compliant Applications (Macintosh) .................................................. 110

TWAIN Driver Settings (Macintosh) ......................... 111

Change 2-Sided Print Settings .............................. 90

Print a List of Printer Settings .............................. 91

Restore Printer Factory Settings ......................... 90

Auto Continue .......................................... 90

Test Print .................................................. 91

Cancel a Print Job .......................................... 89

Change the Printer Emulation Mode ...................... 89

Print the Internal Font List .............................. 91

Save Scanned Data to a Folder as a PDF File Using ControlCenter (Macintosh) .............................. 106
### Contents

<table>
<thead>
<tr>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>5 Copy</strong></td>
</tr>
<tr>
<td>Copy a Document</td>
</tr>
<tr>
<td>Copy Option</td>
</tr>
<tr>
<td>Change the Copy Quality</td>
</tr>
<tr>
<td>Enlarge or Reduce Copied Images</td>
</tr>
<tr>
<td>Adjust the Copy Contrast</td>
</tr>
<tr>
<td>Adjust the Copy Density (Brightness)</td>
</tr>
<tr>
<td>Make N in 1 Copies Using the Page Layout Feature</td>
</tr>
<tr>
<td>Sort Copies</td>
</tr>
<tr>
<td>Copy Both Sides of an ID Card onto One Page</td>
</tr>
<tr>
<td>Copy on Both Sides of the Paper (2-sided Copy)</td>
</tr>
</tbody>
</table>

| **6 Fax** |
| Send a Fax |
| Send a Fax |
| Select or Change Settings for Sending a Fax |
| Change the Fax Resolution |
| Change the Fax Contrast |
| Send a Fax Manually |
| Set Glass Scan Size for Faxing |
| Send a Fax at the End of a Conversation |
| Use Dual Access to Dial, Scan, Send, and Receive Faxes Simultaneously |
| Send the Same Fax to More than One Recipient (Broadcasting) |
| Cancel a Broadcast in Progress |
| Send a Fax in Real Time |
| Send a Fax Overseas |
| Send a Fax at a Specified Time (Delayed Fax) |
| Add a Cover Page to Your Fax |

---

Scan Using Apple Image Capture (ICA Driver) .................................................. 113
ICA Driver Settings ......................................................................................... 115

---

5 Copy .............................................................................................................. 119
Copy a Document .......................................................................................... 119
Copy Option .................................................................................................. 120
Change the Copy Quality ............................................................................. 121
Enlarge or Reduce Copied Images ............................................................. 122
Adjust the Copy Contrast ........................................................................... 122
Adjust the Copy Density (Brightness) ....................................................... 123
Make N in 1 Copies Using the Page Layout Feature ................................ 123
Sort Copies .................................................................................................. 125
Copy Both Sides of an ID Card onto One Page ........................................ 126
Copy on Both Sides of the Paper (2-sided Copy) ...................................... 128

---

6 Fax .............................................................................................................. 133
Send a Fax ..................................................................................................... 133
Send a Fax ..................................................................................................... 134
Select or Change Settings for Sending a Fax ............................................. 136
Change the Fax Resolution .......................................................................... 136
Change the Fax Contrast ................................................................................ 137
Send a Fax Manually .................................................................................... 137
Set Glass Scan Size for Faxing ................................................................... 138
Send a Fax at the End of a Conversation .................................................. 138
Use Dual Access to Dial, Scan, Send, and Receive Faxes Simultaneously ... 138
Send the Same Fax to More than One Recipient (Broadcasting) ........... 138
Cancel a Broadcast in Progress .................................................................. 139
Send a Fax in Real Time ................................................................................ 139
Send a Fax Overseas ..................................................................................... 140
Send a Fax at a Specified Time (Delayed Fax) ........................................... 141
Add a Cover Page to Your Fax .................................................................. 141

---

ICA Driver Settings ......................................................................................... 115
Receive a Fax ................................................................. 143

Receive Mode Settings .................................................. 144
  Receive Modes ........................................................ 144
  Choose the Correct Receive Mode ................................. 145
  Set the Number of Rings Before the Machine Answers (Ring Delay) ............................................ 146
  Set the F/T Ring Time (Pseudo/Double-ring) ................ 146
  Set the Easy Receive .................................................. 147

Additional Receiving Operations .................................... 147
  Shrink Page Size of an Oversized Incoming Fax .......... 148
  Set the 2-sided Printing for Received Faxes ................ 148
  Set the Fax Receive Stamp ......................................... 148
  Receive a Fax at the End of a Telephone Conversation . 149
  Avoid Incoming Fax from Specific Numbers ................. 149

Memory Receive (Remote Fax) Options ............................ 150
  Forward Incoming Faxes to Another Machine ................ 151
  Store Incoming Faxes in the Machine’s Memory .......... 151
  Change Memory Receive (Remote Fax) Options .............. 151
  Turn off Memory Receive (Remote Fax) Options .......... 152
  Print a Fax Stored in the Machine’s Memory ............ 152

Remote Retrieval ....................................................... 152
  Set a Remote Access Code ....................................... 153
  Use Your Remote Access Code .................................. 153
  Remote Retrieval Commands ...................................... 153
  Forward Faxes Remotely ............................................. 154
  Change the Fax Forwarding Number ......................... 155

Receive Faxes into Memory When the Paper Tray is Empty .. 155

Compose Your Own Comments ....................................... 142

Turn Off the Destination Information Display ................ 142

Cancel a Fax in Progress ............................................. 143

Check and Cancel Pending Fax .................................... 143

Turn Off the Destination Information Display ................ 142

Receive Faxes into Memory When the Paper Tray is Empty .. 155

Remote Retrieval ....................................................... 152
  Set a Remote Access Code ....................................... 153
  Use Your Remote Access Code .................................. 153
  Remote Retrieval Commands ...................................... 153
  Forward Faxes Remotely ............................................. 154
  Change the Fax Forwarding Number ......................... 155

Receive Faxes into Memory When the Paper Tray is Empty .. 155
### Dial and Store Fax Numbers

- How to Dial .................................................. 155
- Dial Manually ................................................. 156
- Dial a Number Using One Touch Dial .......................... 156
- Dial a Number Using Speed Dial ................................ 156
- Redial a Fax Number ........................................... 157

### Voice Operations

- Send Tone Signals ............................................ 157
- Pick up a Voice Call in Fax/Tel Receive Mode .................. 157
- Special Line Considerations .................................... 158

### Additional Dialing Operations

- Dial Access Codes and Credit Card Numbers .................. 160
- How to Store Numbers ......................................... 161
- Store Numbers .................................................. 161
- Set up Groups for Broadcasting ................................ 163

### Telephone Services and External Devices

- Voice Mail .................................................... 165
- Distinctive Ring ................................................ 166
- Register the Distinctive Ring Pattern ............................ 167
- Turn Off Distinctive Ring ....................................... 168
- Caller ID ....................................................... 168

### External TAD (Telephone Answering Device)

- Connect an External TAD ...................................... 169
- Record an Outgoing Message (OGM) on the External TAD ........ 170
- Multi-line Connections (PBX) .................................. 170

### External and Extension Telephones

- Connect an External or Extension Telephone .................... 171
- Operation from External and Extension Telephones ............ 171
- Use a Non-Dell Cordless External Handset ..................... 172
- Use the Remote Codes ....................................... 172
Configure Your Machine for a Wireless Network Using the One Push Method of Wi-Fi Protected Setup™ (WPS) or AOSS™ ................................................................. 198

How to Configure Your Wireless Network Using the One Push Method of WPS or AOSS™ ................. 198

Configure Your Machine for a Wireless Network Using the PIN Method of Wi-Fi Protected Setup™ (WPS) ................................. 200

Two Wireless Network Connection Types Using the PIN Method of Wi-Fi Protected Setup™ (WPS) ........ 200

How to Configure Your Wireless Network Using the PIN Method of Wi-Fi Protected Setup™ (WPS) ........ 201

Configure Your Machine for a Wireless Network in Ad-Hoc Mode (For IEEE 802.11b/g/n) .............. 202

Configure Your Machine for a Wireless Network in Ad-Hoc Mode Using a New SSID ....................... 203

Configure Your Machine for a Wireless Network in Ad-Hoc Mode Using an Existing SSID .............. 204

Configure Your Machine for a Wireless Network Using the Machine's Control Panel Setup Wizard ........ 205

Configure Your Machine for a Wireless Network When the SSID Is Not Broadcast ....................... 206

Use Wi-Fi Direct® ........................................................................................................ 208

Print or Scan from Your Mobile Device Using Wi-Fi Direct ........................................................ 208

Mobile Printing .............................................................................................................. 209

Printing with Mopria™ ............................................................................................... 209

Configure Your Wi-Fi Direct Network ............................................................................... 210

Advanced Network Features .......................................................................................... 214

Print the Network Configuration Report .......................................................................... 214

Configure Your Mail Server Settings Using Web Based Management ......................... 214

Synchronize Time with the SNTP Server Using Web Based Management .................... 215

Configure Date and Time Using Web Based Management ............................................ 215

Configure the SNTP Protocol Using Web Based Management ...................................... 216

Technical Information for Advanced Users ..................................................................... 217

Additional Network Settings for Windows® .................................................................. 218

Before Configuring Additional Network Settings .......................................................... 218

Use Web Services to Install Drivers Used for Printing and Scanning (Windows Vista®, Windows® 7 and Windows® 8) ................................................................. 218

Use Web Services to Uninstall Drivers Used for Printing and Scanning (Windows Vista®, Windows® 7 and Windows® 8) ................................................................. 219

Use Vertical Pairing to Install Drivers Used for Printing and Scanning in Infrastructure Mode (Windows® 7 and Windows® 8) ............................................................. 220
Use Vertical Pairing to Install Drivers Used for Printing from the Wi-Fi Direct Network (Windows® 8.1)  ...  221

Available Services ................................................................. 222

Other Ways to Configure the IP Address .................................... 222

Configure the IP Address Using DHCP ................................. 222

Configure the IP Address Using BOOTP ................................. 223

Configure the IP Address Using RARP ................................. 223

Configure the IP Address Using APIPA ................................. 224

Configure the IP Address Using ARP ................................. 224

Reset the Network Settings to the Factory Settings .................. 225

Print the WLAN Report ..................................................... 225

Wireless LAN Report Error Codes ........................................ 225

Network Menu on the Dell Control Panel .................................. 227

TCP/IP  .................................................................................. 227

Ethernet (Wired Network Only) ............................................. 229

Wired Status ................................................................. 229

MAC Address ............................................................... 229

Setup Wizard (Wireless Network Only) .................................. 229

WPS/AOSS™ (Wireless Network Only) .................................. 229

WPS w/PIN Code (Wireless Network Only) ......................... 229

WLAN Status (Wireless Network Only) ............................... 229

Set to Default ............................................................ 230

Wired Enable (Wired Network Only) ............................... 230

WLAN Enable (Wireless Network Only) ............................ 230

Wi-Fi Direct ............................................................ 230

Scan to E-mail .......................................................... 230

Scan to FTP .......................................................... 230

Network Reset .......................................................... 230

8 Security ............................................................................. 233

Lock the Machine Settings .................................................... 233

About Using TX Lock ........................................................ 233
My Dell Machine is not Found on the Network Even After Successful Installation ........................................... 259
My Security Settings are not Working Properly .................................................................................................. 260
I Want to Check that My Network Devices are Working Correctly ................................................................. 260
Other Problems .................................................................................................................................................. 261
Error and Maintenance Messages ....................................................................................................................... 263
Transfer Your Faxes or Fax Journal Report ......................................................................................................... 266
Transfer Faxes to Another Fax Machine ............................................................................................................. 266
Transfer the Fax Journal Report to Another Fax Machine ................................................................................... 267
Document Jams ..................................................................................................................................................... 267
Document is Jammed in the Top of the ADF Unit ................................................................................................. 267
Document is Jammed under the Document Cover ............................................................................................. 267
Remove Small Scraps of Paper Jammed in the ADF .......................................................................................... 268
Paper Jams .......................................................................................................................................................... 268
Paper is Jammed in the Paper Tray ....................................................................................................................... 269
Paper is Jammed in the Output Paper Tray .......................................................................................................... 270
Paper is Jammed at the Back of the Machine ...................................................................................................... 272
Paper is Jammed inside the Machine .................................................................................................................... 274
Paper is Jammed in the 2-sided Tray .................................................................................................................... 276
Improve the Print Quality ..................................................................................................................................... 279
Machine Information ............................................................................................................................................. 285
Check the Serial Number ..................................................................................................................................... 285
Check the Firmware ............................................................................................................................................... 285
Reset Functions ...................................................................................................................................................... 285
How to Reset the Machine ..................................................................................................................................... 286
11 Routine Maintenance ......................................................................................................................................... 291
Replace Supplies .................................................................................................................................................... 291
Learn About The Toner Cartridge ......................................................................................................................... 293
Replace the Toner Cartridge .................................................................................................................................. 293
Learn About The Drum Unit .................................................................................................................................. 296
Replace the Drum Unit ........................................................................................................................................... 297
Reset the Drum Counter ................................................................. 299
Clean the Machine ........................................................................ 300
Clean the Scanner ......................................................................... 302
Clean the Corona Wire ................................................................. 302
Clean the Drum Unit .................................................................... 304
Clean the Paper Pick-up Rollers .................................................... 308
Check the Remaining Life of Parts ................................................. 309
Pack and Ship Your Dell Machine .................................................. 309

12 Machine Settings ..................................................................... 315

General Settings ......................................................................... 315
Change the Default Mode ............................................................. 316
Set the Mode Timer ....................................................................... 316
Adjust the Machine Volume .......................................................... 317
Adjust the Ring Volume .................................................................. 317
Adjust the Beeper Volume ............................................................. 317
Adjust the Speaker Volume ........................................................... 318
Change for Daylight Saving Time Automatically .......................... 318
Set the Sleep Mode Countdown ..................................................... 318
About Deep Sleep Mode ................................................................ 319
Set Auto Power Off Mode ............................................................. 319
Set the Date and Time .................................................................. 319
Set the Time Zone ......................................................................... 320
Adjust the LCD Contrast .............................................................. 320
Reduce Toner Consumption .......................................................... 321
Set the Continue Mode ................................................................. 321
Learn About the Receiving faxes in Continue Mode .................... 322
Set Your Station ID ....................................................................... 322
Set Tone or Pulse Dialing Mode ..................................................... 323
Add a Prefix to Every Fax Number ............................................... 323
Prevent Dialing a Wrong Number (Dial Restriction) ..................... 323
Appendix ........................................................................................................... 341

Print Reports .................................................................................................... 325
Reports .................................................................................................................. 325
Print a Report ...................................................................................................... 326

Settings and Features Tables .............................................................................. 326
Settings Tables (Dell E514dw) ........................................................................... 326
General Setup ...................................................................................................... 326
Fax .......................................................................................................................... 327
Copy ....................................................................................................................... 329
Printer .................................................................................................................... 329
Print Reports ........................................................................................................ 329
Network .................................................................................................................. 330
Machine Info ......................................................................................................... 332
Initial Setup .......................................................................................................... 332

Settings Tables (Dell E515dn/Dell E515dw) .............................................................. 333
General Setup ...................................................................................................... 333
Copy ....................................................................................................................... 333
Printer .................................................................................................................... 334
Network .................................................................................................................. 335
Machine Info ......................................................................................................... 337

Appendix .............................................................................................................. 341
Specifications ...................................................................................................... 341
General Specifications ......................................................................................... 341
Document Size Specification ................................................................................. 342
Print Media Specifications .................................................................................... 343
Fax Specifications .................................................................................................. 343
Before You Use Your Dell Machine .................................................. 21
Applicable Models ................................................................. 21
Definitions of Notes ............................................................... 21
Important Note ................................................................. 22
Before You Use Your Dell Machine

• Applicable Models
• Definitions of Notes
• Important Note

Applicable Models

This User's Guide applies to the following models:
Dell Multifunction Printer | E515dw
Dell Multifunction Printer | E515dn
Dell Multifunction Printer | E514dw

Definitions of Notes

We use the following symbols and conventions throughout this User's Guide:

⚠️ WARNING

WARNING indicates a potentially hazardous situation which, if not avoided, could result in death or serious injuries.

⚠️ CAUTION

CAUTION indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injuries.

⚠️ IMPORTANT

IMPORTANT indicates a potentially hazardous situation which, if not avoided, may result in damage to property or loss of product functionality.

⚠️ NOTE

NOTE specifies the operating environment, conditions for installation, or special conditions of use.

Tips icons provide helpful hints and supplementary information.

Electrical Hazard icons alert you to possible electrical shock.

Fire Hazard icons alert you to the possibility of a fire.

Hot Surface icons warn you not to touch hot machine parts.

Prohibition icons indicate actions you must not perform.

Bold style identifies buttons on the machine's control panel or computer screen.

Italicized style emphasizes an important point or refers you to a related topic.

Courier New font identifies messages shown on the machine's LCD.
Important Note

• This product is approved for use in the country of purchase only. Do not use this product outside the country of purchase as it may violate the wireless telecommunication and power regulations of that country.
• In this User's Guide, the LCD messages of the Dell E515dw is used unless otherwise specified.
• In this User's Guide, the illustrations of the Dell E515dw is used unless otherwise specified.
• Unless otherwise specified, the screens in this manual are from Windows® 7 and OS X v10.8.x. Screens on your computer may vary depending on your operating system.
• If the LCD messages, control panel key names, and other indications are different depending on the country, the indications for each country will be shown.
• The contents of this guide and the specifications of this product are subject to change without notice.
• Locate this product in a well-ventilated area. Do not obstruct ventilation openings of the product. Keep the minimum clearance as follows for ventilation and an access to the power plug. Unplug the product if an abnormal condition is noted.
• Ventilate well during extended operation or mass copying. It may affect the office air environment due to odor such as ozone in a poorly ventilated room. Provide proper ventilation to ensure the comfortable and safe environment.
• Connect this product to the LAN connection which is not subjected to over voltages.
• IT Power system (For Norway Only)
  This product is also designed for IT power system with phase to phase voltage 230V.
Introduction to Your Dell Machine ........................................ 25

Control Panel Overview ....................................................... 25

Dell Printer Hub (Windows® Only) ........................................... 30
Introduction to Your Dell Machine

• Control Panel Overview
• Dell Printer Hub (Windows® Only)

Control Panel Overview

The control panel will vary depending on your model.
Dell E515dn/Dell E515dw
Dell E514dw

Dell E515dn/Dell E515dw

1. One Touch buttons
   Store and recall up to eight fax and telephone numbers.
   To access stored One Touch fax and telephone numbers 1-4, press the One Touch button assigned to that number. To access stored One Touch fax and telephone numbers 5-8, hold down (Shift) as you press the number.

2. Fax buttons
   (Redial/Pause)
   Press to dial the last numbers you called. This button also inserts a pause when programming quick dial numbers or when dialing a number manually.
   (Hook)
   Press Hook before dialing to ensure a fax machine answers, and then press (Start). If the machine is in Fax/Tel (F/T) Mode and you pick up the handset of an external telephone during the F/T ring (pseudo double-rings), press Hook to talk.

3. Wi-Fi (for Dell E515dw)
   Press the Wi-Fi button and launch the wireless installer on your computer. Follow the on-screen instructions to set up a wireless connection between your machine and your network.
   When the Wi-Fi light is on, your Dell machine is connected to a wireless access point. When the Wi-Fi light blinks, the wireless connection is down, or your machine is in the process of connecting to a wireless access point.
   While Wi-Fi is on, if you push the Wi-Fi button, the wireless connection is down.
Resolution (for Dell E515dn)
Press to change the Fax resolution.

4. Liquid Crystal Display (LCD)
Displays messages to help you set up and use the machine.
If the machine is in Fax Mode, the LCD displays:

- a. Date & Time
- b. Receive Mode

When you press Copy, the LCD displays:

- c. Type of copy
- d. Number of copies
- e. Quality
- f. Contrast
- g. Copy ratio

5. Mode buttons

- (Fax)
  Press to switch the machine to FAX Mode.

- (Scan)
  Press to switch the machine to SCAN Mode.

- (Copy)
  Press to switch the machine to COPY Mode.

6. Copy buttons

- (Options)
  Press to access temporary settings for copying.

- (ID Copy)
  Press to copy both sides of an identification card onto a single page.
7. **Menu buttons**

- **(Clear)**
  - Press to delete entered data or cancel the current setting.

- **(Menu)**
  - Press to access the Menu for programming your machine settings.

- **OK**
  - Press to store your machine settings.
  - ▲ or ▼
    - Press to scroll back or forward through menu selections.
  - ▲ or ▼
    - Press to scroll up or down through menus and options.
    - Press to change the resolution in Fax Mode.

  - ▲
    - Press ▲ to access speed dial numbers.

8. **Dial Pad**

- Use to dial fax and telephone numbers.
- Use as a keyboard to enter text or characters.

9. **Power On/Off**

- Turn on the machine by pressing .
- Turn off the machine by pressing and holding . The LCD displays **Shutting Down** and stays on for a few seconds before turning off. If you have an external telephone or TAD connected, it is always available.

10. **(Cancel)**

- Press to stop an operation.
- Press to exit from a menu.

11. **(Start)**

- Press to start sending faxes.
• Press to start copying.
• Press to start scanning documents.

Dell E514dw

1. Power On/Off
   • Turn on the machine by pressing .
   • Turn off the machine by pressing and holding . The LCD displays Shutting Down and stays on for a few seconds before turning off.

2. Copy buttons
   (Options)
   Press to access temporary settings for copying.
   (ID Copy)
   Press to copy both sides of an identification card onto a single page.

   NOTE: Two functions are assigned to one button on some models.

3. (Scan)
   Press to switch the machine to Scan Mode.

4. Wi-Fi
   Press the Wi-Fi button and launch the wireless installer on your computer. Follow the on-screen instructions to set up a wireless connection between your machine and your network.
   When the Wi-Fi light is on, your Dell machine is connected to a wireless access point. When the Wi-Fi light blinks, the wireless connection is down, or your machine is in the process of connecting to a wireless access point.

5. Liquid Crystal Display (LCD)
   Displays messages to help you set up and use the machine.
   If the machine is in Ready Mode or COPY Mode, the LCD displays:
a. Type of copy  
b. Number of copies  
c. Quality  
d. Contrast  
e. Copy ratio

6. Menu buttons

(Menu)
Press to access the Menu for programming your machine settings.

(Clear)
- Press to delete entered data.  
- Press to cancel the current setting.

OK
Press to store your machine setting.

▲ or ▼
Press to scroll up or down through menus and options.

7. (Cancel)
- Press to stop an operation.  
- Press to exit from a menu.

8. (Start)
- Press to start copying.  
- Press to start scanning documents.
Dell Printer Hub (Windows® Only)

This software allows you to share, print, scan, and store digital documents with cloud services. It also notifies you of the firmware/software updates, printer status and toner level. For more information, open the program and click on the top right of the main window to see the FAQs.
Paper Handling ................................................................. 33
  Load Paper ........................................................................ 33
  Paper Settings .................................................................... 42
  Unscannable and Unprintable Areas. ................................. 44
  Using Special Paper ........................................................ 44
  Load Documents .................................................................. 45
Paper Handling

• Load Paper
• Paper Settings
• Unscannable and Unprintable Areas
  The figures in the table show maximum unscannable and unprintable areas from the edges of the most commonly-used paper sizes. These measurements may vary depending on the paper size or settings in the application you are using.
• Using Special Paper
  Always test paper samples before purchasing them to ensure desirable performance.
• Load Documents
  You can send a fax, make copies and scan from the Automatic Document Feeder (ADF) and from the scanner glass.

Load Paper

• Load and Print using the Paper Tray
• Load and Print Paper in the Manual Feed Slot

Load and Print using the Paper Tray

• If the Check Size setting is set to On and you pull the paper tray out of the machine, a message appears on the LCD asking if you want to change the paper size. Change the paper size and paper type settings if needed, following the on-screen instructions.
• When you load a different paper size in the tray, you must change the paper size setting in the machine or on your computer at the same time.

1.  Pull the paper tray completely out of the machine.

2.  Press and slide the paper guides to fit the paper.
  Press the release levers to slide the paper guides.
NOTE: For Legal or Folio size paper, press the release button (1) in the bottom of the paper tray and then pull out the back of the paper tray. (Legal and Folio size paper are not available in some regions.)

3. Fan the stack of paper well.

4. Load paper with the printing surface face down in the paper tray.

   NOTE: DO NOT load different types of paper in the paper tray at the same time. Doing this may cause the paper to jam or misfeed.
5. Make sure the paper is below the "MAX" mark. Overfilling the paper tray will cause paper jams.

6. Slowly push the paper tray completely into the machine.

7. Lift the flap to prevent paper from sliding off the output tray.

8. Send your print job to the machine.

**NOTE:** Change your print preferences in the Print dialog box before sending the print job from your computer.
Load and Print Paper in the Manual Feed Slot

- Load and Print Plain Paper, Thin Paper, Recycled Paper and Bond Paper in the Manual Feed Slot
- Load and Print on Thick Paper and Labels in the Manual Feed Slot
- Load and Print on Envelopes in the Manual Feed Slot
- Printing Problems
- Error and Maintenance Messages

Load and Print Plain Paper, Thin Paper, Recycled Paper and Bond Paper in the Manual Feed Slot

When you load a different paper size in the tray, you must change the paper size setting in the machine or on your computer at the same time.

1. Lift the support flap to prevent paper from sliding off the face-down output tray.

2. Open the manual feed slot cover.
3. Use both hands to slide the manual feed slot paper guides to fit the width of the paper you are using.

4. Using both hands, put one full sheet of paper in the manual feed slot until the front edge touches the paper feed roller. When you feel the machine pull it in, let go.

**NOTE:** Load paper into the manual feed slot with the printing surface facing up.

**NOTE:** Make sure the paper is straight and in the correct position in the manual feed slot. If it is not, the paper may not be fed correctly, resulting in a skewed printout or a paper jam.

**NOTE:** To remove a small printout from the output tray, use both hands to lift up the scanner cover.
NOTE: You can still use the machine while the scanner cover is up. To close the scanner cover, push it down with both hands.

5. Send your print job to the machine.
   
   NOTE: Change your print preferences in the Print screen before sending the print job from your computer.

6. After the printed page comes out from the machine, load the next sheet of paper in the manual feed slot. Repeat for each page that you want to print.

Load and Print on Thick Paper and Labels in the Manual Feed Slot

When you load a different paper size in the tray, you must change the paper size setting in the machine or on your computer at the same time.

1. Open the machine's back cover (the face-up output tray).
NOTE: The machine automatically turns on Manual Feed mode when you load paper in the manual feed slot.

2. On the front of the machine, open the manual feed slot cover.

3. Use both hands to slide the manual feed slot paper guides to fit the width of the paper that you are using.

4. Using both hands, put one full sheet of paper in the manual feed slot until the front edge touches the paper feed roller. When you feel the machine pull it in, let go.
NOTE: Load paper into the manual feed slot with the printing surface facing up.

NOTE: Pull the paper out completely if you must reload the paper into the manual feed slot.

NOTE: Do not put more than one sheet of paper in the manual feed slot at one time, as it may cause a jam.

NOTE: Make sure the paper is straight and in the correct position in the manual feed slot. If it is not, the paper may not be fed correctly, resulting in a skewed printout or a paper jam.

5. Send your print job to the machine.

NOTE: Change your print preferences in the Print screen before sending the print job from your computer.

6. After the printed page comes out from the back of the machine, load the next sheet of paper in the manual feed slot. Repeat for each page that you want to print.

7. Close the back cover (the face-up output tray) until it locks in the closed position.

Load and Print on Envelopes in the Manual Feed Slot

When you load a different paper size in the tray, you must change the paper size setting in the machine or on your computer at the same time.

1. Open the machine's back cover (the face-up output tray).

NOTE: The machine automatically turns on Manual Feed mode when you load paper in the manual feed slot.

2. Pull down the two levers, one on the left side and one on the right side, as shown in the illustration.
3. On the front of the machine, open the manual feed slot cover.

4. Use both hands to slide the manual feed slot paper guides to fit the width of the paper that you are using.

5. Using both hands, put one envelope in the manual feed slot until the front edge touches the paper feed roller. When you feel the machine pull it in, let go.
NOTE: Load the envelope into the manual feed slot with the printing surface facing up.

NOTE: Pull the envelope out completely when you reload the envelope into the manual feed slot.

NOTE: Do not put more than one envelope in the manual feed slot at one time, as it may cause a jam.

NOTE: Make sure the envelope is straight and in the correct position on the manual feed slot. If it is not, the envelope may not be fed correctly, resulting in a skewed printout or a paper jam.

6. Send your print job to the machine.

NOTE: Change your print preferences in the Print dialog box before sending the print job from your computer.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Options for Envelopes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Size</td>
<td>Com-10</td>
</tr>
<tr>
<td></td>
<td>DL</td>
</tr>
<tr>
<td></td>
<td>C5</td>
</tr>
<tr>
<td></td>
<td>Monarch</td>
</tr>
<tr>
<td>Media Type</td>
<td>Envelopes</td>
</tr>
<tr>
<td></td>
<td>Env. Thick</td>
</tr>
<tr>
<td></td>
<td>Env. Thin</td>
</tr>
</tbody>
</table>

7. After the printed envelope comes out of the machine, put in the next envelope. Repeat for each envelope that you want to print.

8. When you have finished printing, return the two levers that you adjusted in former step back to their original positions.

9. Close the back cover (the face-up output tray) until it locks in the closed position.

**Paper Settings**

- Change the Paper Size
  When you change the size of the paper you load in the tray, you must change the paper size setting on the LCD at the same time.
- Change the Paper Type
  To get the best print quality, set the machine for the type of paper you are using.
- Set the Check Size
Your Dell machine's Check Size setting causes the machine to display a message when you remove the paper tray from the machine, asking if you changed the paper size.

**Change the Paper Size**

When you change the size of the paper you load in the tray, you must change the paper size setting on the LCD at the same time.

1. Press **Menu**.
2. Press ▲ or ▼ to display the General Setup option, and then press **OK**.
3. Press ▲ or ▼ to display the Paper option, and then press **OK**.
4. Press ▲ or ▼ to display the Paper Size option, and then press **OK**.
5. Press ▲ or ▼ to display the Letter, Legal, Executive, A5, A5 L, A6, Folio, or A4 option, and then press **OK**.
6. Press **Cancel**.

**Change the Paper Type**

To get the best print quality, set the machine for the type of paper you are using.

1. Press **Menu**.
2. Press ▲ or ▼ to display the General Setup option, and then press **OK**.
3. Press ▲ or ▼ to display the Paper option, and then press **OK**.
4. Press ▲ or ▼ to display the Paper Type option, and then press **OK**.
5. Press ▲ or ▼ to display the Thin, Plain, Thick, Thicker, or Recycled Paper option, and then press **OK**.
6. Press **Cancel**.

**Set the Check Size**

Your Dell machine's Check Size setting causes the machine to display a message when you remove the paper tray from the machine, asking if you changed the paper size.

The default setting is On.

1. Press **Menu**.
2. Press ▲ or ▼ to display the General Setup option, and then press **OK**.
3. Press ▲ or ▼ to display the Paper option, and then press **OK**.
4. Press ▲ or ▼ to display the Check Size option, and then press **OK**.
5. Press ▲ or ▼ to select the On or Off option, and then press **OK**.
6. Press **Cancel**.
Unscannable and Unprintable Areas

The figures in the table show maximum unscannable and unprintable areas from the edges of the most commonly-used paper sizes. These measurements may vary depending on the paper size or settings in the application you are using.

![Diagram of paper edges]

**NOTE:** Do not attempt to scan, copy, or print into these areas; your output will not reflect anything in these areas.

<table>
<thead>
<tr>
<th>Usage</th>
<th>Document Size</th>
<th>Top (1)</th>
<th>Bottom (3)</th>
<th>Left (2)</th>
<th>Right (4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax (Sending)</td>
<td>Letter, Legal (ADF)</td>
<td>0.12 in. (3 mm)</td>
<td>0.16 in. (4 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A4</td>
<td>0.12 in. (3 mm)</td>
<td></td>
<td>0.04 in. (1 mm)</td>
<td>(ADF)</td>
<td>0.12 in. (3 mm)</td>
</tr>
<tr>
<td>Copy*1</td>
<td>Letter, Legal (ADF)</td>
<td>0.16 in. (4 mm)</td>
<td>0.12 in. (3 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A4</td>
<td>0.16 in. (4 mm)</td>
<td></td>
<td>0.12 in. (3 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scan</td>
<td>Letter</td>
<td>0.12 in. (3 mm)</td>
<td>0.12 in. (3 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A4</td>
<td>0.12 in. (3 mm)</td>
<td></td>
<td>0.12 in. (3 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legal (ADF)</td>
<td>Approximately 0.12 in. (3 mm)</td>
<td>Approximately 0.12 in. (3 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td>Letter, Legal</td>
<td>0.16 in. (4.2 mm)</td>
<td>0.16 in. (4.2 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A4</td>
<td>0.16 in. (4.2 mm)</td>
<td></td>
<td>0.16 in. (4.2 mm)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1: a single copy or a 1 in 1 copy

**Using Special Paper**

Always test paper samples before purchasing them to ensure desirable performance.

**WARNING**

Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. When paper jam occurs, it may cause short-circuit and eventually a fire accident.

- **DO NOT** use inkjet paper; it may cause a paper jam or damage your machine.
- If you use bond paper, paper with a rough surface, or paper that is wrinkled or creased, the paper may exhibit degraded performance.
IMPORTANT

Some types of paper may not perform well or may cause damage to your machine.
DO NOT use paper:
• that is highly textured
• that is extremely smooth or shiny
• that is curled or warped
• that is coated or has a chemical finish
• that is damaged, creased or folded
• that exceeds the recommended weight specification in this guide
• with tabs and staples
• with letterheads using low temperature dyes or thermography
• that is multipart or carbonless
• that is designed for inkjet printing

If you use any of the types of paper listed above, they may damage your machine. This damage is not covered under any Dell warranty or service agreement.

Load Documents

You can send a fax, make copies and scan from the Automatic Document Feeder (ADF) and from the scanner glass.
• Load Documents in the Automatic Document Feeder (ADF)
  Use the ADF when copying or scanning multiple-page, standard-sized documents.
• Load Documents on the Scanner Glass
  Use the scanner glass to fax, copy, or scan one page at a time.

Load Documents in the Automatic Document Feeder (ADF)

Use the ADF when copying or scanning multiple-page, standard-sized documents.

• The ADF can hold up to 35 pages and feed each sheet individually.
• Use standard 20 lb (80 g/m²) paper.
• Make sure documents with correction fluid or written in ink are completely dry.

IMPORTANT

• DO NOT leave thick documents on the scanner glass. If you do this, the ADF may jam.
• DO NOT use paper that is curled, wrinkled, folded, ripped, stapled, paper-clipped, pasted, or taped.
• DO NOT use cardboard, newspaper, or fabric.
• To avoid damaging your machine while using the ADF, DO NOT pull on the document while it is feeding.
**Document Sizes Supported**

<table>
<thead>
<tr>
<th>Length:</th>
<th>5.8 in. to 14.0 in. (147.3 to 355.6 mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width:</td>
<td>5.8 in. to 8.5 in. (147.3 to 215.9 mm)</td>
</tr>
<tr>
<td>Weight:</td>
<td>17 to 24 lb (64 to 90 g/m²)</td>
</tr>
</tbody>
</table>

1. Unfold the ADF document support.
   Lift and unfold the ADF document output support flap.

2. Fan the pages well.

3. Stagger the pages of your document and load it *face up and top edge first*, into the ADF as shown in the illustration.

4. Adjust the paper guides to fit the width of your document.

**Load Documents on the Scanner Glass**

Use the scanner glass to fax, copy, or scan one page at a time.

**Document Sizes Supported**

<table>
<thead>
<tr>
<th>Length:</th>
<th>Up to 11.8 in. (300.0 mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width:</td>
<td>Up to 8.5 in. (215.9 mm)</td>
</tr>
<tr>
<td>Weight:</td>
<td>Up to 4.4 lb (2.0 kg)</td>
</tr>
</tbody>
</table>

**NOTE:** To use the scanner glass, the ADF must be empty.

1. Lift the document cover.

2. Place the document on the scanner glass *face down.*
3. Place the corner of the page in the upper left corner of the scanner glass.

4. Close the document cover.
   If the document is a book or is thick, gently press on the document cover.
Print ................................................................. 51
Before Printing .................................................... 51
Print from Your Computer (Windows®) ..................... 51
Print from Your Computer (Macintosh) ..................... 76
Adjust Print Settings from the Machine’s Control Panel . 88
Print

• Before Printing
• Print from Your Computer (Windows®)
• Print from Your Computer (Macintosh)
• Adjust Print Settings from the Machine's Control Panel

Before Printing

Before attempting any printing operation, confirm the following:
• The instructions for printer driver are described based on PCL driver. Since the XPS printer driver is installed as the default printer driver for Windows® 8, the function may vary from the instructions on this user guide.
• For USB or network cable users: Make sure the interface cable is physically secure.

Simultaneous printing, scanning and faxing
Your machine can print from your computer while sending or receiving a fax in memory or while scanning a document into the computer. Fax sending will not be stopped during printing from your computer. However, when the machine is copying or receiving a fax on paper, it pauses the printing operation, and then continues printing when copying or fax receiving has finished.

NOTE: Dell E514dw does not support the fax feature.

Firewall (Windows®)
If your computer is protected by a firewall and you are unable to network print, network scan, or PC-FAX, you may need to configure the firewall settings. If you are using any other personal firewall software, see the User’s Guide for your software or contact the software manufacturer.

Print from Your Computer (Windows®)

Basic Printing Methods (Windows®)
• Print a Document (Windows®)
• Print Preview (Windows®)
• Change the Paper Size (Windows®)
  The Paper Size options offer a large selection of standard paper sizes.
• Change the Orientation of Your Print (Portrait or Landscape) (Windows®)
• Print Multiple Copies of the Same Document (Windows®)
• Change the Media Type (Windows®)
  To achieve the best print results, the media being printed on should be selected in the driver. The machine changes the way it prints depending on the selected media type.
• Change the Resolution (Windows®)
  You can choose the print resolution. As print resolution and speed are related, the higher the resolution, the longer it will take to print the document.
• Change the Print Settings (Windows®)
The Print Settings selection lets you choose the print resolution. As print quality and speed are related, the higher the quality, the longer it takes to print the document.

- **Improve Gray Printing (Windows®)**
  You can improve the image quality of a shaded area.

- **Improve Pattern Printing (Windows®)**
  You can improve the pattern printing if printed fills and patterns are different from the fills and patterns you see on your computer screen.

- **Improve Thin Line (Windows®)**
  Use this option to improve the image quality of thin lines.

- **Print More Than One Page on a Single Sheet of Paper (N in 1) (Windows®)**

- **Print as a Poster (Windows®)**
  Enlarge your print size and print the document in poster mode.

- **Print on Both Sides of the Paper (Windows®)**

- **Print as a Booklet (Windows®)**
  Use this option to print a document in booklet format using 2-sided printing. The document's pages will be arranged according to the correct page number and will allow you to fold the print output at the center and read the booklet pages numerically, without having to change the order of the printed pages.

- **Change the Paper Source (Windows®)**
  Select a paper source setting that matches your print conditions or purpose.

### Print a Document (Windows®)

1. Select the print command in your application.
2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. Make sure you have loaded the correct size paper in the paper tray.
4. Click the **Paper Size** drop-down list, and then select your paper size.
5. In the **Orientation** field, select either **Portrait** or **Landscape** option to set the orientation of your printout.
   **NOTE:** If your application software contains a similar layout feature, we recommend using the one in the application.
6. Type the number of copies (1-999) you want in the **Copies** field.
7. Click the **Media Type** drop-down list, and then select the type of paper you are using.
8. To print multiple pages on a single sheet of paper or print one page of your document on multiple sheets, click the **Multiple Page** drop-down list, and then select your options.
9. Change other printer settings if needed.
10. Click **OK**.
11. Complete your print operation.
Print Preview (Windows®)

1. Select the print command in your application.
2. Select Dell MFP EXXXX (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. Select the Print Preview check box.
4. Change other printer settings if needed.
5. Click OK.
6. Click the proceed or next button in your application dialog box.
   The Print Preview viewer opens before printing starts.
7. Select the page(s) you want to print from the list in the Print Page field.
   The print results will be displayed in the preview area. By default, all pages are selected. To print only some pages, clear the check boxes for the pages you do not want to print.
   **NOTE:** If the 2-sided / Booklet setting is selected in the printer driver, you cannot select the Print Page check box.
8. Click File, and then click Print to start printing.

Change the Paper Size (Windows®)

The Paper Size options offer a large selection of standard paper sizes.

1. Select the print command in your application.
2. Select Dell MFP EXXXX (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. Click the Paper Size drop-down list, and then select your paper size.
4. Click OK.
5. Complete your print operation.

Create a Custom Paper Size (Windows®)

1. Do one of the following:
   - (For Windows Server® 2003)
     Click **Start > Printers and Faxes**.
   - (For Windows Vista® and Windows Server® 2008)
     Click **(Start) > Control Panel > Hardware and Sound > Printers**.
   - (For Windows® 7 and Windows Server® 2008 R2)
     Click **(Start) > Devices and Printers**.
   - (For Windows® 8)
     Move your mouse to the lower right corner of your desktop. When the menu bar appears, click **Settings**, and then click **Control Panel**. In the Hardware and Sound group, click **View devices and printers**.
**Change the Orientation of Your Print (Portrait or Landscape) (Windows®)**

<table>
<thead>
<tr>
<th>Portrait</th>
<th>Landscape</th>
</tr>
</thead>
</table>

1. Select the print command in your application.

2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.

3. In the Orientation field, select either **Portrait** or **Landscape** option to set the orientation of your printout.

   **NOTE:** If your application software contains a similar layout feature, we recommend using the one in the application.
4. Click **OK**.
5. Complete your print operation.

**Print Multiple Copies of the Same Document (Windows®)**

1. Select the print command in your application.
2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
   
   The printer driver window appears.
3. Type the number of copies (1-999) you want in the **Copies** field.
4. Select the **Collate** check box, if needed.
   
   **Collate**
   
   When the **Collate** check box is selected, one complete copy of your document will be printed, and then reprinted according to the number of copies you choose. If the **Collate** check box is not selected, then each page will be printed according to the number of copies chosen before the next page of the document is printed.
5. Change other printer settings if needed.
6. Click **OK**.
7. Complete your print operation.

**Change the Media Type (Windows®)**

To achieve the best print results, the media being printed on should be selected in the driver. The machine changes the way it prints depending on the selected media type.

1. Select the print command in your application.
2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
   
   The printer driver window appears.
3. Click the **Media Type** drop-down list, and then select the media type you want to use.

<table>
<thead>
<tr>
<th>Select this Media Type</th>
<th>For this paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Paper</td>
<td>Ordinary plain paper</td>
</tr>
<tr>
<td>Thin Paper</td>
<td>Ordinary thin paper</td>
</tr>
<tr>
<td>Thick Paper</td>
<td>Rough paper or thicker paper</td>
</tr>
<tr>
<td>Thicker Paper</td>
<td>Select this option if you have selected <strong>Thick Paper</strong>, and toner smudges while printing.</td>
</tr>
<tr>
<td>Bond Paper</td>
<td>Bond paper</td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelopes</td>
</tr>
<tr>
<td>Env. Thick</td>
<td>Select this option if the toner does not correctly stick to the envelope when the <strong>Envelopes</strong> option is selected.</td>
</tr>
<tr>
<td>Env. Thin</td>
<td>Select this option if the envelope is crumpled when the <strong>Envelopes</strong> option is selected.</td>
</tr>
<tr>
<td>Recycled Paper</td>
<td>Recycled paper</td>
</tr>
<tr>
<td>Label</td>
<td>Label</td>
</tr>
</tbody>
</table>
4. Click **OK**.
5. Complete your print operation.

**Change the Resolution (Windows®)**

You can choose the print resolution. As print resolution and speed are related, the higher the resolution, the longer it will take to print the document.

1. Select the print command in your application.
2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. Click the **Resolution** drop down list and click the print resolution you want to use.
   - **300 dpi**
   - **600 dpi**
   - **HQ 1200**
4. Click **OK**.
5. Complete your print operation.

**Change the Print Settings (Windows®)**

The Print Settings selection lets you choose the print resolution. As print quality and speed are related, the higher the quality, the longer it takes to print the document.

1. Select the print command in your application.
2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. Click the **Print Settings** drop down list and click the print settings you want to use.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphics</td>
<td>This is the best mode for printing documents that contain graphics.</td>
</tr>
<tr>
<td>Text</td>
<td>This is the best mode for printing text documents.</td>
</tr>
<tr>
<td>Manual</td>
<td>You can change the advanced settings manually.</td>
</tr>
</tbody>
</table>

4. To change more advanced settings such as brightness, contrast, and other settings, select **Manual** and click **Manual Settings...**
5. Click **OK**.

6. Complete your print operation.

**Improve Gray Printing (Windows®)**

You can improve the image quality of a shaded area.

1. Select the print command in your application.
2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. Click the **Print Settings** drop-down list, select **Manual**, and then click the **Manual Settings...** button.
4. Select the **Improve Gray Printing** check box.
5. Click **OK** to return to the printer driver window.
6. Click **OK**.
7. Complete your print operation.
**Improve Pattern Printing (Windows®)**

You can improve the pattern printing if printed fills and patterns are different from the fills and patterns you see on your computer screen.

1. Select the print command in your application.
2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. Click the **Print Settings** drop-down list, select **Manual**, and then click the **Manual Settings...** button.
4. Select the **Improve Pattern Printing** check box.
5. Click **OK** to return to the printer driver window.
6. Click **OK**.
7. Complete your print operation.

**Improve Thin Line (Windows®)**

Use this option to improve the image quality of thin lines.

1. Select the print command in your application.
2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. Click the **Print Settings** drop-down list, select **Manual**, and then click the **Manual Settings...** button.
4. Confirm that the **Improve Thin Line** check box is selected.
5. Click **OK** to return to the printer driver window.
6. Click **OK**.
7. Complete your print operation.

**Print More Than One Page on a Single Sheet of Paper (N in 1) (Windows®)**

1. Select the print command in your application.
2. Select Dell MFP EXXXX (where XXXX is the name of your model), and then click the printing properties or preferences button. The printer driver window appears.

3. In the Orientation field, select either Portrait or Landscape option to set the orientation of your printout.

   NOTE: If your application software contains a similar layout feature, we recommend using the one in the application.

4. Click the Multiple Page drop-down list, and then select the 2 in 1, 4 in 1, 9 in 1, 16 in 1, or 25 in 1 option.

5. Click the Page Order drop-down list, and then select your page order.

6. Click the Border Line drop-down list, and then select your border line type.

7. Change other printer settings if needed.

8. Click OK.

9. Complete your print operation.

Print as a Poster (Windows®)

Enlarge your print size and print the document in poster mode.

1. Select the print command in your application.

2. Select Dell MFP EXXXX (where XXXX is the name of your model), and then click the printing properties or preferences button. The printer driver window appears.

3. Click the Multiple Page drop-down list, and then select the 1 in 2x2 Pages, 1 in 3x3 Pages, 1 in 4x4 Pages, or 1 in 5x5 Pages option.

4. Select the Print cut-out line check box, if needed.

   Print cut-out line
   Prints a faint cut-out line around the printable area so that you can easily cut it out.

5. Change other printer settings if needed.

6. Click OK.

7. Complete your print operation.
Print on Both Sides of the Paper (Windows®)

- Select Letter, Legal, or Folio sized paper when using the automatic 2-sided printing function.
- Make sure the back cover is closed.
- If paper is curled, straighten it and put it back in the paper tray.
- Use regular paper or thin paper. DO NOT use bond paper.
- If the paper is too thin, it may wrinkle.
- When you use the manual 2-sided printing function, it is possible there may be paper jams or poor print quality.

1. Select the print command in your application.
2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. In the **Orientation** field, select either **Portrait** or **Landscape** option to set the orientation of your printout.
   **NOTE:** If your application software contains a similar layout feature, we recommend using the one in the application.
4. Click the **2-sided / Booklet** drop-down list, and then select the **2-sided** or **2-sided (Manual)** option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-sided (available only for certain models)</td>
<td>Automatically prints on both sides of the paper.</td>
</tr>
<tr>
<td>2-sided (Manual)</td>
<td>The machine prints all the even-numbered pages on one side of the paper first. Then, the printer driver instructs you (with a pop-up message) to reinsert the paper.</td>
</tr>
</tbody>
</table>
5. Click the **2-sided Settings** button.
6. Select one of the options from the **2-sided Type** menu.
   When 2-sided is selected, four types of 2-sided binding are available for each orientation:
<table>
<thead>
<tr>
<th>Option for Portrait</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long Edge (Left)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td></td>
<td>![Diagram]</td>
</tr>
<tr>
<td>Long Edge (Right)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td></td>
<td>![Diagram]</td>
</tr>
<tr>
<td>Short Edge (Top)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td></td>
<td>![Diagram]</td>
</tr>
<tr>
<td>Short Edge (Bottom)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td></td>
<td>![Diagram]</td>
</tr>
<tr>
<td>Option for Landscape</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Long Edge (Left)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td></td>
<td>![Diagram]</td>
</tr>
<tr>
<td>Long Edge (Right)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td></td>
<td>![Diagram]</td>
</tr>
<tr>
<td>Short Edge (Top)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td></td>
<td>![Diagram]</td>
</tr>
<tr>
<td>Short Edge (Bottom)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td></td>
<td>![Diagram]</td>
</tr>
</tbody>
</table>
7. Select the **Binding Offset** check box if you want to specify the offset for binding in inches or millimeters.

8. Click **OK**.

9. Change other printer settings if needed.

10. Do one of the following:
    - For automatic 2-sided printing, click **OK** again, and then complete your print operation.
    - For manual 2-sided printing, click **OK** again and follow the screen instructions.

If the paper is not feeding correctly, it may be curled. Remove the paper, straighten it, and put it back in the paper tray.

**Print as a Booklet (Windows®)**

Use this option to print a document in booklet format using 2-sided printing. The document’s pages will be arranged according to the correct page number and will allow you to fold the print output at the center and read the booklet pages numerically, without having to change the order of the printed pages.
• Select Letter, Legal, or Folio sized paper when using the automatic 2-sided printing function.
• Make sure the back cover is closed.
• If paper is curled, straighten it and put it back in the paper tray.
• Use regular paper or thin paper. DO NOT use bond paper.
• If the paper is too thin, it may wrinkle.
• When you use the manual 2-sided printing function, it is possible there may be paper jams or poor print quality.

1. Select the print command in your application.
2. Select Dell MFP EXXX (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. In the Orientation field, select either Portrait or Landscape option to set the orientation of your printout.
   **NOTE:** If your application software contains a similar layout feature, we recommend using the one in the application.
4. Click the 2-sided / Booklet drop-down list, and then select the Booklet or Booklet (Manual) option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Booklet (available only for certain models)</td>
<td>Automatically prints as a booklet.</td>
</tr>
<tr>
<td>Booklet (Manual)</td>
<td>Manually prints as a booklet.</td>
</tr>
</tbody>
</table>

5. Click the 2-sided Settings button.
6. Select the one of the options from the 2-sided Type menu.
   There are two types of 2-sided binding directions available for each orientation:
### Option for Portrait

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left Binding</td>
</tr>
</tbody>
</table>

![Left Binding Diagram](image1)

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right Binding</td>
</tr>
</tbody>
</table>

![Right Binding Diagram](image2)

### Option for Landscape

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Binding</td>
</tr>
</tbody>
</table>

![Top Binding Diagram](image3)

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bottom Binding</td>
</tr>
</tbody>
</table>

![Bottom Binding Diagram](image4)

7. Select one of the options from the **Booklet Printing Method** menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Pages at Once</td>
<td>Every page will be printed in booklet format (four pages to every piece of paper, two pages per side). Fold your printout in the middle to create the booklet.</td>
</tr>
</tbody>
</table>

![All Pages at Once Diagram](image5)
8. Select the **Binding Offset** check box if you want to specify the offset for binding in inches or millimeters.

9. Click **OK**.

10. Change other printer settings if needed.

11. Do one of the following:
    - For automatic booklet printing, click **OK** again, and then complete your print operation.
    - For manual booklet printing, click **OK** again and follow the screen instructions.

**Change the Paper Source (Windows®)**

Select a paper source setting that matches your print conditions or purpose.

1. Select the print command in your application.

2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
   
   The printer driver window appears.

3. Click the **First Page** and **Other Pages** drop-down lists to select your paper tray from each list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Select</td>
<td>The machine will automatically select the tray to use if the paper type and paper size configured on the machine match the printer driver settings. The paper size and paper type for each tray must be configured correctly on the machine.</td>
</tr>
<tr>
<td>Tray1</td>
<td>The machine will exclusively use tray #1 when printing.</td>
</tr>
<tr>
<td>Manual</td>
<td>The machine will exclusively use the Manual Feed Slot when printing.</td>
</tr>
</tbody>
</table>

   **NOTE:** You can specify different trays for printing the first page of your document and for printing from the second page onwards.

4. Click **OK**.

5. Complete your print operation.

**Advanced Printing Methods (Windows®)**

- Print in Toner Save Mode (Windows®)
This feature conserves your toner by using less toner to print documents; print appears lighter, but is still readable.

• Scaled Print (Windows®)
  This option lets you enlarge or reduce the pages in your document to fit your printed paper size.

• Reverse Print (Windows®)
  This setting rotates the printed image 180 degrees.

• Add a Watermark to the Printed Document (Windows®)
  Print a logo or text onto your document as a watermark. Select one of the preset watermarks, add a new watermark, or use an image file you have created.

• Print the Date, Time and PC Login User Name on the Document (Header-Footer Print) (Windows®)

• Use a Macro from Your Computer (Windows®)
  If you have stored the electronic forms (macros) in your machine's memory, you can use the macro to print the data as an overlay on the print job you want.

• Adjust the Print Density (Windows®)
  You can increase or decrease the print density.

• Reduce Paper Curl (Windows®)

• Improve Toner Fixing (Windows®)

• Skip Blank Page (Windows®)
  Use this option to allow the printer driver to automatically detect blank pages and exclude them from printing.

• Print Text in Black (Windows®)
  Use this option when you want to print color text in black.

• Save an Archive File of the Print Data (Windows®)
  Print data can be saved as a PDF file to your computer.

Print in Toner Save Mode (Windows®)

This feature conserves your toner by using less toner to print documents; print appears lighter, but is still readable.

NOTE: We do not recommend using this mode for printing photo or grayscale images.

1. Select the print command in your application.

2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
The printer driver window appears.

3. Click the **Advanced** tab.
4. Select the **Toner Save Mode** check box.
5. Change other printer settings if needed.
6. Click **OK**.
7. Complete your print operation.

**Scaled Print (Windows®)**

This option lets you enlarge or reduce the pages in your document to fit your printed paper size.

1. Select the print command in your application.
2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. Click the **Advanced** tab.
4. Do one of the following:
   - Select the **Fit to Paper Size** option to enlarge or reduce the document to fit your printed paper size, and then select the paper size from the drop-down list.
   - Select the **Free** option to enlarge or reduce the document's page size manually, and then type a value into the field.
5. Change other printer settings if needed.
6. Click **OK**.
7. Complete your print operation.

**Reverse Print (Windows®)**

This setting rotates the printed image 180 degrees.

1. Select the print command in your application.
2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. Click the **Advanced** tab.
4. Select the **Reverse Print** check box.
5. Change other printer settings if needed.
6. Click **OK**.
7. Complete your print operation.

**Add a Watermark to the Printed Document (Windows®)**

Print a logo or text onto your document as a watermark. Select one of the preset watermarks, add a new watermark, or use an image file you have created.

1. Select the print command in your application.
2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. Click the **Advanced** tab.
4. Select the **Use Watermark** check box, and then click the **Settings** button.
5. Select the watermark you want to use from the **Select Watermark** list, or create a new watermark.
   - To create a new watermark, click **Add**.
     a. Select either the **Use Text** or **Use Image File** option in the **Watermark Style** field.
     b. Type a title for the watermark in the **Title** field.
     c. If you select the **Use Text** option:
        • Select your **Text, Font, Style, Size** and **Darkness** options.
     d. If you select the **Use Image File** option:
        • Type the file name and location of your image in the **File** field or click the **Browse** button to search for the file.
        • Once an image selected, you can scale the size of the image.
     e. To move the position of the watermark on the page, adjust it in the **Position** field.
   • To modify an existing watermark, select the watermark, and then click the **Settings** button.

**Bring To Front**
This option will overlay the watermark on your printed document.

**In Outline Text**
Select the **In Outline Text** check box to print only an outline of the watermark. This feature is available only when using a text watermark.

**Custom Settings**
Select where your watermark will print. Include it on all pages, on the first page only, or on all pages except the first page.

6. Click **OK**.
7. Change other printer settings if needed.
8. Click **OK**.
9. Complete your print operation.
Print the Date, Time and PC Login User Name on the Document (Header-Footer Print) (Windows®)

1. Select the print command in your application.

2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
   
   The printer driver window appears.

3. Click the **Advanced** tab.

4. Select the **Header-Footer Print** check box, and then click the **Settings** button.

5. Select the options you want from the following settings: **Format**, **Position**, **Font** and **Background**.

   **ID Print**
   
   Select your computer login user name or custom text as a header or footer using one of the following methods:
   
   - Select the **Login User Name** option to print your computer login user name.
   - Select the **Custom** option to print the text you enter in the **Custom** field.

6. Click **OK** to return to the printer driver window.

7. Change other printer settings if needed.

8. Click **OK**.

9. Complete your print operation.

Use a Macro from Your Computer (Windows®)

If you have stored the electronic forms (macros) in your machine’s memory, you can use the macro to print the data as an overlay on the print job you want.

1. Select the print command in your application.

2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
   
   The printer driver window appears.

3. Click the **Advanced** tab.

4. Click the **Other Print Options** button.

5. Select **Macro**.

6. Click the **Macro Settings** button.
7. Enter **Macro ID** and **Macro Name** you want to use.

8. Select **Insert Macro Command**.

9. Select the page to overlay the macro data.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Pages</td>
<td>Lets you insert the macro onto all pages.</td>
</tr>
<tr>
<td>Page</td>
<td>Lets you insert the macro onto a specific page. Select this option, and then enter a page number within the range 1 to 255.</td>
</tr>
<tr>
<td>Add to Top of Page</td>
<td>Send the macro data to the top of the page.</td>
</tr>
<tr>
<td>Add to End of Page</td>
<td>Send the macro data to the bottom of the page.</td>
</tr>
</tbody>
</table>

**NOTE:** When **Booklet** has been selected, the **Page** setting in **Insert Macro Command** is disabled.

10. Click **OK**.

11. Click **OK** to return to the printer driver window.

12. Click **OK**.

13. Complete your print operation.

   The macro data is printed as an overlay.

**Adjust the Print Density (Windows®)**

You can increase or decrease the print density.

1. Select the print command in your application.

2. Select **Dell MFP EXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.

   The printer driver window appears.

3. Click the **Advanced** tab.

4. Click the **Other Print Options** button.

5. Select **Density Adjustment**.

6. Clear the **Printer Default** check box.

7. To increase or decrease the print density, move the slide bar to the right or left.

8. Click **OK** to return to the printer driver window.

9. Click **OK**.

10. Complete your print operation.
Reduce Paper Curl (Windows®)

If you are printing only a few pages, you do not need to select this setting. If paper curls excessively, we recommend changing the **Media Type** setting in the printer driver to the **Thin Paper** or **Env. Thin** setting.

**NOTE:** This setting decreases the temperature of the machine’s fusing process, which reduces paper curl.

1. Select the print command in your application.
2. Select **Dell MFP EXXXX** (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. Click the **Advanced** tab.
4. Click the **Other Print Options** button.
5. Select the **Improve Print Output** option from the **Printer Function** list.
6. Select the **Reduce Paper Curl** radio button.
7. Click **OK** to return to the printer driver window.
8. Click **OK**.
9. Complete your print operation.

**Improve Toner Fixing (Windows®)**

**NOTE:** This setting increases the temperature of the machine’s fusing process, which improves toner’s ability to stick to paper.
1. Select the print command in your application.

2. Select Dell MFP EXXXX (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.

3. Click the Advanced tab.

4. Click the Other Print Options button.

5. Select the Improve Print Output option from the Printer Function list.

6. Select the Improve Toner Fixing radio button.

7. Click OK to return to the printer driver window.

8. Click OK.

9. Complete your print operation.

If this selection does not provide enough improvement, change the Media Type setting in the printer driver to the Thick Paper or Env. Thick setting.

**Skip Blank Page (Windows®)**

Use this option to allow the printer driver to automatically detect blank pages and exclude them from printing.

This option does not work if the following settings are active:

- Use Watermark
- Header-Footer Print
- N in 1 or 1 in NxN Pages in the Multiple Page drop-down list
- 2-sided (Manual), Booklet, Booklet (Manual) and Binding Offset.

1. Select the print command in your application.

2. Select Dell MFP EXXXX (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.

3. Click the Advanced tab.

4. Click the Other Print Options button.

5. Select the Skip Blank Page option from the Printer Function list.

6. Select the Skip Blank Page check box.

7. Click OK to return to the printer driver window.

8. Click OK.

9. Complete your print operation.

**Print Text in Black (Windows®)**

Use this option when you want to print color text in black.
NOTE: The Print Text in Black option may not work with certain data.

1. Select the print command in your application.
2. Select Dell MFP EXXXX (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. Click the Advanced tab.
4. Click the Other Print Options button.
5. Select the Print Text in Black option from the Printer Function list.
6. Select the Print Text in Black check box.
7. Click OK to return to the printer driver window.
8. Click OK.
9. Complete your print operation.

Save an Archive File of the Print Data (Windows®)

Print data can be saved as a PDF file to your computer.

1. Select the print command in your application.
2. Select Dell MFP EXXXX (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. Click the Advanced tab.
4. Click the Other Print Options button.
5. Select the Print Archive option from the Printer Function list.
6. Select the Print Archive check box.
7. Change the file size by moving the File Size slider to the right or left.
   The resolution is set according to the file size.
8. Click OK to return to the printer driver window.
9. Click OK.
10. Complete your print operation.
    The machine prints the data and saves the archive file to your computer.

Select a Print Profile (Windows®)

Print Profiles are presets designed to give you quick access to frequently-used printing configurations.

1. Select the print command in your application.
2. Select Dell MFP EXXXX (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. Click the Print Profiles tab.
4. Select your profile from the print profile list. The profile settings are shown on the left side of the printer driver window.

5. Do one of the following:
   • If the settings are correct for your print job, click OK.
   • To change the settings, go back to the Basic or Advanced tab, change settings, and then click OK.

   NOTE: To display the Print Profiles tab at the front of the window the next time you print, select the Always show Print Profiles tab first. check box.

Add a Print Profile

Add up to 20 new print profiles with customized settings.

1. Select the print command in your application.

2. Select Dell MFP EXXX (where XXXX is the name of your model), and then click the printing properties or preferences button.

   The printer driver window appears.

3. Click the Basic tab and the Advanced tab, and configure the print settings you want for the new Print Profile.

4. Click the Print Profiles tab.

5. Click Add Profile.

   The Add Profile dialog box appears.

6. Type the new print profile name in the Name field.

7. Click the icon you want to use to represent this profile from the icon list.

8. Click OK.

   The new Print Profile name is added to the list in the Print Profiles tab.

Delete a Print Profile

1. Select the print command in your application.

2. Select Dell MFP EXXX (where XXXX is the name of your model), and then click the printing properties or preferences button.

   The printer driver window appears.

3. Click the Print Profiles tab.

4. Click Delete Profile.

   The Delete Profile dialog box appears.

5. Select the profile you want to delete.

6. Click Delete.

7. Click Yes.

8. Click Close.
Change the Default Print Settings (Windows®)

When you change print settings from within a program, the changes apply only to the items you are printing in that program, at that time. To select print settings to use for all of your Windows® programs, all the time, use these steps to change the default print settings.

1. Do one of the following:
   • (For Windows Server® 2003) Click Start > Printers and Faxes.
   • (For Windows Vista® and Windows Server® 2008) Click (Start) > Control Panel > Hardware and Sound > Printers.
   • (For Windows® 7 and Windows Server® 2008 R2) Click (Start) > Devices and Printers.
   • (For Windows® 8) Move your mouse to the lower right corner of your desktop. When the menu bar appears, click Settings, and then click Control Panel. In the Hardware and Sound group, click View devices and printers.
   • (For Windows Server® 2012) Move your mouse to the lower right corner of your desktop. When the menu bar appears, click Settings, and then click Control Panel. In the Hardware group, click View devices and printers.
   • (For Windows Server® 2012 R2) Click Control Panel on the Start screen. In the Hardware group, click View devices and printers.

2. Right-click the Dell MFP EXXXX icon (where XXXX is your model name), and then select Printer properties. If printer driver options appear, select your printer driver.

3. Click the General tab, and then click the Printing Preferences... or Preferences... button.
   The printer driver dialog box appears.
   
   **NOTE:** To configure the tray settings, click the Device Settings tab.

   **NOTE:** To change the printer port, click the Ports tab.

4. Select the print settings you want to use as defaults for all of your Windows® programs.

5. Click OK.

6. Close the printer properties dialog box.

Print a Document Using the Dell Emulate PS Printer Driver (PostScript® 3™ Language Emulation) (Windows®)

The Dell emulate PS printer driver lets you print PostScript® data more clearly.

1. Select the print command in your application.

2. Select Dell MFP EXXXX PS emulate (where XXXX is the name of your model), and then click the printing properties or preferences button.
   The printer driver window appears.
3. Click the **Layout** or **Paper/Quality** tab to change basic print settings.
   Click the **Advanced...** button to change advanced print settings.

4. Click **OK**.

5. Complete your print operation.

**Print from Your Computer (Macintosh)**

- **Print a Document (Macintosh)**
- **Set Print Options (Macintosh)**
- **Print a Document Using the Dell Emulate PS Printer Driver (PostScript® 3™ language emulation) (Macintosh)**
  The Dell emulate PS printer driver lets you print PostScript® data more clearly.
- **Monitor the Status of the Machine from Your Computer (Macintosh)**
  The Status Monitor utility is a configurable software tool for monitoring the status of a device, allowing you to get immediate notification of error messages, such as paper empty or paper jam, at pre-set update intervals. You can also access Web Based Management.

**Print a Document (Macintosh)**

1. Make sure you have loaded the correct size paper in the paper tray.
2. From an application, such as Apple TextEdit, click the **File** menu, and then select **Print**.
3. Select **Dell MFP EXXX** (where XXXX is your model name).
NOTE: For more page setup options, click the Show Details button.

4. Type the number of copies you want in the Copies field.

5. Click the Paper Size pop-up menu, and then select your paper size.

6. Select the Orientation option that matches the way you want the document to print.

7. Click the application pop-up menu, and then select Print Settings.
   The Print Settings options appear.

8. Click the Media Type pop-up menu, and then select the type of paper you are using.

9. Change other printer settings, if needed.

10. Click Print.

Set Print Options (Macintosh)

- Print in Toner Save Mode (Macintosh)
  This feature conserves your toner by using less toner to print documents; print appears lighter, but is still readable.

- Print Multiple Copies of the Same Document (Macintosh)

- Print on Both Sides of the Paper (Macintosh)

- Change the Paper Size (Macintosh)
  Paper Size choices include a large selection of standard paper sizes.

- Change the Orientation of Your Print (Portrait or Landscape) (Macintosh)

- Print More Than One Page on a Single Sheet of Paper (N in 1) (Macintosh)

- Reverse Print (Macintosh)
  This setting rotates the printed image 180 degrees.

- Flip Horizontally (Macintosh)
  The Flip horizontally option reverses the printout horizontally from left to right.

- Scaled Print (Macintosh)
  This option lets you enlarge or reduce the pages in your document to fit your printed paper size.

- Change the Media Type (Macintosh)
  To achieve the best print results, the media being printed on should be selected in the driver. The machine changes the way it prints depending on the selected media type.

- Change the Resolution (Macintosh)
  You can choose the print resolution. As print resolution and speed are related, the higher the resolution, the longer it will take to print the document.

- Reduce or Enlarge Document Layout (Macintosh)
  You can reduce or enlarge the layout of a document by scaling it to a percentage of the document's original size.

- Change the Paper Source (Macintosh)
  Select a paper source setting that matches your print conditions or purpose.

- Change the Graphic Quality (Macintosh)
  You can change the print quality.

- Reduce Paper Curl (Macintosh)

- Improve Toner Fixing (Macintosh)
• Adjust the Print Density (Macintosh)
  You can increase or decrease the print density.
• Skip Blank Page (Macintosh)
  Use this option to allow the printer driver to automatically detect blank pages and exclude them from printing.

**Print in Toner Save Mode (Macintosh)**

This feature conserves your toner by using less toner to print documents; print appears lighter, but is still readable.

**NOTE:** We do not recommend using this mode for printing photo or grayscale images.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Dell MFP EXXXX (where XXXX is your model name).
   **NOTE:** For more page setup options, click the Show Details button.
3. Click the application pop-up menu, and then select Print Settings.
   The Print Settings options appear.
4. Click the Advanced print settings list.
5. Click Toner Save Mode.
6. Check the Toner Save Mode check box.
7. Change other printer settings if needed.
8. Click Print.

**Print Multiple Copies of the Same Document (Macintosh)**

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Dell MFP EXXXX (where XXXX is your model name).
   **NOTE:** For more page setup options, click the Show Details button.
3. Type the number of copies you want in the Copies field.
4. Click the application pop-up menu, and then select Paper Handling.
   The Paper Handling options appear.
5. Select the Collate pages check box, if needed.
Collate pages
When the Collate pages check box is selected, one complete copy of your document will be printed, and then reprinted according to the number of copies you select. If the Collate pages check box is not selected, then each page will be printed according to the number of copies selected before the next page of the document is printed.

6. Change other printer settings, if needed.
7. Click Print.

Print on Both Sides of the Paper (Macintosh)

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Dell MFP EXXXX (where XXXX is your model name).
   
   NOTE: For more page setup options, click the Show Details button.
3. Select the Orientation option that matches the way you want the document to print.
4. For automatic 2-sided printing, do the following:
   a. Click the application pop-up menu, and then select Layout.
      The Layout setting options appear.
   b. In the Two-Sided section, select the Short-Edge binding or Long-Edge binding option.
   c. Change other printer settings, if needed.
   d. Click Print.
5. For manual 2-sided printing, do the following:
   a. Click the application pop-up menu, and then select Paper Handling.

• Select Letter, Legal, or Folio sized paper when using the automatic 2-sided printing function.
• Make sure the back cover is closed.
• If paper is curled, straighten it and put it back in the paper tray.
• Use regular paper or thin paper. DO NOT use bond paper.
• If the paper is too thin, it may wrinkle.
• When you use the manual 2-sided printing function, it is possible there may be paper jams or poor print quality.
The **Paper Handling** options appear.

b. In the **Pages to Print** pop-up menu, select **Even Only**.

c. Change other print settings, if needed.

d. Click the **Print** button.

e. After the machine prints the even-numbered pages, remove the printed pages from the output paper tray.

f. Make sure the pages are completely flat, and put the paper back in the tray, blank side facing down.

g. Repeat steps 1-3, selecting the same printer and settings you used to print the even-numbered pages.

h. Click the application pop-up menu, and then select **Paper Handling**. The **Paper Handling** options appear.
i. In the **Pages to Print** pop-up menu, select **Odd Only**.

j. Click **Print**.

**Change the Paper Size (Macintosh)**

Paper Size choices include a large selection of standard paper sizes.

1. From an application, such as Apple TextEdit, click the **File** menu, and then select **Print**.

2. Select **Dell MFP EXXXX** (where EXXX is your model name).

   **NOTE:** For more page setup options, click the **Show Details** button.

3. Click the **Paper Size** pop-up menu, and then select your paper size.

4. Change other printer settings, if needed.

5. Click **Print**.

**Create Custom Size (Macintosh)**

1. Click the **Paper Size** pop-up menu, and then select **Manage Custom Sizes**....

2. Click **+**.

3. Type the name for this custom size.

4. Type size and margin values in the **Paper Size** and **Non-Printable Area** fields.

5. Click **OK**.
Change the Orientation of Your Print (Portrait or Landscape) (Macintosh)

<table>
<thead>
<tr>
<th>Portrait</th>
<th>Landscape</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Portrait Image]</td>
<td>![Landscape Image]</td>
</tr>
</tbody>
</table>

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Dell MFP EXXXX (where XXXX is your model name).
   **NOTE:** For more page setup options, click the Show Details button.
3. Select the Orientation option that matches the way you want the document to print.
4. Change other printer settings, if needed.
5. Click Print.

Print More Than One Page on a Single Sheet of Paper (N in 1) (Macintosh)

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Dell MFP EXXXX (where XXXX is your model name).
   **NOTE:** For more page setup options, click the Show Details button.
3. Click the application pop-up menu, and then select Layout.
   The Layout setting options appear.
4. Click the Pages per Sheet pop-up menu, and then select the number of pages to print on each sheet.
5. Click the Layout Direction menu, and then select how you want the pages ordered.
6. Click the Border pop-up menu, and then select your border line type.
7. Change other printer settings if needed.
8. Click Print.

Reverse Print (Macintosh)

This setting rotates the printed image 180 degrees.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Dell MFP EXXXX (where XXXX is your model name).
   
   NOTE: For more page setup options, click the Show Details button.
3. Click the application pop-up menu, and then select Layout.
   
   The Layout setting options appear.
4. Select the Reverse page orientation check box.
5. Change other printer settings, if needed.
6. Click Print.

Flip Horizontally (Macintosh)

The Flip horizontally option reverses the printout horizontally from left to right.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Dell MFP EXXXX (where XXXX is your model name).
   
   NOTE: For more page setup options, click the Show Details button.
3. Click the application pop-up menu, and then select Layout.
The Layout setting options appear.

4. Select the Flip horizontally check box.
5. Change other printer settings, if needed.
6. Click Print.

Scaled Print (Macintosh)

This option lets you enlarge or reduce the pages in your document to fit your printed paper size.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Dell MFP EXXXX (where XXXX is your model name).
   
   NOTE: For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Paper Handling.
   The Paper Handling options appear.

4. Select the Scale to fit paper size check box, and then choose your paper size from the Destination Paper Size pop-up menu.
   
   NOTE: If you want to scale the document because it is too big for your paper, select Scale down only. If this option is selected and the document is formatted for paper that is smaller than the paper you have, the document prints at its original size.

5. Change other printer settings if needed.
6. Click Print.

Change the Media Type (Macintosh)

To achieve the best print results, the media being printed on should be selected in the driver. The machine changes the way it prints depending on the selected media type.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Dell MFP EXXXX (where XXXX is your model name).
   
   NOTE: For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Print Settings.
   The Print Settings options appear.

4. Click the Media Type pop-up menu, and then select the media type you want to use.

<table>
<thead>
<tr>
<th>Select this Media Type</th>
<th>For this paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Paper</td>
<td>Ordinary plain paper</td>
</tr>
<tr>
<td>Thin Paper</td>
<td>Ordinary thin paper</td>
</tr>
<tr>
<td>Thick Paper</td>
<td>Rough paper or thicker paper</td>
</tr>
<tr>
<td>Thicker Paper</td>
<td>Select this option if you have selected Thick Paper, and toner smudges while printing</td>
</tr>
<tr>
<td>Bond Paper</td>
<td>Bond paper</td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelopes</td>
</tr>
</tbody>
</table>
5. Change other printer settings, if needed.

6. Click Print.

**Change the Resolution (Macintosh)**

You can choose the print resolution. As print resolution and speed are related, the higher the resolution, the longer it will take to print the document.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.

2. Select Dell MFP EXXXX (where XXXX is your model name).

   **NOTE:** For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Print Settings.

   The Print Settings options appear.

4. Click the Resolution pop-up menu, and then select the print resolution you want to use.
   - 300 dpi
   - 600 dpi
   - HQ 1200

5. Change other printer settings, if needed.

6. Click Print.

**Reduce or Enlarge Document Layout (Macintosh)**

You can reduce or enlarge the layout of a document by scaling it to a percentage of the document's original size.

1. From an application, such as Apple TextEdit, click the File menu, and then select Page Setup.

2. Select Dell MFP EXXXX (where XXXX is your model name).

3. Type the percentage by which you want to reduce or enlarge the printout in the Scale field.

4. Change other printer settings, if needed.

5. Click OK.

6. From an application, such as Apple TextEdit, click the File menu, and then select Print.

7. Click Print.

**Change the Paper Source (Macintosh)**

Select a paper source setting that matches your print conditions or purpose.
If you load one sheet of paper in the manual feed slot, the paper is automatically pulled from this slot. Do not load any paper in the manual feed slot when printing from paper tray.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Dell MFP EXXXX (where XXXX is your model name).
   
   **NOTE:** For more page setup options, click the Show Details button.
3. Click the application pop-up menu, and then select Print Settings. The Print Settings options appear.
4. Click the Paper Source pop-up menu, and then select your paper tray.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Select</td>
<td>The machine will automatically select the tray to use if the paper type and paper size configured on the machine match the printer driver settings. The paper size and paper type for each tray must be configured correctly on the machine.</td>
</tr>
<tr>
<td>Tray 1</td>
<td>The machine will exclusively use tray #1 when printing.</td>
</tr>
<tr>
<td>Manual</td>
<td>The machine will exclusively use the Manual Feed Slot when printing.</td>
</tr>
</tbody>
</table>
5. Change other printer settings, if needed.
6. Click Print.

**Change the Graphic Quality (Macintosh)**

You can change the print quality.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Dell MFP EXXXX (where XXXX is your model name).
   
   **NOTE:** For more page setup options, click the Show Details button.
3. Click the application pop-up menu, and then select Print Settings. The Print Settings options appear.
4. Click the Advanced print settings list.
5. Click Graphics Quality, and then select the print quality you want to use.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphics</td>
<td>The Graphics mode prioritizes contrast. Choose this setting for printing text and figures, such as business and presentation documents. You can represent sharp contrasts in shaded areas.</td>
</tr>
<tr>
<td>Text</td>
<td>This is the best mode for printing text documents.</td>
</tr>
</tbody>
</table>
6. Click Print.
Reduce Paper Curl (Macintosh)

If you are printing only a few pages, you do not need to select this setting. If paper curls excessively, we recommend changing the Media Type setting in the printer driver to the Thin Paper or Env. Thin setting.

NOTE: This setting decreases the temperature of the machine’s fusing process, which reduces paper curl.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Dell MFP EXXXX (where XXXX is your model name).
   NOTE: For more page setup options, click the Show Details button.
3. Click the application pop-up menu, and then select Print Settings.
   The Print Settings options appear.
4. Click the Advanced print settings list.
5. Select the Improve Print Output option.
6. Select the Reduce Paper Curl option.
7. Click Print.

Improve Toner Fixing (Macintosh)

NOTE: This setting increases the temperature of the machine’s fusing process, which improves toner’s ability to stick to paper.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Dell MFP EXXXX (where XXXX is your model name).
NOTE: For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Print Settings. The Print Settings options appear.

4. Click the Advanced print settings list.

5. Select the Improve Print Output option.

6. Select Improve Toner Fixing.

7. Click Print.

Adjust the Print Density (Macintosh)

You can increase or decrease the print density.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.

2. Select Dell MFP EXXXX (where XXXX is your model name).
   
   NOTE: For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Print Settings. The Print Settings options appear.

4. Click the Advanced print settings list.

5. Click Density Adjustment.

6. Clear the Printer Default check box.

7. To increase or decrease the print density, move the slide bar to the right or left.

8. Click Print.

Skip Blank Page (Macintosh)

Use this option to allow the printer driver to automatically detect blank pages and exclude them from printing.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.

2. Select Dell MFP EXXXX (where XXXX is your model name).
   
   NOTE: For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Print Settings. The Print Settings options appear.

4. Click the Advanced print settings list.

5. Click the Other Print Options menu.

6. Select the Skip Blank Page check box.

7. Click Print.

Print a Document Using the Dell Emulate PS Printer Driver (PostScript® 3™ language emulation) (Macintosh)

The Dell emulate PS printer driver lets you print PostScript® data more clearly.
• Make sure you have added the Dell emulate PS printer driver from Print & Scan or Printers & Scanners in the System Preferences list on your Macintosh.

1. Make sure you have loaded the correct size paper in the paper tray.
2. From an application, such as Apple TextEdit, click the File menu, and then select Print.
3. Select Dell MFP XXXX PS emulate (where XXXX is your model name).
   NOTE: For more page setup options, click the Show Details button.
4. Type the number of copies you want in the Copies field.
5. Click the Paper Size pop-up menu, and then select your paper size.
6. Select the Orientation option that matches the way you want the document to print.
7. Click the print options pop-up menu, and then click Printer Features.
   The Printer Features options appear.
8. Click the Resolution pop-up menu, and then select the resolution.
9. Click the Media Type pop-up menu, and then select the type of paper you are using.
10. Change other printer settings, if needed.
11. Click Print.

Monitor the Status of the Machine from Your Computer (Macintosh)

The Status Monitor utility is a configurable software tool for monitoring the status of a device, allowing you to get immediate notification of error messages, such as paper empty or paper jam, at pre-set update intervals. You can also access Web Based Management.

1. Click the System Preferences menu, select Print & Scan or Printers & Scanners, and then select your machine.
2. Click the Options & Supplies button.
3. Click the Utility tab, and then click the Open Printer Utility button.
   Status Monitor starts.
   Updating the machine’s status
   To view the latest machine status while the Status Monitor window is open, click the icon. You can set the interval at which the software updates machine status information. Click Status Monitor in the menu bar, and then select Preferences.
   Web Based Management (Network Connection Only)
   Access the Web Based Management System by clicking the machine icon on the Status Monitor screen. You can use a standard Web Browser to manage your machine using HTTP (Hyper Text Transfer Protocol).

Adjust Print Settings from the Machine’s Control Panel

• Cancel a Print Job
• Change the Printer Emulation Mode
We recommend setting Printer Emulation mode using your application software or network server. If the setting does not work correctly, select the required emulation mode manually using the machine's control panel.

- **Change 2-Sided Print Settings**
  Change the settings for printing on both sides of the paper from your machine's control panel.

- **Auto Continue**
  This setting enables the machine to automatically clear a paper size error and use any compatible paper from other paper trays to complete the print job.

- **Restore Printer Factory Settings**
  Use this function to return the machine's printer settings to the factory settings.

- **Print the Internal Font List**
  Print a list of the machine's internal (also called resident) fonts to see how each font looks before you select it.

- **Print a List of Printer Settings**

- **Test Print**
  If there are problems with print quality, follow these instructions to do a test print.

### Cancel a Print Job

1. Press Cancel.

### Change the Printer Emulation Mode

We recommend setting Printer Emulation mode using your application software or network server. If the setting does not work correctly, select the required emulation mode manually using the machine's control panel.

Your machine will receive print commands in a printer job language, or emulation. Different operating systems and applications send the print commands in different languages. Your machine can receive print commands in a variety of emulations and has an automatic emulation selection feature. When the machine receives data from the computer, it automatically selects the emulation mode. The default setting is Auto.

#### PCL Setting Mode

PCL Setting mode is the emulation mode in which this printer supports the PCL6 language of a Hewlett-Packard LaserJet laser printer. Many applications support this type of laser printer. Using this mode will allow your machine to run at its best with those applications.

#### Dell emulate PS Mode

Dell emulate PS is an original Dell page description language and a PostScript® language emulation interpreter. This machine supports PostScript® 3™. The Dell emulate PS interpreter of this machine allows you to control text and graphics on the page.

For technical information about PostScript® commands, see the following manuals:


1. Press Menu.
2. Press ▲ or ▼ to display the Printer option, and then press OK.
3. Press ▲ or ▼ to display the Emulation option, and then press OK.
4. Select the emulation mode you want.
5. Press Cancel.

Change 2-Sided Print Settings
Change the settings for printing on both sides of the paper from your machine's control panel.

Settings in the printer driver always take priority over settings you change manually on the control panel. If you do not print 2-sided frequently, select None for the 2-sided / Booklet pull down list in the printer driver, and use the control panel to turn it on manually only when you want to print on both sides of the paper.

1. Press Menu.
2. Press ▲ or ▼ to display the Printer option, and then press OK.
3. Press ▲ or ▼ to display the 2-sided option, and then press OK.
4. Press ▲ or ▼ to display the Off, On(Long Edge), or On(Short Edge) option, and then press OK.
5. Press Cancel.

Auto Continue
This setting enables the machine to automatically clear a paper size error and use any compatible paper from other paper trays to complete the print job.

1. Press Menu.
2. Press ▲ or ▼ to display the Printer option, and then press OK.
3. Press ▲ or ▼ to display the Auto Continue option, and then press OK.
4. Press ▲ or ▼ to display the On or Off option, and then press OK.
5. Press Cancel.

Restore Printer Factory Settings
Use this function to return the machine's printer settings to the factory settings.

This will not reset the network settings.

1. Press Menu.
2. Press ▲ or ▼ to display the Printer option, and then press OK.
3. Press ▲ or ▼ to display the Reset Printer option, and then press OK.
4. Follow the machine's instruction to reset printer settings.
5. Press Cancel.
Print the Internal Font List

Print a list of the machine's internal (also called resident) fonts to see how each font looks before you select it.

1. Press Menu.
2. Press ▲ or ▼ to display the Printer option, and then press OK.
3. Press ▲ or ▼ to display the Print Options option, and then press OK.
4. Press ▲ or ▼ to display the INTERNAL FONT option, and then press OK.
5. Press the PCL Setting or PS Emulate option.
6. Press Cancel.

Print a List of Printer Settings

1. Press Menu.
2. Do one of the following:
   • For Dell E515dn/Dell E515dw
     Press ▲ or ▼ to display the Print Reports option, and then press OK.
   • For Dell E514dw
     Press ▲ or ▼ to display the Machine Info. option, and then press OK.
3. Press ▲ or ▼ to display the Print Settings option, and then press OK.
   The machine prints the Printer Settings.

Test Print

If there are problems with print quality, follow these instructions to do a test print.

1. Press Menu.
2. Press ▲ or ▼ to display the Printer option, and then press OK.
3. (For Printer Emulation Supported models)
   Press ▲ or ▼ to display the Print Options option, and then press OK.
4. Press ▲ or ▼ to display the Test Print option, and then press OK.
5. Press Start.
   The machine prints a Test Print page.
6. Press Cancel.
Scan .......................................................... 95

Before Scanning .................................................. 95
Scan Using the Scan Button on Your Dell Machine .......... 97
Scan from Your Computer (Windows®) ......................... 104
Scan from Your Computer (Macintosh) ......................... 104
Scan

• Before Scanning
• Scan Using the Scan Button on Your Dell Machine
• Scan from Your Computer (Windows®)
• Scan from Your Computer (Macintosh)

There are several ways you can use your Macintosh to scan photos and documents on your Dell machine. Use the software applications provided by Dell or your favorite scanning application.

Before Scanning

Before attempting to scan, confirm the following:
• For USB or network cable users: Make sure the interface cable is correctly inserted.

Configure Network Scanning for Windows®

To use the machine as a network scanner, the machine must be configured with a TCP/IP address.

1. Do one of the following:
   • (Windows Vista®)
     Click (Start) > Control Panel > Hardware and Sound > Scanners and Cameras.
   • (Windows® 7)
     Click (Start) > All Programs > Dell Printers.
     Click the drop-down list and select your model name (if not already selected). Click SCAN in the left navigation bar, and then click Scanners and Cameras.
   • (Windows® 8)
     Dell Printer Hub, and then click the drop-down list and select your model name (if not already selected). Click SCAN in the left navigation bar, and then click Scanners and Cameras.

2. Do one of the following:
   • (Windows Vista®, Windows® 7 and Windows® 8)
     Click the Properties button.

   NOTE: (Windows Vista®, Windows® 7 and Windows® 8)
   If the User Account Control screen appears, do the following:
     • For users who have administrator rights: Click Continue or Yes.
3. Click the Network Setting tab, and then select the appropriate connection method.
   • Specify your machine by address.
     Type the machine's IP address in the IP Address field, and then click OK.
   • Specify your machine by name.
     Type the machine's node name in the Node Name field, or click Browse to search for a device, and then select the machine you want to use. Click OK.

4. Click the Scan To Button tab, and then type your computer's name in the Display Name (Max 15 characters) field. The machine's LCD displays the name you type. The default setting is your computer's name. You can type any name you like.

5. To avoid receiving unwanted documents, type a four-digit PIN in the Pin number and Retype Pin number fields. To send data to a computer protected by a PIN, the LCD prompts you to enter the PIN before the document can be scanned and sent to the computer.

• For users who do not have administrator rights: Type the administrator password, and then click OK or Yes.
Configure Network Scanning for Macintosh

To use the machine as a network scanner, the machine must be configured with a TCP/IP address.

- If you installed the machine following the instructions for a network user, the machine should already be configured for your network.
- To use the machine as a network scanner, the machine must be configured with a TCP/IP address. You can set or change the address settings from the machine’s control panel.
- To scan from the machine on a network, you must select the networked machine in the Device Selector application.

1. In the Finder menu bar, click Go > Applications > Dell, and then double-click the (ControlCenter2) icon. The ControlCenter2 screen appears.
2. Click the Model pop-up menu, and then select Other.... The Device Selector window appears.
3. Click the + button.
4. Select a machine from the list of available machines, and then click Add. You can also specify your machine by IP address. Click the IP button, and then type the IP address.
5. Click OK.

**NOTE:** To use the Scan button features on the machine, select the Scan Key Setting check box to register your computer with the “Scan To” features at the machine. Type the name for your Macintosh that you want to be displayed on the machine’s LCD (up to 15 characters).

**NOTE:** To avoid receiving unwanted documents, select the Enable PIN code protection check box, and then type a four-digit PIN in the PIN code and Verify fields. To send data to a computer protected by a PIN, the LCD prompts you to type the PIN before the document can be scanned and sent to the computer.

Scan Using the Scan Button on Your Dell Machine

- Scan Photos and Graphics
  Send scanned photos or graphics directly to your computer. Dell's ControlCenter software (for Macintosh only) will launch the default graphics application on your computer and open your scanned document automatically.
- Save Scanned Data to a Folder as a PDF File
  Scan documents and save them to a folder on your computer as PDF files.
- Web Services for Scanning on Your Network (Windows Vista® SP2 or greater, Windows® 7 and Windows® 8)
  The Web Services protocol enables Windows Vista® (SP2 or greater), Windows® 7 and Windows® 8 users to scan using a Dell machine on the network. You must install the driver via Web Services.
- Change Scan Button Settings from ControlCenter (Macintosh)
Scan Photos and Graphics

Send scanned photos or graphics directly to your computer. Dell's ControlCenter software (for Macintosh only) will launch the default graphics application on your computer and open your scanned document automatically.

Use the Scan button on the machine to make temporary changes to the scan settings. To make permanent changes, use Dell's ControlCenter software (for Macintosh only).

1. Load your document.
2. Press (Scan).
3. Press ▲ or ▼ to select the Scan to PC option, and then press OK.
4. Press ▲ or ▼ to select the Image option, and then press OK.
5. If the machine is connected over the network, select the destination computer.
6. Press OK.
   NOTE: If the LCD prompts you to enter a PIN, enter the four-digit PIN for the destination computer on the LCD.
7. Do one of the following:
   • To change the scan settings for this document, press ▲ or ▼ to select Yes, and then press OK. Go to the next step.
   • To use the default scan settings, press ▲ or ▼ to select No, and then press OK. Press Start.
     The machine starts scanning. If you are using the machine's scanner glass, follow the LCD instructions to complete the scanning job.
   NOTE: In order to change scan settings, Dell’s Control Center software (for Macintosh only) must be installed on a computer connected to the machine.
   NOTE: (For Windows) In order to change scan settings, see the FAQ in Dell Printer Hub software.
8. Select the scan settings you want to change:
   • Scan Type
   • Resolution
   • File Type
   • Scan Size
   • Remove Bkg. Clr
     (available only for the Color and Gray options.)
   The machine starts scanning. If you are using the machine's scanner glass, follow the LCD instructions to complete the scanning job.
Save Scanned Data to a Folder as a PDF File

Scan documents and save them to a folder on your computer as PDF files.

Use the Scan button on the machine to make temporary changes to the scan settings. To make permanent changes, use Dell's ControlCenter software (for Macintosh only).

1. Load your document.
2. Press (Scan).
3. Press ▲ or ▼ to select the Scan to PC option, and then press OK.
4. Press ▲ or ▼ to select the File option, and then press OK.
5. If the machine is connected over the network, select the destination computer.
6. Press OK.
   NOTE: If the LCD prompts you to enter a PIN, enter the four-digit PIN for the destination computer on the LCD.
7. Do one of the following:
   • To change the scan settings for this document, press ▲ or ▼ to select Yes, and then press OK. Go to the next step.
   • To use the default scan settings, press ▲ or ▼ to select No, and then press OK. Press Start. The machine starts scanning. If you are using the machine's scanner glass, follow the LCD instructions to complete the scanning job.
   NOTE: In order to change scan settings, Dell’s Control Center software (for Macintosh only) must be installed on a computer connected to the machine.
   NOTE: (For Windows) In order to change scan settings, see the FAQ in Dell Printer Hub software.
8. Select the scan settings you want to change:
   • Scan Type
   • Resolution
   • File Type
   • Scan Size
   • Remove Bkg. Clr
     (available only for the Color and Gray options.)
   The machine starts scanning. If you are using the machine's scanner glass, follow the LCD instructions to complete the scanning job.

Web Services for Scanning on Your Network (Windows Vista® SP2 or greater, Windows® 7 and Windows® 8)

The Web Services protocol enables Windows Vista® (SP2 or greater), Windows® 7 and Windows® 8 users to scan using a Dell machine on the network. You must install the driver via Web Services.
• Scan Using Web Services from the Dell Machine (Windows Vista® SP2 or greater, Windows® 7 and Windows® 8)

If you have installed the driver for scanning via Web Services, you can access the Web Services scanning menu on your Dell machine's LCD.

• Configure Scan Settings for Web Services

Scan Using Web Services from the Dell Machine (Windows Vista® SP2 or greater, Windows® 7 and Windows® 8)

If you have installed the driver for scanning via Web Services, you can access the Web Services scanning menu on your Dell machine's LCD.

Certain characters in the messages displayed on the LCD may be replaced with spaces if the language settings of your OS and your Dell machine are different.

1. Load your document.

2. Press (Scan).

3. Press ▲ or ▼ to select the Web Service option, and then press OK.

4. Press ▲ or ▼ to select the type of scan you want to do, and then press OK.

5. Press ▲ or ▼ to select the destination computer where you want to send the scan, and then press OK.

6. Press Start.

The machine starts scanning.

Configure Scan Settings for Web Services

1. Do one of the following:
   • (Windows Vista®)
     Click (Start) > Control Panel > Hardware and Sound > Scanners and Cameras.
   • (Windows® 7)
     Click (Start) > Devices and Printers.
   • (Windows® 8)
     Move your mouse to the lower right corner of your desktop. When the menu bar appears, click Settings, and then click Control Panel. In the Hardware and Sound group, click View devices and printers.

2. Do one of the following:
   • (Windows Vista®)
     Click your machine, and then click the Scan Profiles button. The Scan Profiles dialog box appears.
   • (Windows® 7) and (Windows® 8)
     Right-click on the machine icon, and then select Scan profiles.... The Scan Profiles dialog box appears.

3. Select the scan profile you want to use.

4. Make sure the scanner selected in the Scanner list is a Dell machine that supports Web Services for scanning,
and then click the **Set as Default** button.

5. Click **Edit**....
   The **Edit Default Profile** dialog box appears.

6. Select the **Source**, **Paper size**, **Color format**, **File type**, **Resolution (DPI)**, **Brightness** and **Contrast** settings.

7. Click the **Save Profile** button.
   These settings will be applied when you scan using the Web Services protocol.

If you are requested to select a scanning application, select Windows® Fax and Scan or Windows® Photo Gallery from the list.

### Change Scan Button Settings from ControlCenter (Macintosh)

1. In the **Finder** menu bar, click **Go > Applications > Dell**, and then double-click the **(ControlCenter2)** icon. The **ControlCenter2** screen appears.

2. Hold the Control key on your keyboard and click on the scan destination (**Image**, **OCR**, **E-mail**, or **File**) whose settings you want to change.

3. Click the **Device Button** tab.
   The settings for the scan destination that you selected appear.
   The following example shows the **Scan to Image** settings.

   ![ControlCenter2 screen](image)

   **NOTE:** Each tab corresponds to a scan feature, as described below. These settings can be changed.
<table>
<thead>
<tr>
<th>Tab Name</th>
<th>Corresponding Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td>Scan to Image</td>
</tr>
<tr>
<td>OCR</td>
<td>Scan to OCR</td>
</tr>
<tr>
<td>E-mail</td>
<td>Scan to E-mail</td>
</tr>
<tr>
<td>File</td>
<td>Scan to File</td>
</tr>
</tbody>
</table>

**Settings**

**Applicable Features**

<table>
<thead>
<tr>
<th></th>
<th>Image</th>
<th>OCR</th>
<th>E-mail</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Target Application/E-mail Application</strong></td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Select which application is used to open scanned data. Only applications installed on your computer can be selected.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>Add</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add an application to the pop-up menu.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type the application name in the Application Name field (up to 30 characters) and select your preferred application by clicking the Browse button. Select the File Type option from the pop-up menu.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>Delete</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete an application you have added to the pop-up menu.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select the application from the Application Name pop-up menu, and then click Delete.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**File Type**

Select the file type you want to use for the scanned data.

**File size**

Change the file size by moving the File size slider to the right or left.

**OCR Language**

Set the OCR language to match the language of the scanned document’s text.

**Destination File Path**

Click the Change button to change the prefix of the file name and the path of the destination folder.

**File Name**

Type a prefix for your file name, if needed.

**Insert Date in File Name**

Automatically insert the date in the file name of the scanned image.

**Destination Folder**

Click Browse to select the folder where you would like to save your scanned document.
<table>
<thead>
<tr>
<th><strong>Show Folder</strong></th>
<th>-</th>
<th>-</th>
<th>-</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the Show Folder option to automatically display the destination folder after scanning.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Resolution</strong></th>
<th>Yes</th>
<th>Yes</th>
<th>Yes</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a scanning resolution from the Resolution pop-up menu. Higher resolutions take more memory and transfer time, but produce a finer scanned image.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Scan Type</strong></th>
<th>Yes</th>
<th>Yes</th>
<th>Yes</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select from a range of scan color depths.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>Black &amp; White</strong> Use for text or line art images.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>Gray (Error Diffusion)</strong> Use for photographic images or graphics. (Error Diffusion is a method for creating simulated gray images without using true gray dots. Black dots are put in a specific pattern to give a gray appearance.)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>True Gray</strong> Use for photographic images or graphics. This mode is more accurate because it uses up to 256 shades of gray.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>24bit Color</strong> Use to create an image with the most accurate color reproduction. This mode uses up to 16.8 million colors to scan the image, but it requires the most memory and has the longest transfer time.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>Auto</strong> Use for any type of document. This mode automatically picks an appropriate color depth for the document.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Document Size</strong></th>
<th>Yes</th>
<th>Yes</th>
<th>Yes</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the exact size of your document from the Document Size pop-up menu.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• If you select 1 to 2 (A4), the scanned image will be divided into two A5-size documents.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Configure advanced settings by clicking the Advanced Settings button in the Scan Settings dialog box.

- **Brightness**
  Set the Brightness level by dragging the slider to the right or left to lighten or darken the image. If the scanned image is too light, set a lower brightness level and scan the document again. If the image is too dark, set a higher brightness level and scan the document again.

- **Contrast**
  Increase or decrease the Contrast level by moving the slider to the right or left. An increase emphasizes dark and light areas of the image, while a decrease reveals more details in gray areas. You can also enter a value in the box to set the contrast.

- **Remove Background Color**
  Remove the base color of documents to make the scanned data more recognizable. When you use this function, select from three settings: high, medium, and low.
  (Available only for the Auto, True Gray and 24bit Color options)

Select this option to restore all settings to their factory setting values.

Scan from Your Computer (Windows®)
When you scan from your computer, see the FAQ in Dell Printer Hub software.

Scan from Your Computer (Macintosh)
There are several ways you can use your Macintosh to scan photos and documents on your Dell machine. Use the software applications provided by Dell or your favorite scanning application.

- **Scan Using ControlCenter (Macintosh)**
  Use Dell's ControlCenter software to scan photos and save them as JPEGs, PDFs, or other file formats.
- **Scan Using TWAIN-Compliant Applications (Macintosh)**
- **Scan Using Apple Image Capture (ICA Driver)**
  The Apple Image Capture application uses the ICA scanner driver.

Scan Using ControlCenter (Macintosh)
Use Dell's ControlCenter software to scan photos and save them as JPEGs, PDFs, or other file formats.

- **Scan Documents and Photos Using ControlCenter (Macintosh)**
Send scanned photos or graphics directly to your computer. Dell's ControlCenter software (for Macintosh only) will launch the default graphics application on your computer and open your scanned document automatically.

- Save Scanned Data to a Folder as a PDF File Using ControlCenter (Macintosh)
- Scan to E-mail Attachment Using ControlCenter (Macintosh)
  Send a scanned document as an email attachment.
- Scan to an Editable Text File (OCR) Using ControlCenter (Macintosh)
  Your machine can convert characters in a scanned document to text data using optical character recognition (OCR) technology. Edit this text using your preferred text-editing application.
- Scan Settings for ControlCenter (Macintosh)

**Scan Documents and Photos Using ControlCenter (Macintosh)**

Send scanned photos or graphics directly to your computer. Dell’s ControlCenter software (for Macintosh only) will launch the default graphics application on your computer and open your scanned document automatically.

1. Load your document.

2. In the Finder menu bar, click Go > Applications > Dell, and then double-click the (ControlCenter2) icon. The ControlCenter2 screen appears.

3. Click the SCAN tab.

4. Click the Image button.

   The scan settings dialog box appears.
5. Change the scan settings, such as file format, file name, destination file path, resolution, or color, if needed.
   **NOTE:** To change the file name or destination file path, click **Change**.

6. Click the **Start Scanning** button.
   The machine starts scanning. The scanned image will open in the application you have selected.

---

**Save Scanned Data to a Folder as a PDF File Using ControlCenter (Macintosh)**

1. Load your document.

2. In the **Finder** menu bar, click **Go > Applications > Dell**, and then double-click the **(ControlCenter2)** icon. The **ControlCenter2** screen appears.

3. Click the **SCAN** tab.

4. Click the **File** button.
   The scan settings dialog box appears.

5. Click the **File Type** pop-up menu, and then select **PDF (*.pdf)**.
   **NOTE:** To save the document as a password-protected PDF, select **Secure PDF (*.pdf)** from the **File Type** pop-up menu, type your password in the **Password** and **Re-type Password** fields, and then click **OK**.

6. Change the scan settings, such as file format, file name, destination folder, resolution, or color, if needed.

7. Click the **Start Scanning** button.
   The machine starts scanning. The file will be saved in the folder you selected.
Scan Both Sides of an ID Card Using ControlCenter

1. Place an ID card on the scanner glass.

2. In the Finder menu bar, click Go > Applications > Dell, and then double-click the ControlCenter2 icon. The ControlCenter2 screen appears.

3. Click the SCAN tab.

4. Click the File button.
   The scan settings dialog box appears.

5. Select the ID Card Scan check box.
   The instruction dialog appears.

6. Read the instructions on the screen, and then press OK.

7. Configure other settings, if needed.

8. Click the Start Scanning button.
   The machine starts scanning one side of the identification card.

9. After the machine has scanned one side, turn over the identification card, and then click Continue to scan the other side.

10. Click Finish.
Scan to E-mail Attachment Using ControlCenter (Macintosh)

Send a scanned document as an email attachment.

- The Scan to E-mail feature does not support Webmail services. Use the Scan to Image or Scan to File feature to scan a document or a picture, and then attach the file of the scanned data to an email message.

**NOTE:** The machine scans to your default email client.

1. Load your document.

2. In the Finder menu bar, click Go > Applications > Dell, and then double-click the (ControlCenter2) icon. The ControlCenter2 screen appears.

3. Click the SCAN tab.

4. Click the E-mail button. The scan settings dialog box appears.

5. Change the scan settings, such as file format, file name, destination file path, resolution, or color, if needed.

   **NOTE:** To change the file name or destination file path, click Change.

6. Click the Start Scanning button.
   The machine starts scanning. Your default email application will open and the scanned image is attached to a new, blank email.
Scan to an Editable Text File (OCR) Using ControlCenter (Macintosh)

Your machine can convert characters in a scanned document to text data using optical character recognition (OCR) technology. Edit this text using your preferred text-editing application.

(Macintosh) OCR Software must be installed on your computer. Download OCR Software from Install OCR Software.

**NOTE:** The Scan to OCR feature is available for English, French, German, Dutch, Italian, Spanish, Brazilian Portuguese, Danish, Swedish, Japanese, Korean, Traditional Chinese and Simplified Chinese.

1. Load your document.

2. In the Finder menu bar, click **Go > Applications > Dell**, and then double-click the (ControlCenter2) icon. The ControlCenter2 screen appears.

3. Click the **SCAN** tab.

4. Click the **OCR** button. The scan settings dialog box appears.

![Scan to OCR dialog box](image)

5. Change the scan settings, such as file format, file name, destination file path, resolution, or color, if needed.

   **NOTE:** To change the file name or destination file path, click **Change**.

6. Click the **Start Scanning** button. The machine scans the document, converts it to editable text, and then sends it to your default word processing
Scan Using TWAIN-Compliant Applications (Macintosh)

1. Launch your scanning application.
   The first time you use the Dell TWAIN driver, you must set it as the default driver.

2. Select the scan command in your application.
   The scanner setup dialog box appears.

3. Change the scan settings, such as Resolution, Scan Type, or Adjust Image options, if needed.

4. Click the Document Size pop-up menu, and then select your document size.
   **NOTE:** After you select a document size, adjust the scanning area by holding down the mouse button and dragging your mouse pointer over the portion you want to scan.

5. Click the PreScan option to preview your image and crop unwanted portions before scanning.

6. Click Start.
   The machine starts scanning.
TWAIN Driver Settings (Macintosh)

NOTE: Item names and assignable values will vary depending on the machine.

NOTE: The Brightness setting is available only when selecting Black & White, Gray (Error Diffusion), True Gray, or 24bit Color from the Scan Type options.

NOTE: The Contrast setting is available only when selecting Gray (Error Diffusion), True Gray, or 24bit Color from the Scan Type options.

Resolution
Select a scanning resolution from the Resolution pop-up menu. Higher resolutions take more memory and transfer time, but produce a finer scanned image.

Scan Type
Select from a range of scan color depths.

• Black & White
  Use for text or line art images.

• Gray (Error Diffusion)
  Use for photographic images or graphics. (Error Diffusion is a method for creating simulated gray images without using true gray dots. Black dots are put in a specific pattern to give a gray appearance.)

• True Gray
  Use for photographic images or graphics. This mode is more accurate because it uses up to 256 shades of gray.

• 256 Color
  Use for simple color illustrations that do not use the full color spectrum. This mode uses up to 256 colors to create images.

• 24bit Color
  Use to create an image with the most accurate color reproduction. This mode uses up to 16.8 million colors to scan the image, but it requires the most memory and has the longest transfer time.

Document Size
Select the exact size of your document from a selection of preset scan sizes.
• If you select **Custom**, you can specify the document size.

**Adjust Image**

Click the **Adjust Image** button to adjust other image qualities.

**Brightness**
Set the **Brightness** level by dragging the slider to the right or left to lighten or darken the image. If the scanned image is too light, set a lower brightness level and scan the document again. If the image is too dark, set a higher brightness level and scan the document again.

You can also type a value in the box to set the brightness.

**Contrast**
Increase or decrease the **Contrast** level by moving the slider to the right or left. An increase emphasizes dark and light areas of the image, while a decrease reveals more details in gray areas. You can also type a value in the box to set the contrast.

**Reduce Noise**
Improve and enhance the quality of your scanned images with this selection. The **Reduce Noise** option is available when selecting the **24bit Color** option and the **300 x 300 dpi**, **400 x 400 dpi**, or **600 x 600 dpi** scan resolutions.
Scan Using Apple Image Capture (ICA Driver)

The Apple Image Capture application uses the ICA scanner driver.

1. Launch the Image Capture application.

2. Select the machine from the list on the left side of the screen.
   If you connected the Dell machine to your Macintosh with a USB cable, you will see the machine in the DEVICES area. If connected via LAN, you will see it in the SHARED area.

3. Load your document.

4. Do one of the following:
   • (For OS X v10.8.x, 10.9.x and 10.10.x)
     If you place the document in the ADF, select the Use Document Feeder check box and then select the size of your document from the scan size setting pop-up menu.
• (For OS X v10.8.x, 10.9.x and 10.10.x)
  If you place the document on the scanner glass, clear the **Use Document Feeder** check box.

**Show Details**
Change the scanning settings, if needed.
You can crop the image manually by dragging the mouse pointer over the portion you want to scan when scanning from the scanner glass.

5. Select the destination folder or destination application from the **Scan To** pop-up menu.
6. Click **Scan**.
The machine starts scanning.
ICA Driver Settings

NOTE: Item names and assignable values listed here may vary depending on the machine.

Scan Mode
Select Document Feeder, or Flatbed.

Kind
Select Color, Black & White, or Text.

Resolution
Select the resolution for your document.

Use Custom Size
Select this check box to customize the document size when scanning from the Flatbed.

Scan Size/Size
Select the paper size of the document being scanned.

Orientation / Rotation Angle
Select the orientation of the document being scanned.

Auto selection
If you selected Use Custom Size when using the Flatbed, choose the Image Capture's automatic detection features here.

Scan To
Select the destination folder or destination application.

Name
Type the prefix text for the name of the scanned image.

Format
Select the file format of the scanned data.

Combine into single document
When you select PDF or TIFF for the file format, select this check box to scan and save a multiple-page document as one file.

Image Correction
Select Manual to adjust Brightness, Contrast, Tint, Temperature and Saturation.
Copy .............................................. 119
Copy a Document .............................................. 119
Copy Option ..................................................... 120
Change the Copy Quality ........................................ 121
Enlarge or Reduce Copied Images ............................... 122
Adjust the Copy Contrast ........................................ 122
Adjust the Copy Density (Brightness) .......................... 123
Make N in 1 Copies Using the Page Layout Feature ........... 123
Sort Copies ...................................................... 125
Copy Both Sides of an ID Card onto One Page .................. 126
Copy on Both Sides of the Paper (2-sided Copy) .............. 128
Copy

• Copy a Document
• Copy Option
• Change the Copy Quality
  Select the copy quality for the type of document you are copying.
• Enlarge or Reduce Copied Images
  Select an enlargement or reduction ratio to resize your copied data.
• Adjust the Copy Contrast
  If your document is very light or very dark, changing the contrast may improve the quality of the copy.
• Adjust the Copy Density (Brightness)
  Adjust the copy density to make copies darker or lighter.
• Make N in 1 Copies Using the Page Layout Feature
  The N in 1 copy feature saves paper by copying two or four pages of your document onto one page of the copy.
• Sort Copies
  Sort multiple copies. Pages will be stacked in the order they are fed, that is: 1, 2, 3, and so on.
• Copy Both Sides of an ID Card onto One Page
  Use the ID Copy feature to copy both sides of an identification card onto one page, keeping the original card size.
• Copy on Both Sides of the Paper (2-sided Copy)
  Reduce the amount of paper you use by copying onto both sides of the paper.

Copy a Document

1. Make sure you have loaded the correct size paper in the paper tray.
2. Do one of the following:
   • Place the document face up in the ADF.
     (If you are copying multiple pages, we recommend using the ADF)
   • Place the document face down on the scanner glass.
3. Do one of the following:
   • Dell E515dn/Dell E515dw
     Press \[\text{(Copy)}\].
     Use the dial pad to enter the number of copies you want.
   • Dell E514dw
     Press ▲ or ▼ to enter the number of copies you want.

   The LCD displays:

   ![LCD display showing Copy settings]

4. Press Start.

**Copy Option**

To change Copy settings, press the **Options** button.

<table>
<thead>
<tr>
<th>Menu selections</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality</td>
<td>Auto</td>
</tr>
<tr>
<td></td>
<td>Text</td>
</tr>
<tr>
<td></td>
<td>Photo</td>
</tr>
<tr>
<td></td>
<td>Receipt</td>
</tr>
</tbody>
</table>
Change the Copy Quality

Select the copy quality for the type of document you are copying.

1. Load your document.

2. Do one of the following:

   - Dell E515dn/Dell E515dw
     Press (Copy).
     Use the dial pad to enter the number of copies you want.

   - Dell E514dw
     Press ▲ or ▼ to enter the number of copies you want.

3. Press Options.

4. Press ▲ or ▼ to select the Quality option, and then press OK.
5. Press ▲ or ▼ to select the Auto, Text, Photo or Receipt option, and then press OK.
6. Press Start.

**Enlarge or Reduce Copied Images**

Select an enlargement or reduction ratio to resize your copied data.

1. Load your document.
2. Do one of the following:
   - Dell E515dn/Dell E515dw
     Press (Copy).
     Use the dial pad to enter the number of copies you want.
   - Dell E514dw
     Press ▲ or ▼ to enter the number of copies you want.
3. Press Options.
4. Press ▲ or ▼ to select Enlarge/Reduce, and then press OK.
5. Press ▲ or ▼ to select the enlargement or reduction ratio you want, and then press OK.
   - If you select Custom(25–400%), use the dial pad, or press ▲ or ▼ to enter an enlargement or reduction ratio from 25% to 400%.
6. Press Start.

**NOTE:** Auto sets the machine to calculate the reduction ratio that best fits the size of paper.

**NOTE:** Auto is only available when using the ADF.

**Adjust the Copy Contrast**

If your document is very light or very dark, changing the contrast may improve the quality of the copy.
1. Load your document.

2. Do one of the following:
   • Dell E515dn/Dell E515dw
     Press (Copy).
     Use the dial pad to enter the number of copies you want.
   • Dell E514dw
     Press ▲ or ▼ to enter the number of copies you want.

3. Press Options.

4. Press ▲ or ▼ to select Contrast, and then press OK.

5. Press ◀ or ▶ (▲ or ▼ for some models) to select a level of contrast, and then press OK.

6. Press Start.

**Adjust the Copy Density (Brightness)**

Adjust the copy density to make copies darker or lighter.

1. Load your document.

2. Do one of the following:
   • Dell E515dn/Dell E515dw
     Press (Copy).
     Use the dial pad to enter the number of copies you want.
   • Dell E514dw
     Press ▲ or ▼ to enter the number of copies you want.

3. Press Options.

4. Press ▲ or ▼ to select Brightness, and then press OK.

5. Press ◀ or ▶ (▲ or ▼ for some models) to select a level of brightness from Light to Dark, and then press OK.

6. Press Start.

**Make N in 1 Copies Using the Page Layout Feature**

The N in 1 copy feature saves paper by copying two or four pages of your document onto one page of the copy.
If you are copying from the ADF, insert the documents face up in the direction as shown below:

- 2 in 1 (P)

- 2 in 1 (L)

- 4 in 1 (P)

- 4 in 1 (L)

If you are copying from the scanner glass, place the document face down in the direction as shown below:

- 2 in 1 (P)

- 2 in 1 (L)

- 4 in 1 (P)
1. Load your document.
2. Do one of the following:
   • Dell E515dn/Dell E515dw
     Press (Copy).
     Use the dial pad to enter the number of copies you want.
   • Dell E514dw
     Press ▲ or ▼ to enter the number of copies you want.
3. Press Options.
4. Press ▲ or ▼ to select Page Layout, and then press OK.
5. Press ▲ or ▼ to select Off(1 in 1), 2 in 1 (P), 2 in 1 (L), 4 in 1 (P) or 4 in 1 (L), and then press OK.
6. Press Start.
   If you placed the document in the ADF, the machine scans the pages and starts printing.
   If you are using the scanner glass, go to the next step.
7. Repeat the following steps for each page of the layout:
   • Dell E515dn/Dell E515dw
     a. After the machine scans the page, press 1 to scan the next page.
     b. Place the next page on the scanner glass, and then press OK to scan the page.
   • Dell E514dw
     a. After the machine scans the page, press ▲ to select the Yes option.
     b. Place the next page on the scanner glass, and then press OK to scan the page.
8. After scanning all the pages, do one of the following:
   • Dell E515dn/Dell E515dw
     Press 2 to select the No option.
   • Dell E514dw
     Press ▼ to select the No option.

Sort Copies

Sort multiple copies. Pages will be stacked in the order they are fed, that is: 1, 2, 3, and so on.
1. Load your document.
2. Do one of the following:
   • Dell E515dn/Dell E515dw
     Press (Copy).
     Use the dial pad to enter the number of copies you want.
   • Dell E514dw
     Press ▲ or ▼ to enter the number of copies you want.

3. Press Options.
4. Press ▲ or ▼ to select Stack/Sort, and then press OK.
5. Press ▲ or ▼ to select Sort, and then press OK.
6. Press Start.
   If you placed the document in the ADF, the machine scans the pages and starts printing.
   If you are using the scanner glass, go to the next step.
7. Repeat the following steps for each page:
   • Dell E515dn/Dell E515dw
     a. After the machine scans the page, press 1 to scan the next page.
     b. Place the next page on the scanner glass, and then press OK to scan the page.
   • Dell E514dw
     a. After the machine scans the page, press ▲ to select the Yes option.
     b. Place the next page on the scanner glass, and then press OK to scan the page.
8. After scanning all the pages, do one of the following:
   • Dell E515dn/Dell E515dw
     Press 2 to select the No option.
   • Dell E514dw
     Press ▼ to select the No option.

**Copy Both Sides of an ID Card onto One Page**

Use the ID Copy feature to copy both sides of an identification card onto one page, keeping the original card size.
Copy an identification card only to the extent permitted under applicable laws. For more information, see the Safety Guide.

1. Press (Copy).
2. Place an identification card face down near the upper left corner of the scanner glass.

1 0.16 in. (4.0 mm) or greater (top, left)

3. Press ID Copy.
4. Do one of the following:
   • Dell E515dn/Dell E515dw
     Use the dial pad to enter the number of copies you want.
   • Dell E514dw
     Press ▲ or ▼ to enter the number of copies you want.
5. Press Start.
   The machine scans one side of the identification card.
6. After the machine has scanned the first side, turn over the identification card.
7. Press **Start** to scan the other side.

**Copy on Both Sides of the Paper (2-sided Copy)**

Reduce the amount of paper you use by copying onto both sides of the paper.

- You must choose a 2-sided copy layout from the following options before you can start 2-sided copying.
- The layout of your original document determines which 2-sided copy layout you should choose.
- To use the automatic 2-sided copy feature, you must load your document in the ADF.
- To use the manual 2-sided copy feature, place your document on the scanner glass.

---

**Portrait**

1–sided > 2–sided Long Edge Flip

![Diagram of 1-sided to 2-sided Long Edge Flip]

1–sided > 2–sided Short Edge Flip

![Diagram of 1-sided to 2-sided Short Edge Flip]

**Landscape**

1–sided > 2–sided Long Edge Flip

![Diagram of 1-sided to 2-sided Long Edge Flip]
1--sided > 2--sided Short Edge Flip

1. Load your document.

2. Do one of the following:
   • Dell E515dn/Dell E515dw
     Press (Copy).
     Use the dial pad to enter the number of copies you want.
   • Dell E514dw
     Press ▲ or ▼ to enter the number of copies you want.

3. Do one of the following:
   • Press 2-sided.
   • Press Options.
     • Press ▲ or ▼ to select 2-sided, and then press OK.

4. Press ▲ or ▼ to select 1-sided2-sided L, 1-sided2-sided S, or Off, and then press OK.

5. Press Start.
   If you placed the document in the ADF, the machine scans the pages and starts printing.
   **If you are using the scanner glass, go to the next step.**

6. Repeat the following steps for each page of the layout:
   • Dell E515dn/Dell E515dw
     a. After the machine scans the page, press 1 to scan the next page.
     b. Place the next page on the scanner glass, and then press OK to scan the page.
   • Dell E514dw
     a. After the machine scans the page, press ▲ to select the Yes option.
     b. Place the next page on the scanner glass, and then press OK to scan the page.

7. After scanning all the pages, do one of the following:
   • Dell E515dn/Dell E515dw
     Press 2 to select the No option.
   • Dell E514dw
     Press ▼ to select the No option.
Fax

• Send a Fax
• Receive a Fax
• Dial and Store Fax Numbers
• Telephone Services and External Devices
• Fax Reports
  The Transmission Verification Report and the Fax Journal are available to confirm the results of fax transmission.
• PC-FAX

Send a Fax

• Send a Fax
• Select or Change Settings for Sending a Fax
  Before you send a fax, you can change any combination of settings.
• Change the Fax Resolution
  The fax quality can often be improved by changing the Fax Resolution.
• Change the Fax Contrast
  If your document is very light or very dark, changing the contrast may improve the fax quality.
• Send a Fax Manually
  Manual fax transmission lets you hear the dialing, ringing and fax-receiving tones while sending a fax.
• Set Glass Scan Size for Faxing
  When faxing A4 size documents, you must set the scan glass size to A4; otherwise, a portion of your faxes will be missing.
• Send a Fax at the End of a Conversation
  At the end of a conversation, you can send a fax to the other party before you both hang up.
• Use Dual Access to Dial, Scan, Send, and Receive Faxes Simultaneously
  Dial a number and scan the fax into memory - even while the machine is sending from memory, receiving faxes, or printing from a computer.
• Send the Same Fax to More than One Recipient (Broadcasting)
  Use the Broadcasting feature to send the same fax to multiple fax numbers at the same time.
• Send a Fax in Real Time
  When sending a fax, the machine scans the document into the memory before sending it. As soon as the telephone line is free, the machine starts dialing and sending. If you want to send an important document immediately without waiting for the machine to retrieve the scan from its memory, transmit the fax quickly by turning on Real Time TX.
• Send a Fax Overseas
  If you are having difficulty sending a fax overseas due to a bad connection, then turning on Overseas Mode may help.
• Send a Fax at a Specified Time (Delayed Fax)
  You can store up to 50 faxes in the machine's memory to be sent within the next twenty-four hour period.
• Add a Cover Page to Your Fax
You can add a cover page to the next fax or every outgoing fax.

• Turn Off the Destination Information Display
  When you send a fax, the machine displays the destination fax number (or the recipient's name if the name is stored in the machine's memory).

• Cancel a Fax in Progress

• Check and Cancel Pending Fax
  You can cancel a fax job before it is sent. You can cancel a fax job that is stored and waiting in the memory.

**Send a Fax**

Related Models: Dell E515dn / Dell E515dw

1. Press ☎️ **(Fax)**.

2. Do one of the following:
   • Place the document *face up* in the ADF.
     (If you are faxing multiple pages, we recommend using the ADF.)
   • Place the document *face down* on the scanner glass.
3. Enter the fax number.
   • **Using the dial pad**
     Enter the fax number using the dial pad.

   ![Dial Pad Image]

   • **Using the One Touch Buttons**
     Choose a contact stored on a One Touch button.

   ![One Touch Buttons Image]

   • **Using the Speed Dial Codes**
     Enter the fax number by pressing ▲ twice, and then enter the three-digit Speed Dial code.

4. Press **Start**.

   The machine scans and sends the document.

   **If you placed the document on the scanner glass, follow the instructions in the table:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>To scan the next page, press 1 to select the Yes option, and then place the next page on the scanner glass. Press OK to scan the page.</td>
</tr>
</tbody>
</table>
When you have scanned the last page, press 2 to select the No(Send) option (or press Start again).
The machine sends the document.

- To stop faxing, press Cancel.

Select or Change Settings for Sending a Fax

Related Models:Dell E515dn / Dell E515dw
Before you send a fax, you can change any combination of settings.

Most settings are temporary and the machine returns to its default settings after you send a fax.

1. Press (Fax).
2. Load your document.
3. Press Menu.
4. Press ▲ or ▼ to display the Fax option, and then press OK.
5. Press ▲ or ▼ to display the Setup Send option, and then press OK.
6. Press ▲ or ▼ to display a setting you want, and then press OK.
7. Press ▲ or ▼ to display an option you want, and then press OK.
8. After the setting is accepted, the machine asks if you want to change more settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The LCD returns to the Setup Send menu so you can select another setting.</td>
</tr>
<tr>
<td>2</td>
<td>When finished, press 2 to proceed to entering the fax number.</td>
</tr>
</tbody>
</table>

9. Enter the fax number.

Change the Fax Resolution

Related Models:Dell E515dn / Dell E515dw
The fax quality can often be improved by changing the Fax Resolution.

1. Press (Fax).
2. Load your document.
3. Press ▼ (or Resolution for certain models) to change the resolution.
4. Press ▲ or ▼ to display the Standard, Fine, S.Fine, or Photo option, and then press OK.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Suitable for most typed documents.</td>
</tr>
<tr>
<td>Fine</td>
<td>Good for small print and transmits a little slower than Standard resolution.</td>
</tr>
</tbody>
</table>
**S.Fine**  Good for small print or artwork and transmits slower than Fine resolution.

**Photo**  Use when the document has varying shades of gray or is a photograph. This has the slowest transmission time.

5. Enter the fax number.

6. Press **Start**.

**Change the Fax Contrast**

Related Models:Dell E515dn / Dell E515dw

If your document is very light or very dark, changing the contrast may improve the fax quality.

1. Press (Fax).
2. Load your document.
3. Press **Menu**.
4. Press ▲ or ▼ to display the Fax option, and then press **OK**.
5. Press ▲ or ▼ to display the Setup Send option, and then press **OK**.
6. Press ▲ or ▼ to display the Contrast option, and then press **OK**.
7. Press ▲ or ▼ to display the Auto, Light, or Dark option, and then press **OK**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>For most documents the default setting of Auto will give the best results. Auto automatically chooses the appropriate contrast for your document.</td>
</tr>
<tr>
<td>Light</td>
<td>Select Light to make the faxed document darker.</td>
</tr>
<tr>
<td>Dark</td>
<td>Select Dark to make the faxed document lighter.</td>
</tr>
</tbody>
</table>

**NOTE:** Even if you choose Light or Dark, the machine will send the fax using the Auto setting if you choose Photo as the Fax Resolution.

8. When finished, press 2.
9. Enter the fax number.
10. Press **Start**.

**Send a Fax Manually**

Related Models:Dell E515dn / Dell E515dw

Manual fax transmission lets you hear the dialing, ringing and fax-receiving tones while sending a fax.

1. Press (Fax).
2. Load your document.
3. Press **Hook** and listen for a dial tone.
4. Dial the fax number you want to call.
5. When you hear the fax tone, press **Start**.
• If you are using the scanner glass, press 1.

Set Glass Scan Size for Faxing

Related Models: Dell E515dn / Dell E515dw
When faxing A4 size documents, you must set the scan glass size to A4; otherwise, a portion of your faxes will be missing.

1. Press Menu.
2. Press ▲ or ▼ to display the General Setup option, and then press OK.
3. Press ▲ or ▼ to display the Glass Scan Size option, and then press OK.
4. Press ▲ or ▼ to display the A4 option, and then press OK.
5. Press Cancel.

Send a Fax at the End of a Conversation

Related Models: Dell E515dn / Dell E515dw
At the end of a conversation, you can send a fax to the other party before you both hang up.

1. Ask the other party to wait for fax tones (beeps) and then to press the Start or Send button before hanging up.
2. Load your document.
3. Press Start.
   • If you are using the scanner glass, press 1.
4. Replace the handset of the external telephone.

Use Dual Access to Dial, Scan, Send, and Receive Faxes Simultaneously

Related Models: Dell E515dn / Dell E515dw
Dial a number and scan the fax into memory - even while the machine is sending from memory, receiving faxes, or printing from a computer.
The LCD shows the new job number.
The number of pages you can scan into the machine’s memory varies depending on the type of data.

**NOTE:** If an Out of Memory message appears while scanning the document, press the button shown in the table to send the scanned pages, or to cancel the operation.

<table>
<thead>
<tr>
<th>Applicable Models</th>
<th>To send scanned page</th>
<th>To cancel the operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell E515dn/Dell E515dw</td>
<td>Start</td>
<td>Cancel</td>
</tr>
</tbody>
</table>

Send the Same Fax to More than One Recipient (Broadcasting)

Related Models: Dell E515dn / Dell E515dw
Use the Broadcasting feature to send the same fax to multiple fax numbers at the same time.

• The same broadcast can include Groups, Address Book numbers (One Touch Dial numbers and Speed Dial numbers in some models) and up to 50 manually dialed numbers.
• Dell E515dn/Dell E515dw
  If you did not use any of the One Touch Dial numbers and the Speed Dial numbers for Groups, you can broadcast faxes to as many as 258 different numbers.
• Address Book numbers (One Touch Dial numbers and Speed Dial numbers in some models) must be stored in the machine’s memory before they can be used in a broadcast.
• Group numbers must also be stored in the machine’s memory before they can be used in a broadcast. Group numbers include many stored Address Book numbers (One Touch Dial numbers and Speed Dial numbers in some models) for easier dialing.

1. Press (Fax).
2. Load your document.
3. Enter a number, and press OK.
   You can use One Touch Dial, Speed Dial, Group numbers and numbers manually entered using the dial pad. Repeat this step to enter the all the numbers you want to broadcast to.
4. Press Start.

Cancel a Broadcast in Progress

Related Models: Dell E515dn / Dell E515dw
While broadcasting you can cancel the fax currently being sent or the whole broadcast job.

1. Press Menu.
2. Press ▲ or ▼ to display the Fax option, and then press OK.
3. Press ▲ or ▼ to display the Remaining Jobs option, and then press OK.
   The LCD will display the Broadcast job number followed by the fax number being dialed (for example, #001123456789) and the broadcast job number (for example, Broadcast#001).
4. Press ▲ or ▼ to display the fax number being dialed or the broadcast job number, and then press OK.
5. Press the option shown in the table to cancel or exit the cancel process.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The machine cancels the fax currently being sent.</td>
</tr>
<tr>
<td>2</td>
<td>The machine exits from the cancel process without canceling.</td>
</tr>
</tbody>
</table>

If you canceled the fax currently being sent, the LCD will ask you if you want to cancel the broadcast job.

6. Press the option shown in the table to cancel the broadcast job or exit the cancel process.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The machine cancels the broadcast job.</td>
</tr>
<tr>
<td>2</td>
<td>The machine exits from the cancel process without canceling.</td>
</tr>
</tbody>
</table>

7. Press Cancel.

Send a Fax in Real Time

Related Models: Dell E515dn / Dell E515dw
When sending a fax, the machine scans the document into the memory before sending it. As soon as the telephone line is free, the machine starts dialing and sending. If you want to send an important document immediately without waiting for the machine to retrieve the scan from its memory, transmit the fax quickly by turning on Real Time TX.

- If the memory is full and you are sending a fax from the ADF, the machine sends the document in real time (even if Real Time TX is set to Off). If the memory is full, faxes from the scanner glass cannot be sent until you clear some of the memory.
- In Real Time Transmission, the automatic redial feature does not work when using the scanner glass.

1. Press (Fax).
2. Load your document.
3. Press Menu.
4. Press ▲ or ▼ to display the Fax option, and then press OK.
5. Press ▲ or ▼ to display the Setup Send option, and then press OK.
6. Press ▲ or ▼ to display the Real Time TX option, and then press OK.
7. Press ▲ or ▼ to display the On option, and then press OK.
8. When finished, press 2.
9. Enter the fax number.

**Send a Fax Overseas**

Related Models:Dell E515dn / Dell E515dw

If you are having difficulty sending a fax overseas due to a bad connection, then turning on Overseas Mode may help.

1. Press (Fax).
2. Load your document.
3. Press Menu.
4. Press ▲ or ▼ to display the Fax option, and then press OK.
5. Press ▲ or ▼ to display the Setup Send option, and then press OK.
6. Press ▲ or ▼ to display the Overseas Mode option, and then press OK.
7. Press ▲ or ▼ to display the Next Fax:On, On, or Off option, and then press OK.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Fax:On</td>
<td>The Overseas Mode will only be active for your next fax.</td>
</tr>
<tr>
<td>On</td>
<td>The Overseas Mode will be active.</td>
</tr>
<tr>
<td>Off</td>
<td>The Overseas Mode will be inactive.</td>
</tr>
</tbody>
</table>

8. Press OK.
10. Enter the fax number.
11. Press Start.

**Send a Fax at a Specified Time (Delayed Fax)**

Related Models: Dell E515dn / Dell E515dw
You can store up to 50 faxes in the machine's memory to be sent within the next twenty-four hour period.

1. Press (Fax).
2. Load your document.
3. Press Menu.
4. Press ▲ or ▼ to display the Fax option, and then press OK.
5. Press ▲ or ▼ to display the Setup Send option, and then press OK.
6. Press ▲ or ▼ to display the Delayed Fax option, and then press OK.
7. Enter the time you want the fax to be sent.
   • If you set 12h Clock in the Date&Time setting, enter the time in 12-hour format, and then press OK. Press ▲ or ▼ to display the AM or PM option, and then press OK.
   • If you set 24h Clock in the Date&Time setting, enter the time in 24-hour format, and then press OK.
     (For example, enter 19:45 for 7:45 PM.)
8. When finished, press 2.
9. Enter the fax number.

**NOTE:** The number of pages you can scan into the memory depends on the amount of data printed on each page.

**Add a Cover Page to Your Fax**

Related Models: Dell E515dn / Dell E515dw
You can add a cover page to the next fax or every outgoing fax.

- This feature will not work unless you have programmed your Station ID.
- Your cover page includes your Station ID, a comment, and the name stored in the Address Book, One Touch Dial, or Speed Dial.

1. Press (Fax).
2. Load your document.
3. Press Menu.
4. Press ▲ or ▼ to display the Fax option, and then press OK.
5. Press ▲ or ▼ to display the Setup Send option, and then press OK.
6. Press ▲ or ▼ to display the Coverpage option, and then press OK.
1. Press ▲ or ▼ to display the Setup option, and then press OK.

2. Press ▲ or ▼ to display a option in the table, and then press OK.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Select this option to add a cover page to outgoing fax.</td>
</tr>
<tr>
<td>Off</td>
<td>Select this option if you do not want to add a cover page to outgoing faxes.</td>
</tr>
</tbody>
</table>

3. If you selected On, Press ▲ or ▼ to display comment options, and then press OK.

4. Enter the number of total pages using the dial pad, and then press OK.

5. When finished, press 2.

6. Enter the fax number.

7. Press Start.

Compose Your Own Comments

Related Models:Dell E515dn / Dell E515dw

You can set up two comments of your own.

1. Press (Fax).

2. Press Menu.

3. Press ▲ or ▼ to display the Fax option, and then press OK.

4. Press ▲ or ▼ to display the Setup Send option, and then press OK.

5. Press ▲ or ▼ to display the Coverpage option, and then press OK.

6. Press ▲ or ▼ to display the Message option, and then press OK.

7. Press ▲ or ▼ to display the 5 or 6 option to store your own comment, and then press OK.

8. Enter your own comment using the dial pad, and then press OK.


Turn Off the Destination Information Display

Related Models:Dell E515dn / Dell E515dw

When you send a fax, the machine displays the destination fax number (or the recipient's name if the name is stored in the machine's memory).

You can set the machine to hide the destination information on the LCD.

1. Press (Fax).

2. Press Menu.

3. Press ▲ or ▼ to display the Fax option, and then press OK.

4. Press ▲ or ▼ to display the Setup Send option, and then press OK.

5. Press ▲ or ▼ to display the Destination option, and then press OK.

6. Press ▲ or ▼ to display the Hidden (or Display) option, and then press OK.

7. Press Cancel.
Cancel a Fax in Progress
Related Models:Dell E515dn / Dell E515dw
1. Press Stop/Exit while the machine is dialing or sending a fax.
2. Press a options in the table to cancel or continue the fax job in progress.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The machine cancels sending the fax job.</td>
</tr>
<tr>
<td>2</td>
<td>The machine exits from the process without canceling the fax job.</td>
</tr>
</tbody>
</table>

Check and Cancel Pending Fax
Related Models:Dell E515dn / Dell E515dw
You can cancel a fax job before it is sent. You can cancel a fax job that is stored and waiting in the memory.
1. Press (Fax).
2. Press Menu.
3. Press ▲ or ▼ to display the Fax option, and then press OK.
4. Press ▲ or ▼ to display the Remaining Jobs option, and then press OK.
   The LCD displays the number of jobs waiting in the memory to be sent.
5. Press ▲ or ▼ to display the job you want to cancel, and then press OK.
6. Press the options in the following table to cancel or exit the cancel process.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The machine cancels the job.</td>
</tr>
<tr>
<td>2</td>
<td>The machine exits from the cancel process without canceling.</td>
</tr>
</tbody>
</table>
7. Press Cancel.

Receive a Fax

- Receive Mode Settings
- Additional Receiving Operations
- Memory Receive (Remote Fax) Options
  Use Memory Receive (Remote Fax) options to direct incoming faxes while you are away from the machine. You can use only one Memory Receive option at a time.
- Remote Retrieval
  Use Remote Retrieval to call your machine from any touch-tone telephone or fax machine and use a remote access code and remote commands to retrieve fax messages.
- Receive Faxes into Memory When the Paper Tray is Empty
Receive Mode Settings

• Receive Modes
• Choose the Correct Receive Mode
  The correct Receive Mode for you is determined by the external devices and telephone subscriber services (Voice Mail, Distinctive Ring and so on) you will be using on the same line as the Dell machine.
• Set the Number of Rings Before the Machine Answers (Ring Delay)
  When somebody calls your machine, you will hear the normal telephone ring sound. The number of rings is set in the Ring Delay option.
• Set the F/T Ring Time (Pseudo/Double-ring)
  When you set the Receive Mode to Fax/Tel Mode, if the call is a fax, your machine will automatically receive it. However, if it is a voice call, the machine will sound the F/T ring (pseudo/double-ring) for the time you set in the F/T Ring Time option. When you hear the F/T ring, it means that a voice caller is on the line.
• Set the Easy Receive

Receive Modes

Related Models: Dell E515dn / Dell E515dw

Some receive modes answer automatically (Fax Only Mode and Fax/Tel Mode). You may want to change the Ring Delay before using these modes.

Fax Only Mode
  (Fax or Fax only in the Machine’s Menu)
  Fax Only Mode automatically answers every call as a fax.

Fax/Tel Mode
  (Fax/Tel in the Machine’s Menu)
  Fax/Tel Mode helps you manage incoming calls, by recognizing whether they are fax or voice calls and handling them in one of the following ways:
  • Faxes will be received automatically.
  • Voice calls will start the F/T ring to tell you to pick up the call. The F/T ring is a fast pseudo/double-ring made by your machine.

Manual Mode
  (Manual in the Machine’s Menu)
  Manual Mode turns off all automatic answering operations unless you are using the Distinctive Ring Receive feature.
  To receive a fax in Manual Mode, lift the handset of the external telephone or press Hook.
  When you hear fax tones (short repeating beeps), press the buttons in the table to receive a fax. Use the Easy Receive feature to receive faxes when you have lifted a handset on the same line as the machine.

<table>
<thead>
<tr>
<th>Applicable Models</th>
<th>To receive the fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell E515dn/Dell E515dw</td>
<td>Start and then 2</td>
</tr>
</tbody>
</table>

External TAD Mode
  (External TAD in the Machine’s Menu)
  External TAD Mode lets an external answering device manage your incoming calls.
Incoming calls will be handled in the following ways:

- Faxes will be received automatically.
- Voice callers can record a message on the external TAD.

**Choose the Correct Receive Mode**

Related Models: Dell E515dn / Dell E515dw

The correct Receive Mode for you is determined by the external devices and telephone subscriber services (Voice Mail, Distinctive Ring and so on) you will be using on the same line as the Dell machine.

**Will you be using a Distinctive Ring number for receiving faxes?**

Dell uses the term "Distinctive Ring" but different telephone companies may have other names for this service such as Custom Ringing, RingMaster, Personalized Ring, Teen Ring, Ident-A-Ring, Ident-A-Call, Data Ident-A-Call, Smart Ring and SimpleBiz Fax & Alternate Number Ringing.

**Will you be using Voice Mail on the same telephone line as your Dell machine?**

If you have Voice Mail on the same telephone line as your Dell machine, there is a strong possibility that Voice Mail and the Dell machine will conflict with each other when receiving incoming calls.

**Will you be using a Telephone Answering Device on the same telephone line as your Dell machine?**

Your external telephone answering device (TAD) will answer every call automatically. Voice messages are stored on the external TAD and fax messages are printed. Select External TAD Mode as your receive mode.

**Will you be using your Dell machine on a dedicated fax line?**

Your machine automatically answers every call as a fax. Select Fax Only Mode as your receive mode.

**Will you be using your Dell machine on the same line as your telephone?**

- **Do you want to receive voice calls and faxes automatically?**
  The Fax/Tel Mode is used when sharing the Dell machine and your telephone on the same line. Select Fax/Tel Mode as your receive mode.
  
  **Important Note:** You cannot receive voice messages on either Voice Mail or an answering machine if you selected the Fax/Tel Mode.

- **Do you expect to receive very few faxes?**
  Choose Manual Mode as your receive mode. You control the telephone line and must answer every call yourself.

1. Press (Fax).
2. Press Menu.
3. Press ▲ or ▼ to display the Fax option, and then press OK.
4. Press ▲ or ▼ to display the Setup Receive option, and then press OK.
5. Press ▲ or ▼ to display the Receive Mode option, and then press OK.
   
   **NOTE:** If you cannot change the Receive Mode option, make sure the Distinctive Ring feature is set to Off.
6. Press ▲ or ▼ to select the Fax only, Fax/Tel, External TAD, or Manual option, and then press OK.
7. Press Cancel.
Set the Number of Rings Before the Machine Answers (Ring Delay)

Related Models: Dell E515dn / Dell E515dw
When somebody calls your machine, you will hear the normal telephone ring sound. The number of rings is set in the Ring Delay option.

- The Ring Delay setting sets the number of times the machine rings before it answers in the Fax Only Mode and the Fax/Tel Mode.
- If you have external or extension telephones on the same line as the machine, keep the Ring Delay setting of 4.

1. Press (Fax).
2. Press Menu.
3. Press ▲ or ▼ to display the Fax option, and then press OK.
4. Press ▲ or ▼ to display the Setup Receive option, and then press OK.
5. Press ▲ or ▼ to display the Ring Delay option, and then press OK.
6. Press ▲ or ▼ to select the number of rings you want the line to ring before the machine answers, and then press OK.
7. Press Cancel.

**NOTE:** If you select 00, the machine will answer immediately and the line will not ring at all (available only for some countries).

Set the F/T Ring Time (Pseudo/Double-ring)

Related Models: Dell E515dn / Dell E515dw
When you set the Receive Mode to Fax/Tel Mode, if the call is a fax, your machine will automatically receive it. However, if it is a voice call, the machine will sound the F/T ring (pseudo/double-ring) for the time you set in the F/T Ring Time option. When you hear the F/T ring, it means that a voice caller is on the line.

The F/T Ring Time feature works when you set Fax/Tel Mode as the Receive Mode.

Because the F/T ring is made by the machine, extension and external telephones will not ring; however, you can still answer the call on any telephone.

1. Press (Fax).
2. Press Menu.
3. Press ▲ or ▼ to display the Fax option, and then press OK.
4. Press ▲ or ▼ to display the Setup Receive option, and then press OK.
5. Press ▲ or ▼ to display the F/T Ring Time option, and then press OK.
6. Press ▲ or ▼ to display how long the machine will ring to alert you that you have a voice call, and then press OK.
7. Press Cancel.
**NOTE:** Even if the caller hangs up during the pseudo/double-ringing, the machine will continue to ring for the set time.

**Set the Easy Receive**

Related Models: Dell E515dn / Dell E515dw

**If Easy Receive is On:**
The machine can receive a fax automatically, even if you answer the call. When you see Receiving on the LCD or hear a click on the phone line through the handset you are using, just replace the handset. Your machine will do the rest.

**If Easy Receive is Off:**
If you are at the machine and answer a fax call first by lifting the external handset, press the buttons in the following table to receive the fax. If you answered at an extension telephone, press *51.

<table>
<thead>
<tr>
<th>Applicable Models</th>
<th>To receive the fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell E515dn/Dell E515dw</td>
<td>Start and then 2</td>
</tr>
</tbody>
</table>

**NOTE:** If this feature is set to On, but your machine does not connect a fax call when you lift an extension or external telephone handset, press the fax receive code *51.

**NOTE:** If you send faxes from a computer on the same telephone line and the machine intercepts them, set Easy Receive to Off.

1. Press (Fax).
2. Press Menu.
3. Press ▲ or ▼ to display the Fax option, and then press OK.
4. Press ▲ or ▼ to display the Setup Receive option, and then press OK.
5. Press ▲ or ▼ to display the Easy Receive option, and then press OK.
6. Press ▲ or ▼ to display the On (or Off) option, and then press OK.
7. Press Cancel.

**Additional Receiving Operations**
- Shrink Page Size of an Oversized Incoming Fax
- Set the 2-sided Printing for Received Faxes
  - Your machine prints received faxes on both sides of the paper when 2-sided is set to On.
- Set the Fax Receive Stamp
  - You can set the machine to print the received date and time at the top center of each received fax page.
- Receive a Fax at the End of a Telephone Conversation
  - If you are speaking on the telephone connected to your Dell machine and the other party is also speaking on a
telephone connected to his fax machine, at the end of the conversation, the other party can send you a fax before you both hang up.

- Avoid Incoming Fax from Specific Numbers

**Shrink Page Size of an Oversized Incoming Fax**

Related Models:Dell E515dn / Dell E515dw

If you enable the auto reduction function, the machine reduces each page of an incoming fax to fit on your paper. The machine calculates the reduction ratio by using the page size of the fax and your Paper Size setting.

1. Press (Fax).
2. Press Menu.
3. Press ▲ or ▼ to display the Fax option, and then press OK.
4. Press ▲ or ▼ to display the Setup Receive option, and then press OK.
5. Press ▲ or ▼ to display the Auto Reduction option, and then press OK.
6. Press ▲ or ▼ to display the On (or Off) option, and then press OK.
7. Press Cancel.

**Set the 2-sided Printing for Received Faxes**

Related Models:Dell E515dn / Dell E515dw

Your machine prints received faxes on both sides of the paper when 2-sided is set to On.

- Use Letter, Legal or Folio (8.5 in. × 13 in.) sized paper for this function [16 to 28 lb (60 to 105 g/m²)].
- When 2-sided printing is enabled, incoming faxes are automatically reduced to fit the paper in the paper tray.

1. Press (Fax).
2. Press Menu.
3. Press ▲ or ▼ to display the Fax option, and then press OK.
4. Press ▲ or ▼ to display the Setup Receive option, and then press OK.
5. Press ▲ or ▼ to display the 2-sided option, and then press OK.
6. Press ▲ or ▼ to display the On (or Off) option, and then press OK.
7. Press Cancel.

**Set the Fax Receive Stamp**

Related Models:Dell E515dn / Dell E515dw

You can set the machine to print the received date and time at the top center of each received fax page.

- Make sure you have set the current date and time on the machine.

1. Press (Fax).
2. Press **Menu**.
3. Press ▲ or ▼ to display the Fax option, and then press **OK**.
4. Press ▲ or ▼ to display the Setup Receive option, and then press **OK**.
5. Press ▲ or ▼ to display the Fax Rx Stamp option, and then press **OK**.
6. Press ▲ or ▼ to display the On (or Off) option, and then press **OK**.
7. Press **Cancel**.

**Receive a Fax at the End of a Telephone Conversation**

Related Models:Dell E515dn / Dell E515dw

If you are speaking on the telephone connected to your Dell machine and the other party is also speaking on a telephone connected to his fax machine, at the end of the conversation, the other party can send you a fax before you both hang up.

Your machine's ADF must be empty.

1. Ask the other party to place the document in their machine and to press the Start or Send button.
2. When you hear the CNG tones (slowly repeating beeps), press **Start**.
3. Press 2 to receive a fax.
4. Replace the external handset.

**Avoid Incoming Fax from Specific Numbers**

- **Register a Number in the Blocked List**
  - If you do not want to receive faxes or calls from specific numbers, register the numbers to the blocked list. The machine can register up to 100 fax or telephone numbers from the caller ID memory.
- **Delete a Number from the Blocked List**
- **Print the Blocked List**

**Register a Number in the Blocked List**

Related Models:Dell E515dn / Dell E515dw

If you do not want to receive faxes or calls from specific numbers, register the numbers to the blocked list. The machine can register up to 100 fax or telephone numbers from the caller ID memory.

- You must apply for the Caller ID service at your local telephone company.
- The number you want to register must be stored in the caller ID memory.

The Caller ID feature is not available in some countries.

1. Press (Fax).
2. Press **Menu**.
3. Press ▲ or ▼ to display the Fax option, and then press **OK**.
4. Press ▲ or ▼ to display the Anti-Junk Fax option, and then press OK.
5. Press ▲ or ▼ to display the Register option, and then press OK.
   The machine displays the numbers in the caller ID memory.
6. Press ▲ or ▼ to display the number you want, and then press OK.
7. Press 1 to register the number.
   NOTE: To go back without registering the number, press 2.
8. Press Cancel.

Delete a Number from the Blocked List
Related Models:Dell E515dn / Dell E515dw
1. Press (Fax).
2. Press Menu.
3. Press ▲ or ▼ to display the Fax option, and then press OK.
4. Press ▲ or ▼ to display the Anti-Junk Fax option, and then press OK.
5. Press ▲ or ▼ to display the Delete option, and then press OK.
   The machine displays the numbers in the blocked list.
6. Press ▲ or ▼ to display the number you want to delete.
7. Press 1 to delete the number.
   NOTE: To go back without deleting the number, press 2.
8. Press Cancel.

Print the Blocked List
Related Models:Dell E515dn / Dell E515dw
1. Press (Fax).
2. Press Menu.
3. Press ▲ or ▼ to display the Fax option, and then press OK.
4. Press ▲ or ▼ to display the Anti-Junk Fax option, and then press OK.
5. Press ▲ or ▼ to display the Print Report option, and then press OK.
6. Press Start.
7. Press Cancel.

Memory Receive (Remote Fax) Options
Related Models:Dell E515dn / Dell E515dw
Use Memory Receive (Remote Fax) options to direct incoming faxes while you are away from the machine. You can use only one Memory Receive option at a time.
Memory Receive (Remote Fax) can be set to:
• Fax Forwarding
• Fax Storage
• Off

Forward Incoming Faxes to Another Machine

Related Models: Dell E515dn / Dell E515dw

Use the Fax Forwarding feature to automatically forward your incoming faxes to another machine.

1. Press Menu.
2. Press ▲ or ▼ to display the Fax option, and then press OK.
3. Press ▲ or ▼ to display the Remote Fax Opt option, and then press OK.
4. Press ▲ or ▼ to display the Forward/Store option, and then press OK.
5. Press ▲ or ▼ to display the Fax Forward option, and then press OK.

The LCD will ask you to enter the fax number you want your faxes to be forwarded to.

6. Enter the forwarding number using the dial pad (up to 20 digits), a One Touch button, or ▲ and the three-digit code, and then press OK.

    NOTE: If you stored a Group on a One Touch key or in a Speed Dial code, the faxes will be forwarded to multiple fax numbers.

7. Press ▲ or ▼ to select on or off for the Backup Print setting.
8. Press Cancel.

Store Incoming Faxes in the Machine’s Memory

Related Models: Dell E515dn / Dell E515dw

Use the Fax Storage feature to store incoming faxes in the machine's memory. Retrieve your stored fax messages from a fax machine at another location using the Remote Retrieval commands. Your machine will print a backup copy of each stored fax.

1. Press Menu.
2. Press ▲ or ▼ to display the Fax option, and then press OK.
3. Press ▲ or ▼ to display the Remote Fax Opt option, and then press OK.
4. Press ▲ or ▼ to display the Forward/Store option, and then press OK.
5. Press ▲ or ▼ to display the Fax Storage option, and then press OK.
6. Press Cancel.

Change Memory Receive (Remote Fax) Options

Related Models: Dell E515dn / Dell E515dw

If there are faxes in your machine's memory when you change any Memory Receive option, the LCD displays you one of the following questions:

If received faxes have already been printed, the LCD displays Erase All Fax?
• Do one of the following:
  • If you press 1, faxes in the memory will be erased before the setting changes.
• If you press 2, faxes in the memory will not be erased and the setting will be unchanged.

If unprinted faxes are in the memory, the LCD displays Print All Fax?
• Do one of the following:
  • If you press 1, faxes in the memory will be printed before the setting changes. If a backup copy has already been printed, it will not be printed again.
  • If you press 2, faxes in the memory will not be printed and the setting will be unchanged.

Turn off Memory Receive (Remote Fax) Options
Related Models:Dell E515dn / Dell E515dw
Turn off Memory Receive if you do not want the machine to save or transfer incoming faxes.

1. Press Menu.
2. Press ▲ or ▼ to display the Fax option, and then press OK.
3. Press ▲ or ▼ to display the Remote Fax Opt option, and then press OK.
4. Press ▲ or ▼ to display the Forward/Store option, and then press OK.
5. Press ▲ or ▼ to display the Off option, and then press OK.
   
   NOTE: The LCD displays options if there are received faxes still in your machine’s memory.
6. Press Cancel.

Print a Fax Stored in the Machine’s Memory
Related Models:Dell E515dn / Dell E515dw
If you select Fax Storage, you can still print a fax from the memory when you are at your machine.

1. Press Menu.
2. Press ▲ or ▼ to display the Fax option, and then press OK.
3. Press ▲ or ▼ to display the Remote Fax Opt option, and then press OK.
4. Press ▲ or ▼ to display the Print Fax option, and then press OK.
5. Press Start.
6. Press Cancel.

Remote Retrieval
Use Remote Retrieval to call your machine from any touch-tone telephone or fax machine and use a remote access code and remote commands to retrieve fax messages.
• Set a Remote Access Code
  Set a Remote Access Code to access and control your Dell machine even when you are away from it.
• Use Your Remote Access Code
• Remote Retrieval Commands
• Forward Faxes Remotely
  Call your Dell machine from any touch-tone telephone or fax machine to forward incoming faxes to another machine.
• Change the Fax Forwarding Number
  You can change your fax forwarding number from another touch-tone telephone or fax machine.

Set a Remote Access Code
Related Models:Dell E515dn / Dell E515dw
Set a Remote Access Code to access and control your Dell machine even when you are away from it.

Before you can use the remote access and retrieval features, you must set up your own code. The factory default code is the inactive code (---*).

1. Press Menu.
2. Press ▲ or ▼ to display the Fax option, and then press OK.
3. Press ▲ or ▼ to display the Remote Fax Opt option, and then press OK.
4. Press ▲ or ▼ to display the Remote Access option, and then press OK.
5. Enter a three-digit code using the numbers 0 to 9, * or # using the dial pad, and then press OK.
   NOTE: To make your code inactive, press Clear to delete the three-digit code in this step. Then press OK.
   NOTE: You cannot change the preset *.
   NOTE: DO NOT use the same code used for your Fax Receive Code (*51) or Telephone Answer Code (#51).
6. Press Cancel.

Use Your Remote Access Code
Related Models:Dell E515dn / Dell E515dw
1. Dial your fax number from a telephone or another fax machine using touch tone.
2. When your machine answers, immediately enter your Remote Access Code (three digits followed by *).
3. The machine signals if it has received messages:
   • One long beep -- Fax messages
   • No beeps -- No messages
4. When the machine gives two short beeps, enter a command.
   • The machine will hang up if you wait longer than 30 seconds to enter a command.
   • The machine will beep three times if you enter an invalid command.
5. Press 9 0 to reset the machine when you are finished.
6. Hang up.
   • If your machine is set to Manual mode and you want to use the remote retrieval features, wait for about 100 seconds after it starts ringing, and then enter the remote access code within 30 seconds.
   • This function may not be available in some countries or supported by your local telephone company.

Remote Retrieval Commands
Related Models:Dell E515dn / Dell E515dw
Use the Remote Commands in this table to access fax commands and options when you are away from your Dell machine. When you call the machine and enter your remote access code (three digits followed by *), the system will give two short beeps and you must enter a Remote Command (column 1), followed by one of the options (column 2) for that command.

<table>
<thead>
<tr>
<th>Remote commands</th>
<th>Options</th>
<th>Operation details</th>
</tr>
</thead>
<tbody>
<tr>
<td>95</td>
<td>Change the Fax Forwarding, or Fax Storage settings</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 OFF</td>
<td>You can select Off after you retrieve or erase all your messages.</td>
</tr>
<tr>
<td></td>
<td>2 Fax Forwarding</td>
<td>One long beep means the change is accepted. If you hear three short beeps, you cannot make a change because something has not been set up (for example, a Fax Forwarding number has not been registered). You can register your Fax Forwarding number by entering 4. After you register the number, Fax Forwarding will work.</td>
</tr>
<tr>
<td></td>
<td>4 Fax Forwarding number</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6 Fax Storage</td>
<td></td>
</tr>
<tr>
<td>96</td>
<td>Retrieve a fax</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 Retrieve all faxes</td>
<td>Enter the fax number of a remote fax machine to receive stored fax messages.</td>
</tr>
<tr>
<td></td>
<td>3 Erase faxes from memory</td>
<td>If you hear one long beep, fax messages have been erased from memory.</td>
</tr>
<tr>
<td>97</td>
<td>Check the receiving status</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 Fax</td>
<td>Check whether your machine has received any faxes. If yes, you will hear one long beep. If not, you will hear three short beeps.</td>
</tr>
<tr>
<td>98</td>
<td>Change the Receive Mode</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 External TAD</td>
<td>One long beep means the change has been accepted.</td>
</tr>
<tr>
<td></td>
<td>2 Fax/Tel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 Fax Only</td>
<td></td>
</tr>
<tr>
<td>90</td>
<td>Exit</td>
<td>Press 90 to stop remote retrieval. Wait for the long beep, then hang up.</td>
</tr>
</tbody>
</table>

**Forward Faxes Remotely**

Related Models:Dell E515dn / Dell E515dw

Call your Dell machine from any touch-tone telephone or fax machine to forward incoming faxes to another machine.

You must turn on Fax Storage to use this feature.

1. Dial your fax number.
2. When your machine answers, enter your Remote Access Code (three digits followed by *). If you hear one long beep, you have messages.
4. Wait for the long beep, and then use the dial pad to enter the number of the remote fax machine where you want your fax messages sent, followed by # # (up to 20 digits).
   
   **NOTE:** You cannot use * and # as dial numbers. However, press # if you want to create a pause.

5. Hang up after you hear your machine beep. Your machine will call the other fax machine which will then print your fax messages.

**Change the Fax Forwarding Number**

Related Models:Dell E515dn / Dell E515dw

You can change your fax forwarding number from another touch-tone telephone or fax machine.

1. Dial your fax number.

2. When your machine answers, enter your Remote Access Code (three digits followed by *). If you hear one long beep, you have messages.


4. Wait for the long beep, enter the new number (up to 20 digits) of the remote fax machine you want your fax messages forwarded to using the dial pad, then enter # #.

   **NOTE:** You cannot use * and # as dial numbers. However, press # if you want to create a pause.

5. Press 9 0 to stop Remote Access when you have finished.

6. Hang up after you hear your machine beep.

**Receive Faxes into Memory When the Paper Tray is Empty**

Related Models:Dell E515dn / Dell E515dw

As soon as the paper tray becomes empty during fax reception, the machine begins receiving faxes into the machine's memory.

Incoming faxes will be stored until the machine's memory becomes full or until paper is loaded in the paper tray. When the memory is full, the machine will stop automatically answering calls. To print the faxes, load paper in the tray.

**Dial and Store Fax Numbers**

* How to Dial
* Voice Operations
* Additional Dialing Operations
* How to Store Numbers

**How to Dial**

* Dial Manually
* Dial a Number Using One Touch Dial
* Dial a Number Using Speed Dial
* Redial a Fax Number
If you are sending a fax automatically and the line is busy, the machine will redial up to three times at five minute intervals.

**Dial Manually**

Related Models:Dell E515dn / Dell E515dw

1. Press (Fax).
2. Load your document.
3. Press all digits of the fax number.
4. Press Start.

**Dial a Number Using One Touch Dial**

Related Models:Dell E515dn / Dell E515dw

1. Press (Fax).
2. Load your document.
3. Press the One Touch button assigned to the fax or telephone number you want to dial.
   
   **NOTE:** To dial One Touch numbers 1 to 4, press the One Touch button. To dial One Touch numbers 5 to 8, hold down Shift as you press the One Touch button.
4. Press Start.

**Dial a Number Using Speed Dial**

Related Models:Dell E515dn / Dell E515dw

1. Press (Fax).
2. Load your document.
3. Do one of the following:
   - Press ▲ twice and enter the three-digit Speed Dial code.
   - Press ▲ .
Press the dial pad buttons for the first few letters of the name, and then press OK.
Press ▲ or ▼ to scroll until you find the name you are looking for, and then press OK.

4. Press Start.

Redial a Fax Number

Related Models: Dell E515dn / Dell E515dw
If you are sending a fax automatically and the line is busy, the machine will redial up to three times at five minute intervals.
• Redial only works if you dialed from the machine.
• In real time transmission, the automatic redial feature does not work when you are using the scanner glass.

1. Load your document.
2. Press (Fax).
3. Press Redial/Pause.
   
   **NOTE:** If you are sending a fax manually and the line is busy, press Hook before pressing Redial/Pause to wait for the other fax machine to answer.
4. Press 1 or 2 to select the call history list you use, if required.
5. Press ▲ or ▼ to select the number you want to dial, and then press OK.
6. Press Start.

Voice Operations

• Send Tone Signals
  If you have a Pulse dialing service, but must send Tone signals (for example, for telephone banking), follow these steps. If you have Touch Tone service, you will not need this feature to send tone signals.
  • Pick up a Voice Call in Fax/Tel Receive Mode
  • Special Line Considerations

Send Tone Signals

Related Models: Dell E515dn / Dell E515dw
If you have a Pulse dialing service, but must send Tone signals (for example, for telephone banking), follow these steps. If you have Touch Tone service, you will not need this feature to send tone signals.

1. Press (Fax).
2. Press Hook.
3. Press # on the machine’s control panel.
   Any digits dialed after this will send tone signals.
When you are finished with the call, the machine will return to the Pulse dialing service.

Pick up a Voice Call in Fax/Tel Receive Mode

Related Models: Dell E515dn / Dell E515dw
When the machine is in Fax/Tel mode, it will use the F/T Ring (pseudo/double-ring) to alert you to pick up a voice
call.
If you are at the machine, lift the external telephone’s handset, and then press the button in the following table to answer.

<table>
<thead>
<tr>
<th>Applicable Models</th>
<th>To pick up voice call</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell E515dn/Dell E515dw</td>
<td>Hook</td>
</tr>
</tbody>
</table>

If you are at an extension telephone, lift the handset during the F/T Ring and then press #51 between the pseudo/double rings. If no one is on the line, or if someone wants to send you a fax, send the call back to the machine by pressing *51.

**Special Line Considerations**

- **Rollover Telephone Lines**
  A rollover telephone system is a group of two or more separate telephone lines that pass incoming calls to each other if they are busy.
- **Two-Line Telephone System**
  A two-line telephone system is nothing more than two separate telephone numbers on the same wall outlet.
- **Convert Telephone Wall Outlets**
- **Install Your Dell Machine, a External Two-Line TAD and Two-Line Telephone**
  When you are installing an external two-line telephone answering device (TAD) and a two-line telephone, your machine must be isolated on one line at both the wall jack and at the TAD.

**Rollover Telephone Lines**

Related Models:Dell E515dn / Dell E515dw
A rollover telephone system is a group of two or more separate telephone lines that pass incoming calls to each other if they are busy.
This feature is available only in the USA and Canada.
The calls are usually passed down or ‘rolled over’ to the next available telephone line in a preset order.
Your machine can work in a rollover system only if it is the last number in the sequence, so the call cannot roll away. Do not place the machine on any of the other numbers; when the other lines are busy and a second fax call is received, the fax call would be transferred to a line that does not have a fax machine. **Your machine will work best on a dedicated line.**

**Two-Line Telephone System**

Related Models:Dell E515dn / Dell E515dw
A two-line telephone system is nothing more than two separate telephone numbers on the same wall outlet.
This feature is available only in the USA and Canada.
The two telephone numbers can be on separate jacks (RJ11) or combined into one jack (RJ14). Your machine must be plugged into an RJ11 jack. RJ11 and RJ14 jacks may be equal in size and appearance and both may contain four wires (black, red, green, yellow). To test the type of jack, plug in a two-line telephone and see if it can access both lines. If it can, you must separate the line for your machine.
Convert Telephone Wall Outlets

Related Models: Dell E515dn / Dell E515dw

This feature is available only in the USA and Canada.

There are three ways to convert to an RJ11 jack. The first two ways may require assistance from the telephone company. You can change the wall outlets from one RJ14 jack to two RJ11 jacks. Or, you can have an RJ11 wall outlet installed and slave or jump one of the telephone numbers to it.

The third way is the easiest: Buy a triplex adapter. You can plug a triplex adapter into an RJ14 outlet. It separates the wires into two separate RJ11 jacks (Line 1, Line 2) and a third RJ14 jack (Lines 1 and 2). If your machine is on Line 1, plug the machine into L1 of the triplex adapter. If your machine is on Line 2, plug it into L2 of the triplex adapter.

Triplex adapter

Install Your Dell Machine, a External Two-Line TAD and Two-Line Telephone

Related Models: Dell E515dn / Dell E515dw

When you are installing an external two-line telephone answering device (TAD) and a two-line telephone, your machine must be isolated on one line at both the wall jack and at the TAD.

- This feature is available only in the USA and Canada.
- The most common connection is to place the machine on Line 2, which is explained in the following steps. The back of the two-line TAD must have two telephone jacks: one labeled L1 or L1/L2, and the other labeled L2. You will need at least three telephone line cords, the one that came with your machine and two for your external two-line TAD. You will need a fourth line cord if you add a two-line telephone.

1. Place the two-line TAD and the two-line telephone next to your machine.
2. Plug one end of the telephone line cord for your machine into the L2 jack of the triplex adapter. Plug the other end into the LINE jack of the machine.
3. Plug one end of the first telephone line cord for your TAD into the L1 jack of the triplex adapter. Plug the other end into the L1 or L1/L2 jack of the two-line TAD.
4. Plug one end of the second telephone line cord for your TAD into the L2 jack of the two-line TAD. Plug the other end into the EXT. jack of the machine.
a. Triplex Adapter
b. Two Line Telephone
c. External Two Line TAD
d. Machine

You can keep two-line telephones on other wall outlets as always. There are ways to add a two-line telephone to the machine's wall outlet. You can plug the telephone line cord from the two-line telephone into the L1+L2 jack of the triplex adapter. Or, you can plug the two-line telephone into the TEL jack of the two-line TAD.

**Additional Dialing Operations**

- **Dial Access Codes and Credit Card Numbers**

  Sometimes you may want to choose from several long-distance carriers when you send a fax. Rates may vary depending on the time and destination. To take advantage of low rates, you can store the access codes of long-distance carriers and credit card numbers as Address Book numbers.

**Dial Access Codes and Credit Card Numbers**

**Related Models:** Dell E515dn / Dell E515dw

Sometimes you may want to choose from several long-distance carriers when you send a fax. Rates may vary depending on the time and destination. To take advantage of low rates, you can store the access codes of long-distance carriers and credit card numbers as Address Book numbers.

You can store these long dialing sequences by dividing them and setting them up as separate Address Book numbers in any combination. You can even include manual dialing using the dial pad.

For example: You might have stored '555' and '7000' in your machine as shown in the following table.

<table>
<thead>
<tr>
<th>Applicable Models</th>
<th>'555' stored in</th>
<th>'7000' stored in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell E515dn/Dell E515dw</td>
<td>Quick Dial: 003</td>
<td>Quick Dial: 002</td>
</tr>
</tbody>
</table>

You can use them both to dial '555-7000' by following procedure.

1. Press (Fax).
2. Press ▲ twice, 003.
3. Press ▼ twice, 002 and Start.
   The machine will dial '555-7000'.

To temporarily change a number, you can substitute part of the number by pressing it using the dial pad. For
example, to change the number to '555-7001', you could enter the number (555) using Quick Dial 003, and then press 7001 using the dial pad.

NOTE: If you must wait for another dial tone or signal at any point in the dialing sequence, create a pause in the number by pressing Redial/Pause.

How to Store Numbers

• Store Numbers
• Set up Groups for Broadcasting
  A Group, which can be stored in the Address Book, One Touch Dial, or Speed Dial allows you to send the same fax message to many fax numbers.
• How to Enter Text on Your Dell Machine

Store Numbers

Related Models:Dell E515dn / Dell E515dw
Store fax and telephone numbers in the machine for quick dialing and broadcasting faxes to groups. When you dial a stored number, the LCD displays the number.

NOTE: If you lose electrical power, the Address Book numbers that are in the machine’s memory will not be lost.

Store One Touch Dial Numbers

Related Models:Dell E515dn / Dell E515dw
You can store eight One Touch Dial numbers on the four One Touch buttons. To access One Touch Dial Numbers 5 to 8, hold down Shift as you press the One Touch button.

1. Press (Fax).
2. Press the One Touch button where you want to store the number.
   If a number is not stored there, the LCD displays Register Now?.
3. Press 1 to select Yes.
4. Enter the telephone or fax number (up to 20 digits), and then press OK.
5. Do one of the following:
   • Enter the name using the dial pad (up to 15 characters), and then press OK.
   • To store the number without a name, press OK.

Change or Delete One Touch Dial Numbers

Related Models:Dell E515dn / Dell E515dw

1. Press Menu.
2. Press ▲ or ▼ to display the Fax option, and then press OK.
3. Press ▲ or ▼ to display the Address Book option, and then press OK.
4. Press ▲ or ▼ to display the One Touch Dial option, and then press OK.
5. Press the One Touch button you want to change or delete.
6. Do one of the following:
   • To change the stored name and number:
     a. Press 1.
     b. Edit the name and number: To edit the stored name or number, press ▲ or ▼ to move the cursor to the character you want to change, and then press Clear. Enter the correct character, and then press OK.
   • To delete the stored name and number:
     a. Press 2.
     b. Press 1 to confirm.
   • To exit without making a change, press Cancel.

7. Press Cancel.

### Store Speed Dial Numbers

Related Models: Dell E515dn / Dell E515dw

Use the Speed Dial numbers to store up to 200 numbers with a name.

1. Press (Fax).
2. Press ▲ twice and enter a three-digit Speed Dial code (001 - 200).
   If a number is not stored there, the LCD displays Register Now?.
3. Press 1 to select Yes.
4. Enter the telephone or fax number (up to 20 digits), and then press OK.
5. Do one of the following:
   • Enter the name using the dial pad (up to 15 characters), and then press OK.
   • To store the number without a name, press OK.

### Change or Delete Speed Dial Numbers

Related Models: Dell E515dn / Dell E515dw

You can change or delete Speed Dial Codes.

1. Press Menu.
2. Press ▲ or ▼ to display the Fax option, and then press OK.
3. Press ▲ or ▼ to display the Address Book option, and then press OK.
4. Press ▲ or ▼ to display the Speed Dial option, and then press OK.
5. Enter the Speed Dial code you want to change or delete, and then press OK.
6. Do one of the following:
   • To change the stored fax or telephone number and name:
     a. Press 1.
     b. Edit the number and name:
        To edit the stored number or name, press ▲ or ▼ to move the cursor to the character you want to change, and then press Clear.
Enter the correct character, and then press OK.

• To delete the stored fax or telephone number and name:
  a. Press 2.
  b. Press 1.
• To exit without making a change, press Cancel.

7. Press Cancel.

Set up Groups for Broadcasting

Related Models:Dell E515dn / Dell E515dw

A Group, which can be stored in the Address Book, One Touch Dial, or Speed Dial allows you to send the same fax message to many fax numbers.

First, you must store each fax number in Address Book. Then you can include them as numbers in the Group. Each Group uses up an Address Book, a One Touch Dial, or a Speed Dial number.

<table>
<thead>
<tr>
<th>Applicable Models</th>
<th>Maximum number of Group</th>
<th>Maximum numbers in a large Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell E515dn/Dell E515dw</td>
<td>20 groups</td>
<td>207 numbers</td>
</tr>
</tbody>
</table>

1. Press Menu.

2. Press ▲ or ▼ to display the Fax option, and then press OK.

3. Press ▲ or ▼ to display the Address Book option, and then press OK.

4. Press ▲ or ▼ to display the Setup Groups option, and then press OK.

5. Do one of the following:
   • To store a Group in a Speed Dial Location
     Press ▲ and then enter the three-digit Speed Dial location. and then press OK.
   • To store a Group in a One Touch Dial
     Press a One Touch button.

6. Use the dial pad to enter a Group number (01 to 20), and then press OK.

7. Add numbers to the Group:
   • To add Speed Dial Numbers
     Press ▲ and then enter the three-digit Speed Dial location.
   • To add One Touch Dial Numbers
     press the One Touch keys one after the other.
     The LCD will display selected Speed Dial numbers with a # and One Touch Dial numbers with a * (for example *006, #009).

8. Press OK, if you finish adding numbers.

9. Enter the Group name using the dial pad (up to 15 characters).

10. Press OK.

Change a Group Name

Related Models: Dell E515dn / Dell E515dw

1. Press **Menu**.

2. Press ▲ or ▼ to display the Fax option, and then press **OK**.

3. Press ▲ or ▼ to display the Address Book option, and then press **OK**.

4. Press ▲ or ▼ to display the Setup Groups option, and then press **OK**.

5. Do one of the following:
   - To change the Group name of a Group stored in a Speed Dial Location
     Press ▲ and then enter the three-digit Speed Dial location, and then press **OK**.
   - To change the Group name of a Group stored in a One Touch Dial
     Press a One Touch button.

6. Press 1 to change the stored Group information.

7. Press 2 if you do not need to change the numbers stored in the Group.

8. Press **OK**.

9. To edit the name, press ▼ or ▲ position the cursor under the character you want to change. Then press **Clear** to delete it, and enter the correct character using the dial pad.

   When you are finished editing, press **OK**.

10. Press **Cancel**.

Delete a Group

Related Models: Dell E515dn / Dell E515dw

1. Press **Menu**.

2. Press ▲ or ▼ to display the Fax option, and then press **OK**.

3. Press ▲ or ▼ to display the Address Book option, and then press **OK**.

4. Press ▲ or ▼ to display the Setup Groups option, and then press **OK**.

5. Do one of the following:
   - To delete a Group stored in a Speed Dial Location
     Press ▲ and then enter the three-digit Speed Dial location, and then press **OK**.
   - To delete a Group stored in a One Touch Dial
     Press a One Touch button.

6. Press 2 to delete the Group.

7. Press 1 to confirm.

8. Press **Cancel**.

Add or Delete Group Members

Related Models: Dell E515dn / Dell E515dw

1. Press **Menu**.
2. Press ▲ or ▼ to display the Fax option, and then press OK.
3. Press ▲ or ▼ to display the Address Book option, and then press OK.
4. Press ▲ or ▼ to display the Setup Groups option, and then press OK.
5. Do one of the following:
   • To change the numbers of a Group stored in a Speed Dial Location
     Press ▲ and then enter the three-digit Speed Dial location, and then press OK.
   • To change the numbers of a Group stored in a One Touch Dial
     Press a One Touch button.
6. Press 1 to change the numbers stored in the Group.
7. Add or delete One Touch or Speed Dial numbers
   • To add One Touch numbers
     Press ◄ or ► to position the cursor just after the last number.
     Then press the One Touch button of the number you want to add.
   • To add Speed Dial numbers
     Press ◄ or ► to position the cursor just after the last number.
     Then press ▲ and then enter the three-digit Speed Dial location of the number you want to add.
   • To delete One Touch or Speed Dial numbers, press ◄ or ► to position the cursor under the number you want
to delete, and then press Clear.
   When you are finished editing, press OK.
8. Press OK.

Telephone Services and External Devices

• Voice Mail
• Distinctive Ring
• Caller ID
  The Caller ID feature lets you use the Caller ID subscriber service offered by many local telephone companies.
  This service displays the telephone number, or name if it is available, of your caller as the line rings.
• External TAD (Telephone Answering Device)
• External and Extension Telephones

Voice Mail

Related Models:Dell E515dn / Dell E515dw
This feature is available only in the USA and Canada.
If you have Voice Mail on the same telephone line as your Dell machine, Voice Mail and the Dell machine will
conflict with each other when receiving incoming calls.
For example, if your Voice Mail is set to answer after four rings and your Dell machine is set to answer after two
rings, then your Dell machine will answer first. This will prevent callers from being able to leave a message in your
Voice Mail.
Similarly, if your Dell machine is set to answer after four rings and your Voice Mail is set to answer after two rings, then your Voice Mail will answer first. This will prevent your Dell machine from being able to receive an incoming fax, since Voice Mail cannot transfer the incoming fax back to the Dell machine.

To avoid conflicts between your Dell machine and your Voice Mail service, do one of the following:

- Get the Distinctive Ring service from your telephone company. Distinctive Ring is a feature of your Dell machine that allows a person with one line to receive fax and voice calls through two different telephone numbers on that one line.

  Dell uses the term 'Distinctive Ring,' but telephone companies market the service under a variety of names, such as Custom Ringing, Personalized Ring, Smart Ring, RingMaster, Ident-A-Ring, Ident-A-Call, Data Ident-A-Call, Teen Ring, and SimpleBiz Fax & Alternate Number Ringing. This service establishes a second telephone number on the same line as your existing telephone number, and each number has its own ring pattern. Typically, the original number rings with the standard ring pattern and is used for receiving voice calls, and the second number rings with a different ring pattern and is used for receiving faxes.

- Set your Dell machine’s Receive Mode to "Manual". Manual Mode requires you answer every incoming call if you want to be able to receive a fax. If the incoming call is a telephone call, then complete the call as you normally would. If you hear fax sending tones you must transfer the call to the Dell machine.

Unanswered fax and voice calls will go to your Voice Mail.

**Distinctive Ring**

Related Models:Dell E515dn / Dell E515dw

This feature is available only in the USA and Canada.

Distinctive Ring is a function of your Dell machine that allows a person with one line to receive fax and voice calls through two different phone numbers on that one line. Dell uses the term "Distinctive Ring," but telephone companies market the service under a variety of names, such as Smart Ring, Ring Master or Ident-a-Ring. This service establishes a second telephone number on the same line as your existing telephone number, and each number has its own ring pattern. Typically, the original number rings with the standard ring pattern and is used for receiving voice calls, and the second number rings with a different ring pattern and is used for receiving faxes.

**NOTE:** You must pay for your telephone company’s Distinctive Ring service before you program the machine to work with it.

**NOTE:** Contact your telephone company for availability and rates.

**What does your telephone company’s ‘Distinctive Ring’ do?**

Your telephone company’s Distinctive Ring service allows you to have more than one number on the same telephone line. **If you need more than one telephone number, it is cheaper than paying for an extra line.** Each telephone number has its own distinctive ring pattern, so you will know which telephone number is ringing. This is one way to have a separate telephone number for your machine.

**NOTE:** Contact your telephone company for availability and rates.

**What does Dell’s ‘Distinctive Ring’ do?**

The Dell machine has a Distinctive Ring feature that allows you to use your machine to take full advantage of the telephone company’s Distinctive Ring service. The new telephone number on your line can just receive faxes.

**NOTE:** You must pay for your telephone company’s Distinctive Ring service before you program the machine to work.
with it.

**Do you have Voice Mail?**

If you have Voice Mail on the telephone line that you will install your new machine on, there is a strong possibility that Voice Mail and the machine will conflict with each other while receiving incoming calls. **However, the Distinctive Ring feature allows you to use more than one number on your line, so both Voice Mail and the machine can work together without any problems.** If each one has a separate telephone number, neither will interfere with the other's operations.

If you decide to get the Distinctive Ring service from the telephone company, you must register the new Distinctive Ring pattern they give you. This is so your machine can recognize its incoming calls.

**NOTE:** You can change or cancel the Distinctive Ring pattern at any time. You can switch it off temporarily, and turn it back on later. When you get a new fax number, make sure you reset this feature.

**Before you choose the ring pattern to register**

You can only register one Distinctive Ring pattern with the machine. Some ring patterns cannot be registered. The ring patterns below are supported by your Dell machine. Register the one your telephone company gives you.

<table>
<thead>
<tr>
<th>Ring Pattern</th>
<th>Rings</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>short-short or long-long</td>
</tr>
<tr>
<td>2</td>
<td>short-long-short</td>
</tr>
<tr>
<td>3</td>
<td>short-short-long</td>
</tr>
<tr>
<td>4</td>
<td>very long (normal pattern)</td>
</tr>
</tbody>
</table>

**NOTE:** Ring Pattern #1 is often called Short-Short and is the most commonly used.

**NOTE:** If the ring pattern you received is not on this chart, contact your telephone company and ask for one that is shown.

- The machine will only answer calls to its registered number.
- The first two rings are silent on the machine. This is because the fax must <<listen>> to the ring pattern (to compare it to the pattern that was ‘registered’). (Other telephones on the same line will ring.)
- If you program the machine correctly, it will recognize the registered ring pattern of the ‘fax number’ within two ring patterns and then answer with a fax tone. When the ‘voice number’ is called, the machine will not answer.

**Register the Distinctive Ring Pattern**

**Related Models:** Dell E515dn / Dell E515dw

This feature is available only in the USA and Canada.

After you set the Distinctive Ring feature to **On**, your Distinctive Ring number will receive faxes automatically. The receive mode is automatically set to **Manual** and you cannot change it to another receive mode while Distinctive Ring is set to **On**. This ensures the Dell machine will only answer the Distinctive Ring number and not interfere when your main telephone number is called.

When Distinctive Ring is on, the LCD displays **D/R** as the Receive Mode.

1. Press **(Fax).**
2. Press Menu.
3. Press ▲ or ▼ to display the Fax option, and then press OK.
4. Press ▲ or ▼ to display the Miscellaneous option, and then press OK.
5. Press ▲ or ▼ to display the Distinctive option, and then press OK.
6. Press ▲ or ▼ to display the Set option, and then press OK.
7. Press ▲ or ▼ to display the prestore ring pattern you want to use, and then press OK.
   NOTE: You will hear each pattern as you scroll through the four patterns. Make sure you select the pattern that
   the telephone company gave you.
8. Press Cancel.

**Turn Off Distinctive Ring**

Related Models: Dell E515dn / Dell E515dw

This feature is available only in the USA and Canada.

1. Press (Fax).
2. Press Menu.
3. Press ▲ or ▼ to display the Fax option, and then press OK.
4. Press ▲ or ▼ to display the Miscellaneous option, and then press OK.
5. Press ▲ or ▼ to display the Distinctive option, and then press OK.
6. Press ▲ or ▼ to display the Off option, and then press OK.
7. Press Cancel.

If you turn off Distinctive Ring, the machine will stay in Manual Mode. You must set the Receive Mode again.

**Caller ID**

Related Models: Dell E515dn / Dell E515dw

The Caller ID feature lets you use the Caller ID subscriber service offered by many local telephone companies. This
service displays the telephone number, or name if it is available, of your caller as the line rings.
- The # Unavailable message means the call originated outside your Caller ID service area.
- The Private Call message means the caller has intentionally blocked transmission of Caller ID information.

Call your telephone company for more information.

Once you answer a call, the Caller ID information disappears from the LCD and is stored in Caller ID memory.
View the list or select a number and add it to the Address Book (the Speed Dial or One the Touch Dial in some
models), or delete it from the history.

You can print a list of the Caller ID information received by your machine.

**NOTE:** This feature is not available in some countries.

**NOTE:** This feature may not be available in certain areas of the USA and Canada.
NOTE: The Caller ID service varies with different carriers. Contact your local telephone company to learn about the service available in your area.

External TAD (Telephone Answering Device)

Related Models: Dell E515dn / Dell E515dw

You can connect an external Telephone Answering Device (TAD) to the same line as your machine. When the TAD answers a call, your machine will “listen” for the CNG (fax calling) tones sent by a sending fax machine. If it hears them it will take over the call and receive the fax. If it does not hear them, it will let your TAD take a voice message and the display will show Telephone.

The external TAD must answer within four rings (we recommend setting it to two rings). This is because your machine cannot hear the CNG tones until the external TAD has picked up the call. The sending machine will send CNG tones for only eight to ten seconds longer. We do not recommend using the toll saver feature on your external TAD if it needs more than four rings to activate it.

Unless you are using Distinctive Ring, the TAD must be connected to the EXT. jack of the machine.

- **If you subscribe to your telephone company’s Distinctive Ring service:**
  You may connect an external TAD to a separate wall jack only if you subscribe to your telephone company’s Distinctive Ring service, have registered the distinctive ring pattern on your machine, and use that number as a fax number. The recommended setting is at least four rings on the external TAD when you have the telephone company’s Distinctive Ring service. You cannot use the Toll Saver setting.

- **If You Do Not Subscribe to the Distinctive Ring Service:**
  You must plug your TAD into the EXT. jack of your machine. If your TAD is plugged into a wall jack, both your machine and the TAD will try to control the telephone line. (See the illustration.)
IMPORTANT

DO NOT connect a TAD elsewhere on the same telephone line.

NOTE: If you have problems receiving faxes, reduce the Ring Delay setting on your external TAD.

Connect an External TAD

Related Models: Dell E515dn / Dell E515dw

The external TAD must be plugged into the back of the machine, into the jack labeled EXT. Your machine cannot work correctly if you plug the TAD into a wall jack (unless you are using Distinctive Ring).

1. Plug the telephone line cord from the telephone wall jack into the back of the machine, in the jack labeled LINE.

2. Plug the telephone line cord from your external TAD into the back of the machine, in the jack labeled EXT.
   (Make sure this cord is connected to the TAD at the TAD’s telephone line jack, and not its handset jack.)

3. Set your external TAD to four rings or less. (The machine’s Ring Delay setting does not apply.)

4. Record the outgoing message on your external TAD.

5. Set the TAD to answer calls.

6. Set the Receive Mode on your machine to External TAD.

Record an Outgoing Message (OGM) on the External TAD

Related Models: Dell E515dn / Dell E515dw

1. Record 5 seconds of silence at the beginning of your message. This allows your machine time to listen for fax tones.

2. Limit your speaking to 20 seconds.

3. End your 20-second message by giving your Fax Receive Code for people sending manual faxes. For example: “After the beep, leave a message or press *51 and Start to send a fax.”

   NOTE: We recommend beginning your OGM with an initial 5 second silence because the machine cannot hear fax tones over a loud voice. You may try leaving out this pause, but if your machine has trouble receiving faxes, then you should re-record the OGM to include it.

Multi-line Connections (PBX)

Related Models: Dell E515dn / Dell E515dw

We suggest you ask the company who installed your PBX to connect your machine. If you have a multi line system we suggest you ask the installer to connect the unit to the last line on the system. This prevents the machine being activated each time the system receives telephone calls. If all incoming calls will be answered by a switchboard operator we recommend setting the Receive Mode to Manual.

We cannot guarantee that your machine will operate correctly under all circumstances when connected to a PBX. Any difficulties with sending or receiving faxes should be reported first to the company who handles your PBX.
External and Extension Telephones

- Connect an External or Extension Telephone
- Operation from External and Extension Telephones
- Use a Non-Dell Cordless External Handset
- Use the Remote Codes

Connect an External or Extension Telephone

Related Models: Dell E515dn / Dell E515dw

You can connect a separate telephone to your machine as shown in the diagram below.

Connect the telephone line cord to the jack labeled EXT.

Before you connect an external telephone, remove the protective cap (3) from the EXT. jack on the machine.

Operation from External and Extension Telephones

Related Models: Dell E515dn / Dell E515dw

Use extension telephones

If you answer a fax call at an extension telephone, you can make your machine receive the fax by pressing the Fax Receive Code *51.

If the machine answers a voice call and pseudo/double-rings for you to take over, you can take the call at an extension telephone by pressing the Telephone Answer Code #51.

Use an external telephone (Connected to the EXT. jack of the machine)

If you answer a fax call at the external telephone connected to the EXT. jack of the machine, you can make the machine receive the fax by pressing Start, and selecting 2.

If the machine answers a voice call and pseudo/double-rings for you to take over, you can take the call at the external telephone by pressing Hook.
If you answer a call and no one is on the line:
You should assume that you’re receiving a manual fax.
Press *51 and wait for the chirp or until the LCD displays Receiving, and then hang up.

NOTE: You can also use the Easy Receive feature to make your machine automatically take the call.

Use a Non-Dell Cordless External Handset
Related Models: Dell E515dn / Dell E515dw

If your non-Dell cordless telephone is connected to the EXT. jack of the machine and you typically carry the cordless handset elsewhere, it is easier to answer calls during the Ring Delay.
If you let the machine answer first, you must go to the machine so you can press Hook or Hook to transfer the call to the cordless handset.

Use the Remote Codes
Related Models: Dell E515dn / Dell E515dw

Fax Receive Code
If you answer a fax call on an extension telephone, you can tell your machine to receive it by pressing the Fax Receive Code *51. Wait for the chirping sounds then replace the handset.
If you answer a fax call at the external telephone, you can make the machine receive it by pressing the buttons in the following table.

<table>
<thead>
<tr>
<th>Applicable Models</th>
<th>To make the machine receive the fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell E515dn/Dell E515dw</td>
<td>Start and then 2</td>
</tr>
</tbody>
</table>

Telephone Answer Code
If you receive a voice call and the machine is in F/T mode, it will start to sound the F/T ring (pseudo/double-ring) after the initial ring delay. If you pick up the call on an extension telephone you can turn the F/T ring off by pressing #51 (make sure you press this between the rings).
If the machine answers a voice call and pseudo/double-rings for you to take over, you can take the call at the external telephone by pressing the button in the following table.

<table>
<thead>
<tr>
<th>Applicable Models</th>
<th>To make the machine receive the fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell E515dn/Dell E515dw</td>
<td>Hook</td>
</tr>
</tbody>
</table>

Change the Remote Codes
Related Models: Dell E515dn / Dell E515dw

The preset Fax Receive Code is *51. The preset Telephone Answer Code is #51. If you are always disconnected when accessing your External TAD remotely, try changing the three-digit remote codes, for example ### and 999.

1. Press (Fax).
2. Press Menu.
3. Press ▲ or ▼ to display the Fax option, and then press OK.
4. Press ▲ or ▼ to display the Setup Receive option, and then press OK.
5. Press ▲ or ▼ to display the Remote Codes option, and then press OK.

6. Press ▲ or ▼ to display the On option, and then press OK.
   **NOTE:** To turn off Remote Codes, select the Off option.

7. Enter the new Fax Receive Code, and then press OK.

8. Enter the new Telephone Answer Code, and then press OK.


**Fax Reports**

The Transmission Verification Report and the Fax Journal are available to confirm the results of fax transmission.

- Print a Transmission Verification Report
  
  You can use the Transmission Verification Report as proof that you sent a fax. This report lists the receiving party's name or fax number, the time and date of transmission, duration of transmission, number of pages sent, and whether or not the transmission was successful.

- Print a Fax Journal
  
  You can set the machine to print a journal at specific intervals (every 50 faxes, 6, 12 or 24 hours, 2 or 7 days).

**Print a Transmission Verification Report**

Related Models:Dell E515dn / Dell E515dw

You can use the Transmission Verification Report as proof that you sent a fax. This report lists the receiving party's name or fax number, the time and date of transmission, duration of transmission, number of pages sent, and whether or not the transmission was successful.

There are several settings available for the Transmission Verification Report:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Prints a report after every fax you send.</td>
</tr>
<tr>
<td>On+Image</td>
<td>Prints a report after every fax you send.</td>
</tr>
<tr>
<td></td>
<td>A portion of the fax's first page appears on the report.</td>
</tr>
<tr>
<td>Off</td>
<td>Prints a report if your fax is unsuccessful due to a transmission error.</td>
</tr>
<tr>
<td></td>
<td>Off is the factory setting.</td>
</tr>
<tr>
<td>Off+Image</td>
<td>Prints a report if your fax is unsuccessful due to a transmission error.</td>
</tr>
<tr>
<td></td>
<td>A portion of the fax's first page appears on the report.</td>
</tr>
<tr>
<td>No Report</td>
<td>Your Dell machine does not print any reports after sending faxes.</td>
</tr>
</tbody>
</table>

1. Press Menu.

2. Press ▲ or ▼ to display the Fax option, and then press OK.

3. Press ▲ or ▼ to display the Report Setting option, and then press OK.

4. Press ▲ or ▼ to display the Transmission option, and then press OK.

5. Press ▲ or ▼ to display the On, On+Image, Off, Off+Image, or No Report option, and press OK.
6. Press Cancel.

Print a Fax Journal

Related Models:Dell E515dn / Dell E515dw
You can set the machine to print a journal at specific intervals (every 50 faxes, 6, 12 or 24 hours, 2 or 7 days).

1. Press Menu.
2. Press ▲ or ▼ to display the Fax option, and then press OK.
3. Press ▲ or ▼ to display the Report Setting option, and then press OK.
4. Press ▲ or ▼ to display the Journal Period option, and then press OK.
5. Press ▲ or ▼ to display the Every 50 Faxes, Every 6 Hours, Every 12 Hours, Every 24 Hours, Every 2 Days, Every 7 Days, or Off option, and then press OK.
   - 6, 12, 24 hours, 2 or 7 days
     The machine will print the report at the selected time and then erase all jobs from its memory. If the machine's memory becomes full with 200 jobs before the time you selected has passed, the machine will print the Journal early and then erase all jobs from the memory. If you want an extra report before it is due to print, you can print it without erasing the jobs from the memory.
   - Every 50 Faxes
     The machine will print the Journal when the machine has stored 50 jobs.

6. If you chose Every 7 Days, Press ▲ or ▼ to display the Every Monday, Every Tuesday, Every Wednesday, Every Thursday, Every Friday, Every Saturday or Every Sunday option, and then press OK.

7. If you selected 6, 12, 24 hours, 2 or 7 days, do one of the following to enter the time to start printing:
   - If you selected 12h Clock in the Date&Time setting, enter the time in 12-hour format, and then press OK.
     Press ▲ or ▼ to display the AM or PM option, and then press OK.
   - If you selected 24h Clock in the Date&Time setting, enter the time in 24-hour format, and then press OK.
     (For example, enter 19:45 for 7:45 PM.)

8. Press Cancel.

PC-FAX

- PC-FAX for Windows®
- PC-FAX for Macintosh

PC-FAX for Windows®

- PC-FAX Overview (Windows®)
  Reduce paper consumption and save time by using Dell's PC-FAX software to send faxes directly from your machine.
PC-FAX Overview (Windows®)

Reduce paper consumption and save time by using Dell’s PC-FAX software to send faxes directly from your machine.

• Configure PC-FAX (Windows®)
  Before sending faxes using PC-FAX, personalize the send options in each tab of the PC-FAX Setup dialog box.
• Configure your PC-Fax Address Book (Windows®)
  Add, edit and delete members and groups to personalize your Dell Address Book.
• Send a Fax Using PC-FAX (Windows®)
• Change the Port Used for PC-FAX Send (Windows®)
  You can change the printer port that is used when you send a fax using PC-FAX.

Configure PC-FAX (Windows®)

Before sending faxes using PC-FAX, personalize the send options in each tab of the PC-FAX Setup dialog box.

1. Select the print command in your application.
2. Select Dell PC-FAX as your printer, and then complete your print operation.
   The Dell PC-FAX dialog box appears.
3. Click \r
   The PC-FAX Setup dialog box appears.
4. Do one of the following:
   • Click the User Information tab, and then type your user information in the fields.
   NOTE: Each Microsoft® account can have its own customized User Information screen for custom fax headers and cover pages.
   • Click the Sending tab, and then type the number needed to access an outside line (if needed) in the Outside line access field. Select the Include header check box to include the header information.
   • Click the Address Book tab, and then select the address book you want to use for PC-FAX from the Select Address Book drop-down list.
5. Click OK.

Configure your PC-Fax Address Book (Windows®)

Add, edit and delete members and groups to personalize your Dell Address Book.

• Add a Member to the Address Book (Windows®)
  Add new people and their fax information to the PC-Fax Address Book if you want to send a fax using Dell PC-Fax software.
• Create a Group in the Address Book (Windows®)
  Create a group to broadcast the same PC-FAX to several recipients at one time.
• Edit Member or Group Information (Windows®)
• Delete a Member or Group (Windows®)
• Export the Address Book (Windows®)
  You can export the Address Book as an ASCII text file (*.csv), a vCard (an electronic business card), or Remote
Setup Dial Data and save it on your computer.

• Import Information to the Address Book (Windows®)
  You can import ASCII text files (*.csv), vCards (electronic business cards), or Remote Setup Dial Data into your Address Book.

Add a Member to the Address Book (Windows®)

Related Models:Dell E515dn / Dell E515dw
Add new people and their fax information to the PC-Fax Address Book if you want to send a fax using Dell PC-Fax software.

1. Do one of the following:
   • (Windows Vista® and Windows® 7)
     Click (Start) > All Programs > Dell Printers.
     Click your model name. Click Address Book.
   • (Windows® 8)
     Click Dell Printers, and then click your model name. Click Address Book.
     The Address Book dialog box appears.

2. Click .
   The Address Book Member Setup dialog box appears.
3. Type the member's information in the corresponding fields. Only the Name field is required.

4. Click OK.

Create a Group in the Address Book (Windows®)

Related Models:Dell E515dn / Dell E515dw

Create a group to broadcast the same PC-FAX to several recipients at one time.

1. Do one of the following:
   • (Windows Vista® and Windows® 7)
     Click (Start) > All Programs > Dell Printers.
     Click your model name. Click Address Book.
   • (Windows® 8)
     Click Dell Printers, and then click your model name. Click Address Book.

The Address Book dialog box appears.
2. Click 

The Address Book Group Setup dialog box appears.

3. Type the name of the new group in the Group Name field.

4. In the Available Names field, select each name you want to include in the group, and then click Add >.

Members added to the group appear in the Group Members box.

5. When finished, click OK.

NOTE: Each group can contain up to 50 members.
Edit Member or Group Information (Windows®)

Related Models:Dell E515dn / Dell E515dw

1. Do one of the following:
   • (Windows Vista® and Windows® 7)
     Click (Start) > All Programs > Dell Printers.
     Click your model name. Click Address Book.
   • (Windows® 8)
     Click Dell Printers, and then click your model name. Click Address Book.

The Address Book dialog box appears.

2. Select the member or group you want to edit.

3. Click (Properties).

4. Change the member or group information.

5. Click OK.

Delete a Member or Group (Windows®)

Related Models:Dell E515dn / Dell E515dw

1. Do one of the following:
   • (Windows Vista® and Windows® 7)
     Click (Start) > All Programs > Dell Printers.
     Click your model name. Click Address Book.
   • (Windows® 8)
     Click Dell Printers, and then click your model name. Click Address Book.

The Address Book dialog box appears.
2. Select the member or group you want to delete.

3. Click (Delete).

4. When the confirmation dialog box appears, click OK.

Export the Address Book (Windows®)

Related Models: Dell E515dn / Dell E515dw
You can export the Address Book as an ASCII text file (*.csv), a vCard (an electronic business card), or Remote Setup Dial Data and save it on your computer.

- You cannot export the group settings when you export the Address Book data.

1. Do one of the following:
   - (Windows Vista® and Windows® 7)
     Click (Start) > All Programs > Dell Printers.
     Click your model name. Click Address Book.
   - (Windows® 8)
     Click Dell Printers, and then click your model name. Click Address Book.
     The Address Book dialog box appears.
2. Click the **File** menu, and then select **Export**.

3. Select one of the following:
   - **Text**
     - The **Select Items** dialog box appears. Go to step 4.
   - **vCard**
     - You must select the member you want to export from your address book before selecting this option.
     - Browse to the folder where you want to save the vCard, type the vCard name in the **File name** field, and then click **Save**.
   - **Remote Setup Dial Data**
     - Browse to the folder where you want to save the data, type the file name in the **File name** field, and then click **Save**.

4. In the **Available Items** field, select the data you want to export, and then click **Add >>**.
NOTE: Select and add the items in the order you want them listed.

5. If you are exporting to an ASCII file, under the Divide Character section, select the Tab or Comma option to separate the data fields.

6. Click OK.

7. Browse to the folder on your computer where you want to save the data, type the file name, and then click Save.

Import Information to the Address Book (Windows®)

Related Models: Dell E515dn / Dell E515dw

You can import ASCII text files (*.csv), vCards (electronic business cards), or Remote Setup Dial Data into your Address Book.

1. Do one of the following:
   • (Windows Vista® and Windows® 7)
     Click (Start) > All Programs > Dell Printers.
     Click your model name. Click Address Book.
   • (Windows® 8)
     Click Dell Printers, and then click your model name. Click Address Book.

The Address Book dialog box appears.
2. Click the File menu, and then select Import.

3. Select one of the following:
   - Text
     The Select Items dialog box appears. Go to step 4.
   - vCard
     Go to step 7.
   - Remote Setup Dial Data
     Go to step 7.

4. In the Available Items field, select the data you want to import, and then click Add >>.

NOTE: You must select and add fields from the Available Items list in the same order they are listed in the import
5. If you are importing an ASCII file, under the Divide Character section, select the Tab or Comma option to separate the data fields.

6. Click OK.

7. Browse to the folder where you want to import the data, type the file name, and then click Open.

---

**Send a Fax Using PC-FAX (Windows®)**

Related Models:Dell E515dn / Dell E515dw

PC-FAX supports only black and white faxes. A black and white fax will be sent even if the original data is color and the receiving fax machine supports color faxes.

1. Create a file in any application on your computer.
2. Select the print command in your application.
3. Select Dell PC-FAX as your printer, and then complete your print operation.
   The Dell PC-FAX dialog box appears.
4. Type a fax number using one of the following methods:
   • Click the numbers on the dial pad to type the number, and then click .
   
   **NOTE:** If you select the Dial Restriction check box, a confirmation dialog box will appear for you to re-type the fax number using the dial pad. This feature helps to prevent transmissions to the wrong destination.
   • Click the Address Book button, and then select a member or group from the Address Book.
   
   **NOTE:** If you make a mistake, click All Clear to delete all entries.
5. To include a cover page, select the Add Cover Page check box. You can also click to create or edit a cover page.
6. Click **Start** to send the fax.
   
   **NOTE:** To cancel the fax, click **Cancel**.

   **NOTE:** To redial a number, click **Redial** to scroll through the last five fax numbers, select a number, and then click **Start**.

**Cover Page Settings (Windows®)**

Related Models:Dell E515dn / Dell E515dw

**NOTE:** If you send a fax to more than one recipient, the recipients' information will not be printed on the cover page.

**To**
Select the check boxes to indicate which recipient information you want to add to the cover page.

**From**
Select the check boxes to indicate which sender information you want to add to the cover page.
Sender information will be entered automatically based on the **User Information** tab.

**Comment**
Type a comment to add to the cover page (not required).

**Form**
Click the **Layout** drop-down list to select a cover page format.

- **Cover page title**
  Select one of the options.
  If you select the **Custom** option, you can include a bitmap file, such as your company logo, on the cover page.
  Click **Browse** to select a BMP file, and then choose the alignment.

- **Count cover page**
  Select the **Count cover page** check box if you want to include the cover page in the total page count.

**Change the Port Used for PC-FAX Send (Windows®)**

Related Models:Dell E515dn / Dell E515dw
You can change the printer port that is used when you send a fax using PC-FAX.

1. Do one of the following:
   - (Windows Vista®)
     Click **(Start) > Control Panel > Hardware and Sound > Printers**
   - (Windows® 7)
     Click **(Start) > Devices and Printers > Printers and Faxes**
   - (Windows® 8)
     Move your mouse to the lower right corner of your desktop. When the menu bar appears, click **Settings > Control Panel**. In the **Hardware and Sound** group, click **View devices and printers > Printers**

2. Do one of the following:
   - (Windows Vista®)
     Right-click **Dell PC-FAX** and select **Properties**.
   - (Windows® 7 and Windows® 8)
Right-click Dell PC-FAX and select Printer properties.

3. Click the Ports tab and then select using the port.
4. Click OK.

PC-FAX for Macintosh

• PC-FAX Overview (Macintosh)
  Use Dell's PC-FAX software to send faxes directly from your Macintosh without printing them. This feature helps reduce your paper consumption and save time.
• Send Faxes from Your Application (Macintosh)

PC-FAX Overview (Macintosh)
Use Dell's PC-FAX software to send faxes directly from your Macintosh without printing them. This feature helps reduce your paper consumption and save time.

Send Faxes from Your Application (Macintosh)
Related Models:Dell E515dn / Dell E515dw
1. Create a document in a Macintosh application.
2. From an application, such as Apple TextEdit, click the File menu, and then select Print.
3. Click the application pop-up menu, and then select the Send Fax option.
4. Click the Output pop-up menu, and then select the Facsimile option.
5. Type a fax number in the **Input Fax Number** field, and then click **Add**. The fax number is displayed in the **Destination Fax Numbers** field.

**NOTE:** To send a fax to more than one number, click the **Add** button after entering the first fax number and type the next fax number. The destination fax numbers will be listed in the **Destination Fax Numbers** field.

6. Click **Print** to send the fax.
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Started</td>
<td>191</td>
</tr>
<tr>
<td>Select Your Network Connection Type</td>
<td>192</td>
</tr>
<tr>
<td>Learn to Use Network Management Utilities</td>
<td>195</td>
</tr>
<tr>
<td>Locate the Machine’s Network Settings</td>
<td>197</td>
</tr>
<tr>
<td>Additional Methods of Configuring Your Dell Machine for a Wireless Network</td>
<td>198</td>
</tr>
<tr>
<td>Advanced Network Features</td>
<td>214</td>
</tr>
<tr>
<td>Technical Information for Advanced Users</td>
<td>217</td>
</tr>
<tr>
<td>Network Menu on the Dell Control Panel</td>
<td>227</td>
</tr>
</tbody>
</table>
Network

• Get Started
  We recommend setting up and connecting to your network using the Dell installation CD-ROM. This guide provides more information on network connection types, introduces various methods to manage your network and explains some useful network features of your Dell machine.

• Select Your Network Connection Type
  You must identify your network connection type: wired network connection or wireless network connection.

• Learn to Use Network Management Utilities
  Configure and change your Dell machine’s network settings using a management utility.

• Locate the Machine’s Network Settings
  You can change your machine's network settings (IP address, subnet mask, gateway and others) using the control panel or Web Based Management.

• Additional Methods of Configuring Your Dell Machine for a Wireless Network
  To connect your machine to your wireless network, we recommend using the Installer CD-ROM.

• Advanced Network Features

• Technical Information for Advanced Users

• Network Menu on the Dell Control Panel
  The control panel’s Network menu selections allow you to configure the Dell machine for your network.

Get Started

We recommend setting up and connecting to your network using the Dell installation CD-ROM. This guide provides more information on network connection types, introduces various methods to manage your network and explains some useful network features of your Dell machine.

• Supported Basic Network Features
  The print server supports various features depending on the operating system. Use this chart to see what network features and connections are supported by each operating system.

Supported Basic Network Features

The print server supports various features depending on the operating system. Use this chart to see what network features and connections are supported by each operating system.

| Operating Systems | Windows Vista®
| | Windows® 7
| | Windows® 8
| | Windows Server®
| | 2003/2008/2012/2012 R2
| | OS X v10.8.x
| | OS X v10.9.x
| | OS X v10.10.x
| Printing | Yes | Yes | Yes
| Scanning | Yes | Yes | Yes
| PC Fax Send | Yes | | Yes
| Web Based Management | Yes | Yes | Yes
| Status Monitor | | | Yes
| Vertical Pairing (Windows® 7 and Windows® 8 only) | Yes
| Dell Printer Hub (Windows® 7 and Windows® 8 only) | Yes
Select Your Network Connection Type

You must identify your network connection type: wired network connection or wireless network connection.

- Wired Network Connection Examples
  Identify your wired network connection type: Peer-to-Peer or Network Shared environment.

- Wireless Network Connection Examples
  Identify your wireless network connection type: Infrastructure mode, Ad-Hoc mode, or Wi-Fi Direct® mode.

Wired Network Connection Examples

Identify your wired network connection type: Peer-to-Peer or Network Shared environment.

- Peer-to-Peer Printing Using TCP/IP
  In a Peer-to-Peer environment, each computer sends and receives data directly to and from each device. There is no central server controlling file access or printer sharing.

- Network Shared Printing
  In a Network Shared environment, each computer sends data via a centrally controlled computer. This type of computer is often called a "Server" or a "Print Server". Its job is to control all print jobs.

Peer-to-Peer Printing Using TCP/IP

In a Peer-to-Peer environment, each computer sends and receives data directly to and from each device. There is no central server controlling file access or printer sharing.

1. Router
2. Network Machine (your machine)

NOTE: In a smaller network of two or three computers, we recommend the Peer-to-Peer printing method, as it is easier to configure than the Network Shared printing method.

NOTE: Each computer must use the TCP/IP protocol.

NOTE: The Dell machine needs an appropriate IP address configuration.

NOTE: If you are using a router, the Gateway address must be configured on the computers and the Dell machine.
Network Shared Printing

In a Network Shared environment, each computer sends data via a centrally controlled computer. This type of computer is often called a "Server" or a "Print Server". Its job is to control all print jobs.

1. Client Computer
2. Centrally controlled computer, also known as the "Server" or "Print Server"
3. Ethernet Cable or USB
4. Network Machine (your machine)

**NOTE:** In a larger network, we recommend a Network Shared Printing environment.

**NOTE:** The "Server" or the "Print Server" must use the TCP/IP protocol.

**NOTE:** The Dell machine needs to have an appropriate IP address configuration, unless it is connected via the USB interface at the server.

Wireless Network Connection Examples

Identify your wireless network connection type: Infrastructure mode, Ad-Hoc mode, or Wi-Fi Direct® mode.

- **Connected to a Computer with a Wireless LAN Access Point Router in the Network (Infrastructure Mode)**
  
  This type of network has a wireless LAN central access point/router at the heart of the network. The access point can also act as a bridge or a gateway to a wired network. When the Dell wireless machine (your machine) is part of this network, it receives all print jobs via an access point.

- **Connected to a Wireless Computer without a Wireless LAN Access Point Router in the Network (Ad-Hoc Mode)**
  
  This type of network does not have a central wireless LAN access point/router. Each wireless client communicates directly with each other. When the Dell wireless machine (your machine) is part of this network, it receives all print jobs directly from the computer sending print data.

- **Wi-Fi Direct**
Connected to a Computer with a Wireless LAN Access Point Router in the Network (Infrastructure Mode)

Related Models: Dell E514dw / Dell E515dw
This type of network has a wireless LAN central access point/router at the heart of the network. The access point can also act as a bridge or a gateway to a wired network. When the Dell wireless machine (your machine) is part of this network, it receives all print jobs via an access point.

1. Wireless LAN Access Point/Router
2. Wireless Network Machine (your machine)
4. Wired Computer Connected to the Wireless LAN Access Point/Router with a Network Cable

Configuration Method
Select one of these methods for configuring your Dell machine in a wireless network environment.
- Wireless Configuration Using the Setup Wizard from the Computer (Recommended)
- Wireless Configuration Using the Setup Wizard from the Control Panel
- One-Push Wireless Configuration Using WPS or AOSS™
- PIN Method Wireless Configuration Using WPS

Connected to a Wireless Computer without a Wireless LAN Access Point Router in the Network (Ad-Hoc Mode)

Related Models: Dell E514dw / Dell E515dw
This type of network does not have a central wireless LAN access point/router. Each wireless client communicates directly with each other. When the Dell wireless machine (your machine) is part of this network, it receives all print jobs directly from the computer sending print data.
Learn to Use Network Management Utilities

Configure and change your Dell machine's network settings using a management utility.

- Web Based Management

Learn about Network Management Utilities

- What is Web Based Management?

What is Web Based Management?

Web Based Management is a utility that uses a standard web browser to manage your machine using the Hyper Text Transfer Protocol (HTTP). Type your machine's IP address into your web browser to access and change your print server settings.

**NOTE:** We recommend Microsoft® Internet Explorer® 8.0/9.0/10.0 for Windows® and Safari 5.0/6.0 for Macintosh. Make sure that JavaScript and Cookies are always enabled in whichever browser you use. If a different web browser is used, make sure it is compatible with HTTP 1.0 and HTTP 1.1.

**NOTE:** You must use the TCP/IP protocol on your network and have a valid IP address programmed into the print server and your computer.

Access Network Management Software and Utilities

Before using your Dell machine in a network environment, you must install the Dell software and configure the appropriate TCP/IP network settings on the machine itself.

If you do not want to or are unable to use the Dell installer, see Related Information.

Access Web Based Management

1. Start your web browser.
2. Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the machine's IP address).
   For example: http://192.168.1.2

   **NOTE:** If you are using a Domain Name System or enable a NetBIOS name, you can type another name, such as "SharedPrinter" instead of the IP address.
   • For example:
     http://SharedPrinter
   If you enable a NetBIOS name, you can also use the node name.
   • For example:
     http://DELL000499
   The NetBIOS name can be found in the Network Configuration Report.

   **NOTE:** For Macintosh, access Web Based Management by clicking the machine's icon on the **Status Monitor** screen.

3. No password is required by default. Type a password if you have set one, and then click . You can now change the print server settings.
   If you have changed the protocol settings, you must restart the machine after clicking **Submit** to activate the configuration.

**Set a Logon Password for Web Based Management**

We recommend setting a logon password to prevent unauthorized access to Web Based Management.

1. Start your web browser.

2. Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the machine's IP address).
   For example: http://192.168.1.2

   **NOTE:** If you are using a Domain Name System or enable a NetBIOS name, you can type another name, such as "SharedPrinter" instead of the IP address.
   • For example:
     http://SharedPrinter
   If you enable a NetBIOS name, you can also use the node name.
   • For example:
     http://DELL000499
   The NetBIOS name can be found in the Network Configuration Report.

   **NOTE:** For Macintosh, access Web Based Management by clicking the machine's icon on the **Status Monitor** screen.

3. No password is required by default. Type a password if you have set one, and then click .

4. Click **Administrator**.

5. Type the password you want to use (up to 32 characters).

6. Retype the password in the **Confirm New Password** box.
7. Click Submit.

In the future, every time you access Web Based Management, type the password in the Login box, and then click .

After configuring the settings, log off by clicking .

NOTE: If you are not setting a logon password, you can also set a password by clicking the Please configure the password button on the machine's web page.

Locate the Machine's Network Settings

You can change your machine's network settings (IP address, subnet mask, gateway and others) using the control panel or Web Based Management.

- Locate Network Settings When Using the Dell Control Panel
- Locate Network Settings When Using Web Based Management

Locate Network Settings When Using the Dell Control Panel

1. Press Menu.
2. Press ▲ or ▼ to select the Network option, and then press OK.
3. Proceed to the menu selections you want to configure.

Locate Network Settings When Using Web Based Management

1. Start your web browser.
2. Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the machine's IP address).
   For example: http://192.168.1.2

   NOTE: If you are using a Domain Name System or enable a NetBIOS name, you can type another name, such as "SharedPrinter" instead of the IP address.
   - For example:
     http://SharedPrinter
   If you enable a NetBIOS name, you can also use the node name.
   - For example:
     http://DELL000499
   The NetBIOS name can be found in the Network Configuration Report.

   NOTE: For Macintosh, access Web Based Management by clicking the machine's icon on the Status Monitor screen.
3. No password is required by default. Type a password if you have set one, and then click .

   You can change the network settings.
   If you change the protocol settings, restart the machine after clicking Submit to activate the configuration.
Additional Methods of Configuring Your Dell Machine for a Wireless Network

To connect your machine to your wireless network, we recommend using the Installer CD-ROM.

• Before Configuring Your Dell Machine for a Wireless Network
• Configure Your Machine for a Wireless Network Using the One Push Method of Wi-Fi Protected Setup™ (WPS) or AOSS™
• Configure Your Machine for a Wireless Network Using the PIN Method of Wi-Fi Protected Setup™ (WPS)
  If your wireless LAN access point/router supports WPS, you can use the Personal Identification Number (PIN) Method to configure your wireless network settings.
• Configure Your Machine for a Wireless Network in Ad-Hoc Mode (For IEEE 802.11b/g/n)
• Configure Your Machine for a Wireless Network Using the Machine's Control Panel Setup Wizard
• Configure Your Machine for a Wireless Network When the SSID Is Not Broadcast
• Use Wi-Fi Direct®

Before Configuring Your Dell Machine for a Wireless Network

Related Models:Dell E514dw / Dell E515dw

Before attempting to configure a wireless network, confirm the following:

• To achieve optimum results with normal everyday document printing, place the Dell machine as close to the wireless LAN access point/router as possible with minimal obstructions. Large objects and walls between the two devices and interference from other electronic devices can affect the data transfer speed of your documents.
  Due to these factors, wireless may not be the best method of connection for all types of documents and applications. If you are printing large files, such as multi-page documents with mixed text and large graphics, you may want to consider selecting wired Ethernet for faster data transfer, or USB for the fastest throughput speed.
• Although the Dell machine can be used in both a wired and wireless network, only one connection method can be used at a time. However, a wireless network connection and Wi-Fi Direct connection, or a wired network connection (supported models only) and Wi-Fi Direct connection can be used at the same time.
• Before configuring wireless settings, you must know your Network name (SSID) and Network Key.

Configure Your Machine for a Wireless Network Using the One Push Method of Wi-Fi Protected Setup™ (WPS) or AOSS™

Related Models:Dell E514dw / Dell E515dw

If your wireless access point/router supports either WPS (Push Button Configuration) or AOSS™, you can use WPS or AOSS™ from your machine’s control panel menu to configure your wireless network settings.
How to Configure Your Wireless Network Using the One Push Method of WPS or AOSS™

Related Models:Dell E514dw / Dell E515dw

1. Press Menu.
2. Press ▲ or ▼ to select the Network option, and then press OK.
3. Press ▲ or ▼ to select the WLAN option, and then press OK.
4. Press ▲ or ▼ to select the WPS/AOSS option, and then press OK.
5. When WLAN Enable ? appears, enable the wireless network.
   This will start the wireless setup wizard.
6. When the LCD shows Start WPS/AOSS on your wireless access point/router., press the WPS or AOSS™ button on your wireless access point/router. Then press OK and your machine will now automatically detect which mode (WPS or AOSS™) your wireless access point/router uses and try to connect to your wireless network.

If your wireless device is connected successfully, the machine's LCD displays Connected. The machine will print your machine's wireless status report. If the connection fails, check the error code on the printed report.

   NOTE: If the connection fails, your machine reverts to a wired network interface.

For Windows®:
You have completed the wireless network setup. Install drivers and software necessary for operating your device from the Installer CD-ROM.
For Macintosh:
You have completed the wireless network setup. Install drivers and software necessary from "StartHereOS X.app" in the installation CD-ROM.

**Configure Your Machine for a Wireless Network Using the PIN Method of Wi-Fi Protected Setup™ (WPS)**

Related Models:Dell E514dw / Dell E515dw
If your wireless LAN access point/router supports WPS, you can use the Personal Identification Number (PIN) Method to configure your wireless network settings.
The PIN Method is one of the connection methods developed by the Wi-Fi Alliance®. By submitting a PIN created by an Enrollee (your machine) to the Registrar (a device that manages the wireless LAN), you can set up the wireless network and security settings. For more information on how to access WPS mode, see the instructions provided with your wireless access point/router.

**Two Wireless Network Connection Types Using the PIN Method of Wi-Fi Protected Setup™ (WPS)**

Related Models:Dell E514dw / Dell E515dw

**Type A**
Connection when the wireless LAN access point/router (1) doubles as Registrar.
Type B
Connection when another device (2), such as a computer, is used as Registrar.

NOTE: Routers or access points that support WPS are marked with this symbol:

How to Configure Your Wireless Network Using the PIN Method of Wi-Fi Protected Setup™ (WPS)

Related Models:Dell E514dw / Dell E515dw

1. Press Menu.
2. Press ▲ or ▼ to select the Network option, and then press OK.
3. Press ▲ or ▼ to select the WLAN option, and then press OK.
4. Press ▲ or ▼ to select the WPS w/PIN Code option, and then press OK.
5. When WLAN Enable ? appears, enable the wireless network.
   This will start the wireless setup wizard.
6. The LCD displays an eight-digit PIN and the machine starts searching for a wireless LAN access point/router.
7. Using a computer that is on the network, type "http://access point’s IP address" in your browser (where "access point’s IP address" is the IP address of the device that is used as the Registrar).
8. Go to the WPS setting page and type the PIN, and then follow the on-screen instructions.
NOTE: The Registrar is usually the wireless LAN access point/router.

NOTE: The setting page will differ depending on the brand of wireless LAN access point/router. For more information, see the instructions supplied with your wireless LAN access point/router.

If you are using a Windows Vista®, Windows® 7, or Windows® 8 computer as a Registrar, complete the following steps:

9. Do one of the following:
   • (Windows Vista®)
     Click (Start) > Network > Add a wireless device.
   • (Windows® 7)
     Click (Start) > Devices and Printers > Add a device.
   • (Windows® 8)
     Move your mouse to the lower right corner of your desktop. When the menu bar appears, click Settings > Control Panel > Hardware and Sound > Devices and Printers > Add a device.

NOTE: To use a Windows Vista®, Windows® 7, or Windows® 8 computer as a Registrar, you must register it to your network in advance. For more information, see the instructions supplied with your wireless LAN access point/router.

NOTE: If you use Windows® 7 or Windows® 8 as a Registrar, you can install the printer driver after the wireless configuration by following the on-screen instructions. To install the full driver and software package, use the Dell installer on the Installer CD-ROM.

10. Select your machine and click Next.

11. Type the PIN displayed on the machine's LCD, and then click Next.

12. Select your network, and then click Next.

13. Click Close.

If your wireless device is connected successfully, the machine's LCD displays Connected. The machine will print your machine's wireless status report. If the connection fails, check the error code on the printed report.

NOTE: If the connection fails, your machine reverts to a wired network interface.

For Windows®:
You have completed the wireless network setup. Install drivers and software necessary for operating your device from the Installer CD-ROM.

For Macintosh:
You have completed the wireless network setup. Install drivers and software necessary from "StartHereOS X.app" in the installation CD-ROM.

Configure Your Machine for a Wireless Network in Ad-Hoc Mode (For IEEE 802.11b/g/n)

• Configure Your Machine for a Wireless Network in Ad-Hoc Mode Using a New SSID

   If you are using a new SSID, all other devices will connect using the SSID you assign to your Dell machine in the
following steps. You must connect to this SSID from your computer when it is configured for Ad-Hoc mode.

- **Configure Your Machine for a Wireless Network in Ad-Hoc Mode Using an Existing SSID**
  If you are trying to pair your Dell machine to a computer that is already in Ad-Hoc mode and has a configured SSID, use these instructions.

- **Connected to a Wireless Computer without a Wireless LAN Access Point Router in the Network (Ad-Hoc Mode)**
  This type of network does not have a central wireless LAN access point/router. Each wireless client communicates directly with each other. When the Dell wireless machine (your machine) is part of this network, it receives all print jobs directly from the computer sending print data.

### Configure Your Machine for a Wireless Network in Ad-Hoc Mode Using a New SSID

**Related Models:** Dell E514dw / Dell E515dw

If you are using a new SSID, all other devices will connect using the SSID you assign to your Dell machine in the following steps. You must connect to this SSID from your computer when it is configured for Ad-Hoc mode.

1. **Press Menu.**
2. **Press ▲ or ▼ to select the Network option, and then press OK.**
3. **Press ▲ or ▼ to select the WLAN option, and then press OK.**
4. **Press ▲ or ▼ to select the Setup Wizard option, and then press OK.**
5. **When WLAN Enable ? appears, enable the wireless network. This will start the wireless setup wizard.**
6. **The machine will search for your network and display a list of available SSIDs. Press ▲ or ▼ to select the <New SSID> option, and then press OK.**
7. **Enter the SSID name, and then press OK.**
8. **Press ▲ or ▼ to select the Ad-hoc option, and then press OK.**
9. **Press ▲ or ▼ to select the Encryption Type None or WEP, and then press OK.**
10. **If you selected the WEP option for Encryption Type, enter the WEP key, and then press OK.**

  **NOTE:** Your Dell machine supports the use of the first WEP key only.

11. **To apply the settings, select Yes. To cancel, select No.**
12. **The machine will attempt to connect to the wireless device you have selected.**

If your wireless device is connected successfully, the machine's LCD displays Connected. The machine will print your machine's wireless status report. If the connection fails, check the error code on the printed report.

  **NOTE:** If the connection fails, your machine reverts to a wired network interface.

For Windows®:

You have completed the wireless network setup. Install drivers and software necessary for operating your device from the Installer CD-ROM.

For Macintosh:

You have completed the wireless network setup. Install drivers and software necessary from "StartHereOS X.app" in the installation CD-ROM.
Configure Your Machine for a Wireless Network in Ad-Hoc Mode Using an Existing SSID

Related Models:Dell E514dw / Dell E515dw

If you are trying to pair your Dell machine to a computer that is already in Ad-Hoc mode and has a configured SSID, use these instructions.

Before configuring your machine, we recommend writing down your wireless network settings. You will need this information before you continue with the configuration.

1. Check and record the current wireless network settings of the computer to which you are connecting.

   **NOTE:** The wireless network settings of the computer you are connecting with must be set to Ad-Hoc mode with an SSID already configured. For more information on how to configure your computer in Ad-Hoc mode, see the instructions included with your computer or contact your network administrator.

<table>
<thead>
<tr>
<th>Network Name (SSID)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HELLO</td>
</tr>
</tbody>
</table>

   For example:

<table>
<thead>
<tr>
<th>Communication Mode</th>
<th>Encryption Mode</th>
<th>Network Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ad-Hoc</td>
<td>WEP</td>
<td>12345</td>
</tr>
</tbody>
</table>

   **NOTE:** Your Dell machine supports the use of the first WEP key only.

2. Press **Menu**.

3. Press ▲ or ▼ to select the Network option, and then press **OK**.

4. Press ▲ or ▼ to select the WLAN option, and then press **OK**.

5. Press ▲ or ▼ to select the Setup Wizard option, and then press **OK**.

6. When WLAN Enable ? appears, enable the wireless network.
   This will start the wireless setup wizard.

7. The machine will search for your network and display a list of available SSIDs. When a list of SSIDs appears, press ▲ or ▼ to select the SSID you want.

8. Press **OK**.

9. Enter the WEP key, and then press **OK**.
   To apply the settings, select Yes, and then press **OK**. To cancel, select No.

   **NOTE:** Your Dell machine supports the use of the first WEP key only.

10. The machine will attempt to connect to the wireless device you have selected.
    If your wireless device is connected successfully, the machine's LCD displays Connected. The machine will print
your machine's wireless status report. If the connection fails, check the error code on the printed report.

**NOTE:** If the connection fails, your machine reverts to a wired network interface.

For Windows®:
You have completed the wireless network setup. Install drivers and software necessary for operating your device from the Installer CD-ROM.

For Macintosh:
You have completed the wireless network setup. Install drivers and software necessary from "StartHereOS X.app" in the installation CD-ROM.

Configure Your Machine for a Wireless Network Using the Machine's Control Panel Setup Wizard

Related Models:Dell E514dw / Dell E515dw

Before configuring your machine, we recommend writing down your wireless network settings. You will need this information before you continue with the configuration.

1. Check and record the current wireless network settings of the computer to which you are connecting.

<table>
<thead>
<tr>
<th>Network Name (SSID)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HELLO</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Network Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>12345</td>
</tr>
</tbody>
</table>

   **NOTE:** Your access point/router may support the use of multiple WEP keys, however your Dell machine supports the use of the first WEP key only.

   **NOTE:** If you need assistance during setup and want to contact Dell Customer Service, make sure you have your SSID (Network Name) and Network Key ready. We cannot assist you in locating this information.

   **NOTE:** If you do not know this information (SSID and Network Key), you cannot continue the wireless setup.

   **How can I find this information?**
   - Check the documentation provided with your wireless access point/router.
   - The initial SSID could be the manufacturer’s name or the model name.
   - If you do not know the security information, please consult the router manufacture, your system administrator, or your Internet provider.

2. Press Menu.
3. Press ▲ or ▼ to select the Network option, and then press OK.
4. Press ▲ or ▼ to select the WLAN option, and then press OK.
5. Press ▲ or ▼ to select the Setup Wizard option, and then press OK.
6. When WLAN Enable ? appears, enable the wireless network. This will start the wireless setup wizard.
7. The machine will search for your network and display a list of available SSIDs. When a list of SSIDs appears, press ▲ or ▼ to select the SSID you want.
8. Press OK.
9. Do one of the following:
   • If you are using an authentication and encryption method that requires a Network Key, enter the Network Key you wrote down in the first step. Enter the WEP key, and then press OK to apply your settings. To apply the settings, select Yes. To cancel, select No.
   • If your authentication method is Open System and your encryption mode is None, go to the next step.
   • If your WLAN access point/router supports WPS, WPS is available appears. To connect your machine using the automatic wireless mode, press ▲. (If you choose No, enter the Network Key you wrote down in the first step.) When Press WPS on rtr appears, press the WPS button on your WLAN access point/router, and then press ▲ twice.
10. The machine attempts to connect to the wireless device you have selected. If your wireless device is connected successfully, the machine’s LCD displays Connected. The machine will print your machine’s wireless status report. If the connection fails, check the error code on the printed report.

   NOTE: If the connection fails, your machine reverts to a wired network interface.

For Windows®:
You have completed the wireless network setup. Install drivers and software necessary for operating your device from the Installer CD-ROM.
For Macintosh:
You have completed the wireless network setup. Install drivers and software necessary from "StartHereOS X.app" in the installation CD-ROM.

Configure Your Machine for a Wireless Network When the SSID Is Not Broadcast
Related Models:Dell E514dw / Dell E515dw

Before configuring your machine, we recommend writing down your wireless network settings. You will need this information before you continue with the configuration.

1. Check and record the current wireless network settings.

<table>
<thead>
<tr>
<th>Network Name (SSID)</th>
<th>Communication Mode</th>
<th>Authentication Method</th>
<th>Encryption Mode</th>
<th>Network Key</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Network Infrastructure Open System NONE -
Shared Key WEP
WPA/WPA2-PSK AES
TKIP (TKIP is supported for WPA-PSK only.)

For example:

<table>
<thead>
<tr>
<th>Network Name (SSID)</th>
<th>Communication Mode</th>
<th>Authentication Method</th>
<th>Encryption Mode</th>
<th>Network Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>HELLO</td>
<td>Infrastructure</td>
<td>WPA2-PSK</td>
<td>AES</td>
<td>12345678</td>
</tr>
</tbody>
</table>

**NOTE:** If your router uses WEP encryption, enter the key used as the first WEP key. Your Dell machine supports the use of the first WEP key only.

2. Press **Menu**.

3. Press ▲ or ▼ to select the **Network** option, and then press **OK**.

4. Press ▲ or ▼ to select the **WLAN** option, and then press **OK**.

5. Press ▲ or ▼ to select the **Setup Wizard** option, and then press **OK**.

6. When **WLAN Enable ?** appears, enable the wireless network.
   This will start the wireless setup wizard.

7. The machine will search for your network and display a list of available SSIDs. Press ▲ or ▼ to select the **<New SSID>** option, and then press **OK**.

8. Enter the SSID name, and then press **OK**.

9. Press ▲ or ▼ to select the **Infrastructure** option, and then press **OK**.

10. Press ▲ or ▼ to select the Authentication Method you want, and then press **OK**.

11. Do one of the following:
   - If you selected the **Open System** option, press ▲ or ▼ to select the Encryption Type **None** or **WEP**, and then press **OK**.
     - If you selected the **WEP** option for Encryption Type, enter the WEP key, and then press **OK**.
   - If you selected the **Shared Key** option, enter the WEP key, and then press **OK**.
   - If you selected the **WPA/WPA2-PSK** option, press ▲ or ▼ to select the Encryption Type **TKIP+AES** or **AES**, and then press **OK**.
     - Enter the WPA key, and then press **OK**.
   **NOTE:** Your Dell machine supports the use of the first WEP key only.

12. To apply the settings, select **Yes**. To cancel, select **No**.

13. The machine will attempt to connect to the wireless device you have selected.
   - If your wireless device is connected successfully, the machine's LCD displays **Connected**. The machine will print your machine's wireless status report. If the connection fails, check the error code on the printed report.
NOTE: If the connection fails, your machine reverts to a wired network interface.

For Windows®:
You have completed the wireless network setup. Install drivers and software necessary for operating your device from the Installer CD-ROM.

For Macintosh:
You have completed the wireless network setup. Install drivers and software necessary from "StartHereOS X.app" in the installation CD-ROM.

Use Wi-Fi Direct®

- Print or Scan from Your Mobile Device Using Wi-Fi Direct
- Mobile Printing
- Printing with Mopria™
- Configure Your Wi-Fi Direct Network
  Configure your Wi-Fi Direct network settings from your machine's control panel.
- I Cannot Complete the Wireless Network Setup Configuration.

Print or Scan from Your Mobile Device Using Wi-Fi Direct

Related Models:Dell E514dw / Dell E515dw
Wi-Fi Direct is one of the wireless configuration methods developed by the Wi-Fi Alliance®. It allows you to configure a secured wireless network between your Dell machine and a mobile device, such as an Android™ device, Windows® Phone device, iPhone, iPod touch, or iPad, without using an access point. Wi-Fi Direct supports wireless network configuration using the one-push or PIN Method of Wi-Fi Protected Setup™ (WPS). You can also configure a wireless network by manually setting an SSID and password. Your Dell machine's Wi-Fi Direct feature supports WPA2™ security with AES encryption.

1. Mobile device
2. Your Dell machine
NOTE: Although the Dell machine can be used in both a wired and wireless network, only one connection method can be used at a time. However, a wireless network connection and Wi-Fi Direct connection, or a wired network connection (supported models only) and Wi-Fi Direct connection can be used at the same time.

NOTE: The Wi-Fi Direct-supported device can become a Group Owner (G/O). When configuring the Wi-Fi Direct network, the G/O serves as an access point.

Mobile Printing

Your Dell machine supports printing from a variety of mobile devices. Easy to use and navigate, the application for Mobile Printing enables direct printing of photos, documents, web content and more, on supported Dell printers via Wi-Fi or Ethernet network.

For Android™ Devices

Download the Dell Document Hub app for free from Google Play™. Easy to use and navigate, the Dell Document Hub app enables direct printing of photos, documents web content and more, to supported Dell printers on a Wi-Fi, Wi-Fi Direct, or Ethernet network.
Scan the QR Code® for quick access to the relevant application store.

For iOS Devices

This printer is compatible with AirPrint. This printer is also compatible with Dell Document Hub App, available for free download from App Store.
Scan the QR Code for quick access to the relevant application store.

Printing with Mopria™

Related Models: Dell E514dw / Dell E515dn / Dell E515dw
Mopria-certified mobile devices can connect and print to certify printer. Either connect your mobile devices to the same network as the printer or make a direct connection with Wi-Fi Direct®. Works with Mopria-certified smartphones and tablets or Android 4.4 devices with the Mopria Print Service download from Google Play.
https://play.google.com/store/apps/
http://www.mopria.org/

**Configure Your Wi-Fi Direct Network**

Configure your Wi-Fi Direct network settings from your machine’s control panel.

- **Step-by-step Guide for Wi-Fi Direct Network Configuration**
  - The following instructions offer five methods for configuring your Dell machine in a wireless network environment. Select the method you prefer for your environment.
  - **Configure Your Wi-Fi Direct Network Using the One-Push Method**
  - **Configure Your Wi-Fi Direct Network Using the One-Push Method of Wi-Fi Protected Setup™ (WPS)**
  - **Configure Your Wi-Fi Direct Network Using the PIN Method**
  - **Configure Your Wi-Fi Direct Network Using the PIN Method of Wi-Fi Protected Setup™ (WPS)**
  - **Configure Your Wi-Fi Direct Network Manually**

**Step-by-step Guide for Wi-Fi Direct Network Configuration**

Related Models: Dell E514dw / Dell E515dw

The following instructions offer five methods for configuring your Dell machine in a wireless network environment. Select the method you prefer for your environment.

Check your mobile device for configuration.

1. **Does your mobile device support Wi-Fi Direct?**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Go to Step 2</td>
</tr>
<tr>
<td>No</td>
<td>Go to Step 3</td>
</tr>
</tbody>
</table>

2. **Does your mobile device support one-push configuration for Wi-Fi Direct?**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>See Related Information: Configure Your Wi-Fi Direct Network Using the One-Push Method</td>
</tr>
<tr>
<td>No</td>
<td>See Related Information: Configure Your Wi-Fi Direct Network Using the PIN Method</td>
</tr>
</tbody>
</table>

3. **Does your mobile device support Wi-Fi Protected Setup™ (WPS)?**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Go to Step 4</td>
</tr>
<tr>
<td>No</td>
<td>See Related Information: Configure Your Wi-Fi Direct Network Manually</td>
</tr>
</tbody>
</table>

4. **Does your mobile device support one-push configuration for Wi-Fi Protected Setup™ (WPS)?**
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>See Related Information: Configure Your Wi-Fi Direct Network Using the One-Push Method and Wi-Fi Protected Setup™ (WPS)</td>
</tr>
<tr>
<td>No</td>
<td>See Related Information: Configure Your Wi-Fi Direct Network Using the PIN Method of Wi-Fi Protected Setup™ (WPS)</td>
</tr>
</tbody>
</table>

To use Mobile Printing functionality in a Wi-Fi Direct network configured by one-push configuration using Wi-Fi Direct or by PIN Method configuration using Wi-Fi Direct, the device you use to configure Wi-Fi Direct must be running Android™ 4.0 or greater.

**Configure Your Wi-Fi Direct Network Using the One-Push Method**

Related Models:Dell E514dw / Dell E515dw

If your mobile device supports Wi-Fi Direct, follow these steps to configure a Wi-Fi Direct network:

1. Press Menu.
2. Press ▲ or ▼ to select the Network option, and then press OK.
3. Press ▲ or ▼ to select the Wi-Fi Direct option, and then press OK.
4. Press ▲ or ▼ to select the Push Button option, and then press OK.
5. When Wi-Fi Direct On? appears, enable the Wi-Fi Direct network.
6. Activate Wi-Fi Direct on your mobile device (see your mobile device's user's guide for instructions) when Activate Wi-Fi Direct on other device and press OK. appears on the machine's LCD. Press OK on your machine.
   This will start the Wi-Fi Direct setup. To cancel, press Clear.
7. Do one of the following:
   - When your Dell machine is the Group Owner (G/O), connect your mobile device to the machine directly.
   - When your Dell machine is not the G/O, it will display available device names with which to configure a Wi-Fi Direct network. Press ▲ or ▼ to select the mobile device you want to connect to and press OK. Search for available devices again by pressing Rescan.
8. If your mobile device connects successfully, the machine's LCD displays Connected. You have completed the Wi-Fi Direct network setup.

**Configure Your Wi-Fi Direct Network Using the One-Push Method of Wi-Fi Protected Setup™ (WPS)**

Related Models:Dell E514dw / Dell E515dw

If your mobile device supports WPS (PBC; Push Button Configuration), follow these steps to configure a Wi-Fi Direct network:

1. Press Menu.
2. Press ▲ or ▼ to select the Network option, and then press OK.
3. Press ▲ or ▼ to select the Wi-Fi Direct option, and then press OK.
4. Press ▲ or ▼ to select the Group Owner option, and then press OK.
5. Press ▲ or ▼ to select the On option, and then press OK.
6. Press ▲ or ▼ to select the Push Button option, and then press OK.
7. When Wi-Fi Direct On? appears, enable the Wi-Fi Direct network.
8. Activate your mobile device's WPS one-push configuration method (see your mobile device's user's guide for instructions) when Activate Wi-Fi Direct on other device and press OK. appears on the machine's LCD. Press OK on your machine. This will start the Wi-Fi Direct setup. To cancel, press Clear.
9. If your mobile device connects successfully, the machine's LCD displays Connected. You have completed the Wi-Fi Direct network setup.

Configure Your Wi-Fi Direct Network Using the PIN Method

Related Models:Dell E514dw / Dell E515dw
If your mobile device supports the PIN Method of Wi-Fi Direct, follow these steps to configure a Wi-Fi Direct network:

1. Press Menu.
2. Press ▲ or ▼ to select the Network option, and then press OK.
3. Press ▲ or ▼ to select the Wi-Fi Direct option, and then press OK.
4. Press ▲ or ▼ to select the PIN Code option, and then press OK.
5. When Wi-Fi Direct On? appears, enable the Wi-Fi Direct network.
6. Activate Wi-Fi Direct on your mobile device (see your mobile device's user's guide for instructions) when Activate Wi-Fi Direct on other device and press OK. appears on the machine's LCD. Press OK on your machine. This will start the Wi-Fi Direct setup. To cancel, press Clear.
7. Do one of the following:
   • When your machine is the Group Owner (G/O), it will wait for a connection request from your mobile device. When Input PIN Code appears, enter the PIN displayed on your mobile device in your machine. Press OK to complete the setup.
   • If the PIN is displayed on your machine, enter the PIN in your mobile device.
   • When your machine is not the G/O, it will display available device names with which to configure a Wi-Fi Direct network. Press ▲ or ▼ to select the mobile device you want to connect to and press OK. Search for available devices again by pressing Rescan.
8. Do one of the following:
   • Follow the machine's instruction to display the PIN on your machine, enter the PIN in your mobile device, and then go to the next step.
   • Follow the machine's instruction to enter the PIN displayed by your mobile device in your machine. Press OK, and then go to the next step.
   • If your mobile device does not display a PIN, press Cancel on your machine. Go back to the first step and try again.
9. If your mobile device connects successfully, the machine's LCD displays Connected. You have completed the
Wi-Fi Direct network setup.

**Configure Your Wi-Fi Direct Network Using the PIN Method of Wi-Fi Protected Setup™ (WPS)**

Related Models:Dell E514dw / Dell E515dw

If your mobile device supports the PIN Method of Wi-Fi Protected Setup™ (WPS), follow these steps to configure a Wi-Fi Direct network.

1. Press **Menu**.
2. Press ▲ or ▼ to select the **Network** option, and then press **OK**.
3. Press ▲ or ▼ to select the **Wi-Fi Direct** option, and then press **OK**.
4. Press ▲ or ▼ to select the **Group Owner** option, and then press **OK**.
5. Press ▲ or ▼ to select the **On** option, and then press **OK**.
6. Press ▲ or ▼ to select the **PIN Code** option, and then press **OK**.
7. When **Wi-Fi Direct On?** appears, enable the Wi-Fi Direct network.
8. Activate your mobile device's WPS PIN configuration method (see your mobile device's user's guide for instructions) when **Activate Wi-Fi Direct on other device and press OK**. appears on the machine's LCD. Press **OK** on your machine.
   This will start the Wi-Fi Direct setup. To cancel, press **Clear**.
9. The machine will wait for a connection request from your mobile device. When **Input PIN Code** appears, enter the PIN displayed on your mobile device in the machine.
10. Press **OK**.
11. If your mobile device connects successfully, the machine's LCD displays **Connected**. You have completed the Wi-Fi Direct network setup.

**Configure Your Wi-Fi Direct Network Manually**

Related Models:Dell E514dw / Dell E515dw

If your mobile device does not support Wi-Fi Direct or WPS, you must configure a Wi-Fi Direct network manually.

1. Press **Menu**.
2. Press ▲ or ▼ to select the **Network** option, and then press **OK**.
3. Press ▲ or ▼ to select the **Wi-Fi Direct** option, and then press **OK**.
4. Press ▲ or ▼ to select the **Manual** option, and then press **OK**.
5. When **Wi-Fi Direct On?** appears, enable the Wi-Fi Direct network.
6. The machine will display the SSID name and Password for two minutes. Go to your mobile device's wireless network settings screen and enter the SSID name and password.
7. If your mobile device connects successfully, the machine's LCD displays **Connected**. You have completed the Wi-Fi Direct network setup.
Advanced Network Features

• Print the Network Configuration Report
  The Network Configuration Report lists the current network configuration, including the network print server settings.

• Configure Your Mail Server Settings Using Web Based Management
  Use Web Based Management to configure your Dell machine to connect with your mail server.

• Synchronize Time with the SNTP Server Using Web Based Management
  The Simple Network Time Protocol (SNTP) is used to synchronize the time used by the machine for authentication with the SNTP time server. (This is not the time displayed on the machine's LCD.) You can automatically or manually synchronize the machine's time with the Coordinated Universal Time (UTC) provided by the SNTP time server.

Print the Network Configuration Report

The Network Configuration Report lists the current network configuration, including the network print server settings.

NOTE: Node Name: The Node Name appears on the current Network Configuration Report. The default Node Name is "DELLxxxxxx" (where 'xxxxxx' is your machine’s MAC Address / Ethernet Address.)

NOTE: If the IP Address on the Network Configuration Report shows 0.0.0.0, wait for one minute and try printing it again.

NOTE: You can find your machine’s settings, such as IP address, subnet mask, node name, and MAC Address on the report, for example:
  - IP address: 192.168.0.5
  - Subnet mask: 255.255.255.0
  - Node name: DELL000499
  - MAC Address: 00-0c-a0-00-04-99

1. Press Menu.

2. Do one of the following:
   • Dell E515dn/E515dw
     Press ▲ or ▼ to display the Print Reports option, and then press OK.
   • Dell E514dw
     Press ▲ or ▼ to display the Machine Info. option, and then press OK.

3. Press ▲ or ▼ to select the Network Config option, and then press OK.

4. Press Start.

Configure Your Mail Server Settings Using Web Based Management

Use Web Based Management to configure your Dell machine to connect with your mail server.

1. Start your web browser.

2. Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the machine's
IP address).
For example: http://192.168.1.2

3. No password is required by default. Type a password if you have set one, and then click <button> .
4. Click the **Network** tab.
5. Click **Protocol** in the left navigation bar.
6. In the **SMTP** field, click **Advanced Setting** and make sure the **Status** is **Enabled**.

7. Enter the necessary settings for the mail server.
8. Click **Submit**.

**Synchronize Time with the SNTP Server Using Web Based Management**

The Simple Network Time Protocol (SNTP) is used to synchronize the time used by the machine for authentication with the SNTP time server. (This is not the time displayed on the machine’s LCD.) You can automatically or manually synchronize the machine’s time with the Coordinated Universal Time (UTC) provided by the SNTP time server.

- Configure Date and Time Using Web Based Management
  Configure date and time to synchronize the time used by the machine with the SNTP time server.
- Configure the SNTP Protocol Using Web Based Management
  Configure the SNTP protocol to synchronize the time the machine uses for authentication with the time kept by the SNTP time server.

**Configure Date and Time Using Web Based Management**

Configure date and time to synchronize the time used by the machine with the SNTP time server.
This feature is not available in some countries.

1. Start your web browser.
2. Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the machine's IP address).
   
   For example: http://192.168.1.2
3. No password is required by default. Type a password if you have set one, and then click .
4. Click the General tab.
5. Click Date&Time in the left navigation bar.

   ![Date&Time](image)

   **NOTE:** Select the time difference between your location and UTC from the Time Zone drop-down list. For example, the time zone for Eastern Time in the USA and Canada is UTC-05:00.
6. Verify the Time Zone settings.
7. Select the Synchronize with SNTP server check box.
8. Click Submit.

Configure the SNTP Protocol Using Web Based Management

Configure the SNTP protocol to synchronize the time the machine uses for authentication with the time kept by the SNTP time server.

1. Start your web browser.
2. Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the machine's IP address).
   
   For example: http://192.168.1.2
3. No password is required by default. Type a password if you have set one, and then click .
4. Click the Network tab.
5. Click Protocol in the left navigation bar.
6. Select the SNTP check box to activate the settings.
7. Next to the SNTP check box, click Advanced Setting and follow the instructions below:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Displays whether the SNTP protocol is enabled or disabled.</td>
</tr>
<tr>
<td>SNTP Server Method</td>
<td>Select <strong>AUTO</strong> or <strong>STATIC</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>AUTO</strong></td>
</tr>
<tr>
<td></td>
<td>If you have a DHCP server in your network, the SNTP server will obtain the address from that server automatically.</td>
</tr>
<tr>
<td></td>
<td>• <strong>STATIC</strong></td>
</tr>
<tr>
<td></td>
<td>Type the address you want to use.</td>
</tr>
<tr>
<td>Primary SNTP Server Address</td>
<td>Type the server address (up to 64 characters).</td>
</tr>
<tr>
<td>Secondary SNTP Server Address</td>
<td>The secondary SNTP server address is used as a backup to the primary SNTP server address. If the primary server is unavailable, the machine will contact the secondary SNTP server.</td>
</tr>
<tr>
<td>Primary SNTP Server Port</td>
<td>Type the port number (1-65535).</td>
</tr>
<tr>
<td>Secondary SNTP Server Port</td>
<td>The secondary SNTP server port is used as a backup to the primary SNTP server port. If the primary port is unavailable, the machine will contact the secondary SNTP port.</td>
</tr>
<tr>
<td>Synchronization Interval</td>
<td>Type the number of hours between server synchronization attempts (1-168 hours).</td>
</tr>
<tr>
<td>Synchronization Status</td>
<td>Confirm the latest synchronization status.</td>
</tr>
</tbody>
</table>

8. Click Submit.

**Technical Information for Advanced Users**

- Additional Network Settings for Windows®
- Available Services

When you want your computer to print to the Dell print server, you must use a resource, also known as a 'service.' The Dell print server provides these predefined services:
• Other Ways to Configure the IP Address
• Reset the Network Settings to the Factory Settings
  You can use your machine's control panel to reset the print server to its default factory settings. This resets all information, such as the password and IP address.
• Print the WLAN Report
  The WLAN Report reflects your machine's wireless status. If the wireless connection fails, check the error code on the printed report.

Additional Network Settings for Windows®

• Before Configuring Additional Network Settings
• Use Web Services to Install Drivers Used for Printing and Scanning (Windows Vista®, Windows® 7 and Windows® 8)
  Use Web Services to monitor printers on the network.
• Use Web Services to Uninstall Drivers Used for Printing and Scanning (Windows Vista®, Windows® 7 and Windows® 8)
• Use Vertical Pairing to Install Drivers Used for Printing and Scanning in Infrastructure Mode (Windows® 7 and Windows® 8)
  Windows® Vertical Pairing is a technology that allows your Vertical Pairing-supported wireless machine to connect to your Infrastructure network using the PIN Method of WPS and the Web Services feature. It enables printer driver and scanner driver installation from the multi-function printer icon in the Add a device screen. If you are in Infrastructure mode, you can connect your machine to the wireless network, and then install the printer driver and scanner driver using this feature.
• Use Vertical Pairing to Install Drivers Used for Printing from the Wi-Fi Direct Network (Windows® 8.1)
  Windows® 8.1 allows your Vertical Pairing-supported wireless machine to connect to the Wi-Fi Direct network using the one-push or PIN Method of WPS and the Web Services feature. It enables printer driver installation from the printer icon in the Add a device screen. You can connect your machine to the Wi-Fi Direct network, and then install the printer driver using this feature. Your machine also supports the Persistent Group feature of Vertical Pairing for Windows® 8.1.

Before Configuring Additional Network Settings

Use one of the following features to configure additional network settings:
• Web Services for printing and scanning (Windows Vista®, Windows® 7 and Windows® 8)
• Vertical Pairing (Windows® 7 and Windows® 8)

Use Web Services to Install Drivers Used for Printing and Scanning (Windows Vista®, Windows® 7 and Windows® 8)

Use Web Services to monitor printers on the network.

• Verify that the host computer and the Dell machine are on the same subnet, or that the router is correctly configured to pass data between the two devices.
• You must configure the IP address on your Dell machine before you configure this setting.

1. Insert the Installer CD-ROM.
2. Open Windows® Explorer, and navigate to your CD-ROM drive, and then select **install > bin > ComDLL > Data**.
3. Double-click **PnPDrvInst.exe**.
4. If the **User Account Control** screen appears, do one of the following:
   - (Windows Vista®)
     Click **Allow**.
   - (Windows® 7/Windows® 8)
     Click **Yes**.
5. Do one of the following:
   - (Windows Vista®)
     Click **(Start) > Network**.
     The machine's Web Services Name appears with the printer icon.
     Right-click the machine you want to install.
   - (Windows® 7)
     Click **(Start) > Control Panel > Network and Internet > View network computers and devices**.
     The machine's Web Services Name appears with the printer icon.
     Right-click the machine you want to install.
   - (Windows® 8)
     Move your mouse to the lower right corner of your desktop. When the menu bar appears, click **Settings > Change PC settings > Devices > Add a device**.
     The machine's Web Services Name appears.
   - (Windows® 8.1)
     Move your mouse to the lower right corner of your desktop. When the menu bar appears, click **Settings > Change PC settings > PC & devices > Devices > Add a device**.
     The machine's Web Services Name appears.

**NOTE:** The Web Services Name for the Dell machine is your model name and the MAC Address (Ethernet Address) of your machine (for example, Dell EXXXX (model name) [XXXXXXXXXXXX] (MAC Address / Ethernet Address)).

**NOTE:** (Windows® 8)
Move your mouse over the machine name to display the machine's information.

6. Do one of the following:
   - (Windows Vista®/Windows® 7)
     Click **Install** in the machine's drop-down menu.
   - (Windows® 8)
     Select the machine you want to install.

**Use Web Services to Uninstall Drivers Used for Printing and Scanning (Windows Vista®,**
**Windows® 7 and Windows® 8**

1. Do one of the following:
   - (Windows Vista®)
     - Click **(Start) > Network.**
   - (Windows® 7)
     - Click **(Start) > Control Panel > Network and Internet > View network computers and devices.**
   - (Windows® 8)
     - Move your mouse to the lower right corner of your desktop. When the menu bar appears, click **Settings > Change PC settings > Devices.**
   - (Windows® 8.1)
     - Move your mouse to the lower right corner of your desktop. When the menu bar appears, click **Settings > Change PC settings > PC & devices > Devices.**

2. Do one of the following:
   - (Windows Vista®/Windows® 7)
     - The machine’s Web Services Name will be shown with the printer icon. Right-click the machine you want to uninstall.
   - (Windows® 8)
     - The machine’s Web Service Name will be shown. Select the machine you want to uninstall, and then click **(Remove device).**

3. Do one of the following:
   - (Windows Vista®/Windows® 7)
     - Click **Uninstall** in the machine’s drop-down menu.
   - (Windows® 8)
     - When the dialog box appears, follow the on-screen instruction.

**Use Vertical Pairing to Install Drivers Used for Printing and Scanning in Infrastructure Mode (Windows® 7 and Windows® 8)**

Related Models:Dell E514dw / Dell E515dw

Windows® Vertical Pairing is a technology that allows your Vertical Pairing-supported wireless machine to connect to your Infrastructure network using the PIN Method of WPS and the Web Services feature. It enables printer driver and scanner driver installation from the multi-function printer icon in the **Add a device** screen. If you are in Infrastructure mode, you can connect your machine to the wireless network, and then install the printer driver and scanner driver using this feature.

- Verify that the host computer and the Dell machine are on the same subnet, or that the router is correctly configured to pass data between the two devices.
- If you have disabled your machine’s Web Services feature, you must re-enable it by selecting the Web Services check box and clicking **Submit.** The default setting of Web Services for the Dell machine is Enabled. You can
change the Web Services setting using Web Based Management.

• Make sure your wireless LAN access point/router has the Windows® 7 or Windows® 8 compatibility logo. If you are not sure about the compatibility logo, contact your access point/router manufacturer.

• Make sure your computer has the Windows® 7 or Windows® 8 compatibility logo. If you are not sure about the compatibility logo, contact your computer manufacturer.

• If you are configuring your wireless network using an external wireless Network Interface Card (NIC), make sure the wireless NIC has the Windows® 7 or Windows® 8 compatibility logo. For more information, contact your wireless NIC manufacturer.

• To use a Windows® 7 or a Windows® 8 computer as a Registrar, you must register it to your network in advance. See the instructions supplied with your wireless LAN access point/router.

1. Turn on your machine.

2. Set your machine to WPS mode (PIN Method).

3. Do one of the following:
   • (Windows® 7)
     Click (Start) > Devices and Printers > Add a device.
   • (Windows® 8)
     Move your mouse to the lower right corner of your desktop. When the menu bar appears, click Settings > Control Panel > Hardware and Sound > Devices and Printers > Add a device.

4. Select your machine and type the PIN.

5. Select the infrastructure network to which you want to connect, and then click Next.

6. When your machine appears in the Devices and Printers dialog box, the wireless configuration and the printer driver installation are successfully completed.

Use Vertical Pairing to Install Drivers Used for Printing from the Wi-Fi Direct Network (Windows® 8.1)

Related Models:Dell E514dw / Dell E515dw

Windows® 8.1 allows your Vertical Pairing-supported wireless machine to connect to the Wi-Fi Direct network using the one-push or PIN Method of WPS and the Web Services feature. It enables printer driver installation from the printer icon in the Add a device screen. You can connect your machine to the Wi-Fi Direct network, and then install the printer driver using this feature. Your machine also supports the Persistent Group feature of Vertical Pairing for Windows® 8.1.

• If you have disabled your machine’s Web Services feature, you must re-enable it by selecting the Web Services check box, and clicking Submit. The default setting of the Web Services for the Dell machine is Enabled. You can change the Web Services setting using Web Based Management.

• Make sure your computer has the Windows® 8.1 compatibility logo. If you are not sure about the compatibility logo, contact your computer manufacturer.

• If you are configuring your wireless network using an external wireless Network Interface Card (NIC), make sure
the wireless NIC has the Windows® 8.1 compatibility logo. For more information, contact your wireless NIC manufacturer.

1. Turn on your machine.
2. Enable your machine's Wi-Fi Direct feature.
3. Move your mouse to the lower right corner of your desktop. When the menu bar appears, click **Settings > Control Panel > Hardware and Sound > Devices and Printers > Add a device**.
4. Select your machine.
   **NOTE:** If your computer displays a dialog box that requires the WPS PIN, type the PIN displayed on your Dell machine's LCD, and then click **Next**.
5. Select the Wi-Fi Direct push button menu on your machine.
6. When your machine appears in the **Devices and Printers** dialog box, the wireless configuration and the printer driver installation are successfully completed.

**Available Services**

When you want your computer to print to the Dell print server, you must use a resource, also known as a 'service.' The Dell print server provides these predefined services:

<table>
<thead>
<tr>
<th>Service (Example)</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>BINARY_P1</td>
<td>TCP/IP binary</td>
</tr>
<tr>
<td>TEXT_P1</td>
<td>TCP/IP text service (adds carriage return after each line feed)</td>
</tr>
<tr>
<td>PCL_P1</td>
<td>PCL service (switches PJL-compatible machine to PCL mode)</td>
</tr>
<tr>
<td>DELLxxxxxx*1</td>
<td>TCP/IP binary</td>
</tr>
<tr>
<td>DELLxxxxxx_AT*1</td>
<td>PostScript® service for Macintosh</td>
</tr>
<tr>
<td>POSTSCRIPT_P1</td>
<td>PostScript® service (switches PJL-compatible machine to PostScript® mode)</td>
</tr>
</tbody>
</table>

*1: Where "xxxxxx" is the first six digits of your machine's MAC Address (Ethernet Address).

**Other Ways to Configure the IP Address**

- Configure the IP Address Using DHCP
- Configure the IP Address Using BOOTP
- Configure the IP Address Using RARP
- Configure the IP Address Using APIPA
- Configure the IP Address Using ARP

**Configure the IP Address Using DHCP**

The Dynamic Host Configuration Protocol (DHCP) is one of several automated mechanisms for IP address allocation. If you have a DHCP server on your network, the print server obtains its IP address from the DHCP server automatically and registers its name with any RFC 1001- and 1002-compliant dynamic name services.

If you do not want your print server configured via DHCP, you must set the Boot Method to **Static** so that the print
server has a static IP address. This will prevent the print server from trying to obtain an IP address from any of these systems.
To change the Boot Method, use the machine's control panel Network menu or Web Based Management.

**Configure the IP Address Using BOOTP**

Before you configure the IP address using Bootstrap Protocol (BOOTP), you must set the machine's Boot Method to BOOTP. To change the Boot Method, use the machine's control panel Network menu.

BOOTP is an alternative to Reverse Address Resolution Protocol (RARP) that has the advantage of allowing configuration of the subnet mask and gateway. To use BOOTP to configure the IP address, make sure BOOTP is installed and running on your host computer (it should appear in the /etc/services file on your host as a real service; type man bootpd or see your system documentation for information). BOOTP is usually started up via the /etc/inetd.conf file, so you may need to enable it by removing the "#" in front of the bootp entry in that file.

For example, a typical bootp entry in the /etc/inetd.conf file would be:

```
#bootp dgram udp wait /usr/etc/bootpd bootpd -i
```

Depending on the system, this entry might be called "bootps" instead of "bootp".

**NOTE:** To enable BOOTP, use an editor to delete the "#" (if there is no "#," then BOOTP is already enabled). Then edit the BOOTP configuration file (usually /etc/bootptab) and enter the name, network type (1 for Ethernet), MAC Address (Ethernet Address) and the IP address, subnet mask and gateway of the print server. Unfortunately, the exact format for doing this is not standardized, so you will need to see your system documentation to determine how to enter this information (many UNIX® systems also have template examples in the bootptab file that you can use for reference). Some examples of typical /etc/bootptab entries include:

```
DELL310107 1 00:80:77:31:01:07 192.168.1.2
```

and:

```
DELL310107:ht=ethernet:ha=008077310107:\ip=192.168.1.2:
```

Certain BOOTP host software implementations will not respond to BOOTP requests if you have not included a download filename in the configuration file. If this is the case, create a null file on the host and specify the name of this file and its path in the configuration file.

As with RARP, the print server will load its IP address from the BOOTP server when the machine is powered on.

**Configure the IP Address Using RARP**

Before you configure the IP address using Reverse Address Resolution Protocol (RARP), you must set the machine's Boot Method to RARP. To change the Boot Method, use the machine's control panel or Web Based Management.

The Dell print server's IP address can be configured using the RARP facility on your host computer. This is done by editing the /etc/ethers file (if this file does not exist, you can create it) with an entry similar to the following:

```
00:80:77:31:01:07 DELL008077310107
```

where the first entry is the MAC Address (Ethernet Address) of the print server and the second entry is the name of the print server. (The name must be the same as the one you put in the /etc/hosts file.)

If the RARP daemon is not already running, start it (depending on the system, the command can be rarpd, rarpd -a, in.rarpd -a, or another command; type man rarpd or see your system documentation for additional information). To verify that the RARP daemon is running on a Berkeley UNIX® based system, type the following command:
ps -ax | grep -v grep | grep rarpd
For AT&T UNIX®-based systems, type:
ps -ef | grep -v grep | grep rarpd
The Dell print server will get the IP address from the RARP daemon when the machine is powered on.

**Configure the IP Address Using APIPA**

The Dell print server supports the Automatic Private IP Addressing (APIPA) protocol. With APIPA, DHCP clients automatically configure an IP address and subnet mask when a DHCP server is not available. The device selects its own IP address in the range 169.254.1.0 through 169.254.254.255. The subnet mask is automatically set to 255.255.0.0 and the gateway address is set to 0.0.0.0.

By default, the APIPA protocol is enabled. To disable the APIPA protocol, use the machine’s control panel or Web Based Management.

**Configure the IP Address Using ARP**

If your network does not use a DHCP server, you can also use the Address Resolution Protocol (ARP) command. The ARP command is available on Windows® systems that have TCP/IP installed and UNIX® systems. To use ARP, type the following command:

```
arp -s ipaddress ethernetaddress
```

Where `ethernetaddress` is the MAC Address (Ethernet Address) of the print server and `ipaddress` is the IP address of the print server.

For example:

**Windows® systems**

Windows® systems require the hyphen (dash) "-" character between each digit of the MAC Address (Ethernet Address).

```
arp -s 192.168.1.2 00-80-77-31-01-07
ping 192.168.1.2
```

**UNIX®/Linux systems**

Typically, UNIX® and Linux systems require the colon ":" character between each digit of the MAC Address (Ethernet Address).

```
arp -s 192.168.1.2 00:80:77:31:01:07
ping 192.168.1.2
```

**NOTE:** You must be on the same Ethernet segment to use the ARP command, that is, there cannot be a router between the print server and operating system.

If there is a router, you may use BOOTP or other methods to enter the IP address. If your administrator has configured the system to deliver IP addresses using BOOTP, DHCP, or RARP, your Dell print server can receive an IP address from any one of these IP address allocation systems, so you will not need to use the ARP command. The ARP command works only once. For security reasons, when you have successfully configured the IP address of a Dell print server using the ARP command, you cannot use the ARP command again to change the address. The print server will ignore any attempts to do this. To change the IP address again, use Web Based Management, or perform a factory reset on the print server, which will then allow you to use the ARP command again.
Reset the Network Settings to the Factory Settings

You can use your machine's control panel to reset the print server to its default factory settings. This resets all information, such as the password and IP address.

**NOTE:** This feature restores all wired and wireless network settings to the factory settings.

**NOTE:** You can also reset the print server to its factory settings using Web Based Management.

1. Press **Menu**.
2. Press ▲ or ▼ to display the **Network** option, and then press **OK**.
3. Press ▲ or ▼ to display the **Network Reset** option, and then press **OK**.
4. Follow the machine's instruction to reset the network settings.
   
   The machine will restart.

Print the WLAN Report

Related Models:Dell E514dw / Dell E515dw

The WLAN Report reflects your machine's wireless status. If the wireless connection fails, check the error code on the printed report.

1. Press **Menu**.
2. Do one of the following:
   - Dell E515dw Press ▲ or ▼ to display the **Print Reports** option, and then press **OK**.
   - Dell E514dw Press ▲ or ▼ to display the **Machine Info.** option, and then press **OK**.
3. Press ▲ or ▼ to select the **WLAN Report** option, and then press **OK**.
4. Press **Start**
   
   The machine will print the WLAN Report.

Wireless LAN Report Error Codes

Related Models:Dell E514dw / Dell E515dw

If the Wireless LAN Report shows that the connection failed, check the error code on the printed report and refer to the corresponding instructions in the table:

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Problem and Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>TS-01</td>
<td>The wireless setting is not activated, turn the wireless setting to ON.</td>
</tr>
<tr>
<td></td>
<td>If a network cable is connected to your machine, disconnect it and turn the wireless setting of your machine to ON.</td>
</tr>
</tbody>
</table>
| TS-02 | The wireless access point/router cannot be detected.  
1. Check the following four points:  
   - Make sure that the wireless access point/router is powered on.  
   - Move your machine to an obstruction-free area, or closer to the wireless access point/router.  
   - Temporarily place your machine within about 3.3 feet (one meter) from the wireless access point when you are configuring the wireless settings.  
   - If your wireless access point/router is using MAC address filtering, confirm the MAC address of the Dell machine is allowed in the filter.  
2. If you manually entered the SSID and security information (SSID/authentication method/encryption method/Network Key), the information may be incorrect. Confirm the SSID and security information and enter the correct information as necessary. |

| TS-04 | The Authentication/Encryption methods used by the selected wireless access point/router are not supported by your machine.  
For infrastructure mode, change the authentication and encryption methods of the wireless access point/router.  
Your machine supports the following authentication methods:  
   - WPA-Personal  
     TKIP or AES  
   - WPA2-Personal  
     AES  
   - Open  
     WEP or None (without encryption)  
   - Shared key  
     WEP  
If your problem is not solved, the SSID or network settings you entered may be incorrect. Confirm the wireless network settings.  
For Ad-Hoc Mode, change the authentication and encryption methods of your computer for the wireless setting. Your machine supports Open authentication method only, with optional WEP encryption. |

| TS-05 | The security information (SSID/Network Key) is incorrect.  
Confirm the SSID and Network Key. If your router uses WEP encryption, enter the key used as the first WEP key. Your Dell machine supports the use of the first WEP key only. |

| TS-06 | The wireless security information (Authentication method/Encryption method/Network Key) is incorrect.  
Confirm the wireless security information (Authentication method/Encryption method/Network Key) listed in TS-04. If your router uses WEP encryption, enter the key used as the first WEP key. Your Dell machine supports the use of the first WEP key only. |

| TS-07 | The machine cannot detect a wireless access point/router that has WPS or AOSS™ enabled.  
If you would like to configure your wireless settings using WPS or AOSS™, you must operate both your machine and the wireless access point/router. Confirm your wireless access point/router supports WPS or AOSS™ and try starting again.  
If you do not know how to operate your wireless access point/router using WPS or AOSS™ see the documentation provided with your wireless access point/router, ask the manufacturer of your wireless access point/router or ask your network administrator. |

| TS-08 | Two or more wireless access points that have WPS or AOSS™ enabled are detected.  
   - Confirm that only one wireless access point/router within range has the WPS or AOSS™ method active and try again.  
   - Try starting again after a few minutes in order to avoid interference from other access points. |
Network Menu on the Dell Control Panel

The control panel’s Network menu selections allow you to configure the Dell machine for your network. Note that your Dell machine includes the Web Based Management, which you can use to configure many aspects of the network.

TCP/IP

If you connect the machine to your network with a network cable, use the Wired LAN menu selections. If you connect the machine to a wireless Ethernet network, use the WLAN menu selections.

Boot Method

This selection controls how the machine obtains an IP address.

Auto

In this mode, the machine will scan the network for a DHCP server. If it can find one, and if the DHCP server is configured to allocate an IP address to the machine, then the IP address supplied by the DHCP server will be used.

If no DHCP server is available, the IP Address is set using the APIPA protocol. After the machine is initially powered ON, it may take a few minutes for the machine to scan the network for a server.

Static

In this mode, the machine’s IP address must be manually assigned. When the IP address is entered, it is locked to the assigned address.

If you do not want your print server configured via DHCP, BOOTP, or RARP, you must set the BOOT Method to Static so that the print server has a static IP address. This will prevent the print server from trying to obtain an IP address from any of these systems.

To change the BOOT Method, use the machine’s control panel or Web Based Management.

IP Address

This field displays the current IP address of the machine. If you have selected a BOOT Method of Static, type the IP address that you wish to assign to the machine (check with your network administrator for the IP address to use). If you have selected a method other than Static, the machine will attempt to determine its IP address using the DHCP, BOOTP, or RARP protocols.

The default IP address of your machine will probably be incompatible with the IP address numbering scheme of your network. We recommend contacting your network administrator for an IP address that is compatible with the network to which your machine is connected.

Subnet Mask

This field displays the current subnet mask used by the machine. If you are not using DHCP, BOOTP, or RARP to obtain the subnet mask, type the desired subnet mask. Check with your network administrator for the subnet mask to use.

Gateway

This field displays the current gateway or router address used by the machine. If you are not using DHCP, BOOTP, or RARP to obtain the gateway or router address, type the address you wish to assign. If you do not have a gateway or router, leave this field blank. Check with your network administrator if you are unsure.

Node Name

You can register the machine name on the Network. This name is often referred to as a NetBIOS name; it will be the
name that is registered by the Windows® Internet Name Service (WINS) server on your network. Dell recommends the name "DELLxxxxxx" (where "xxxxxx" is the first six digits of your machine's MAC Address / Ethernet address) (up to 32 characters).

**WINS Configuration**

This selection controls how the machine obtains the IP address of the WINS server.

- **Auto**
  - Automatically uses a DHCP request to determine the IP addresses for the primary and secondary WINS servers.
  - You must set the Boot Method to Auto or DHCP for this feature to work.

- **Static**
  - Uses a specified IP address for the primary and secondary WINS servers.

**WINS Server**

This selection manages the IP address of the WINS server.

- **Primary (Primary WINS Server IP Address)**
  - This field specifies the IP address of the primary WINS server. If set to a non-zero value, the machine will contact this server to register its name with the Windows® Internet Name Service.

- **Secondary (Secondary WINS Server IP Address)**
  - This field specifies the IP address of the secondary WINS server. It is used as a backup to the primary WINS server address. If the primary WINS server is unavailable, the machine still can register itself with a secondary server.
  - If set to a non-zero value, the machine will contact this server to register its name with the Windows® Internet Name Service. If you have a primary WINS server but no secondary WINS server, simply leave this field blank.

**DNS Server**

This selection manages the IP address of the Domain Name System (DNS) server.

- **Primary (Primary DNS Server IP Address)**
  - This field specifies the IP address of the primary DNS server.

- **Secondary (Secondary DNS Server IP Address)**
  - This field specifies the IP address of the secondary DNS server. It is used as a backup to the primary DNS server address. If the primary DNS server is unavailable, the machine will contact the secondary DNS server.

**APIPA**

Selecting On will cause the print server to automatically allocate a link-local IP address in the range (169.254.1.0 - 169.254.254.255) when the print server cannot obtain an IP address through the Boot Method you have set. Selecting Off means the IP address does not change when the print server cannot obtain an IP address through the Boot Method you have set.

**IPv6**

This machine is compatible with IPv6, the next generation Internet protocol. The default setting is Off. If you want to use the IPv6 protocol, select On.

**NOTE:** If you set IPv6 to On, turn off the power switch, and then turn it back on to enable this protocol.

**NOTE:** After you set IPv6 to On, this setting will be applied to both the wired and wireless LAN interface.
Ethernet (Wired Network Only)
Ethernet link mode allows the print server to operate in 100BASE-TX full or half duplex or in 10BASE-T full or half duplex mode by auto-negotiation.

NOTE: If you set this value incorrectly, you may not be able to communicate with your print server.

Wired Status
This field displays the current wired network status.

MAC Address
The MAC Address (Ethernet Address) is a unique number assigned for the machine's network interface. You can check your machine's MAC Address on its control panel.

Setup Wizard (Wireless Network Only)
Related Models:Dell E514dw / Dell E515dw
The Setup Wizard guides you through the wireless network configuration.

WPS/AOSS™ (Wireless Network Only)
Related Models:Dell E514dw / Dell E515dw
If your wireless LAN access point/router supports either WPS (PBC) or AOSS™ (automatic wireless mode), you can configure your Dell machine without a computer.

NOTE: WPS refers to Wi-Fi Protected Setup™.

NOTE: PBC refers to Push Button Configuration.

NOTE: AOSS™ refers to AirStation One-Touch Secure System.

WPS w/PIN Code (Wireless Network Only)
Related Models:Dell E514dw / Dell E515dw
If your wireless LAN access point/router supports WPS (PIN method), you can configure your Dell machine without a computer.

NOTE: WPS refers to Wi-Fi Protected Setup™.

WLAN Status (Wireless Network Only)
Related Models:Dell E514dw / Dell E515dw
Status
This field displays the current wireless network status.

Signal
This field displays the current wireless network signal strength.

SSID
This field displays the current wireless network SSID. The display shows up to 32 characters of the SSID name.

**Comm.Mode**
This field displays the current wireless network communication mode.

### Set to Default
Related Models:Dell E514dw / Dell E515dw
Select the **Set to Default** option to reset each wired or wireless setting to the factory default.

### Wired Enable (Wired Network Only)
Related Models:Dell E514dw / Dell E515dw
Set the **Wired Enable** option to **On** when you want to use a wired network connection.

### WLAN Enable (Wireless Network Only)
Related Models:Dell E514dw / Dell E515dw
Set the **WLAN Enable** option to **On** when you want to use a wireless network connection.

### Wi-Fi Direct
Related Models:Dell E514dw / Dell E515dw
This type of connection is a Wi-Fi standard that allows devices to connect with each other without a wireless access point, using secured method.

### Scan to E-mail
Select Scan to E-mail to change the resolution and file type for an email attachment. You can scan and send a black and white or color document from the computer as an attachment.

### Scan to FTP
Related Models:Dell E515dn / Dell E515dw
Select Scan to FTP to change the resolution and file type for the attachment. You can scan and send a black and white or color document directly to an FTP server on your local network or on the Internet.

### Network Reset
Select the **Network Reset** option to reset the print server to its default factory settings.
Security .......................................................... 233

Lock the Machine Settings .............................................. 233
Before Using Network Security Features ......................... 236
Supported Security Protocols and Features ...................... 237
Send an Email Securely .................................................. 238
Security

- **Lock the Machine Settings**
  Before turning on the machine's access lock feature, make a careful note of your password. If you forget the password, you must reset all passwords stored in the machine by calling your administrator or Dell Customer Service.

- **Before Using Network Security Features**
  Your Dell machine employs some of the latest network security and encryption protocols available today. These network features can be integrated into your overall network security plan to help protect your data and prevent unauthorized access to the machine.

- **Supported Security Protocols and Features**
  - Send an Email Securely

**Lock the Machine Settings**

Before turning on the machine's access lock feature, make a careful note of your password. If you forget the password, you must reset all passwords stored in the machine by calling your administrator or Dell Customer Service.

- **About Using TX Lock**
  Block unauthorized data transmission to and from the machine.

- **About Using Setting Lock**
  Block unauthorized access to machine settings.

**About Using TX Lock**

Related Models:Dell E515dn / Dell E515dw
Block unauthorized data transmission to and from the machine.

While TX Lock is on, the following operations are available IF they active before you turned on TX Lock:

- Receive faxes
- Fax Forward
- Paging
- Remote Retrieval

**NOTE:** To print the faxes in memory, turn off TX Lock.

While TX Lock is on, the following operations are NOT available:

- Fax send
- Copy
- PC print
- Scan

**Set the TX Lock Password**

Related Models:Dell E515dn / Dell E515dw

1. Press Menu.
2. Press ▲ or ▼ to display the General Setup option, and then press OK.

3. Press ▲ or ▼ to display the Security option, and then press OK.

4. Press ▲ or ▼ to display the TX Lock option, and then press OK.

5. Enter a four-digit number for the password.

6. Press OK.

7. When the LCD displays Verify:, re-enter the password.

8. Press Cancel.

**Change the TX Lock Password**

Related Models: Dell E515dn / Dell E515dw

1. Press Menu.

2. Press ▲ or ▼ to display the General Setup option, and then press OK.

3. Press ▲ or ▼ to display the Security option, and then press OK.

4. Press ▲ or ▼ to display the TX Lock option, and then press OK.

5. Press ▲ or ▼ to select the Set Password option, and then press OK.

6. Enter the current four-digit password.

7. Press OK.

8. Enter a four-digit number for the new password.

9. Press OK.

10. When the LCD displays Verify:, re-enter the password.


**Turn TX Lock On/Off**

- Turn TX Lock On
- Turn TX Lock Off

**Turn TX Lock On**

Related Models: Dell E515dn / Dell E515dw

1. Press Menu.

2. Press ▲ or ▼ to display the General Setup option, and then press OK.

3. Press ▲ or ▼ to display the Security option, and then press OK.

4. Press ▲ or ▼ to display the TX Lock option, and then press OK.

5. Press OK when the LCD shows Set TX Lock.

6. Enter the current four-digit password.

7. Press OK.
Turn TX Lock Off

Related Models: Dell E515dn / Dell E515dw

1. Press Menu.
2. Enter the current four-digit password.
3. Press OK.

About Using Setting Lock

Related Models: Dell E515dn / Dell E515dw

Block unauthorized access to machine settings.

When Setting Lock is set to On, you cannot access the machine settings without entering the password.

Set the Setting Lock Password

Related Models: Dell E515dn / Dell E515dw

1. Press Menu.
2. Press ▲ or ▼ to display the General Setup option, and then press OK.
3. Press ▲ or ▼ to display the Security option, and then press OK.
4. Press ▲ or ▼ to display the Setting Lock option, and then press OK.
5. Enter a four-digit number for the password.
6. Press OK.
7. When the LCD displays Verify:, re-enter the password.
8. Press OK.

Change the Setting Lock Password

Related Models: Dell E515dn / Dell E515dw

1. Press Menu.
2. Press ▲ or ▼ to display the General Setup option, and then press OK.
3. Press ▲ or ▼ to display the Security option, and then press OK.
4. Press ▲ or ▼ to display the Setting Lock option, and then press OK.
5. Press ▲ or ▼ to select the Set Password option, and then press OK.
6. Enter the current four-digit password.
7. Press OK.
8. Enter a new four-digit password.
9. Press OK.
10. When the LCD displays Verify:, re-enter the password.
11. Press OK.

**Turn Setting Lock On or Off**

- Turn Setting Lock On
- Turn Setting Lock Off

**Turn Setting Lock On**

Related Models:Dell E515dn / Dell E515dw

1. Press Menu.
2. Press ▲ or ▼ to display the General Setup option, and then press OK.
3. Press ▲ or ▼ to display the Security option, and then press OK.
4. Press ▲ or ▼ to display the Setting Lock option, and then press OK.
5. Press OK when the LCD displays On.
6. Enter the current four-digit password.
7. Press OK.
8. Press Cancel.

**Turn Setting Lock Off**

Related Models:Dell E515dn / Dell E515dw

1. Press Menu.
2. Press ▲ or ▼ to display the General Setup option, and then press OK.
3. Press ▲ or ▼ to display the Security option, and then press OK.
4. Press ▲ or ▼ to display the Setting Lock option, and then press OK.
5. Enter the current four-digit password.
6. Press OK.
7. Press OK when the LCD shows Off.
8. Press Cancel.

**Before Using Network Security Features**

Your Dell machine employs some of the latest network security and encryption protocols available today. These network features can be integrated into your overall network security plan to help protect your data and prevent unauthorized access to the machine.

**NOTE:** We recommend disabling the FTP and TFTP protocols. Accessing the machine using these protocols is not secure. However, note that if you disable FTP, the Scan to FTP feature will be disabled.
Supported Security Protocols and Features

- Security Protocols
- Security Methods for Sending and Receiving Email
- Manage Your Network Machine Securely Using Web Based Management (Web Browser)

To manage your network machine securely, you must use the management utilities with security protocols.

Security Protocols

SNMPv3
The Simple Network Management Protocol version 3 (SNMPv3) provides user authentication and data encryption to manage network devices securely.

Security Methods for Sending and Receiving Email

NOTE: Configure the settings for these security methods using Web Based Management.

SMTP Authentication (SMTP-AUTH)
SMTP-AUTH expands SMTP (the Internet email sending protocol) to include an authentication method that ensures that the true identity of the sender is known.

Manage Your Network Machine Securely Using Web Based Management (Web Browser)

To manage your network machine securely, you must use the management utilities with security protocols.

1. Start your web browser.
2. Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the machine's IP address).
3. No password is required by default. Type a password if you have set one, and then click .
   NOTE: If you use the SNMPv3 protocol, follow the steps below.
4. Click the Network tab.
5. Click Protocol.
6. Make sure the SNMP setting is enabled, and then click Advanced Setting of SNMP.
7. You can configure the SNMP settings.
   We have three selections for SNMP Mode of Operation.
   - SNMP v1/v2c read-write access
     In this mode, the print server uses version 1 and version 2c of the SNMP protocol. You can use all Dell applications under this mode. However, it is not secure since it will not authenticate the user and the data will not be encrypted.
   - SNMPv3 read-write access and v1/v2c read-only access
     In this mode, the print server uses the read-write access of version 3 and the read-only access of version 1 and version 2c of the SNMP protocol.
Security

NOTE: When you use the SNMPv3 read-write access and v1/v2c read-only access mode, some Dell applications that access to the print server do not work correctly since they authorize the read-only access of version 1 and version 2c. If you want to use all applications, use the SNMP v1/v2c read-write access mode.

- **SNMPv3 read-write access**
  With this mode, the print server uses version 3 of the SNMP protocol. If you want to manage the print server securely, use this mode.

  **NOTE:** When you use the SNMPv3 read-write access mode, note the following:
  - You can manage the print server using Web Based Management only.
  - All applications that use SNMPv1/v2c will be restricted. To allow the use of SNMPv1/v2c applications, use SNMPv3 read-write access and v1/v2c read-only access or SNMP v1/v2c read-write access mode.

Send an Email Securely

- Configure Email Sending Using Web Based Management
- Send an Email with User Authentication

Configure Email Sending Using Web Based Management

Related Models: Dell E515dn / Dell E515dw

We recommend using Web Based Management to configure secured email sending with user authentication.

1. Start your web browser.
2. Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the machine's IP address).
   For example: http://192.168.1.2
   **NOTE:** If you are using a Domain Name System or enable a NetBIOS name, you can type another name, such as "SharedPrinter" instead of the IP address.
   - For example:
     http://SharedPrinter
   If you enable a NetBIOS name, you can also use the node name.
   - For example:
     http://DELL000499
      The NetBIOS name can be found in the Network Configuration Report.
   **NOTE:** For Macintosh, access Web Based Management by clicking the machine's icon on the Status Monitor screen.
3. No password is required by default. Type a password if you have set one, and then click ➤.
4. Click the Network tab.
5. Click **Protocol** in the left navigation bar.

6. In the **POP3/IMAP4/SMTP** field, click **Advanced Setting** and make sure the status of **POP3/IMAP4/SMTP** is **Enabled**.

7. In the **SMTP** field, click **Advanced Setting** and make sure the status of **SMTP** is **Enabled**.

8. Configure the **SMTP** settings.
   - For more information, see the Help text in Web Based Management.
   - Confirm that the email settings are correct after configuration by sending a test email.
   - If you do not know the SMTP server setting, contact your network administrator or Internet Service Provider (ISP).

9. When finished, click **Submit**.
   The **Test Send E-mail Configuration** dialog box appears.

10. Follow the instructions in the dialog box to test the current settings.

**Send an Email with User Authentication**

**Related Models:** Dell E515dn / Dell E515dw

Your Dell machine supports the SMTP-AUTH method to send email via an email server that requires user authentication. This method prevents unauthorized users from accessing the email server.

You can use SMTP-AUTH for email notification and email reports.

**NOTE:** We recommend using Web Based Management to configure the SMTP authentication.

**Email Server Settings**

You must configure your machine's SMTP authentication method to match the method used by your email server.
For details about your email server settings, contact your network administrator or Internet Service Provider (ISP).

**NOTE:** To enable SMTP server authentication: in the Web Based Management **SMTP** screen, under **Server Authentication Method**, you must select **SMTP-AUTH**.
ControlCenter .......................... 243
ControlCenter (Macintosh) .......................... 243
ControlCenter

Use Dell's ControlCenter software utility to quickly access your frequently-used applications. Using ControlCenter gives you direct access to specific applications.

- ControlCenter (Macintosh)

ControlCenter (Macintosh)

- Scan Using ControlCenter (Macintosh)
  Use Dell's ControlCenter software to scan photos and save them as JPEGs, PDFs, or other file formats.
- Scan Settings for ControlCenter (Macintosh)

Scan Using ControlCenter (Macintosh)

Use Dell's ControlCenter software to scan photos and save them as JPEGs, PDFs, or other file formats.

- Scan Documents and Photos Using ControlCenter (Macintosh)
  Send scanned photos or graphics directly to your computer. Dell's ControlCenter software (for Macintosh only) will launch the default graphics application on your computer and open your scanned document automatically.
- Save Scanned Data to a Folder as a PDF File Using ControlCenter (Macintosh)
- Scan Both Sides of an ID Card Using ControlCenter
- Scan to E-mail Attachment Using ControlCenter (Macintosh)
  Send a scanned document as an email attachment.
- Scan to an Editable Text File (OCR) Using ControlCenter (Macintosh)
  Your machine can convert characters in a scanned document to text data using optical character recognition (OCR) technology. Edit this text using your preferred text-editing application.
- Scan Settings for ControlCenter (Macintosh)

Scan Settings for ControlCenter (Macintosh)

<table>
<thead>
<tr>
<th>Settings</th>
<th>Applicable Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Application/E-mail Application</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Select which application is used to open scanned data. Only applications installed on your computer can be selected.</td>
<td></td>
</tr>
<tr>
<td><strong>Add</strong></td>
<td></td>
</tr>
<tr>
<td>Add an application to the pop-up menu.</td>
<td></td>
</tr>
<tr>
<td>Type the application name in the Application Name field (up to 30 characters) and select your preferred application by clicking the Browse button. Select the File Type option from the pop-up menu.</td>
<td></td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td></td>
</tr>
<tr>
<td>Delete an application you have added to the pop-up menu. Select the application from the Application Name pop-up menu, and then click Delete.</td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Yes</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----</td>
</tr>
<tr>
<td><strong>File Type</strong></td>
<td></td>
</tr>
<tr>
<td>Select the file type you want to use for the scanned data.</td>
<td></td>
</tr>
<tr>
<td><strong>OCR Language</strong></td>
<td></td>
</tr>
<tr>
<td>Set the OCR language to match the language of the scanned document's text.</td>
<td></td>
</tr>
<tr>
<td><strong>Destination File Path</strong></td>
<td></td>
</tr>
<tr>
<td>Click the <strong>Change</strong> button to change the prefix of the file name and the path of the destination folder.</td>
<td></td>
</tr>
<tr>
<td><strong>File Name</strong></td>
<td></td>
</tr>
<tr>
<td>Type a prefix for your file name, if needed.</td>
<td></td>
</tr>
<tr>
<td><strong>Insert Date in File Name</strong></td>
<td></td>
</tr>
<tr>
<td>Automatically insert the date in the file name of the scanned image.</td>
<td></td>
</tr>
<tr>
<td><strong>Show Save As window</strong></td>
<td></td>
</tr>
<tr>
<td>Select this option if you want to specify the destination of the scanned image every time you scan.</td>
<td></td>
</tr>
<tr>
<td><strong>Destination Folder</strong></td>
<td></td>
</tr>
<tr>
<td>Click <strong>Browse</strong> to select the folder where you would like to save your scanned document.</td>
<td></td>
</tr>
<tr>
<td><strong>Show Folder</strong></td>
<td></td>
</tr>
<tr>
<td>Select the <strong>Show Folder</strong> option to automatically display the destination folder after scanning.</td>
<td></td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td></td>
</tr>
<tr>
<td>Select a scanning resolution from the <strong>Resolution</strong> pop-up menu. Higher resolutions take more memory and transfer time, but produce a finer scanned image.</td>
<td></td>
</tr>
</tbody>
</table>
Scan Type
Select from a range of scan color depths.

- **Black & White**
  Use for text or line art images.

- **Gray (Error Diffusion)**
  Use for photographic images or graphics. (Error Diffusion is a method for creating simulated gray images without using true gray dots. Black dots are put in a specific pattern to give a gray appearance.)

- **True Gray**
  Use for photographic images or graphics. This mode is more accurate because it uses up to 256 shades of gray.

- **24bit Color**
  Use to create an image with the most accurate color reproduction. This mode uses up to 16.8 million colors to scan the image, but it requires the most memory and has the longest transfer time.

- **Auto**
  Use for any type of document. This mode automatically picks an appropriate color depth for the document.

Document Size
Select the exact size of your document from the Document Size pop-up menu.

- If you select 1 to 2 (A4), the scanned image will be divided into two A5-size documents.

Continuous Scanning
Select this option to scan multiple pages from the flatbed or ADF. After a page is scanned, either continue scanning or finish. Use this method to scan more pages than the maximum ADF capacity.

ID Card Scan
Select this check box to crop a portion of a scanned page after pre-scanning the document.

Show Scanner Interface
Select this check box to crop a portion of a scanned page after pre-scanning the document.
Configure advanced settings by clicking the Advanced Settings button in the Scan Settings dialog box.

- **Brightness**
  
  Set the Brightness level by dragging the slider to the right or left to lighten or darken the image. If the scanned image is too light, set a lower brightness level and scan the document again. If the image is too dark, set a higher brightness level and scan the document again.

- **Contrast**
  
  Increase or decrease the Contrast level by moving the slider to the right or left. An increase emphasizes dark and light areas of the image, while a decrease reveals more details in gray areas. You can also enter a value in the box to set the contrast.

- **Remove Background Color**
  
  Remove the base color of documents to make the scanned data more recognizable. When you use this function, select from three settings: high, medium, and low. (Available only for the Auto, True Gray and 24bit Color options)

<table>
<thead>
<tr>
<th>Restore Defaults</th>
<th>Yes</th>
<th>Yes</th>
<th>Yes</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select this option to restore all settings to their factory setting values.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Troubleshooting ................................................................. 249

Printing Problems ............................................................. 250
Telephone and Fax Problems .............................................. 251
Network Problems ............................................................ 255
Other Problems ............................................................... 261
Error and Maintenance Messages ........................................ 263
Transfer Your Faxes or Fax Journal Report .......................... 266
Document Jams ............................................................... 267
Paper Jams ................................................................. 268
Improve the Print Quality .................................................. 279
Machine Information ......................................................... 285
Troubleshooting

Use this section to resolve typical problems you may encounter when using your Dell machine. You can correct most problems yourself.

IMPORTANT

For technical help, you must call the country where you bought the machine. Calls must be made from within that country.

Using non-Dell supplies may affect the print quality, hardware performance, and machine reliability.

(Dell E515dn/Dell E515dw)

To prevent you from losing the received fax data in the machine’s memory, transfer the data to another Fax machine or to your computer before turning off the machine.

First, check the following:

• The machine's power cord is connected correctly and the machine's power is on. See the Setup Guide.
• All of the protective materials have been removed. See the Setup Guide.
• Paper is loaded correctly in the paper tray.
• The interface cables are securely connected to the machine and the computer, or the wireless connection is set up on both the machine and your computer.
• Error and maintenance messages

If you did not solve the problem with the checks, identify the problem and then see Related Information.
# Printing Problems

<table>
<thead>
<tr>
<th>Difficulties</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No printout</td>
<td>Check that the correct printer driver has been installed and selected. Check to see if the Status Monitor (for Macintosh only) or the machine’s control panel displays an error status. Check that the machine is online:</td>
</tr>
<tr>
<td></td>
<td>- Windows® 7 and Windows Server® 2008 R2</td>
</tr>
<tr>
<td></td>
<td>- Click (Start) &gt; Devices and Printers. Right-click Dell MFP EXXXX and click See what's printing. Click Printer in the menu bar. Make sure Use Printer Offline is cleared.</td>
</tr>
<tr>
<td></td>
<td>- Windows Vista® and Windows Server® 2008</td>
</tr>
<tr>
<td></td>
<td>- Click (Start) &gt; Control Panel &gt; Hardware and Sound &gt; Printers. Right-click Dell MFP EXXXX. Make sure Use Printer Online is not listed. If it is listed, click this option to set the driver Online.</td>
</tr>
<tr>
<td></td>
<td>- Windows Server® 2003</td>
</tr>
<tr>
<td></td>
<td>- Click the Start &gt; Printers and Faxes. Right-click Dell MFP EXXXX. Make sure Use Printer Online is not listed. If it is listed, click this option to set the driver Online.</td>
</tr>
<tr>
<td></td>
<td>- Windows® 8 and Windows Server® 2012</td>
</tr>
<tr>
<td></td>
<td>- Click (Start) &gt; Control Panel &gt; Hardware and Sound &gt; Printers. Right-click Dell MFP EXXXX. Make sure Use Printer Online is not listed. If it is listed, click this option to set the driver Online.</td>
</tr>
<tr>
<td></td>
<td>- Windows Server® 2012 R2</td>
</tr>
<tr>
<td></td>
<td>- Click Control Panel on the Start screen. In the Hardware group, click View devices and printers. Right-click the Dell MFP EXXXX. Click See what's printing. If printer driver options appear, select your printer driver. Click Printer in the menu bar and make sure that Use Printer Offline is not selected.</td>
</tr>
<tr>
<td></td>
<td>- (For Dell E514dw) Check the machine is not in Power Off mode. If the machine is in Power Off mode, press and hold on the control panel, and then re-send print data.</td>
</tr>
<tr>
<td>The machine is not printing or has stopped printing.</td>
<td>Press Cancel. The machine will cancel the print job and clear it from the memory. The printout may be incomplete. Resend print data.</td>
</tr>
<tr>
<td>The headers or footers appear when the document displays on the screen but they do not show up when it is printed.</td>
<td>There is an unprintable area on the top and bottom of the page. Adjust the top and bottom margins in your document to allow for this.</td>
</tr>
<tr>
<td>The machine prints unexpectedly or it prints garbage.</td>
<td>Press Cancel. Check the settings in your application to make sure they are set up to work with your machine.</td>
</tr>
<tr>
<td>The machine prints the first couple of pages correctly, then some pages have missing text.</td>
<td>Check the settings in your application to make sure they are set up to work with your machine. Your computer is not recognizing the full signal of the machine’s input buffer. Make sure you connected the interface cable correctly.</td>
</tr>
</tbody>
</table>
The machine does not print on both sides of the paper even though the printer driver setting is 2-sided.

<table>
<thead>
<tr>
<th>Troubleshooting</th>
<th>Check the paper size setting in the printer driver. You must select Letter, Legal or Folio paper that is 16 to 28 lb (60 to 105 g/m²).</th>
</tr>
</thead>
</table>

Print speed is too slow.

<table>
<thead>
<tr>
<th>Troubleshooting</th>
<th>Try changing the printer driver setting. The highest resolution needs longer data processing, sending and printing time.</th>
</tr>
</thead>
</table>

The machine does not feed paper.

<table>
<thead>
<tr>
<th>Troubleshooting</th>
<th>If there is paper in the paper tray, make sure it is straight. If the paper is curled, straighten it. Sometimes it is helpful to remove the paper, turn the stack over and put it back in the paper tray.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Reduce the amount of paper in the paper tray, and then try again. Make sure Manual is not selected for Paper Source in the printer driver. Clean the paper pick-up rollers.</td>
</tr>
</tbody>
</table>

The machine does not feed paper from the Manual feed slot.

<table>
<thead>
<tr>
<th>Troubleshooting</th>
<th>Use both hands to push one sheet of paper firmly into the manual feed slot until the top edge of the paper presses against the paper feed rollers. Continue pressing the paper against the rollers until the machine grabs the paper and pulls it in further.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Put only one sheet of paper in the manual feed slot. Make sure Manual is selected for Paper Source in the printer driver.</td>
</tr>
</tbody>
</table>

The machine does not feed envelopes.

<table>
<thead>
<tr>
<th>Troubleshooting</th>
<th>Load one envelope at a time in the manual feed slot. Your application must be set to print the envelope size you are using. This is usually done in the Page Setup or Document Setup menu of your application.</th>
</tr>
</thead>
</table>

**Telephone and Fax Problems**

**Related Models:** Dell E515dn / Dell E515dw

**Telephone Line or Connections**

<table>
<thead>
<tr>
<th>Difficulties</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dialing does not work. (No dial tone)</td>
<td>Check all line cord connections. Make sure the telephone line cord is plugged into the telephone wall jack and the LINE jack of the machine. If you subscribe to DSL, VoIP or MagicJack services, call your service provider for connection instructions.</td>
</tr>
<tr>
<td></td>
<td>(Available only for some countries.) Change the Tone/Pulse setting. Send a manual fax by pressing Hook button, and dialing the number. Wait to hear fax-receiving tones before pressing Start button. If there is no dial tone, connect a known working telephone and telephone line cord to the jack. Then lift the external telephone’s handset and listen for a dial tone. If there is still no dial tone, ask your telephone company to check the line and/or wall jack.</td>
</tr>
<tr>
<td>The machine does not answer when called.</td>
<td>Make sure the machine is in the correct receive mode for your setup. Check for a dial tone. If possible, call your machine to hear it answer. If there is still no answer, check that the telephone line cord is plugged into the telephone wall jack and the LINE jack of the machine. If there is no ringing when you call your machine, ask your telephone company to check the line.</td>
</tr>
</tbody>
</table>

**Handling Incoming Calls**

<table>
<thead>
<tr>
<th>Difficulties</th>
<th>Suggestions</th>
</tr>
</thead>
</table>
Sending a Fax Call to the machine. If you answered on an extension telephone, press your Fax Receive Code (the factory setting is *51). If you answered on the external telephone (connected to the EXT. jack), press Start button to receive the fax. When your machine answers, hang up.

Custom features on a single line. If you have Call Waiting, Call Waiting/Caller ID, Caller ID, RingMaster, Voice Mail, an answering machine, an alarm system or other custom feature on a single telephone line with your machine, it may create a problem sending or receiving faxes.

For Example: If you subscribe to Call Waiting or some other custom service and its signal comes through the line while your machine is sending or receiving a fax, the signal can temporarily interrupt or disrupt the faxes. Dell’s ECM (Error Correction Mode) feature should help overcome this problem. This condition is related to the telephone system industry and is common to all devices that send and receive information on a single, shared line with custom features. If avoiding a slight interruption is crucial to your business, we recommend using a separate telephone line with no custom features.

Receiving Faxes

<table>
<thead>
<tr>
<th>Difficulties</th>
<th>Suggestions</th>
</tr>
</thead>
</table>
| Cannot receive a fax. | Check all line cord connections. Make sure the telephone line cord is plugged into the telephone wall jack and the LINE jack of the machine. If you subscribe to DSL, VoIP or MagicJack services, call your service provider for connection instructions. To lower the modem speed and turn off ECM (error correction mode), change the telephone line interference / VoIP settings. Make sure your machine has a dial tone by pressing Hook key or Hook button in Fax mode. If you hear static or interference on your fax line, contact your local telephone provider. Make sure the machine is in the correct Receive Mode. This is determined by the external devices and telephone subscriber services you have on the same line as the Dell machine.
|                    | • If you have a dedicated fax line and want your Dell machine to automatically answer all incoming faxes, you should select Fax only mode. |
|                    | • If your Dell machine shares a line with an external answering machine, you should select the External TAD mode. In External TAD mode, your Dell machine will automatically receive incoming faxes and voice callers will be able to leave a message on your answering machine. |
|                    | • If your Dell machine shares the line with a Voice Mail subscriber service, see Related Information: Voice Mail |
|                    | • If your Dell machine is on a line with the Distinctive Ring subscriber service, see Related Information: Distinctive Ring |
|                    | • If your Dell machine shares a line with other telephones and you want it to automatically answer all incoming faxes, you should select the Fax/Tel mode. In Fax/Tel mode, your Dell machine will automatically receive faxes and produce a pseudo/double-ring to alert you to answer voice calls. |
|                    | • If you do not want your Dell machine to automatically answer any incoming faxes, you should select the Manual mode. In Manual mode, you must answer every incoming call and activate the machine to receive faxes. |

Another device or service at your location may be answering the call before your Dell machine answers. To test this, lower the ring delay setting:

• If the Receive Mode is set to Fax Only or Fax/Tel, reduce the Ring Delay to 1 ring. See Related Information: Set the Number of Rings Before the Machine Answers (Ring Delay)
• If the Receive Mode is set to External TAD, reduce the number of rings programmed on your answering machine to 2.
• If the Receive Mode is set to Manual, DO NOT adjust the Ring Delay setting.
Have someone send you a test fax:

- If you received the test fax successfully, your machine is operating correctly. Remember to reset your Ring Delay or answering machine setting back to your original setting. If receiving problems recur after resetting the Ring Delay, then a person, device, or subscriber service is answering the fax call before the machine has a chance to answer.
- If you were not able to receive the fax, then another device or subscriber service may be interfering with your fax reception or there may be a problem with your fax line.

If you are using a telephone answering machine (External TAD mode) on the same line as the Dell machine, make sure your answering machine is set up correctly.

1. Plug the telephone line cord directly from the wall telephone jack to your Dell machine’s LINE jack.
2. Remove the protective cap from your Dell machine’s EXT jack, and then plug the telephone line cord from your answering machine into the EXT jack.
3. Set your answering machine to answer within 4 rings.
   - If you are having problems receiving faxes or voice messages, set your answering machine to answer within 2 or 3 rings.
4. Record the outgoing message on your answering machine.
   - Record five seconds of silence at the beginning of your outgoing message.
   - Limit your speaking to 20 seconds.
   - End your outgoing message with your Fax Receive Code for people sending manual faxes. For example: “After the beep, leave a message or press *51 and Start to send a fax.”
5. Set your answering machine to answer calls.
6. Set your Dell machine’s Receive Mode to External TAD.

**See Related Information: Choose the Correct Receive Mode**

Make sure your Dell machine’s Easy Receive feature is turned On. Easy Receive is a feature that allows you to receive a fax even if you answered the call on an external or extension telephone.

If you often get transmission errors due to possible interference on the telephone line, try changing the Compatibility setting to Basic(for VoIP).

<table>
<thead>
<tr>
<th>Sending Faxes</th>
<th>Difficulties</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot send a fax.</td>
<td>Check all line cord connections. Make sure the telephone line cord is plugged into the telephone wall jack and the LINE jack of the machine. If you subscribe to DSL, VoIP or MagicJack services, call your service provider for connection instructions.</td>
<td>Make sure you pressed Fax and the machine is in Fax mode. Print the Transmission Verification Report and check for an error. Ask the other party to check that the receiving machine has paper.</td>
</tr>
<tr>
<td>Poor sending quality.</td>
<td>Try changing your resolution to Fine or S.Fine. Make a copy to check your machine’s scanner operation. If the copy quality is not good, clean the scanner.</td>
<td></td>
</tr>
</tbody>
</table>

Transmission Verification Report says RESULT:NG.

There is probably temporary noise or static on the line. Try sending the fax again. If you are sending a PC-Fax message and get RESULT:NG on the Transmission Verification Report, your machine may be out of memory. To free up extra memory, you can turn off fax storage, print fax messages in memory or cancel a delayed fax or polling job. If the problem continues, ask the telephone company to check your telephone line.

If you often get transmission errors due to possible interference on the telephone line, try changing the Compatibility setting to Basic(for VoIP).
Troubleshooting

Sent faxes are blank. Make sure you are loading the document correctly. When using the ADF, the document should be face up. When using the scanner glass, the document should be face down.

Vertical black lines when sending. Black vertical lines on faxes you send are typically caused by dirt or correction fluid on the glass strip. Clean the glass strip.

### Printing received faxes

<table>
<thead>
<tr>
<th>Difficulties</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Condensed print</td>
<td>This is usually caused by a poor telephone connection. Make a copy; if your copy looks good, you probably had a bad connection, with static or interference on the telephone line. Ask the other party to send the fax again.</td>
</tr>
<tr>
<td>• Horizontal streaks</td>
<td></td>
</tr>
<tr>
<td>• Top and bottom sentences are cut off</td>
<td></td>
</tr>
<tr>
<td>• Missing lines</td>
<td></td>
</tr>
<tr>
<td>Vertical black lines when receiving</td>
<td>The corona wire for printing may be dirty. Clean the corona wire in the drum unit. The sender’s scanner may be dirty. Ask the sender to make a copy to see if the problem is with the sending machine. Try receiving from another fax machine.</td>
</tr>
</tbody>
</table>

| Received faxes appear as split or blank pages. | Left and right margins are cut off or a single page is printed on two pages. |

**Set Dial Tone Detection**

Related Models:Dell E515dn / Dell E515dw

1. **Setting the Dial Tone to Detection** will shorten the Dial Tone detect pause.
2. Press **Menu**.
3. Press ▲ or ▼ to display the **Initial Setup** option, and then press **OK**.
4. Press ▲ or ▼ to display the **Dial Tone** option, and then press **OK**.
5. Press ▲ or ▼ to choose the **Detection** or **No Detection**, and then press **OK**.
6. Press **Cancel**.

**Set Telephone Line Compatibility for Interference and VoIP Systems**

Related Models:Dell E515dn / Dell E515dw

Problems sending and receiving faxes due to possible interference on the telephone line may be solved by lowering the modem speed to minimize errors in fax transmission. If you are using a Voice over IP (VoIP) service, Dell recommends changing the compatibility to Basic (for VoIP).

**NOTE:** VoIP is a type of phone system that uses an Internet connection, rather than a traditional phone line.
1. Press Menu.
2. Press ▲ or ▼ to display the Fax option, and then press OK.
3. Press ▲ or ▼ to display the Miscellaneous option, and then press OK.
4. Press ▲ or ▼ to display the Compatibility option, and then press OK.
5. Press ▲ or ▼ to display the High, Normal, or Basic (for VoIP) option, and then press OK.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Select High to set the modem speed at 33600 bps.</td>
</tr>
<tr>
<td>Normal</td>
<td>Select Normal to set the modem speed at 14400 bps.</td>
</tr>
<tr>
<td>Basic (for VoIP)</td>
<td>Select Basic (for VoIP) to reduce the modem speed to 9600 bps and turn off Error Correction Mode (ECM). Unless interference is a recurring problem on your telephone line, you may prefer to use it only when needed. To improve compatibility with most VoIP services, Dell recommends changing the compatibility setting to Basic (for VoIP).</td>
</tr>
</tbody>
</table>

6. Press Cancel.

**Network Problems**

- **Error Messages**
  Your Dell machine will display an error message if an error occurs. The most common error messages are shown in the chart.
- **Where Can I Find My Dell Machine's Network Settings?**
- **I Cannot Complete the Wireless Network Setup Configuration.**
- **My Dell Machine Cannot Print or Scan over the Network.**
- **My Dell Machine is not Found on the Network Even After Successful Installation.**
- **My Security Settings are not Working Properly.**
- **I Want to Check that My Network Devices are Working Correctly.**

**Error Messages**

Related Models: Dell E514dw / Dell E515dw

Your Dell machine will display an error message if an error occurs. The most common error messages are shown in the chart.

<table>
<thead>
<tr>
<th>Error Messages</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot Connect</td>
<td>A device is already connected.</td>
<td>After the current connection between your Dell machine and another mobile device has shut down, try to configure the Wi-Fi Direct settings again. You can confirm the connection status by printing the Network Configuration Report.</td>
</tr>
<tr>
<td></td>
<td>Two mobile devices are already connected to the Wi-Fi Direct network when the Dell machine is the Group Owner (G/O).</td>
<td></td>
</tr>
<tr>
<td>Connection Error</td>
<td>Other devices are trying to connect to the Wi-Fi Direct network at the same time.</td>
<td>Make sure there are no other devices trying to connect to the Wi-Fi Direct network, and then try to configure the Wi-Fi Direct settings again.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Connection Fail | The Dell machine and your mobile device cannot communicate during the Wi-Fi Direct network configuration. | • Move the mobile device closer to your Dell machine.  
• Move your Dell machine and the mobile device to an obstruction-free area.  
• If you are using the PIN Method of WPS, make sure you have entered the correct PIN. |
|---------------|------------------------------------------------------------------------------------------------|-----------------------------------------------------------------------------------------------------------------------------------------|
| No Device     | When configuring the Wi-Fi Direct network, the Dell machine cannot find your mobile device.   | • Make sure your machine and mobile device are in the Wi-Fi Direct mode.  
• Move the mobile device closer to your Dell machine.  
• Move your Dell machine and the mobile device to an obstruction-free area.  
• If you are manually configuring the Wi-Fi Direct network, make sure you have entered the correct password.  
• If your mobile device has a configuration page for how to obtain an IP address, make sure the IP address of your mobile device has been configured via DHCP. |

**Where Can I Find My Dell Machine’s Network Settings?**

Use one of the following methods to find your Dell machine's network settings, for example, IP address, default gateway, and other settings:

- Print the Network Configuration Report
- Use your Dell machine's control panel

**I Cannot Complete the Wireless Network Setup Configuration.**

Related Models: Dell E514dw / Dell E515dw

Turn your wireless router off and back on. Then try to configure the wireless settings again. If you are unable to resolve the problem, follow the instructions below:

Investigate the problem using the WLAN Report.
<table>
<thead>
<tr>
<th>Cause</th>
<th>Action</th>
<th>Interface</th>
</tr>
</thead>
</table>
| Your security settings (SSID/Network Key) are not correct. | • Select and confirm that you are using the correct security settings.  
• See the instructions supplied with your wireless LAN access point/router for information on how to find the security settings.  
• The manufacturer's name or model number of the wireless LAN access point/router may be used as the default security settings.  
• Consult with the access point/router manufacturer, your Internet provider, or network administrator.  
• For definitions of SSID and Network Key, see the entries SSID, Network Key and Channels in the Glossary. | Wireless |
| Your Dell machine's MAC address is not allowed. | Confirm that the Dell machine's MAC Address is allowed in the filter. You can find the MAC Address in your Dell machine's control panel. | Wireless |
| Your wireless LAN access point/router is in stealth mode (not broadcasting the SSID). | • Enter the correct SSID name or Network Key manually.  
• Check the SSID name or the Network Key in the instructions supplied with your wireless LAN access point/router and reconfigure the wireless network setup. | Wireless |
| Your security settings (SSID/password) are not correct. | • Confirm the SSID and password.  
• When you are configuring the network manually, the SSID and password are displayed on your Dell machine. If your mobile device supports the manual configuration, the SSID and password will be displayed on your mobile device's screen.  
• For the definition of SSID, see the Glossary. | Wi-Fi Direct |
| You are using Android™ 4.0. | If your mobile device disconnects (approximately six minutes after using Wi-Fi Direct), try the one-push configuration using WPS (recommended) and set the Dell machine as a G/O. | Wi-Fi Direct |
| Your Dell machine is placed too far from your mobile device. | Move your Dell machine within about 3.3 feet (1 meter) of the mobile device when you configure the Wi-Fi Direct network settings. | Wi-Fi Direct |
| There are some obstructions (walls or furniture, for example) between your machine and the mobile device. | Move your Dell machine to an obstruction-free area. | Wi-Fi Direct |
| There is a wireless computer, Bluetooth-supported device, microwave oven, or digital cordless phone near the Dell machine or the mobile device. | Move other devices away from the Dell machine or the mobile device. | Wi-Fi Direct |
| If you have checked and tried all of the above, but still cannot complete the Wi-Fi Direct configuration, do the following: | • Turn your Dell machine off and back on. Then try to configure the Wi-Fi Direct settings again.  
• If you are using your Dell machine as a client, confirm how many devices are allowed in the current Wi-Fi Direct network, and then check how many devices are connected. | Wi-Fi Direct |
## My Dell Machine Cannot Print or Scan over the Network.

<table>
<thead>
<tr>
<th>Cause</th>
<th>Action</th>
<th>Interface</th>
</tr>
</thead>
</table>
| Your security software blocks your machine's access to the network. (The network scanning feature does not work.) | **(Windows®)**  
Configure the third-party Security/Firewall Software to allow Network scanning. To add port 54925 for Network scanning, type the information below:  
- **In Name:** Type any description, for example Dell NetScan.  
- **In Port number:** Type 54925.  
- **In Protocol:** UDP is selected.  
See the instruction manual that came with your third-party Security/Firewall Software or contact the software manufacturer.  
**(Macintosh)**  
Click the **Model** pop-up menu, and then select **Other....**  
The **Device Selector** window appears. Reselect your network machine, make sure **Status** is **idle**, and then click **OK**. | Wired/Wireless |
| Wired/Wireless Your security software blocks your machine's access to the network.         | **Some security software might block access without showing a security alert dialog box even after successful installation.**  
To allow access, see the instructions for your security software or ask the software manufacturer. | Wired/Wireless |
| Wired/Wireless Your Dell machine was not assigned an available IP address.                 | **Confirm the IP address and the Subnet Mask.**  
Verify that both the IP addresses and Subnet Masks of your computer and the Dell machine are correct and located on the same network.  
For more information about how to verify the IP address and the Subnet Mask, ask your network administrator. | Wired/Wireless |
The failed print job is still in your computer's print queue.

- If the failed print job is still in your computer's print queue, delete it.
- Otherwise, double-click the printer icon in the following folder and cancel all documents:
  - (Windows Server® 2003) Click **Start > Printers and Faxes**.
  - (Windows Vista®)
    - Click **Start > Control Panel > Hardware and Sound > Printers**.
  - (Windows® 7)
    - Click **Start > Devices and Printers > Printers and Faxes**.
  - (Windows® 8)
    - Move your mouse to the lower right corner of your desktop. When the menu bar appears, click **Settings > Control Panel**. In the **Hardware and Sound** group, click **View devices and printers > Printers**.
  - (Windows Server® 2008)
    - Click **Start > Control Panel > Printers**.
  - (Windows Server® 2012)
    - Move your mouse to the lower right corner of your desktop. When the menu bar appears, click **Settings > Control Panel**. In the **Hardware** group, click **View devices and printers > Printers**.
  - (For Windows Server® 2012 R2)
    - Click **Control Panel** on the **Start** screen. In the **Hardware** group, click **View devices and printers**.
  - OS X v10.8.x
    - Click the **System Preferences > Print & Scan**.
  - OS X v10.9.x, v10.10.x
    - Click the **System Preferences > Printers & Scanners**.

---

### My Dell Machine is not Found on the Network Even After Successful Installation.

<table>
<thead>
<tr>
<th>Cause</th>
<th>Action</th>
<th>Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your security software blocks your machine's access to the network.</td>
<td>Some security software might block access without showing a security alert dialog box even after successful installation. To allow access, see the instructions for your security software or ask the manufacturer.</td>
<td>Wired/Wireless</td>
</tr>
<tr>
<td>Your Dell machine is not assigned with an available IP address.</td>
<td>Confirm the IP address and the Subnet Mask. Verify that both the IP addresses and Subnet Masks of your computer and the Dell machine are correct and located on the same network. For more information on how to verify the IP address and the Subnet Mask, ask your network administrator.</td>
<td>Wired/Wireless</td>
</tr>
</tbody>
</table>
Your Dell machine is not connected to the network using wireless capabilities.  
Print the WLAN Report to check the error code on the printed report.  

My Security Settings are not Working Properly.

<table>
<thead>
<tr>
<th>Cause</th>
<th>Action</th>
<th>Interface</th>
</tr>
</thead>
</table>
| When using the printing/scanning features, you did not accept the    | If you did not accept the security alert dialog box, the firewall function of your security software may be rejecting access.  
security alert dialog box.                                             | Wired/Wireless            |
|                                                                       | Some security software might block access without showing a security alert dialog box.                              |
|                                                                       | To allow access, see the instructions for your security software or ask the manufacturer.                          |                          |
| The required port number for the security software setting may be     | The following port numbers are used for Dell network features:                                                 | Wired/Wireless            |
| closed.                                                               | • Network scanning *1: Port number 54925 / Protocol UDP                                                        |                          |
|                                                                       | • Network scanning/printing *1: Port number 161 and 137 / Protocol UDP                                         |                          |
|                                                                       | For more information on how to open the port, see the instructions for the security software or ask the         |                          |
|                                                                       | manufacturer.                                                                                                    |                          |

*1: Windows®

I Want to Check that My Network Devices are Working Correctly.

<table>
<thead>
<tr>
<th>Check</th>
<th>Action</th>
<th>Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check that your Dell machine, access point/router, or network hub is</td>
<td>Check the following:</td>
<td>Wired/Wireless</td>
</tr>
<tr>
<td>turned on.</td>
<td>• The power cord is connected correctly and the Dell machine is turned on.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The access point/router or hub is turned on and its link button is blinking.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• All protective packaging has been removed from the machine.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The toner cartridge and drum unit are installed correctly.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The front and back covers are fully closed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Paper is inserted correctly in the paper tray.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• (For wired networks) A network cable is securely connected to the Dell machine and to the router or hub.</td>
<td></td>
</tr>
<tr>
<td>Check the <strong>Link Status</strong> in the Network Configuration Report.</td>
<td>Print the Network Configuration Report and check that <strong>Ethernet Link Status or Wireless Link Status</strong> is <strong>Link OK</strong></td>
<td>Wired/Wireless</td>
</tr>
</tbody>
</table>
Check that you can "ping" the Dell machine from your computer.

Ping the Dell machine from your computer using the IP address or the node name at the Windows® command prompt or Macintosh Terminal application:

\texttt{ping <ipaddress> \textnormal{or} <nodename>}.  

- Successful: Your Dell machine is working correctly and connected to the same network as your computer.
- Unsuccessful: Your Dell machine is not connected to the same network as your computer.

(Windows®)
Ask the network administrator and use the Network Connection Repair Tool to fix the IP address and the subnet mask.

(Macintosh)
Confirm that the IP address and the Subnet Mask are set correctly.

Check that your Dell machine is connected to the wireless network.

Print the WLAN Report to check the error code on the printed report.

If you have checked and tried all of the above but you are still having problems, see the instructions supplied with your wireless LAN access point/router to find the SSID and the Network Key information and set them correctly.

### Other Problems

<table>
<thead>
<tr>
<th>Difficulties</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The machine will not turn on.</td>
<td>Adverse conditions on the power connection (such as lightning or a power surge) may have triggered the machine's internal safety mechanisms. Unplug the power cord. Wait for ten minutes, then plug in the power cord and press \texttt{[1]} to turn on the machine.</td>
</tr>
<tr>
<td></td>
<td>If the problem is not solved, press and hold \texttt{[1]} to turn off the machine. If you are using a backup battery or surge suppressor device, disconnect it to make sure it is not the problem. Plug the machine's power cord directly into a different known working wall outlet and press \texttt{[1]} to turn on the machine.</td>
</tr>
</tbody>
</table>
The machine cannot print EPS data that includes binary with the Dell emulate PS printer driver.

**Windows®**

To print EPS data, do the following:

1. For Windows® 7 and Windows Server® 2008 R2:
   - Click the (Start) button > Devices and Printers.
   - For Windows Vista® and Windows Server® 2008:
     - Click the (Start) button > Control Panel > Hardware and Sound > Printers.
   - For Windows Server® 2003:
     - Click the Start button > Printers and Faxes.
   - For Windows® 8 and Windows Server® 2012:
     - Move your mouse to the lower right corner of your desktop. When the menu bar appears, click Settings > Control Panel. In the Hardware and Sound group, click View devices and printers.
   - For Windows Server® 2012 R2:
     - Click Control Panel on the Start screen. In the Hardware group, click View devices and printers.

2. Right-click the Dell MFP EXXXX PS emulate icon, select Printer properties.

3. From the Device Settings tab, choose TBCP (Tagged binary communication protocol) in Output Protocol.

**Macintosh**

If your machine is connected to a computer with a USB interface, you cannot print EPS data that includes binary. You can print the EPS data at the machine through a network.

The Dell software cannot be installed.

**Windows®**

If the Security Software warning appears on the computer screen during the installation, change the Security Software settings to permit the Dell product setup program or other program to run.

**Macintosh**

If you are using a firewall function of anti-spyware or antivirus security software, temporarily disable it and then install the Dell software.

---

*1: For Windows Server® 2012: Hardware and Sound

### Copying difficulties

<table>
<thead>
<tr>
<th>Difficulties</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot make a copy.</td>
<td>Make sure you pressed Copy and the machine is in Copy mode.</td>
</tr>
<tr>
<td>Vertical black line appears in copies.</td>
<td>Black vertical lines on copies are typically caused by dirt or correction fluid on the glass strip, or the corona wire is dirty. Clean the glass strip and scanner glass and the white bar and white plastic above them.</td>
</tr>
<tr>
<td>Copies are blank.</td>
<td>Make sure you are loading the document correctly.</td>
</tr>
</tbody>
</table>

### Scanning difficulties

<table>
<thead>
<tr>
<th>Difficulties</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>TWAIN or Windows Image Acquisition (WIA) errors appear when starting to scan. (Windows®)</td>
<td>Make sure the Dell TWAIN or Windows Image Acquisition (WIA) driver is selected as the primary source in your scanning application.</td>
</tr>
<tr>
<td>TWAIN or ICA errors appear when starting to scan. (Macintosh)</td>
<td>Make sure the Dell TWAIN driver is selected as the primary source. You can also scan documents using the ICA Scanner Driver.</td>
</tr>
</tbody>
</table>
Error and Maintenance Messages

As with any sophisticated office product, errors may occur and supply items may have to be replaced. If this happens, your machine identifies the error or required routine maintenance and shows the appropriate message. The most common error and maintenance messages are shown in the table.

Follow the instructions in the Actions to improve the status.

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-sided Disabled</td>
<td>The back cover of the machine is not closed completely.</td>
<td>Close the back cover of the machine until it locks in the closed position.</td>
</tr>
<tr>
<td></td>
<td>The 2-sided tray is not installed completely.</td>
<td>Install the 2-sided tray firmly in the machine.</td>
</tr>
<tr>
<td>Cartridge Error</td>
<td>The toner cartridge is not installed correctly.</td>
<td>Pull out the drum unit and toner cartridge assembly, take out the toner cartridge, and put it back in the drum unit again. Put the drum unit and toner cartridge assembly back in the machine. If the problem continues, contact Dell Customer Service or your local Dell dealer.</td>
</tr>
<tr>
<td>Comm. Error</td>
<td>Poor telephone line quality caused a communication error.</td>
<td>Send the fax again or connect the machine to another telephone line. If the problem continues, contact the telephone company and ask them to check your telephone line.</td>
</tr>
<tr>
<td>Cover is Open.</td>
<td>The front cover is not completely closed.</td>
<td>Open and then firmly close the front cover of the machine.</td>
</tr>
<tr>
<td></td>
<td>The fusing unit cover is not completely closed or paper was jammed in the back of the machine when you turned on the power.</td>
<td>Close the fusing unit cover located inside the back cover of the machine.</td>
</tr>
<tr>
<td></td>
<td>The ADF cover is not completely closed.</td>
<td>Close the ADF cover of the machine. If the error message remains, press Cancel.</td>
</tr>
<tr>
<td>Disconnected</td>
<td>The other person or other person’s fax machine stopped the call.</td>
<td>Try to send or receive again. If calls are stopped repeatedly and you are using a VoIP (Voice over IP) system, try changing the Compatibility to Basic (for VoIP).</td>
</tr>
<tr>
<td>Document Jam</td>
<td>The document was not inserted or fed correctly, or the document scanned from the ADF was too long.</td>
<td>Remove the jammed paper from the ADF unit. Clear any debris or scraps of paper from the ADF unit paper path. Press Cancel.</td>
</tr>
<tr>
<td>DR Mode in Use</td>
<td>The machine is set to Distinctive Ring mode. You cannot change the Receive Mode from Manual to another mode.</td>
<td>Set Distinctive Ring to Off.</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>Description</td>
<td>Solution</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Drum !</td>
<td>The corona wire on the drum unit must be cleaned.</td>
<td>Clean the corona wire on the drum unit.</td>
</tr>
<tr>
<td>Drum End Soon</td>
<td>The drum unit is near the end of its life.</td>
<td>Order a new drum unit before you get the Replace Drum message.</td>
</tr>
<tr>
<td>Jam 2-sided</td>
<td>The paper is jammed in the 2-sided paper tray.</td>
<td>Pull the paper tray and the 2-sided tray out completely, open the back cover and then remove the jammed paper. Close the back cover, and put the paper tray and the 2-sided tray firmly back in the machine.</td>
</tr>
<tr>
<td>Jam Inside</td>
<td>The paper is jammed inside the machine.</td>
<td>Open the front cover and remove the toner cartridge and drum unit assembly. Pull out the jammed paper. Close the front cover. If the error message remains, press Start.</td>
</tr>
<tr>
<td>Jam Rear</td>
<td>The paper is jammed in the back of the machine.</td>
<td>Open the fusing unit cover and remove the jammed paper. Close the fusing unit cover. If the error message remains, press Start.</td>
</tr>
<tr>
<td>Jam Tray</td>
<td>The paper is jammed in the paper tray.</td>
<td>Pull the paper tray out completely and remove the jammed paper. Put the paper tray firmly back in the machine.</td>
</tr>
<tr>
<td>Manual Feed</td>
<td>Manual was selected as the paper source in the printer driver when there was no paper in the manual feed slot.</td>
<td>Place paper in the manual feed slot.</td>
</tr>
<tr>
<td>No Caller ID</td>
<td>There is no incoming call history. You did not receive calls or you have not subscribed to the Caller ID service from your telephone company.</td>
<td>If you want to use the Caller ID feature, call your telephone company.</td>
</tr>
</tbody>
</table>
| No Paper              | The machine is out of paper, or paper is not loaded correctly in the paper tray. | • Refill paper in the paper tray. Make sure the paper guides are set to the correct size.  
• Remove the paper and load it again. Make sure the paper guides are set to the correct size.  
• Make sure not to overfill the paper tray. |
<table>
<thead>
<tr>
<th>Issue</th>
<th>Description</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Response/Busy</td>
<td>The number you dialed does not answer or is busy.</td>
<td>Verify the number and try again.</td>
</tr>
<tr>
<td>No Toner</td>
<td>The toner cartridge or the toner cartridge and drum unit assembly is not installed correctly.</td>
<td>Remove the toner cartridge and drum unit assembly. Remove the toner cartridge from the drum unit, and reinstall the toner cartridge back in the drum unit. Reinstall the toner cartridge and drum unit assembly back in the machine. If the problem continues, replace the toner cartridge with a new one.</td>
</tr>
<tr>
<td>Out of Memory</td>
<td>The machine’s memory is full.</td>
<td><strong>If a fax-sending or copy operation is in process</strong>&lt;br&gt;Do one of the following:&lt;br&gt;• Press <strong>Start</strong> to send or copy the scanned pages.&lt;br&gt;• Press <strong>Cancel</strong> and wait until the other operations in progress finish, and then try again.&lt;br&gt;• Print the faxes that are in the memory.&lt;br&gt;• Clear the data in the memory. To gain extra memory, you can turn off Memory Receive.&lt;br&gt;<strong>If a print operation in process</strong>&lt;br&gt;Do one of the following:&lt;br&gt;• Reduce the print resolution.&lt;br&gt;• Clear the faxes from the memory.</td>
</tr>
<tr>
<td>Print Unable XX</td>
<td>The machine has a mechanical problem.</td>
<td>• Press and hold 1 to turn off the machine, wait a few minutes, and then turn it on again.&lt;br&gt;• If the problem continues, contact Dell Customer Service.</td>
</tr>
<tr>
<td>Replace Drum</td>
<td>It is time to replace the drum unit.</td>
<td>Replace the drum unit.</td>
</tr>
<tr>
<td>Replace New Toner</td>
<td>The toner cartridge is at the end of its life. The machine stops all print operations. While memory is available, faxes are stored in the memory.</td>
<td>Replace the toner cartridge with a new one.</td>
</tr>
<tr>
<td>Scan Unable XX</td>
<td>The machine has a mechanical problem.</td>
<td>• Press and hold 1 to turn off the machine, and then turn it on again.&lt;br&gt;• If the problem continues, contact Dell Customer Service.</td>
</tr>
<tr>
<td>Self-Diagnostic</td>
<td>The temperature of the fusing unit does not rise to a specified temperature within the specified time. The fusing unit is too hot.</td>
<td>• Press and hold 1 to turn off the machine, wait a few seconds, and then turn it on again. Leave the machine idle for 15 minutes with the power on.</td>
</tr>
</tbody>
</table>
Troubleshooting

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size Error DX</td>
<td>The paper size specified in the printer driver and the machine’s menu are not available for automatic 2-sided printing.</td>
<td>Press <strong>Cancel</strong>. Choose a paper size supported by 2-sided printing. Paper sizes available for automatic 2-sided printing are Letter, Legal and Folio. The paper in the tray is not the correct size and is not available for automatic 2-sided printing. Load the correct size of paper in the tray and set the tray size for that paper size. Paper sizes available for automatic 2-sided printing are Letter, Legal and Folio.</td>
</tr>
<tr>
<td>Size mismatch</td>
<td>The paper in the tray is not the correct size.</td>
<td>Load the correct size of paper in the tray and set the size of paper to the tray.</td>
</tr>
<tr>
<td>Toner Low</td>
<td>If the LCD displays this message you can still print. The toner cartridge is near the end of its life.</td>
<td>Order a new toner cartridge now so a replacement toner cartridge is available when the LCD shows <strong>Replace New Toner</strong>.</td>
</tr>
<tr>
<td>Wait for a while</td>
<td>The temperature of the inside of the machine is too hot. The machine will pause its current print job and go into cooling down mode. During the cooling down mode, you will hear the cooling fan running while the LCD displays <strong>Wait for a while</strong>.</td>
<td>Make sure you can hear the fan in the machine spinning and that the exhaust outlet is not blocked by something. If the fan is spinning, remove any obstacles that surround the exhaust outlet, and then leave the machine turned on but do not use it for several minutes. If the fan is not spinning, disconnect the machine from the power for several minutes, then reconnect it.</td>
</tr>
</tbody>
</table>

Transfer Your Faxes or Fax Journal Report

Related Models: Dell E515dn / Dell E515dw

If the LCD shows:
- **Print Unable XX**
- **Scan Unable XX**

We recommend transferring your faxes to another fax machine or to your computer.

You can also transfer the Fax Journal report to see if there are any faxes you must transfer.

**NOTE:** If there is an error message on the LCD after the faxes have been transferred, disconnect the machine from the power source for several minutes, and then reconnect it.

Transfer Faxes to Another Fax Machine

Related Models: Dell E515dn / Dell E515dw

If you have not set up your Station ID, you cannot enter fax transfer mode.

1. Press **Menu**.
2. Press ▲ or ▼ to display the **Service** option, and then press **OK**.
3. Press **OK** to select **Data Transfer**.
4. Press ▲ or ▼ to display the **Fax Transfer** option, and then press **OK**.
5. Do one of the following:
   - If the LCD shows **No Data**, there are no faxes left in the machine’s memory. Press **Cancel**.
   - Enter the fax number to which faxes will be forwarded. Press **Start**.

266 | Troubleshooting
Transfer the Fax Journal Report to Another Fax Machine

Related Models: Dell E515dn / Dell E515dw

If you have not set up your Station ID, you cannot enter fax transfer mode.

1. Press Menu.
2. Press ▲ or ▼ to display the Service option, and then press OK.
3. Press OK to select Data Transfer.
4. Press ▲ or ▼ to display the Report Trans. option, and then press OK.
5. Enter the destination fax number for the Fax Journal.
6. Press Start.

Document Jams

• Document is Jammed in the Top of the ADF Unit
• Document is Jammed under the Document Cover
• Remove Small Scraps of Paper Jammed in the ADF

Document is Jammed in the Top of the ADF Unit

1. Remove any paper from the ADF that is not jammed.
2. Open the ADF cover.
3. Pull the jammed document out to the left. If the document rips or tears, be sure you remove any debris or scraps to prevent future jams.
4. Close the ADF cover.
5. Press Cancel.

Document is Jammed under the Document Cover

1. Remove any paper from the ADF that is not jammed.
2. Lift the document cover.
3. Pull the jammed document out to the right. If the document rips or tears, be sure you remove any debris or
scraps to prevent future jams.

4. Close the document cover.
5. Press Cancel.

Remove Small Scraps of Paper Jammed in the ADF

1. Lift the document cover.
2. Insert a piece of stiff paper, such as cardstock, into the ADF to push any small paper scraps through.

3. Close the document cover.
4. Press Cancel.

Paper Jams

Always remove the remaining paper from the paper tray and straighten the stack when you are adding new paper. This helps prevent multiple sheets of paper from feeding through the machine at one time and prevents paper jams.
- Paper is Jammed in the Paper Tray
- Paper is Jammed in the Output Paper Tray
• Paper is Jammed at the Back of the Machine
• Paper is Jammed inside the Machine
• Paper is Jammed in the 2-sided Tray

**Paper is Jammed in the Paper Tray**

If the machine's control panel or the Status Monitor (for Macintosh only) displays there is a jam in the paper tray, do the following steps.

1. Pull the paper tray completely out of the machine.

   ![Paper Tray Out](image)

2. Slowly pull out the jammed paper.

   ![Pulling Jammed Paper](image)

   Pulling the jammed paper downward using both hands allows you to remove the paper more easily.

3. Fan the stack of paper to prevent further jams, and slide the paper guides to fit the paper size.
4. Make sure the paper is below the "MAX" mark.

5. Put the paper tray firmly back in the machine.

**Paper is Jammed in the Output Paper Tray**

When the paper is jammed in the output paper tray, do the following:

1. Use both hands to open the scanner.
2. Remove the paper.

3. Push the scanner down with both hands to close it.
Paper is Jammed at the Back of the Machine

If the machine's control panel or the Status Monitor (for Macintosh only) indicates that there is a jam in the back (Rear) of the machine, complete the following:

1. Leave the machine turned on for 10 minutes. This allows the internal fan to cool the extremely hot parts inside the machine.

2. Open the back cover.

3. Pull the black tabs at the left and right sides toward you to release the fusing unit cover.
⚠️ WARNING

HOT SURFACE

The machine's internal parts will be extremely hot. Wait for the machine to cool down before touching them.

4. Use both hands to gently pull the jammed paper out of the fusing unit.

5. Close the fusing unit cover. Make sure the black tabs at the left and right sides lock into place.
6. Close the back cover until it locks in the closed position.

**Paper is Jammed inside the Machine**

If the machine's control panel or the Status Monitor (for Macintosh only) indicates that there is a jam inside the machine, do the following:

⚠️ **CAUTION**

Do not attempt to remove a paper jammed deeply inside the product, particularly a paper wrapped around a heat roller. Otherwise, it may cause injuries or burns, and even worse, may generate smoke if you keep operating the product with a paper jammed. Switch off the product promptly and contact your local Dell representative for more information.

1. Leave the machine turned on for 10 minutes. This allows the internal fan to cool the extremely hot parts inside the machine.
2. Open the front cover.
3. Remove the toner cartridge and drum unit assembly.
WARNING
HOT SURFACE
The machine’s internal parts will be extremely hot. Wait for the machine to cool down before touching them.

4. Pull out the jammed paper slowly.

5. Install the toner cartridge and drum unit assembly into the machine.
6. Close the front cover.

**Paper is Jammed in the 2-sided Tray**

If the machine's control panel or the Status Monitor (for Macintosh only) indicates that there is a jam in the 2-sided paper tray, do the following:

1. Leave the machine turned on for 10 minutes. This allows the internal fan to cool the extremely hot parts inside the machine.
2. Pull the paper tray completely out of the machine.

3. At the back of the machine, pull the 2-sided tray completely out of the machine.

4. Pull the jammed paper out of the machine or out of the 2-sided tray.
5. Remove paper that may have jammed under the machine due to static electricity.

6. If paper is not caught inside the 2-sided tray, open the back cover.
WARNING
HOT SURFACE
The machine’s internal parts will be extremely hot. Wait for the machine to cool down before touching them.

7. Use both hands to gently pull the jammed paper out of the back of the machine.

8. Close the back cover until it locks in the closed position.
9. Put the 2-sided tray firmly back in the rear of the machine.
10. Put the paper tray firmly back in the front of the machine.
Improve the Print Quality

If you have a print quality problem, print a test page first. If the printout looks good, the problem is probably not the machine. Check the interface cable connections and try printing a different document. If the printout or test page printed from the machine has a quality problem, check the examples of poor print quality in the table and follow the recommendations.

IMPORTANT

Using non-Dell supplies may affect the print quality, hardware performance, and machine reliability.

1. To get the best print quality, we suggest using recommended print media. Make sure you use paper that meets our specifications.

2. Check that the toner cartridge and drum unit are installed correctly.

<table>
<thead>
<tr>
<th>Examples of poor print quality</th>
<th>Recommendation</th>
</tr>
</thead>
</table>
| Faint                         | • If the machine indicates Replace New Toner status, put in a new toner cartridge.  
|                               | • Check the machine’s environment. Conditions such as humidity, high temperatures, and so on, may cause this print fault.  
|                               | • If the whole page is too light, Toner Save may be turned on. Turn off Toner Save mode in the machine’s menu settings or the printer driver.  
|                               | • Clean the drum unit.  
|                               | • Clean the corona wire of the drum unit.  
|                               | • Replace the toner cartridge with a new toner cartridge.  
|                               | • Replace the drum unit with a new drum unit.  
| Gray background               | • Check the machine’s environment. Conditions such as high temperatures and high humidity can increase the amount of background shading.  
|                               | • Clean the drum unit.  
|                               | • Replace the toner cartridge with a new toner cartridge.  
|                               | • Replace the drum unit with a new drum unit.  |
Troubleshooting

**Ghost**

- Check the machine’s environment. Conditions such as low humidity and low temperatures may cause this print quality problem.
- Select the appropriate media type in the printer driver.
- Make sure the two levers inside the back cover are in the up position. Pull up the two levers until they stop.

![Ghost Image]

- Clean the drum unit.
- Replace the drum unit with a new drum unit.
- Replace the toner cartridge with a new toner cartridge.
- The fusing unit may be contaminated.
  Contact Dell Customer Service.

**Toner specks**

- Clean the corona wire on the drum unit.
- The drum unit may be damaged.
  Replace the drum unit with a new drum unit.
- The fusing unit may be contaminated.
  Contact Dell Customer Service.

**Hollow print**

- Select **Thick Paper** mode in the printer driver or use thinner paper than you are currently using.
- Check the machine’s environment. Conditions such as high humidity can cause hollow print.
- The drum unit may be damaged.
  Replace the drum unit with a new drum unit.
**All black**

- Clean the corona wire inside the drum unit by sliding the tab. Make sure you return the tab to the home position (▲).
- The drum unit may be damaged.
  Replace the drum unit with a new drum unit.

**White lines across the page**

- Select the appropriate media type in the printer driver.
- The problem may disappear by itself. Print multiple blank pages to clear this problem, especially if the machine has not been used for a long time.
- Clean the drum unit.
- The drum unit may be damaged.
  Replace the drum unit with a new drum unit.

**Lines across the page**

- Clean the corona wire inside the drum unit.
- Clean the drum unit.
- The drum unit may be damaged.
  Replace the drum unit with a new drum unit.

**White lines, bands or ribbing across the page**

- Check the machine's environment. Conditions such as high humidity and high temperatures may cause this print quality problem.
- Clean the drum unit.
- If the problem is not solved after printing a few pages, replace the drum unit with a new drum unit.
White Spots on black text and graphics at 3.7 in. (94 mm) intervals

• Make 10-15 copies of a blank, white sheet of paper. If the problem is not solved after printing the blank pages, the drum unit may have foreign material, such as glue from a label, stuck on the drum. Clean the drum unit.
• The drum unit may be damaged. Replace the drum unit with a new drum unit.

Black spots at 3.7 in. (94 mm) intervals

• If you use label sheets for laser printers, the glue from the sheets may sometimes stick to the drum surface. Clean the drum unit.
• If you used paper that has clips or staples, the drum unit may be damaged.
• If the unpacked drum unit is in direct sunlight (or room light for long periods of time), the unit may be damaged.
• Clean the drum unit.
• The toner cartridge may be damaged. Replace the toner cartridge with a new toner cartridge.
• The drum unit may be damaged. Replace the drum unit with a new drum unit.

Black toner marks across the page

• Clean the corona wire inside the drum unit by sliding the tab. Make sure you return the tab to the home position (▲).
• The toner cartridge may be damaged. Replace the toner cartridge with a new toner cartridge.
• The drum unit may be damaged. Replace the drum unit with a new drum unit.
• The fusing unit may be contaminated. Contact Dell Customer Service.

Black lines down the page Printed pages have toner stains down the page
White lines down the page

- Make sure foreign material such as a torn piece of paper, sticky notes or dust is not inside the machine and around the toner cartridge and drum unit.
- The toner cartridge may be damaged. Replace the toner cartridge with a new toner cartridge.
- The drum unit may be damaged. Replace the drum unit with a new drum unit.

Image skewed

- Make sure the paper or other print media is loaded correctly in the paper tray and the guides are not too tight or too loose against the paper stack.
- Set the paper guides correctly.
- The paper tray may be too full.
- Check the paper type and quality.
- Check for loose objects such as torn paper inside the machine.
- (For automatic 2-sided printing models)
  If the problem only occurs during 2-sided printing, check for torn paper in the 2-sided tray, verify the 2-sided tray is inserted completely and the back cover is closed completely.

Curl or wavy

- Check the paper type and quality. High temperatures and high humidity will cause paper to curl.
- If you do not use the machine often, the paper may have been in the paper tray too long. Turn over the stack of paper in the paper tray. Also, fan the paper stack, and then rotate the paper 180° in the paper tray.
- Open the back cover (face-up output tray) to let the printed paper exit onto the face-up output tray.
- Choose Reduce Paper Curl mode in the printer driver when you do not use our recommended print media.

Wrinkles or creases

- Make sure paper is loaded correctly.
- Check the paper type and quality.
- Turn over the stack of paper in the tray or rotate the paper 180° in the input tray.
• Make sure the two levers inside the back cover are in the up position. Pull up the two levers until they stop.

• Make sure the media type setting in the driver matches the type of paper you are using.
• Choose **Improve Toner Fixing** mode in the printer driver. If this selection does not provide enough improvement, change the printer driver setting in **Media Type** to a thick setting. If you are printing an envelope, choose **Env. Thick** in the media type setting.

• Make sure the two levers inside the back cover are pulled down to the envelope position when you print envelopes. After you have finished printing, reset the levers back to their original positions. Pull up the levers until they stop.

• Make sure envelopes are printed with the back cover (face-up output tray) opened.
• Make sure envelopes are fed only from the manual feed slot.
Machine Information

• Check the Serial Number
• Check the Firmware
• Reset Functions
• How to Reset the Machine

Check the Serial Number

1. Press Menu.
2. Press ▲ or ▼ to display the Machine Info. option, and then press OK.
3. Press ▲ or ▼ to display the Serial No. option, and then press OK.
   The machine displays the serial number on the LCD.
4. Press Cancel.

Check the Firmware

1. Press Menu.
2. Press ▲ or ▼ to display the Machine Info. option, and then press OK.
3. Press ▲ or ▼ to display the Version option, and then press OK.
   The machine displays the firmware version on the LCD.
4. Press Cancel.

Reset Functions

The following reset functions are available:

NOTE: Unplug the interface cable before you choose Network Settings Reset function, All Settings Reset function or Factory Reset function.

NOTE: Subdivided reset functions are not available for some models.

1. Machine Reset
   This function resets the following settings:
   • Programmed fax jobs in the memory (For Dell E515dn/Dell E515dw) (Delayed Fax, Batch TX)
   • Coverpage Message (For Dell E515dn/Dell E515dw)
   • Remote Fax Options (For Dell E515dn/Dell E515dw) (Remote Access Code, Fax Storage, Fax Forwarding and PC-Fax Send)
   • Setting Lock password (For Dell E515dn/Dell E515dw)
   • Language Setting

2. Network Settings Reset
   You can reset the print server back to its default factory settings, such as the password and IP address information.

3. Address Book and Fax Settings Reset (For Dell E515dn/Dell E515dw)
This function resets the following settings:

- Address Book
  (One Touch Dial / Speed Dial / Setup Groups)
- Programmed fax jobs in the memory
  (Delayed Fax, Batch TX)
- Station ID
  (name and number)
- Coverpage Message
- Remote Fax Options
  (Remote Access Code, Fax Storage, Fax Forwarding and PC-Fax Send)
- Report
  (Transmission Verification Report / Tel Index List / Fax Journal)
- Setting Lock password

4. All Settings Reset
   You can reset all the machine’s settings back to the settings that were set at the factory.
   All Settings Reset takes less time than Factory Reset.

5. Factory Reset (For Dell E515dn/Dell E515dw)
   Use the Settings Reset function to reset all machine settings to the settings originally set at the factory.
   Factory Reset takes more time than All Settings Reset.
   Dell strongly recommends you perform this operation when you dispose of the machine.

   **NOTE:** Unplug the interface cable before you choose Network Settings Reset function, All Settings Reset function or Factory Reset function.

**How to Reset the Machine**

1. Press **Menu**.

2. Do one of the following:
   - For Dell E515dn/Dell E515dw
     Press ▲ or ▼ to display the Initial Setup option, and then press **OK**.
   - For Dell E514dw
     Press ▲ or ▼ to display the General Setup option, and then press **OK**.

3. Press ▲ or ▼ to display the Reset option, and then press **OK**.

4. Press ▲ or ▼ to choose the type of reset you want to perform, and then press **OK**.
   **NOTE:** Subdivided reset functions are not available for some models.

5. Press the option in the table to reset the machine or to exit the process.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 or ▲</td>
<td>Reset the machine.</td>
</tr>
<tr>
<td>2 or ▼</td>
<td>The machine will exit and cancel the reset menu.</td>
</tr>
</tbody>
</table>

The LCD displays Reboot OK?.
6. Press the option in the table to reboot the machine or to exit the process.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 or ▲</td>
<td>Reboot the machine. The machine will begin the reset.</td>
</tr>
<tr>
<td>2 or ▼</td>
<td>The machine will exit without rebooting.</td>
</tr>
</tbody>
</table>

**NOTE:** If you do not reboot your machine, the reset process will not finish and your settings will remain unchanged.
Routine Maintenance .......................................................... 291
Replace Supplies ................................................................. 291
Clean the Machine ................................................................. 300
Check the Remaining Life of Parts ......................................... 309
Pack and Ship Your Dell Machine ......................................... 309
Routine Maintenance

- Replace Supplies
  You must replace supplies when the machine indicates that the life of the supply is over.
- Clean the Machine
  Clean the outside and inside of the machine regularly with a dry, lint-free cloth.
- Check the Remaining Life of Parts
- Pack and Ship Your Dell Machine

Replace Supplies

You must replace supplies when the machine indicates that the life of the supply is over.
You can replace the following supplies yourself.
Using non-Dell supplies may affect the print quality, hardware performance, and machine reliability.

**NOTE:** The toner cartridge and drum unit are two separate supplies. Make sure both are installed as an assembly.

To avoid any inconvenience, you may want to buy spare supplies to keep as replacements before the machine stops printing.

**WARNING**

- Never use a vacuum cleaner for spilled toner and residual toner in this product, toner cartridge or toner bottle. It may catch fire by electric sparks inside a vacuum cleaner and cause explosion. Use a broom or a wet cloth to wipe off the spills. If you spill a large volume of toner, contact your local Dell representative.
- Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch fire and cause burn injuries or explosion. If you have a used toner cartridge no longer needed, contact your local Dell representative for its disposal.

**CAUTION**

- Keep drum cartridges (or drum if not a cartridge type) and toner cartridges out of the reach of children. If a child accidentally swallows toner, spit it out, rinse mouth with water, drink water and consult a physician immediately.
- When replacing drum cartridges (or drum if not a cartridge type) and toner cartridges, be careful not to spill the toner. In case of any toner spills, avoid contact with clothes, skin, eyes and mouth as well as inhalation.
- If toner spills onto your skin or clothing, wash it off with soap and water. If you get toner particles in the eyes, wash it out with plenty of water for at least 15 minutes until irritation is gone. Consult a physician if necessary.

**IMPORTANT**

- Dell machines are designed to work with toner of a particular specification and will work to a level of optimum performance when used with Dell Original toner cartridges. Dell cannot guarantee this optimum performance if toner or toner cartridges of other specifications are used. The machine may not detect toner or toner cartridges of other specifications correctly but may instead detect such items as standard yield toner cartridges. Dell does not therefore recommend the use of cartridges other than Dell Original cartridges with this machine, or the refilling of empty cartridges with toner from other sources. If damage is caused to the drum unit or other parts.
of this machine as a result of the use of toner or toner cartridges other than Dell Original products due to the incompatibility or lack of suitability of those products with this machine, any repairs required as a result may not be covered by the warranty.

- For best performance, use a Dell Original drum and toner cartridge. Printing with a third party drum unit or toner cartridge may reduce not only the print quality but also the quality and life of the machine itself. Warranty coverage may not apply to problems caused by the use of a third party drum or toner cartridge.

**NOTE**

- Be sure to seal up the used supplies tightly in a bag so that toner powder does not spill out of the cartridge.
- Discard the used supply according to local regulations, keeping it separate from domestic waste. If you have questions, contact your local waste disposal office.
- We recommend placing used supplies on a piece of paper to prevent accidentally spilling or scattering the material inside.
- If you use paper that is not a direct equivalent for the recommended print media, the life of supplies and machine parts may be reduced.
- The projected life for each of the toner cartridges is based on ISO/IEC 19752. Frequency of replacement will vary depending on the print volume, percentage of coverage, types of media used, and powering on/off the machine.
- Frequency of replacement supplies except toner cartridges will vary depending on the print volume, types of media used, and powering on/off the machine.
- Handle the toner cartridge carefully. If toner scatters on your hands or clothes, immediately wipe or wash it off with cold water.
- To avoid print quality problems, DO NOT touch the shaded parts shown in the illustrations.

<Toner cartridge>

<Drum unit>
Learn About The Toner Cartridge

The Standard toner cartridge can print approximately 1,200 pages \(^1\). The High Yield toner cartridge can print approximately 2,600 pages \(^1\). Actual page count will vary depending on your average type of document.

When a toner cartridge is running low, the control panel shows Toner Low indication.

The toner cartridge that comes with your Dell machine is a Starter toner cartridge. The approximate toner life may differ from the Standard toner cartridge.

Approximate life of Starter Toner Cartridge
Approximately 700 pages (Letter or A4 pages) \(^1\)

NOTE: It is a good idea to keep a new toner cartridge ready for use when you see the Toner Low warning.

NOTE: To ensure high quality printing, we recommend using only Genuine Dell Brand toner cartridges. When you want to buy toner cartridges, contact Dell Customer Service.

NOTE: DO NOT unpack the new toner cartridge until you are ready to install it.

NOTE: If a toner cartridge is left unpacked for a long time, the toner life will be shortened.

NOTE: Dell strongly recommends you DO NOT refill the toner cartridge provided with your machine. We also strongly recommend you continue to use only Genuine Dell Brand replacement toner cartridges. Use or attempted use of third party toner and/or cartridges in the Dell machine may cause damage to the machine and/or may result in unsatisfactory print quality. Our limited warranty coverage does not apply to any problem that is caused by the use of third party toner and/or cartridges. To protect your investment and obtain premium performance from the Dell machine, we strongly recommend the use of Genuine Dell Supplies.

*1: Approximate cartridge yield is declared in accordance with ISO/IEC 19752.

Replace the Toner Cartridge

1. Make sure the machine is turned on.
2. Open the front cover.
3. Remove the toner cartridge and drum unit assembly from the machine.

4. Push down the lock lever and take the toner cartridge out of the drum unit.
5. Unpack the new toner cartridge.

6. Remove the protective cover.

7. Put the new toner cartridge firmly into the drum unit until you hear it lock into place.

**NOTE:** Make sure you put the toner cartridge in correctly or it may separate from the drum unit.

8. Clean the corona wire inside the drum unit by gently sliding the tab from left to right and right to left several times.
**NOTE:** Be sure to return the tab to the Home position (▲). The arrow on the tab must be aligned with the arrow on the drum unit. If it is not, printed pages may have a vertical stripe.

9. Install the toner cartridge and drum unit assembly back into the machine.

10. Close the front cover of the machine.

**NOTE:** After replacing a toner cartridge, DO NOT turn off the machine or open the Front cover until the machine’s display returns to Ready Mode.

**Learn About The Drum Unit**

A new drum unit can print approximately 12,000 Letter or A4 size single-sided pages. Drum wear and tear occurs due to use and rotation of the drum and interaction with paper, toner and other materials in the paper path. In designing this product, Dell decided to use the number of rotations of the drum as a reasonable determinant of the drum life. When a drum reaches the factory-established rotation limit corresponding to the rated page yield, the product’s LCD will advise you to replace the applicable drum. The product will continue to function; however, print quality may not be optimal.
NOTE

- If an unpacked drum unit is placed in direct sunlight (or room light for long periods of time), the unit may be damaged.
- There are many factors that determine the actual drum life, such as the temperature, humidity, type of paper, type of toner used and so on. Under ideal conditions, the average drum life is estimated at approximately 12,000 pages. The actual number of pages that your drum will print may be significantly less than this estimate. Because we have no control over the many factors that determine the actual drum life, we cannot guarantee a minimum number of pages that will be printed by your drum.
- For best performance, use only genuine Dell toner. The machine should be used only in a clean, dust-free environment with adequate ventilation. Printing with a non-Dell drum unit may reduce not only the print quality but also the quality and life of the machine itself. Warranty coverage does not apply to problems caused by the use of a non-Dell drum unit.

Replace the Drum Unit

1. Make sure the machine is turned on.
2. Open the front cover.
3. Remove the toner cartridge and drum unit assembly from the machine.
4. Push down the lock lever and take the toner cartridge out of the drum unit.

5. Unpack the new drum unit.

6. Put the toner cartridge firmly into the new drum unit until you hear it lock into place.

**NOTE:** Make sure you put the toner cartridge in correctly or it may separate from the drum unit.

7. Clean the corona wire inside the drum unit by gently sliding the tab from left to right and right to left several times.
NOTE: Be sure to return the tab to the Home position (▲). The arrow on the tab must be aligned with the arrow on the drum unit. If it is not, printed pages may have a vertical stripe.

8. Install the toner cartridge and drum unit assembly back into the machine.

9. Close the front cover of the machine.

Reset the Drum Counter

When you replace the drum unit with a new one, you must reset the drum counter by completing the following steps:

IMPORTANT

DO NOT reset the drum counter unless you are replacing the drum unit.

1. Open the front cover.
2. Press and hold OK for 2 seconds.

3. Press ▲ or 1 to reset the drum counter.

**Clean the Machine**

Clean the outside and inside of the machine regularly with a dry, lint-free cloth. When you replace the toner cartridge or the drum unit, make sure you clean the inside of the machine. If printed pages are stained with toner, clean the inside of the machine with a dry, lint-free cloth.

**WARNING**

- DO NOT use flammable substances, any type of spray, or an organic solvent/liquid containing alcohol or ammonia to clean the inside or outside of the product. Doing so could cause a fire or electrical shock. Instead, use only a dry, lint-free cloth.
- When cleaning this product, use the designated cleaning materials exclusive to it. Other cleaning materials may result in poor performance of the product. Never use aerosol cleaners to avoid catching fire and explosion.
CAUTION

When cleaning this product, always switch off and unplug it. Access to a live machine interior may cause electric shock.

IMPORTANT

- Use neutral detergents. Cleaning with volatile liquids such as thinner or benzine will damage the surface of the machine.
- DO NOT use cleaning materials that contain ammonia.
- DO NOT use isopropyl alcohol to remove dirt from the control panel. It may crack the panel.
- To avoid print quality problems, DO NOT touch the shaded parts shown in the illustrations.

<Toner cartridge>

<Drum unit>
Clean the Scanner

1. Press and hold \( \text{OK} \) to turn off the machine.
2. Lift the document cover (1). Clean the white plastic surface (2) and scanner glass (3) underneath it with a soft lint-free cloth moistened with water.

![Scanner Diagram]

3. In the ADF unit, clean the white bar (1) and the scanner glass strip (2) underneath it with a soft lint-free cloth moistened with water.

![ADF Unit Diagram]

4. Close the document cover.
5. Press \( \text{OK} \) to turn on the machine.

Clean the Corona Wire

If you have print quality problems or the control panel displays Drum! status, clean the corona wire.

1. Open the front cover.
2. Remove the toner cartridge and drum unit assembly from the machine.

3. Clean the corona wire inside the drum unit by gently sliding the tab from left to right and right to left several times.
NOTE: Be sure to return the tab to the Home position (▲). The arrow on the tab must be aligned with the arrow on the drum unit. If it is not, printed pages may have a vertical stripe.

4. Install the toner cartridge and drum unit assembly back into the machine.

5. Close the front cover of the machine.

Clean the Drum Unit

If your printout has dots or other repeating marks at 3.7 in. (94 mm) intervals, the drum may have foreign material, such as glue from a label stuck on the drum surface. Follow these steps to solve the problem:

1. Press and hold to turn off the machine.
2. Open the front cover.
3. Remove the toner cartridge and drum unit assembly from the machine.

4. Push down the lock lever and take the toner cartridge out of the drum unit.
5. Turn the drum unit as shown in the illustration. Make sure that the drum unit gear is on the left side.

6. Turn the edge of the drum unit toward you by hand while looking at surface of the suspected area.

**NOTE:** To avoid print quality problems, DO NOT touch the surface of the drum unit except the edge.

7. Wipe the surface of the drum gently with a dry cotton swab until the mark on the surface comes off.
NOTE
DO NOT clean the surface of the photosensitive drum with a sharp object or any liquids.

8. Put the new toner cartridge firmly into the drum unit until you hear it lock into place.

**NOTE:** Make sure you put the toner cartridge in correctly or it may separate from the drum unit.

9. Install the toner cartridge and drum unit assembly back into the machine.

10. Close the front cover of the machine.

11. Press \( \text{ } \) to turn on the machine.
Clean the Paper Pick-up Rollers

Cleaning the paper pick-up rollers periodically may prevent paper jams by insuring the proper feeding of paper.

If you have paper feed problems, clean the pick-up rollers as follows:

1. Press and hold \( \text{on} \) to turn off the machine.
2. Pull the paper tray completely out of the machine.

3. If paper is loaded or something is stuck inside in the paper tray, remove it.
4. Tightly wring out a lint-free cloth soaked in lukewarm water, and then wipe the separator pad on the paper tray to remove dust.

5. Wipe the two pick-up rollers inside the machine to remove dust.
6. Reload the paper and put the paper tray firmly back in the machine.

7. Press to turn on the machine.

Check the Remaining Life of Parts

1. Press Menu.

2. Press ▲ or ▼ to display the Machine Info. option, and then press OK.

3. Press ▲ or ▼ to display the Parts Life option, and then press OK.

4. Press ▲ or ▼ to select the Toner or Drum option, and then press OK.
   The LCD displays the approximate remaining toner or drum life.

5. Press Cancel.

Pack and Ship Your Dell Machine

⚠️ WARNING
When you move the machine, grasp the side handholds that are under the scanner. DO NOT carry the machine by holding it at the bottom.

NOTE: If for any reason you must ship your machine, carefully repack the machine in the original packaging to avoid any damage during transit. The machine should be adequately insured with the carrier.

1. Press and hold to turn off the machine. Leave the machine turned off for at least 10 minutes to cool down.
2. Disconnect all the cables, and then unplug the power cord from the AC power outlet.  
   **NOTE:** The machine is equipped with a non-detachable AC power cord depending on the model.

3. Remove the toner cartridge and drum unit assembly.

4. Push down the lock lever and take the toner cartridge out of the drum unit.

5. Put the protective material on the toner cartridge. Put it in a plastic bag.

6. Put the protective material (1) in the machine to the left as shown in the illustration.
7. Install only the drum unit back into the machine.

8. Close the front cover.

9. Put the machine into the bag it originally came in.

10. Pack the machine and the printed materials in the original carton with the original packing material as shown below.
NOTE: Put the AC power cord and printed materials in the original carton as shown in the illustration.

11. Close the carton and tape it shut.
Machine Settings. 315
  General Settings 315
  Print Reports 325
  Settings and Features Tables 326
Machine Settings

Customize settings and features, create shortcuts, and work with options displayed on the machine's LCD to make your Dell machine a more efficient work tool.

- General Settings
- Print Reports
- Settings and Features Tables
  The Settings tables will help you understand the menu selections and options that are found in the machine’s programs.

General Settings

- Change the Default Mode
  When the machine is idle or you press Cancel, the machine will return to the mode you set.

- Set the Mode Timer
  The machine returns to the default mode after use of the machine in a mode other than the default mode. The Mode Timer setting defines how much time the machine takes after the last operation to return to the default mode. If you choose Off, the machine will stay in the mode you used last.

- Adjust the Machine Volume

- Change for Daylight Saving Time Automatically
  The machine to change automatically for Daylight Saving Time.

- Set the Sleep Mode Countdown
  The Sleep Mode (or Power Save Mode) setting can reduce power consumption. When the machine is in Sleep Mode, it acts as though it is turned off. The machine will wake up and start printing when it receives a print job or a fax. Use these instructions to set a time delay to send the machine into Sleep Mode.

- About Deep Sleep Mode
  If the machine is in Sleep Mode and does not receive any jobs for certain length of time, based on your model and settings, the machine will automatically enter Deep Sleep Mode. You can set the length of time before the machine enters Deep Sleep Mode between 10 to 60 minutes. The default time is 11 minutes.

- Set Auto Power Off Mode
  If the machine is in Deep Sleep Mode for certain length of time, based on your model and settings, the machine will go into Power Off Mode automatically. The machine does not go into Power Off Mode when the machine is connected to a wired or wireless network.

- Set the Date and Time

- Set the Time Zone
  Set the time zone for your location on the machine.

- Adjust the LCD Contrast
  If you are having difficulty reading the LCD, try changing the contrast setting.

- Reduce Toner Consumption
  You can reduce toner consumption using this feature.

- Set the Continue Mode
  The Continue Mode forces the machine to continue printing after the control panel displayed Replace New
Toner indication.

• Learn About the Receiving faxes in Continue Mode
  The machine can store received faxes in the memory if you choose Continue Mode when the LCD displays Replace New Toner.

• Set Your Station ID
  Set the machine to print your Station ID and the fax's date and time at the top of each fax you send.

• Set Tone or Pulse Dialing Mode
  Your Dell machine is set for a Tone dialing service. If you have a Pulse dialing (rotary) service, you must change the dialing mode.

• Add aPrefix to Every Fax Number
  The Dial Prefix setting will automatically dial a predefined number before every fax number you dial. For example: If your telephone system requires a 9 to dial an outside number, use this setting to automatically dial 9 for every fax you send.

• Prevent Dialing a Wrong Number (Dial Restriction)
  This feature is to prevent users from sending a fax or call to the wrong number by mistake. You can set the machine to restrict dialing when you use the dial pad, Address Book and Shortcuts.

• Set Quiet Mode
  Use Quiet Mode to reduce printing noise. When Quiet Mode is turned On, the print speed becomes slower. The factory setting is Off.

• In the Event of Power Failure (Memory Storage)

• Change the Language on the LCD
  Change the LCD language if needed.

**Change the Default Mode**

When the machine is idle or you press **Cancel**, the machine will return to the mode you set.

---

- For Dell E515dn/Dell E515dw, the machine has FAX, SCAN and COPY modes. Factory setting is FAX mode.
- For Dell E514dw, the machine has Scan and Copy modes. The Copy mode is fixed default mode.

---

1. Press **Menu**.
2. Press ▲ or ▼ to display the General Setup option, and then press **OK**.
3. Press ▲ or ▼ to display the Default Mode option, and then press **OK**.
4. Press ▲ or ▼ to display the Fax, Copy, or Scan option, and then press **OK**.
5. Press **Cancel**.

**Set the Mode Timer**

The machine returns to the default mode after use of the machine in a mode other than the default mode. The Mode Timer setting defines how much time the machine takes after the last operation to return to the default mode. If you choose **Off**, the machine will stay in the mode you used last.
• For Dell E515dn/Dell E515dw, the machine has three mode buttons on the control panel: FAX, SCAN and COPY.
• For Dell E514dw, the machine has Scan and Copy. Default is Copy mode and mode timer setting is one minute.

1. Press Menu.
2. Press ▲ or ▼ to display the General Setup option, and then press OK.
3. Press ▲ or ▼ to display the Mode Timer option, and then press OK.
4. Press ▲ or ▼ to display the 5 Mins, 2 Mins, 1 Min, 30 Secs, 0 Sec, or Off option, and then press OK.
5. Press Cancel.

**Adjust the Machine Volume**

• Adjust the Ring Volume
• Adjust the Beeper Volume
  When the beeper is on, the machine will beep when you press a button, make a mistake, or after you send or receive a fax. You can choose from a range of volume levels.
• Adjust the Speaker Volume

**Adjust the Ring Volume**

Related Models: Dell E515dn / Dell E515dw

1. Press Menu.
2. Press ▲ or ▼ to display the General Setup option, and then press OK.
3. Press ▲ or ▼ to display the Volume option, and then press OK.
4. Press ▲ or ▼ to display the Ring option, and then press OK.
5. Press ▲ or ▼ to display the High, Med, Low, or Off option, and then press OK.
6. Press Cancel.

**Adjust the Beeper Volume**

When the beeper is on, the machine will beep when you press a button, make a mistake, or after you send or receive a fax. You can choose from a range of volume levels.

1. Press Menu.
2. Press ▲ or ▼ to display the General Setup option, and then press OK.
3. Press ▲ or ▼ to display the Volume option, and then press OK.
4. Press ▲ or ▼ to display the Beeper option, and then press OK.
5. Press ▲ or ▼ to display the High, Med, Low, or Off option, and then press OK.
6. Press Cancel.
Adjust the Speaker Volume

Related Models:Dell E515dn / Dell E515dw

1. Press Menu.
2. Press ▲ or ▼ to display the General Setup option, and then press OK.
3. Press ▲ or ▼ to display the Volume option, and then press OK.
4. Press ▲ or ▼ to display the Speaker option, and then press OK.
5. Press ▲ or ▼ to display the High, Med, Low, or Off option, and then press OK.
6. Press Cancel.

Adjust the Speaker Volume Using the Hook Option

Related Models:Dell E515dn / Dell E515dw

Another way to adjust your machine’s speaker volume is to use the Hook button on the control panel.

1. Press (Fax).
2. Press Hook.
3. Press  or  to decrease or increase the speaker volume.
4. Press Hook.

Change for Daylight Saving Time Automatically

Related Models:Dell E515dn / Dell E515dw

The machine to change automatically for Daylight Saving Time.

It will reset itself forward one hour in the spring, and backward one hour in the fall. Make sure you have set the correct date and time in the Date & Time setting.

1. Press Menu.
2. Press ▲ or ▼ to display the Initial Setup option, and then press OK.
3. Press ▲ or ▼ to display the Date & Time option, and then press OK.
4. Press ▲ or ▼ to display the Auto Daylight option, and then press OK.
5. Press ▲ or ▼ to display the On or Off option, and then press OK.
6. Press Cancel.

Set the Sleep Mode Countdown

The Sleep Mode (or Power Save Mode) setting can reduce power consumption. When the machine is in Sleep Mode, it acts as though it is turned off. The machine will wake up and start printing when it receives a print job or a fax. Use these instructions to set a time delay to send the machine into Sleep Mode.

- You can choose how long the machine must be idle before it goes into Sleep Mode.
- The timer will restart if any operation is carried out on the machine, such as receiving a print job.
1. Press **Menu**.
2. Press ▲ or ▼ to display the **General Setup** option, and then press **OK**.
3. Press ▲ or ▼ to display the **Ecology** option, and then press **OK**.
4. Press ▲ or ▼ to display the **Sleep Time** option, and then press **OK**.
5. Using the dial pad, enter the length of time the machine (maximum 50 minutes) is idle before entering **Sleep Mode**, and then press **OK**.
6. Press **Cancel**.

### About Deep Sleep Mode

If the machine is in **Sleep Mode** and does not receive any jobs for certain length of time, based on your model and settings, the machine will automatically enter **Deep Sleep Mode**. You can set the length of time before the machine enters Deep Sleep Mode between 10 to 60 minutes. The default time is 11 minutes.

Deep Sleep Mode uses less power than **Sleep Mode**.

<table>
<thead>
<tr>
<th>Machine's Control Panel in Deep Sleep Mode</th>
<th>Conditions that will wake the machine</th>
</tr>
</thead>
<tbody>
<tr>
<td>The LCD displays Deep Sleep.</td>
<td>The machine receives a job.</td>
</tr>
<tr>
<td></td>
<td>Someone presses a button on the control panel.</td>
</tr>
</tbody>
</table>

### Set Auto Power Off Mode

**Related Models:** Dell E514dw

If the machine is in **Deep Sleep Mode** for certain length of time, based on your model and settings, the machine will go into **Power Off Mode** automatically. The machine does not go into **Power Off Mode** when the machine is connected to a wired or wireless network.

To start printing, press 📷 on the control panel and then send a print job.

1. Press **Menu**.
2. Press ▲ or ▼ to display the **General Setup** option, and then press **OK**.
3. Press ▲ or ▼ to display the **Ecology** option, and then press **OK**.
4. Press ▲ or ▼ to display the **Auto Power Off** option, and then press **OK**.
5. Press ▲ or ▼ to display the **8 hours, 4 hours, 2 hours, 1 hour, or off** option, and then press **OK**.
6. Press **Cancel**.

### Set the Date and Time

**Related Models:** Dell E515dn / Dell E515dw

1. Press **Menu**.
2. Press ▲ or ▼ to display the **Initial Setup** option, and then press **OK**.
3. Press ▲ or ▼ to display the **Date & Time** option, and then press **OK**.
4. Press ▲ or ▼ to display the Date&Time option, and then press OK.
5. Enter the last two digits of the year using the dial pad, and then press OK.
6. Enter the two digits for the month using the dial pad, and then press OK.
7. Enter the two digits for the day using the dial pad, and then press OK.
8. Press ▲ or ▼ to display the 12h Clock or 24h Clock option, and then press OK.
9. Do one of the following:
   • If you selected 12h Clock as the format in the Date&Time setting, enter the time (in 12-hour format) using the dial pad.
     Press OK.
     Press ▲ or ▼ to display the AM or PM option, and then press OK.
   • If you selected 24h Clock as the format in the Date&Time setting, enter the time (in 24-hour format) using the dial pad.
     Press OK.
     (For example: enter 19:45 for 7:45 PM.)

Set the Time Zone

Related Models:Dell E515dn / Dell E515dw
Set the time zone for your location on the machine.
For example, the time zone for Eastern Time in the USA and Canada is UTC-05:00. Pacific Time in the USA and Canada is UTC-08:00.

<table>
<thead>
<tr>
<th>Time Zone</th>
<th>Standard Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hawaii-Aleutian Time Zone</td>
<td>UTC - 10:00</td>
</tr>
<tr>
<td>Alaska Time Zone</td>
<td>UTC - 9:00</td>
</tr>
<tr>
<td>Pacific Time Zone</td>
<td>UTC - 8:00</td>
</tr>
<tr>
<td>Mountain Time Zone</td>
<td>UTC - 7:00</td>
</tr>
<tr>
<td>Central Time Zone</td>
<td>UTC - 6:00</td>
</tr>
<tr>
<td>Eastern Time Zone</td>
<td>UTC - 5:00</td>
</tr>
<tr>
<td>Atlantic Time Zone</td>
<td>UTC - 4:00</td>
</tr>
</tbody>
</table>

1. Press Menu.
2. Press ▲ or ▼ to display the Initial Setup option, and then press OK.
3. Press ▲ or ▼ to display the Date&Time option, and then press OK.
4. Press ▲ or ▼ to display the Time Zone option, and then press OK.
5. Press ▲ or ▼ to choose the time zone. Press OK.
6. Press Cancel.

Adjust the LCD Contrast

If you are having difficulty reading the LCD, try changing the contrast setting.
1. Press Menu.
2. Press ▲ or ▼ to display the General Setup option, and then press OK.
3. Press ▲ or ▼ to display the LCD Contrast option, and then press OK.
4. Press ◀▶ or ▲ ▼ to select a level of contrast, and then press OK.
5. Press Cancel.

**Reduce Toner Consumption**

You can reduce toner consumption using this feature.

---

We DO NOT recommend using the Toner Save feature for printing photo or grayscale images.

When you set Toner Save to On, print appears lighter.

1. Press Menu.
2. Press ▲ or ▼ to display the General Setup option, and then press OK.
3. Press ▲ or ▼ to display the Ecology option, and then press OK.
4. Press ▲ or ▼ to display the Toner Save option, and then press OK.
5. Press ▲ or ▼ to display the On or Off option, and then press OK.
6. Press Cancel.

**Set the Continue Mode**

The Continue Mode forces the machine to continue printing after the control panel displayed Replace New Toner indication.

---

Turn on Continue Mode to force the machine to continue printing even if the control panel indicates that it is time to replace the toner cartridge.

**NOTE:** If you continue printing in the Continue Mode, we cannot guarantee the print quality.

**NOTE:** While using Continue Mode the print may appear faint.

**NOTE:** After replacing the toner cartridge with a new one, the Continue Mode will go back to the default setting (Stop).

---

1. Press Menu.
2. Press ▲ or ▼ to display the General Setup option, and then press OK.
3. Press ▲ or ▼ to display the Replace Toner option, and then press OK.
4. Press ▲ or ▼ to display the Continue or Stop option, and then press OK.
5. Press Cancel.
Learn About the Receiving faxes in Continue Mode

Related Models:Dell E515dn / Dell E515dw

The machine can store received faxes in the memory if you choose Continue Mode when the LCD displays Replace Toner.

When received faxes are printed in Continue Mode the LCD will ask if the print quality of the fax is OK. If the quality is not good, choose No. The machine will keep the faxes stored in the memory so you can reprint them after you replace the toner cartridge with a new one. If the print quality is good, choose Yes. The LCD will ask if you want to delete the printed faxes from the memory.

If you choose not to delete them, you will be asked again after you replace the toner cartridge with a new one.

**NOTE:** The machine can store up to 500 faxes in memory.

**NOTE:** The machine will keep faxes stored in Continue Mode even if you change the Continue setting to Stop.

**NOTE:** If you install a new toner cartridge when the LCD displays Replace New Toner, the machine will ask if you want to print the stored faxes. Choose Print to print stored faxes.

**Memory Full in Continue Mode**

If the memory is full and you want to continue receiving faxes, you must install a new toner cartridge.

Set Your Station ID

Related Models:Dell E515dn / Dell E515dw

Set the machine to print your Station ID and the fax’s date and time at the top of each fax you send.

1. Press (Fax).
2. Press Menu.
3. Press ▲ or ▼ to display the Initial Setup option, and then press OK.
4. Press ▲ or ▼ to display the Station ID option, and then press OK.
5. Enter your fax number (up to 20 digits) using the dial pad, and then press OK.
6. Enter your telephone number (up to 20 digits) using the dial pad, and then press OK.
   - If your telephone number and fax number are the same, enter the same number again.
7. Use the dial pad to enter your name (up to 20 characters), and then press OK.
   - **NOTE:** To enter text on your machine, see Related Information: How to Enter Text on Your Dell Machine
8. Press Cancel.

**NOTE**

(USA only) The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or electronic device to send any message via a telephone fax machine unless such messages clearly contain, in a margin at the top or bottom of each transmitted page, or on the first page of the transmission, the date and time it is sent and an identification of the business or other entity or other individual sending the message and the telephone number of the sending machine or such business, other entity or individual. To program this information into your machine, see Set the date and time and Set your Station ID.
**Set Tone or Pulse Dialing Mode**

Related Models:Dell E515dn / Dell E515dw
Your Dell machine is set for a Tone dialing service. If you have a Pulse dialing (rotary) service, you must change the dialing mode.
This feature is not available in some countries.

1. Press Menu.
2. Press ▲ or ▼ to display the Initial Setup option, and then press OK.
3. Press ▲ or ▼ to display the Tone/Pulse option, and then press OK.
4. Press ▲ or ▼ to display the Tone or Pulse option, and then press OK.
5. Press Cancel.

**Add a Prefix to Every Fax Number**

Related Models:Dell E515dn / Dell E515dw
The Dial Prefix setting will automatically dial a predefined number before every fax number you dial. For example: If your telephone system requires a 9 to dial an outside number, use this setting to automatically dial 9 for every fax you send.

**NOTE:** Use the numbers and symbols from 0 to 9, #, and *. (You cannot use ! with any other numbers or symbols.)

**NOTE:** If your telephone system requires a time break recall (hookflash), press ! on the LCD.

**NOTE:** To turn off the dial prefix feature, delete the stored prefix number and then press OK.

1. Press Menu.
2. Press ▲ or ▼ to display the Initial Setup option, and then press OK.
3. Press ▲ or ▼ to display the Dial Prefix option, and then press OK.
4. Do one of the following:
   - If the machine does not have a stored prefix number, enter a number (up to 5 digits) using the dial pad, and then press OK.
   - If the machine has a stored prefix number and you want to change it, press 1 to edit the number. Press Clear to delete each digit of the existing number and enter a new number using the dial pad, and then press OK.

   **NOTE:** To turn off the dial prefix feature, delete the stored prefix number and then press OK.
5. Press Cancel.

**Prevent Dialing a Wrong Number (Dial Restriction)**

Related Models:Dell E515dn / Dell E515dw
This feature is to prevent users from sending a fax or call to the wrong number by mistake. You can set the machine to restrict dialing when you use the dial pad, Address Book and Shortcuts.

1. Press Menu.
2. Press ▲ or ▼ to display the Fax option, and then press OK.
3. Press ▲ or ▼ to display the Dial Restrict option, and then press OK.

4. Press ▲ or ▼ to display your preferred option, and then press OK.
   - Dial Pad
   - One Touch Dial
   - Speed Dial

5. Press ▲ or ▼ to select one of the following options, and then press OK.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter # twice</td>
<td>The machine will prompt you to re-enter the number, and then if you re-enter the same number correctly, the machine will start dialing. If you re-enter the wrong number, the LCD will display an error message.</td>
</tr>
<tr>
<td>On</td>
<td>The machine will restrict all fax sending and outbound calls for that dialing method.</td>
</tr>
<tr>
<td>Off</td>
<td>The machine does not restrict the dialing method.</td>
</tr>
</tbody>
</table>

- The Enter # twice setting will not work if you use an external phone or press Hook before entering the number. You will not be asked to re-enter the number.
- If you choose On or Enter # twice, you cannot use the Broadcasting feature.

6. Press Cancel.

**Set Quiet Mode**

Use Quiet Mode to reduce printing noise. When Quiet Mode is turned On, the print speed becomes slower. The factory setting is Off.

1. Press Menu.

2. Press ▲ or ▼ to display the General Setup option, and then press OK.

3. Press ▲ or ▼ to display the Ecology option, and then press OK.

4. Press ▲ or ▼ to display the Quiet Mode option, and then press OK.

5. Press ▲ or ▼ to display the On or Off option, and then press OK.

6. Press Cancel.

**In the Event of Power Failure (Memory Storage)**

Your menu settings are stored permanently, and in the event of a power failure will not be lost. Temporary settings (for example, Contrast, Overseas Mode) will be lost.

- (Dell E515dn/Dell E515dw)
  During a power failure the machine will retain the date and time and programmed fax timer jobs (for example: Delayed Fax) for approximately 60 hours. Other fax jobs in the machine's memory will not be lost.

**Change the Language on the LCD**

Change the LCD language if needed.
This feature is not available in some countries.

- Dell E514dw
- Dell E515dn/Dell E515dw
**Dell E514dw**

1. Press **Menu**.
2. Press ▲ or ▼ to display the **General Setup** option, and then press **OK**.
3. Press ▲ or ▼ to display the **Local Language** option, and then press **OK**.
4. Press ▲ or ▼ to display your language, and then press **OK**.
5. Press **Cancel**.

**Dell E515dn/Dell E515dw**

1. Press **Menu**.
2. Press ▲ or ▼ to display the **Initial Setup** option, and then press **OK**.
3. Press ▲ or ▼ to display the **Local Language** option, and then press **OK**.
4. Press ▲ or ▼ to display your language, and then press **OK**.
5. Press **Cancel**.

**Print Reports**

- Reports
- Print a Report

**Reports**

The following reports are available:

- **Transmission** *(Dell E515dn/Dell E515dw)*
  The Transmission report prints a Transmission Verification Report for your last transmission.

- **Address Book** *(Dell E515dn/Dell E515dw)*
  The Address Book report prints an alphabetical list of names and numbers stored in the Address Book memory.

- **Fax Journal** *(Dell E515dn/Dell E515dw)*
  The Fax Journal prints a list of information about your last 200 incoming and outgoing faxes. (TX means Transmit) (RX means Receive)

- **User Settings**
  The User Settings report prints a list of your current settings.

- **Printer Settings**
  The Printer Settings report prints a list of your current printer settings.

- **Network Configuration**
  The Network Configuration report prints a list of your current network settings.

- **WLAN Report** *(Dell E514dw/Dell E515dw)*
  The WLAN Report prints the result of wireless LAN connectivity diagnosis.

- **Caller ID history** *(Dell E515dn/Dell E515dw)*
  The Caller ID history report prints a list of the available Caller ID information for the last 30 received faxes and telephone calls.
**NOTE:** To print the Caller ID list, use the Print Report option in the caller ID setting menu.

**Print a Report**

1. Press **Menu**.

2. Do one of the following:
   - **Dell E515dn/Dell E515dw**
     - Press ▲ or ▼ to display the **Print Reports** option, and then press **OK**.
   - **(Dell E514dw)**
     - Press ▲ or ▼ to display the **Machine Info.** option, and then press **OK**.

3. Press ▲ or ▼ to display the report you want to print, and then press **OK**.

4. Do one of the following:
   - If you choose Transmission, do one of the following:
     - To view the Transmission Verification Report, Press ▲ or ▼ to display the **View on LCD**, and then press **OK**.
     - To print the Transmission Verification Report, Press ▲ or ▼ to display the **Print Report**, and then press **OK**.
     - Press **Start**.
   - If you choose other reports, Press **Start**.

5. Press **Cancel**.

**Settings and Features Tables**

The Settings tables will help you understand the menu selections and options that are found in the machine’s programs.

- **Settings Tables (Dell E515dn/Dell E515dw)**
- **Settings Tables (Dell E514dw)**

**Settings Tables (Dell E515dn/Dell E515dw)**

- General Setup
- Fax
- Copy
- Printer
- Print Reports
- Network
- Machine Info.
- Initial Setup

**General Setup**

Related Models: Dell E515dn / Dell E515dw

<table>
<thead>
<tr>
<th>Level 1</th>
<th>Level 2</th>
<th>Level 3</th>
<th>Descriptions</th>
</tr>
</thead>
</table>

326 | Machine Settings
Default Mode | - | - | Select the default mode.
Mode Timer | - | - | Set the time to return to the default mode.
Paper | Paper Type | - | Set the type of paper in the paper tray.
| Paper Size | - | Set the size of paper in the paper tray.
| Check Size | - | Choose whether to display the message to check the size of paper in the machine and the machine setting match.
Volume | Ring | - | Adjust the ring volume.
| Beeper | - | Adjust the beeper volume.
| Speaker | - | Adjust the speaker volume.
Ecology | Toner Save | - | Increase the page yield of the toner cartridge.
| Sleep Time | - | Conserve power.
| Quiet Mode | - | Decrease printing noise.
LCD Contrast | - | - | Adjust the contrast of the LCD.
Security | TX Lock | - | Prohibit most operations except receiving faxes.
| Setting Lock | - | Restrict unauthorized users from changing the machine’s settings.
Glass ScanSize | - | - | Adjust the scan area of the scanner glass to the size of the document.
Replace Toner | - | - | You can choose the machine to continue printing after the LCD displays Replace New Toner, or stop printing when the message is displayed.

Fax

Related Models: Dell E515dn / Dell E515dw

<table>
<thead>
<tr>
<th>Level 1</th>
<th>Level 2</th>
<th>Level 3</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup Receive</td>
<td>Receive Mode</td>
<td>-</td>
<td>Select the receive mode that best suits your needs.</td>
</tr>
<tr>
<td>Ring Delay</td>
<td>-</td>
<td>Set the number of rings before the machine answers in Fax or Fax/Tel mode.</td>
<td></td>
</tr>
<tr>
<td>F/T Ring Time</td>
<td>-</td>
<td>Set the length of the pseudo/double-ring time in Fax/Tel mode.</td>
<td></td>
</tr>
<tr>
<td>Easy Receive</td>
<td>-</td>
<td>Receive fax messages automatically when you answer a call and hear fax tones.</td>
<td></td>
</tr>
<tr>
<td>Remote Codes</td>
<td>-</td>
<td>Answer calls at an extension or external telephone and use codes to turn the machine on or off. You can personalize the codes.</td>
<td></td>
</tr>
<tr>
<td>Auto Reduction</td>
<td>-</td>
<td>Reduce the size of incoming faxes.</td>
<td></td>
</tr>
<tr>
<td>Fax Rx Stamp</td>
<td>-</td>
<td>Print the received time and date on the top of the received faxes.</td>
<td></td>
</tr>
<tr>
<td>2-sided</td>
<td>-</td>
<td>Print received faxes on both sides of the paper.</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Setting/Action</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Setup Send</td>
<td></td>
<td>Change the lightness or darkness of faxes you send.</td>
<td></td>
</tr>
<tr>
<td>Fax Resolution</td>
<td></td>
<td>Set the default resolution for outgoing faxes.</td>
<td></td>
</tr>
<tr>
<td>Delayed Fax</td>
<td></td>
<td>Set the time of day in 24 hour format that the delayed faxes will be sent.</td>
<td></td>
</tr>
<tr>
<td>Real Time TX</td>
<td></td>
<td>Send a fax without using the memory.</td>
<td></td>
</tr>
<tr>
<td>Coverpage</td>
<td></td>
<td>Set the machine to add the cover page to outgoing faxes.</td>
<td></td>
</tr>
<tr>
<td>Overseas Mode</td>
<td></td>
<td>Set the machine to display the destination information on the LCD during fax sending.</td>
<td></td>
</tr>
<tr>
<td>Auto Redial</td>
<td></td>
<td>Set the machine to redial the last fax number after five minutes if the fax did not go through because the line was busy.</td>
<td></td>
</tr>
<tr>
<td>Anti-Junk Fax</td>
<td>Register</td>
<td>Register the specific fax numbers to the blocked list to avoid receiving faxes from the numbers.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Delete the number from the blocked list.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Print Report</td>
<td>You can print a list of registered fax numbers in the blocked list.</td>
<td></td>
</tr>
<tr>
<td>Address Book</td>
<td>One Touch Dial</td>
<td>Store up to 8 One Touch Dial numbers, so you can dial by pressing one key (and <strong>Start</strong>).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Speed Dial</td>
<td>Store up to 200 Speed Dial numbers, so you can dial by pressing only a few keys (and <strong>Start</strong>).</td>
<td></td>
</tr>
<tr>
<td>Report Setting</td>
<td></td>
<td>Select the initial setup for the Transmission Verification Report.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Journal Period</td>
<td>Set the interval for automatic printing of the Fax Journal.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you select other than Off and Every 50 Faxes, you can set the time for the option.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you select Every 7 Days, you can set the day of the week.</td>
<td></td>
</tr>
<tr>
<td>Remote Fax Opt</td>
<td>Forward/Store</td>
<td>Set the machine to forward fax messages or to store incoming faxes in the memory (so you can retrieve them while you are away from your machine).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Remote Access</td>
<td>Set your own code for Remote Retrieval.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Print Fax</td>
<td>Print received faxes stored in the memory.</td>
<td></td>
</tr>
<tr>
<td>Dial Restrict.</td>
<td></td>
<td>Set the machine to restrict dialing when using the dial pad.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>One Touch Dial</td>
<td>Set the machine to restrict the dialing of One Touch numbers.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Speed Dial</td>
<td>Set the machine to restrict the dialing of Speed Dial numbers.</td>
<td></td>
</tr>
<tr>
<td>Remaining Jobs</td>
<td></td>
<td>Check which scheduled jobs are in the memory and cancel selected jobs.</td>
<td></td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>Compatibility</td>
<td>Adjust the equalization for transmission difficulties.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>VoIP service providers offer fax support using various standards.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you regularly experience fax transmission errors, choose Basic (for VoIP).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Distinctive</td>
<td>Turn on the telephone company's Distinctive Ring subscriber service to register your new ring pattern on the machine. (US and Canada only)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(For Denmark)</td>
<td>Turn on the telephone company's Distinctive Ring subscriber service to register your new ring pattern on the machine. (For Denmark)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Caller ID</td>
<td>View or print a list of the last 30 Caller IDs stored in the memory.</td>
<td></td>
</tr>
</tbody>
</table>
Copy

Related Models: Dell E515dn / Dell E515dw

<table>
<thead>
<tr>
<th>Level 1</th>
<th>Level 2</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality</td>
<td>-</td>
<td>Choose the Copy resolution for your type of document.</td>
</tr>
<tr>
<td>Brightness</td>
<td>-</td>
<td>Adjust the brightness for copies.</td>
</tr>
<tr>
<td>Contrast</td>
<td>-</td>
<td>Adjust the contrast for copies.</td>
</tr>
<tr>
<td>ID Copy</td>
<td>Quality</td>
<td>Choose the Copy resolution for your type of document.</td>
</tr>
<tr>
<td>Brightness</td>
<td></td>
<td>Adjust the brightness for copies.</td>
</tr>
<tr>
<td>Contrast</td>
<td></td>
<td>Adjust the contrast for copies.</td>
</tr>
<tr>
<td>2in1/1in1</td>
<td></td>
<td>Make 2 in 1 ID copies.</td>
</tr>
</tbody>
</table>

Print

Related Models: Dell E515dn / Dell E515dw

<table>
<thead>
<tr>
<th>Level 1</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Print</td>
<td>Print a test page.</td>
</tr>
<tr>
<td>2-sided</td>
<td>Turn 2-sided printing off or on and select flip on long edge or short edge.</td>
</tr>
<tr>
<td>Auto Continue</td>
<td>Select this setting if you want the machine to clear paper size errors and to use the paper in the tray.</td>
</tr>
<tr>
<td>Reset Printer</td>
<td>Restore the printer settings to the factory settings.</td>
</tr>
</tbody>
</table>

Print Reports

Related Models: Dell E515dn / Dell E515dw

<table>
<thead>
<tr>
<th>Level 1</th>
<th>Level 2</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission View on LCD</td>
<td>Display a Transmission Verification Report for your last transmission.</td>
<td></td>
</tr>
<tr>
<td>Print Report</td>
<td>Print a Transmission Verification Report for your last transmission.</td>
<td></td>
</tr>
<tr>
<td>Address Book Numeric</td>
<td>Print a list of names and numbers stored in the Address Book, in numerical order.</td>
<td></td>
</tr>
<tr>
<td>Alphabetic</td>
<td>Print a list of names and numbers stored in the Address Book, in alphabetical order.</td>
<td></td>
</tr>
<tr>
<td>Fax Journal</td>
<td>Print a list of information about your last 200 incoming and outgoing faxes. (TX means Transmit. RX means Receive.)</td>
<td></td>
</tr>
<tr>
<td>Print Settings</td>
<td>Print a list of your settings for printing.</td>
<td></td>
</tr>
<tr>
<td>User Settings</td>
<td>Print a list of your settings.</td>
<td></td>
</tr>
<tr>
<td>Network Config</td>
<td>Print a list of your Network settings.</td>
<td></td>
</tr>
<tr>
<td>WLAN Report</td>
<td>Print the result of wireless LAN connectivity.</td>
<td></td>
</tr>
</tbody>
</table>
### Network

Related Models: Dell E515dn / Dell E515dw

**For Dell E515dw**

<table>
<thead>
<tr>
<th>Level 1</th>
<th>Level 2</th>
<th>Level 3</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wired LAN</td>
<td>TCP/IP</td>
<td>Boot Method</td>
<td>Select the BOOT method that best suits your needs.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IP Address</td>
<td>Enter the IP address.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Subnet Mask</td>
<td>Enter the Subnet mask.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Gateway</td>
<td>Enter the Gateway address.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Node Name</td>
<td>Enter the Node name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(Up to 32 characters)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WINS Config</td>
<td>Select the WINS configuration mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WINS Server</td>
<td>Specify the IP address of the primary or secondary WINS server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DNS Server</td>
<td>Specify the IP address of the primary or secondary DNS server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>APIPA</td>
<td>Set the machine to automatically allocate the IP address from the link-local address range.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IPv6</td>
<td>Turn the IPv6 protocol on or off.</td>
</tr>
<tr>
<td>Ethernet</td>
<td>-</td>
<td></td>
<td>Select the Ethernet link mode.</td>
</tr>
<tr>
<td>Wired Status</td>
<td>-</td>
<td></td>
<td>View the current wired status.</td>
</tr>
<tr>
<td>MAC Address</td>
<td>-</td>
<td></td>
<td>View the MAC address of the machine.</td>
</tr>
<tr>
<td>Set to Default</td>
<td>-</td>
<td></td>
<td>Restore the wired network setting to the factory setting.</td>
</tr>
<tr>
<td>Wired Enable</td>
<td>-</td>
<td></td>
<td>Turn the Wired LAN on or off manually.</td>
</tr>
</tbody>
</table>
### Machine Settings

#### TCP/IP

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boot Method</td>
<td>Select the BOOT method that best suits your needs.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Enter the IP address.</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>Enter the Subnet mask.</td>
</tr>
<tr>
<td>Gateway</td>
<td>Enter the Gateway address.</td>
</tr>
<tr>
<td>Node Name</td>
<td>Enter the Node name.</td>
</tr>
<tr>
<td>(Up to 32 characters)</td>
<td></td>
</tr>
<tr>
<td>WINS Config</td>
<td>Select the WINS configuration mode.</td>
</tr>
<tr>
<td>WINS Server</td>
<td>Specify the IP address of the primary or secondary WINS server.</td>
</tr>
<tr>
<td>DNS Server</td>
<td>Specify the IP address of the primary or secondary DNS server.</td>
</tr>
<tr>
<td>APIPA</td>
<td>Set the machine to automatically allocate the IP address from the link-local address range.</td>
</tr>
<tr>
<td>IPv6</td>
<td>Turn the IPv6 protocol on or off.</td>
</tr>
</tbody>
</table>

#### WLAN Assistant

- Configure your wireless network settings using the Dell CD-ROM.

#### Setup Wizard

- Configure your internal print server manually.

#### WPS/AOSS

- Configure your wireless network settings using the one-button push method.

#### WPS w/PIN Code

- Configure your wireless network settings using WPS with a PIN.

#### WLAN

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>View the current wireless network status.</td>
</tr>
<tr>
<td>Signal</td>
<td>View the current wireless network signal strength.</td>
</tr>
<tr>
<td>SSID</td>
<td>View the current SSID.</td>
</tr>
<tr>
<td>Comm. Mode</td>
<td>View the current Communication Mode.</td>
</tr>
</tbody>
</table>

#### MAC Address

- View the MAC address of the machine.

#### Set to Default

- Restore the wireless network setting to the factory setting.

#### WLAN Enable

- Turn the WLAN on or off manually.

#### Wi-Fi Direct

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Push Button</td>
<td>Configure your Wi-Fi Direct® network settings using the one-button push method.</td>
</tr>
<tr>
<td>PIN Code</td>
<td>Configure your Wi-Fi Direct® network settings using WPS with a PIN code.</td>
</tr>
<tr>
<td>Manual</td>
<td>Configure your Wi-Fi Direct® network settings manually.</td>
</tr>
<tr>
<td>Group Owner</td>
<td>Set your machine as the Group Owner.</td>
</tr>
</tbody>
</table>

#### Device Info.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Name</td>
<td>View the device name of your machine.</td>
</tr>
<tr>
<td>SSID</td>
<td>View the SSID of the Group Owner.</td>
</tr>
<tr>
<td>When the machine is not connected, LCD displays Not Connected.</td>
<td></td>
</tr>
</tbody>
</table>

#### IP Address

View the current IP Address of your machine.

#### Status Info.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>View the current Wi-Fi Direct® network status.</td>
</tr>
<tr>
<td>Signal</td>
<td>View the current Wi-Fi Direct® network signal strength.</td>
</tr>
<tr>
<td>When the machine acts as Group Owner, the LCD always indicate a strong signal.</td>
<td></td>
</tr>
</tbody>
</table>

#### I/F Enable

- Turn the Wi-Fi Direct® connection on or off.

#### Network Reset

- Restore all network settings back to the factory settings.
## Machine Settings

### For Dell E515dn

<table>
<thead>
<tr>
<th>Level 1</th>
<th>Level 2</th>
<th>Level 3</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/IP</td>
<td>Boot Method</td>
<td>-</td>
<td>Select the BOOT method that best suits your needs.</td>
</tr>
<tr>
<td></td>
<td>IP Address</td>
<td>-</td>
<td>Enter the IP address.</td>
</tr>
<tr>
<td></td>
<td>Subnet Mask</td>
<td>-</td>
<td>Enter the Subnet mask.</td>
</tr>
<tr>
<td></td>
<td>Gateway</td>
<td>-</td>
<td>Enter the Gateway address.</td>
</tr>
<tr>
<td></td>
<td>Node Name</td>
<td>-</td>
<td>Enter the Node name. (Up to 32 characters)</td>
</tr>
<tr>
<td>WINS Config</td>
<td>-</td>
<td></td>
<td>Select the WINS configuration mode.</td>
</tr>
<tr>
<td>WINS Server</td>
<td>Primary</td>
<td></td>
<td>Specify the IP address of the primary WINS server.</td>
</tr>
<tr>
<td></td>
<td>Secondary</td>
<td></td>
<td>Specify the IP address of the secondary WINS server.</td>
</tr>
<tr>
<td>DNS Server</td>
<td>Primary</td>
<td></td>
<td>Specify the IP address of the primary DNS server.</td>
</tr>
<tr>
<td></td>
<td>Secondary</td>
<td></td>
<td>Specify the IP address of the secondary DNS server.</td>
</tr>
<tr>
<td>APIPA</td>
<td>-</td>
<td></td>
<td>Set the machine to automatically allocate the IP address from the link-local address range.</td>
</tr>
<tr>
<td>IPv6</td>
<td>-</td>
<td></td>
<td>Turn the IPv6 protocol on or off.</td>
</tr>
<tr>
<td>Ethernet -</td>
<td>-</td>
<td></td>
<td>Select the Ethernet link mode.</td>
</tr>
<tr>
<td>Wired Status -</td>
<td>-</td>
<td></td>
<td>View the current wired status.</td>
</tr>
<tr>
<td>MAC Address -</td>
<td>-</td>
<td></td>
<td>View the MAC address of the machine.</td>
</tr>
<tr>
<td>Network Reset -</td>
<td>-</td>
<td></td>
<td>Restore all network settings back to the factory settings.</td>
</tr>
</tbody>
</table>

### Machine Info.

Related Models:Dell E515dn / Dell E515dw

<table>
<thead>
<tr>
<th>Level 1</th>
<th>Level 2</th>
<th>Level 3</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial No. -</td>
<td>-</td>
<td>-</td>
<td>Check the serial number of your machine.</td>
</tr>
<tr>
<td>Version -</td>
<td>-</td>
<td>-</td>
<td>Check the firmware version of your machine.</td>
</tr>
<tr>
<td>Page Counter -</td>
<td>-</td>
<td>-</td>
<td>Check the number of total pages the machine has printed during its life.</td>
</tr>
<tr>
<td>Parts Life</td>
<td>Toner</td>
<td>-</td>
<td>View the approximate remaining toner life.</td>
</tr>
<tr>
<td></td>
<td>Drum</td>
<td>-</td>
<td>You can check the percentage of a Drum life that remains available.</td>
</tr>
</tbody>
</table>

### Initial Setup

Related Models:Dell E515dn / Dell E515dw

<table>
<thead>
<tr>
<th>Level 1</th>
<th>Level 2</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date&amp;Time</td>
<td>Date&amp;Time</td>
<td>Add the date and time on the screen and in the headings of the faxes you send.</td>
</tr>
<tr>
<td>Auto Daylight</td>
<td>Time Zone</td>
<td>Sets the machine to automatically change for Daylight Saving Time. Set your time zone.</td>
</tr>
<tr>
<td>Station ID -</td>
<td></td>
<td>Enter your name and fax number to appear on each page you fax.</td>
</tr>
<tr>
<td>Tone/Pulse -</td>
<td></td>
<td>Select the dialing mode.</td>
</tr>
<tr>
<td>Dial Tone -</td>
<td></td>
<td>Shorten the dial tone detect pause.</td>
</tr>
<tr>
<td>Dial Prefix -</td>
<td></td>
<td>Set a prefix number to always be added before the fax number every time you dial.</td>
</tr>
</tbody>
</table>
Machine Settings

Reset
- Machine Reset
  Reset all the machine settings that you have changed, such as Date and Time and Ring Delay.

Network
- Restore all network settings back to the factory settings.

Address & Fax
- Erase all stored phone numbers and fax settings.

All Settings
- Restore all the machine's settings back to the factory settings.

Factory Reset
- Restores all the machine's settings to the factory defaults. Perform this operation when you dispose of your machine.

Local Language
(available only for certain models)
- Change your LCD language.

Settings Tables (Dell E514dw)

- General Setup
- Copy
- Printer
- Network
- Machine Info.

General Setup

Related Models: Dell E514dw

<table>
<thead>
<tr>
<th>Level 1</th>
<th>Level 2</th>
<th>Level 3</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper</td>
<td>Paper Type</td>
<td>-</td>
<td>Set the type of paper in the paper tray.</td>
</tr>
<tr>
<td>Paper</td>
<td>Paper Size</td>
<td>-</td>
<td>Set the size of paper in the paper tray.</td>
</tr>
<tr>
<td>Check Size</td>
<td>-</td>
<td>-</td>
<td>Choose whether to display the message to check the size of paper in the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>machine and the machine setting match.</td>
</tr>
<tr>
<td>Ecology</td>
<td>Toner Save</td>
<td>-</td>
<td>Increase the page yield of the toner cartridge.</td>
</tr>
<tr>
<td>Sleep Time</td>
<td>-</td>
<td>Conserves power.</td>
<td></td>
</tr>
<tr>
<td>Quiet Mode</td>
<td>-</td>
<td>Decrease printing noise.</td>
<td></td>
</tr>
<tr>
<td>Auto Power Off</td>
<td>-</td>
<td>Set the number of hours that the machine will remain in Deep Sleep Mode</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>before going into Power Off mode.</td>
<td></td>
</tr>
<tr>
<td>LCD Contrast</td>
<td>-</td>
<td>-</td>
<td>Adjust the contrast of the LCD.</td>
</tr>
<tr>
<td>Replace Toner</td>
<td>-</td>
<td>-</td>
<td>Set the machine to continue printing after the LCD displays Replace New Toner.</td>
</tr>
<tr>
<td>Reset</td>
<td>Machine Reset</td>
<td>-</td>
<td>Restore all the machine settings that you have changed, such as Date and</td>
</tr>
<tr>
<td></td>
<td>Network</td>
<td>-</td>
<td>Time.</td>
</tr>
<tr>
<td></td>
<td>All Settings</td>
<td>-</td>
<td>Restore all the machine's settings back to the factory settings.</td>
</tr>
<tr>
<td></td>
<td>Factory Reset</td>
<td>-</td>
<td>Restore all the machine's settings back to the factory settings.</td>
</tr>
<tr>
<td>Local Language (available only for certain models)</td>
<td>-</td>
<td>-</td>
<td>Change your LCD language.</td>
</tr>
</tbody>
</table>

Copy

Related Models: Dell E514dw
### Machine Settings

<table>
<thead>
<tr>
<th>Level 1</th>
<th>Level 2</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality</td>
<td>-</td>
<td>Choose the Copy resolution for your type of document.</td>
</tr>
<tr>
<td>Brightness</td>
<td>-</td>
<td>Adjust the brightness for copies.</td>
</tr>
<tr>
<td>Contrast</td>
<td>-</td>
<td>Adjust the contrast for copies.</td>
</tr>
</tbody>
</table>

**ID Copy**

<table>
<thead>
<tr>
<th>Level 1</th>
<th>Level 2</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality</td>
<td>-</td>
<td>Choose the Copy resolution for your type of document.</td>
</tr>
<tr>
<td>Brightness</td>
<td>-</td>
<td>Adjust the brightness for copies.</td>
</tr>
<tr>
<td>Contrast</td>
<td>-</td>
<td>Adjust the contrast for copies.</td>
</tr>
<tr>
<td>2in1/1in1</td>
<td>-</td>
<td>Make 2 in 1 ID copies.</td>
</tr>
</tbody>
</table>

### Printer

**Related Models:** Dell E514dw

<table>
<thead>
<tr>
<th>Level 1</th>
<th>Level 2</th>
<th>Level 3</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emulation</td>
<td>-</td>
<td>-</td>
<td>Set the printer emulation mode.</td>
</tr>
<tr>
<td>Print Options</td>
<td>Internal Font</td>
<td>PCL Setting</td>
<td>PS Emulate</td>
</tr>
<tr>
<td>Test Print</td>
<td>-</td>
<td>-</td>
<td>Print a test page.</td>
</tr>
<tr>
<td>2-sided</td>
<td>-</td>
<td>-</td>
<td>Turn 2-sided printing off or on and select flip on long edge or short edge.</td>
</tr>
<tr>
<td>Auto Continue</td>
<td>-</td>
<td>-</td>
<td>Select this setting if you want the machine to clear paper size errors and to use the paper in the tray.</td>
</tr>
<tr>
<td>Reset Printer</td>
<td>-</td>
<td>-</td>
<td>Restore the printer settings to the factory settings.</td>
</tr>
</tbody>
</table>
**Network**

Related Models: Dell E514dw

**For wired and wireless network models**

<table>
<thead>
<tr>
<th>Level 1</th>
<th>Level 2</th>
<th>Level 3</th>
<th>Level 4</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wired LAN</td>
<td>TCP/IP</td>
<td>Boot Method</td>
<td></td>
<td>Select the BOOT method that best suits your needs.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IP Address</td>
<td></td>
<td>Enter the IP address.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Subnet Mask</td>
<td></td>
<td>Enter the Subnet mask.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Gateway</td>
<td></td>
<td>Enter the Gateway address.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Node Name</td>
<td></td>
<td>Enter the Node name. (Up to 32 characters)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WINS Config</td>
<td></td>
<td>Select the WINS configuration mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WINS Server</td>
<td>Primary</td>
<td>Specify the IP address of the primary WINS server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Secondary</td>
<td>Specify the IP address of the secondary WINS server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DNS Server</td>
<td>Primary</td>
<td>Specify the IP address of the primary DNS server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Secondary</td>
<td>Specify the IP address of the secondary DNS server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>APIPA</td>
<td></td>
<td>Set the machine to automatically allocate the IP address from the link-local address range.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IPv6</td>
<td></td>
<td>Turn the IPv6 protocol on or off.</td>
</tr>
<tr>
<td>Ethernet</td>
<td></td>
<td></td>
<td></td>
<td>Select the Ethernet link mode.</td>
</tr>
<tr>
<td>Wired</td>
<td></td>
<td></td>
<td></td>
<td>View the current wired status.</td>
</tr>
<tr>
<td>Status</td>
<td></td>
<td></td>
<td></td>
<td>View the MAC address of the machine.</td>
</tr>
<tr>
<td>MAC Address</td>
<td></td>
<td></td>
<td></td>
<td>Restore the wired network setting to the factory setting.</td>
</tr>
<tr>
<td>Set to</td>
<td></td>
<td></td>
<td></td>
<td>Turn the Wired LAN on or off manually.</td>
</tr>
<tr>
<td>Default</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wired</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WLAN</td>
<td>TCP/IP</td>
<td>Boot Method</td>
<td>Select the BOOT method that best suits your needs.</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>-------------</td>
<td>--------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>IP Address</td>
<td>Enter the IP address.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Subnet Mask</td>
<td>Enter the Subnet mask.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Gateway</td>
<td>Enter the Gateway address.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Node Name</td>
<td>Enter the Node name. (Up to 32 characters)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>WINS Config</td>
<td>Select the WINS configuration mode.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>WINS Server</td>
<td>Specify the IP address of the primary WINS server.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DNS Server</td>
<td>Specify the IP address of the primary DNS server.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>APIPA</td>
<td>Set the machine to automatically allocate the IP address from the link-local address range.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>IPv6</td>
<td>Turn the IPv6 protocol on or off.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>WLAN</td>
<td>Configure your wireless network settings using the Dell CD-ROM.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Assistant</td>
<td>Configure your wireless network settings manually.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Setup Wizard</td>
<td>Configure your wireless network settings manually.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>WPS/AOSS</td>
<td>Configure your wireless network settings using the one-button push method.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>WPS w/PIN</td>
<td>Configure your wireless network settings using WPS with a PIN.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SSID</td>
<td>View the current SSID.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Comm. Mode</td>
<td>View the current Communication Mode.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>MAC Address</td>
<td>View the MAC address of the machine.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Set to Default</td>
<td>Restore the wireless network setting to the factory setting.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>WLAN Enable</td>
<td>Turn the wireless LAN on or off manually.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Wi-Fi Direct</td>
<td>Configure your Wi-Fi Direct® network settings using the one-button push method.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Push Button</td>
<td>Configure your Wi-Fi Direct® network settings using WPS with a PIN code.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PIN Code</td>
<td>Configure your Wi-Fi Direct® network settings manually.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Manual</td>
<td>Configure your Wi-Fi Direct® network settings manually.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Group Owner</td>
<td>Set your machine as the Group Owner.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Device Name</td>
<td>View the device name of your machine.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SSID</td>
<td>View the SSID of the Group Owner. When the machine is not connected, LCD displays Not Connected.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>IP Address</td>
<td>View the current IP Address of your machine.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Status</td>
<td>View the current Wi-Fi Direct® network status.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Signal</td>
<td>View the current Wi-Fi Direct® network signal strength. When your machine acts as Group Owner, the LCD always indicate a strong signal.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>I/F Enable</td>
<td>Turn the Wi-Fi Direct® connection on or off.</td>
<td></td>
</tr>
</tbody>
</table>
### Machine Settings

**Network Reset**
- Restore all network settings back to the factory settings.

### Machine Info.

**Related Models:** Dell E514dw

<table>
<thead>
<tr>
<th>Level 1</th>
<th>Level 2</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial No.</td>
<td>-</td>
<td>Check the serial number of your machine.</td>
</tr>
<tr>
<td>Version</td>
<td>-</td>
<td>Check the firmware version of your machine.</td>
</tr>
<tr>
<td>Page Counter</td>
<td>-</td>
<td>Check the number of total pages the machine has printed during its life.</td>
</tr>
<tr>
<td>Parts Life</td>
<td>Toner</td>
<td>View the approximate remaining toner life.</td>
</tr>
<tr>
<td></td>
<td>Drum</td>
<td>You can check the percentage of a Drum life that remains available.</td>
</tr>
<tr>
<td>Print Settings</td>
<td>-</td>
<td>Print a list of your settings for printing.</td>
</tr>
<tr>
<td>User Settings</td>
<td>-</td>
<td>Print a list of your settings.</td>
</tr>
<tr>
<td>Network Config</td>
<td>-</td>
<td>Print a list of your Network settings.</td>
</tr>
<tr>
<td>WLAN Report</td>
<td>-</td>
<td>Print the result of wireless LAN connectivity.</td>
</tr>
</tbody>
</table>
Appendix ................................................................. 341
Specifications ............................................................ 341
How to Enter Text on Your Dell Machine ......................... 346
Environmental Information Notice .................................. 348
Dell Technical Support Policy ........................................... 348
Warranty and Return Policy ............................................. 349
Contacting Dell ........................................................... 349
Additional documents for Important Information ................. 351
Appendix

• Specifications
• How to Enter Text on Your Dell Machine
• Environmental Information Notice
• Dell Technical Support Policy
• Warranty and Return Policy
• Contacting Dell

Specifications

• General Specifications
• Document Size Specification
• Print Media Specifications
• Fax Specifications
• Copy Specification
• Scanner Specifications
• Printer Specifications
• Interface Specifications
• Supported Protocols and Security Features
• Computer Requirements Specifications

General Specifications

<table>
<thead>
<tr>
<th>Printer Type</th>
<th>Laser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Method</td>
<td>Electrophotographic Laser Printer</td>
</tr>
<tr>
<td>Memory Capacity</td>
<td>64 MB</td>
</tr>
<tr>
<td>LCD (liquid crystal display)</td>
<td>16 characters x 2 lines</td>
</tr>
<tr>
<td>Power Source</td>
<td>110 - 120 V AC 50/60Hz</td>
</tr>
<tr>
<td></td>
<td>220 - 240 V AC 50/60Hz</td>
</tr>
<tr>
<td>Power Consumption</td>
<td>Peak (^1) Approximately 1104 W</td>
</tr>
<tr>
<td></td>
<td>Ready (^1) Approximately 60 W at 73.4 °F (23 °C)</td>
</tr>
<tr>
<td></td>
<td>Sleep (^1) (Dell E514dw) 110 - 120 V Approximately 5.3 W</td>
</tr>
<tr>
<td></td>
<td>220 - 240 V Approximately 6.6 W</td>
</tr>
<tr>
<td></td>
<td>(Dell E515dn/Dell E515dw) 110 - 120 V Approximately 5.8 W</td>
</tr>
<tr>
<td></td>
<td>220 - 240 V Approximately 6.6 W</td>
</tr>
<tr>
<td></td>
<td>Deep 110 - 120 V Approximately 2.4 W (^2)</td>
</tr>
<tr>
<td></td>
<td>Sleep (^1) 220 - 240 V Approximately 1.1 W</td>
</tr>
<tr>
<td></td>
<td>Power 110 - 120 V Approximately 0.02 W</td>
</tr>
<tr>
<td></td>
<td>Off (^1) (^1) (^4) 220 - 240 V Approximately 0.08 W</td>
</tr>
</tbody>
</table>
Dimensions

Weights (with supplies)

<table>
<thead>
<tr>
<th></th>
<th>Dell E514dw</th>
<th>Dell E515dn/Dell E515dw</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>24.9 lb (11.3 kg)</td>
<td>27.3 lb (12.4 kg)</td>
</tr>
</tbody>
</table>

Noise Level

<table>
<thead>
<tr>
<th></th>
<th>Printing</th>
<th>Ready</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sound Pressure</td>
<td>LpAm = 50 dB (A)</td>
<td>LpAm = 33 dB (A)</td>
</tr>
<tr>
<td>Sound Power</td>
<td>Printing</td>
<td>LWAd = 6.5 B (A)</td>
</tr>
<tr>
<td></td>
<td>Ready</td>
<td>LWAd = 4.6 B (A)</td>
</tr>
</tbody>
</table>

Temperature

<table>
<thead>
<tr>
<th></th>
<th>Operating</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating</td>
<td>50 °F to 90 °F (10 to 32 °C)</td>
<td>32 °F to 104 °F (0 to 40 °C)</td>
</tr>
<tr>
<td>Storage</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Humidity

<table>
<thead>
<tr>
<th></th>
<th>Operating</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating</td>
<td>20 to 80 % (without condensation)</td>
<td></td>
</tr>
<tr>
<td>Storage</td>
<td></td>
<td>10 to 90 % (without condensation)</td>
</tr>
</tbody>
</table>

ADF (automatic document feeder)

Up to 35 sheets
For best results we recommend:
Temperature: 68 °F to 86 °F (20 to 30 °C)
Humidity: 50% to 70%
Paper: 20 lb (80 g/m²)

*1 USB connections to computer
*2 This condition is equivalent to Network standby mode, the power consumption in this condition is that all wired network ports are connected and all wireless network ports are activated.
*3 Measured according to IEC 62301 Edition 2.0
*4 Power consumption varies slightly depending on the usage environment.

**Document Size Specification**

<table>
<thead>
<tr>
<th>Document Size</th>
<th>ADF Width</th>
<th>ADF Length</th>
<th>Scanner Glass Width</th>
<th>Scanner Glass Length</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>5.8 to 8.5 in. (147.3 to 215.9 mm)</td>
<td>5.8 to 14.0 in. (147.3 to 355.6 mm)</td>
<td>Max. 8.5 in. (215.9 mm)</td>
<td>Max. 11.8 in. (300 mm)</td>
</tr>
</tbody>
</table>
Print Media Specifications

<table>
<thead>
<tr>
<th>Paper Input</th>
<th>Paper Tray (Standard)</th>
<th>Paper Type</th>
<th>Plain Paper, Thin Paper, Recycled Paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Size</td>
<td>A4, Letter, A5, A5 (Long Edge), A6, Executive, Legal, Folio</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper Weight</td>
<td>16 to 28 lb (60 to 105 g/m²)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum Paper Capacity</td>
<td>Up to 250 sheets of 20 lb (80 g/m²) Plain Paper</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Manual Feed Slot

| Paper Size | Width: 3 to 8.5 in. (76.2 to 215.9 mm) Length: 5 to 14 in. (127 to 355.6 mm) |
| Paper Weight | 16 to 45 lb (60 to 163 g/m²) |
| Maximum Paper Capacity | One sheet at a time |

Paper Output

| Face-Down Output Tray | Up to 100 Sheets of 20 lb (80 g/m²) Plain Paper (face-down delivery to the face-down output paper tray) |
| Face-Up Output Tray | One sheet (face-up delivery to the face-up output tray) |

2-sided Automatic 2-sided Printing

| Paper Type | Plain Paper, Thin Paper, Recycled Paper |
| Paper Size | Letter, Legal, Folio |
| Paper Weight | 16 to 28 lb (60 to 105 g/m²) |

Fax Specifications

Related Models: Dell E515dn / Dell E515dw

| Compatibility | ITU-T Super Group 3 |
| Coding System | MH / MR / MMR / JBIG |
| Modem Speed | 33,600 bps (with Automatic Fallback) |
| 2-sided Print Receiving | Yes |
| Scanning Width | Max. 8.19 in. (208 mm) |
| Printing Width | Max. 8.19 in. (208 mm) |
| Gray Scale | 8bit / 256 levels |
| Resolution | Horizontal 203 dpi Vertical Standard: 98 dpi Fine: 196 dpi Super fine: 392 dpi |
| One Touch Dial | 8 (4 x 2) locations |
| Speed Dial | 200 Locations |
| Groups | Up to 20 |
| Broadcasting | 258 Locations |
| Automatic Redial | 3 times at 5 minutes intervals |
| Memory Transmission | Up to 500 pages *1 |
| Out of Paper Reception | Up to 500 pages *1 |

*1 ‘Pages’ refers to the ‘ITU-T Test Chart #1’ (a typical business letter, Standard resolution, JBIG code).
Specifications and printed materials are subject to change without prior notice.
Copy Specification

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Width</td>
<td>Max. 8.27 in. (210 mm)</td>
</tr>
<tr>
<td>Multiple Copies</td>
<td>Sorts/Stacks up to 99 pages</td>
</tr>
<tr>
<td>Enlarge/Reduce</td>
<td>25% to 400% (in increments of 1%)</td>
</tr>
<tr>
<td>Resolution</td>
<td>600 x 600 dpi</td>
</tr>
<tr>
<td>First Copy Out Time</td>
<td>Less than 10 seconds at 73.4 °F (23 °C) / 115 V</td>
</tr>
</tbody>
</table>

*1 From Ready Mode and standard tray

Scanner Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color / Black</td>
<td>Yes / Yes</td>
</tr>
<tr>
<td>TWAIN Compliant</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows Image Acquisition (WIA) Compliant</td>
<td>(Windows Vista® / Windows® 7 / Windows® 8 / Windows® 8.1) (OS X v10.8.x / 10.9.x / 10.10.x *1)</td>
</tr>
<tr>
<td>ICA Compliant</td>
<td>Yes (OS X v10.8.x / 10.9.x / 10.10.x *1)</td>
</tr>
<tr>
<td>Color Depth</td>
<td>30 bit color Processing (Input)</td>
</tr>
<tr>
<td>Gray Scale</td>
<td>10 bit color Processing (Input)</td>
</tr>
<tr>
<td>Resolution</td>
<td>Up to 19200 × 19200 dpi (interpolated)</td>
</tr>
<tr>
<td>Scanning Width</td>
<td>Max. 8.27 in. (210 mm)</td>
</tr>
</tbody>
</table>

*1 For the latest driver updates for the version of OS X you are using, go to your model's page on the Dell website at http://www.dell.com/.

*2 Maximum 1200 × 1200 dpi scanning with the Windows Image Acquisition (WIA) driver in Windows Vista®, Windows® 7, Windows® 8 and Windows® 8.1

Printer Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic 2-sided Print</td>
<td>Yes</td>
</tr>
<tr>
<td>Emulations</td>
<td>PCL6, XPS, Dell emulate PS (PostScript® 3™)</td>
</tr>
<tr>
<td>Resolution</td>
<td>600 x 600 dpi, HQ1200 (2400 x 600 dpi) quality</td>
</tr>
<tr>
<td>Print Speed (2-sided)</td>
<td>Up to 13 sides/minute (Up to 6.5 sheets/minute) (Letter size)</td>
</tr>
<tr>
<td>Print Speed</td>
<td>Up to 27 pages/minute (Letter size)</td>
</tr>
<tr>
<td>First Print Time</td>
<td>Less than 8.5 seconds at 73.4 °F (23 °C) / 115 V</td>
</tr>
</tbody>
</table>

*1 From Ready Mode and standard tray

Interface Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB</td>
<td>Hi-Speed USB 2.0 Use a USB 2.0 interface cable that is no more than 6 feet (2.0 meters) long.</td>
</tr>
</tbody>
</table>
LAN (For models with wired network function) | 10BASE-T / 100BASE-TX
| Use a straight-through Category 5 (or greater) twisted-pair cable

Wireless LAN (For models with wireless network function) | IEEE 802.11b/g/n (Infrastructure/Ad-hoc Mode)
| IEEE 802.11g/n (Wi-Fi Direct®)

*1 Your machine has a USB 2.0 Hi-Speed interface. The machine can also be connected to a computer that has a USB 1.1 interface.

*2 Third party USB ports are not supported.

**Supported Protocols and Security Features**

**Ethernet**
10Base-T/100Base-TX

**Wireless LAN**
IEEE 802.11b/g/n (Infrastructure Mode/Ad-hoc Mode), IEEE 802.11g/n (Wi-Fi Direct®)

**Protocols (IPv4)**
ARP, RARP, BOOTP, DHCP, APIPA(Auto IP), WINS/NetBIOS name resolution, DNS resolver, mDNS, LLNR responder, LPR/LPD, Custom Raw Port/Port 9100, IPP, FTP Server, SNMPv1/v2c/v3, HTTP Server, TFTP Client and Server, SMTP Client, ICMP, Web Services (Print/Scan), SNTP Client

**Protocols (IPv6)**
NDP, RA, DNS Resolver, mDNS, LLNR responder, LPR/LPD, Custom Raw Port/Port 9100, IPP, FTP Server, SNMPv1/v2c, HTTP Server, TFTP Client and Server, SMTP Client, ICMPv6, Web Services (Print/Scan), SNTP Client

**Network Security (Wired)**
SMTP-AUTH, SNMP v3

**Network Security (Wireless)**
SMTP-AUTH, SNMP v3

**Wireless Network Security**
WEP 64/128 bit, WPA-PSK (TKIP/AES), WPA2-PSK (AES)

**Wireless Certification**
Wi-Fi Certification Mark License (WPA™/WPA2™ - Personal), Wi-Fi Protected Setup™ (WPS) Identifier Mark License, AOSS™ Logo, Wi-Fi CERTIFIED Wi-Fi Direct®

**Computer Requirements Specifications**

**Supported Operating Systems And Software Functions**

<table>
<thead>
<tr>
<th>Computer Platform &amp; Operating System Version</th>
<th>PC Interface</th>
<th>Processor</th>
<th>Hard Disk Space to install</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>USB *1</td>
<td>Wireless</td>
<td>For Drivers</td>
</tr>
<tr>
<td></td>
<td>10/100 Base-TX (Ethernet)</td>
<td>802.11b/g/n</td>
<td>For Applications</td>
</tr>
</tbody>
</table>

*1 Your machine has a USB 2.0 Hi-Speed interface. The machine can also be connected to a computer that has a USB 1.1 interface.

*2 Third party USB ports are not supported.
<table>
<thead>
<tr>
<th>Windows® Operating System</th>
<th>Printing</th>
<th>Scanning</th>
<th>32 bit (x86) or 64 bit (x64) processor</th>
<th>500 MB</th>
<th>1.2 GB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows® Vista®</td>
<td>PC Fax*3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows® 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows® 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows® 8.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Server® 2003</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Server® 2003 x64 Edition</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Server® 2008</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Server® 2008 R2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Server® 2012</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Server® 2012 R2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Macintosh Operating System</td>
<td>Printing</td>
<td>Scanning</td>
<td>Intel® Processor</td>
<td>80 MB</td>
<td>400 MB</td>
</tr>
<tr>
<td>OS X v10.8.x</td>
<td>PC-Fax (Send) *3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OS X v10.9.x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OS X v10.10.x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For the latest driver updates, go to your model's page on the Dell website at http://www.dell.com/.
All trademarks, brand and product names are the property of their respective companies.

*1 Third party USB ports are not supported.
*2 For Windows Image Acquisition (WIA), 1200 x 1200 resolution.
*3 PC-Fax supports black and white only.

---

**How to Enter Text on Your Dell Machine**

Dell E514dw Dell E515dn/Dell E515dw

**Dell E514dw**

When setting certain options, such as the Network Key, you must enter characters on the machine:

- Hold down or repeatedly press ▲ or ▼ to select a character from this list:
  0123456789abcdefghijklmnopqrstuvwxyzABCDEFGHIJKLMNOPQRSTUVWXYZ(space)!#$%&'()*+,-./:;<=>?@\]^_`
- Press **OK** when the character or symbol you want is displayed, and then enter the next character.
- Press **Clear** to delete characters entered incorrectly.
When setting certain options, such as the Station ID, you must enter characters. The available number and letters are printed on each dial pad button.

The buttons 0, # and * are used for special characters.

• Press the appropriate dial pad button the number of times shown in this reference table to access the character you want.

<table>
<thead>
<tr>
<th>Press button</th>
<th>One time</th>
<th>Two times</th>
<th>Three times</th>
<th>Four times</th>
<th>Five times</th>
<th>Six times</th>
<th>Seven times</th>
<th>Eight times</th>
<th>Nine times</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>@</td>
<td></td>
<td>1</td>
<td>@</td>
<td></td>
<td>/</td>
<td>1</td>
<td>@</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>a</td>
<td>b</td>
<td>c</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>2</td>
<td>a</td>
<td>b</td>
</tr>
<tr>
<td>3</td>
<td>d</td>
<td>e</td>
<td>f</td>
<td>D</td>
<td>E</td>
<td>F</td>
<td>3</td>
<td>d</td>
<td>e</td>
</tr>
<tr>
<td>4</td>
<td>g</td>
<td>h</td>
<td>i</td>
<td>G</td>
<td>H</td>
<td>I</td>
<td>4</td>
<td>g</td>
<td>h</td>
</tr>
<tr>
<td>5</td>
<td>j</td>
<td>k</td>
<td>l</td>
<td>J</td>
<td>K</td>
<td>L</td>
<td>5</td>
<td>j</td>
<td>k</td>
</tr>
<tr>
<td>6</td>
<td>m</td>
<td>n</td>
<td>o</td>
<td>M</td>
<td>N</td>
<td>O</td>
<td>6</td>
<td>m</td>
<td>n</td>
</tr>
<tr>
<td>7</td>
<td>p</td>
<td>q</td>
<td>r</td>
<td>R</td>
<td>Q</td>
<td>S</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>t</td>
<td>u</td>
<td>v</td>
<td>T</td>
<td>U</td>
<td>V</td>
<td>8</td>
<td>t</td>
<td>u</td>
</tr>
<tr>
<td>9</td>
<td>w</td>
<td>x</td>
<td>y</td>
<td>Z</td>
<td>W</td>
<td>X</td>
<td>Y</td>
<td>Z</td>
<td></td>
</tr>
</tbody>
</table>

For options that do not allow lower case characters, use the following table:

<table>
<thead>
<tr>
<th>Press button</th>
<th>One time</th>
<th>Two times</th>
<th>Three times</th>
<th>Four times</th>
<th>Five times</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>2</td>
<td>A</td>
</tr>
<tr>
<td>3</td>
<td>D</td>
<td>E</td>
<td>F</td>
<td>3</td>
<td>D</td>
</tr>
<tr>
<td>4</td>
<td>G</td>
<td>H</td>
<td>I</td>
<td>4</td>
<td>G</td>
</tr>
<tr>
<td>5</td>
<td>J</td>
<td>K</td>
<td>L</td>
<td>5</td>
<td>J</td>
</tr>
<tr>
<td>6</td>
<td>M</td>
<td>N</td>
<td>O</td>
<td>6</td>
<td>M</td>
</tr>
<tr>
<td>7</td>
<td>P</td>
<td>Q</td>
<td>R</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>T</td>
<td>U</td>
<td>V</td>
<td>8</td>
<td>T</td>
</tr>
<tr>
<td>9</td>
<td>W</td>
<td>X</td>
<td>Y</td>
<td>Z</td>
<td></td>
</tr>
</tbody>
</table>

• Inserting spaces
To enter a space in a fax number, pressɾ once between numbers. To enter a space in a name, pressɾ twice between characters.

• Making corrections
If you entered a character incorrectly and want to change it, press ◄ or ► to move the cursor to the incorrect character, and then press Clear.

• Repeating letters
To enter a letter on the same button as the previous letter, press ► to move the cursor right before pressing the button again.

• Special symbols and characters
Press *, # or 0, then press ◄ or ► to move the cursor to the symbol or character you want. Press OK to select it. The symbols and characters that are available on dial pad buttons are shown in the table.
Environmental Information Notice

At Dell, we aim to make “being environmentally conscious” easier, more efficient and more cost effective for our customers. We thank you for choosing Dell printers, and here are some useful environmental information regarding this printer before you begin using:

1. Choice to print on various print media ranging from recycled, virgin paper to light weight paper in the range of 60-163 g/m² certified under environmental stewardship initiatives.

2. Choice to print on 60 g/m² paper which contains less raw material per print, helping you contribute to saving significant environment resources.

3. Designed to be energy efficient with power saving modes, your new Dell printer is Energy Star qualified so you consume less power during printing and standby modes. Efficient power management in your Dell printer helps you conserve energy resources and gain cost savings for your power usage.

4. If supported, use duplex printing function to print on both sides of paper so you can help reduce the consumption of raw materials used to manufacture paper.

Information on setting the supported duplex printing function as default can be found on the printer User’s Guide found on the Software and Documentation disc. For the latest User’s Guide, check our website at support.dell.com.

For detail information on environmental performance of product, visit Dell Regulatory Environment Data Sheet website at www.dell.com/regulatory_compliance.

For detail information on paper types and toner/ink cartridge yields for this printer, check your local country Dell website for the printer information at dell.com.

Dell Technical Support Policy

Technician-assisted technical support requires the cooperation and participation of the customer in the troubleshooting process and provides for restoration of the operating system, software program and hardware drivers to the original default configuration as shipped from Dell, as well as the verification of appropriate functionality of the printer and all Dell-installed hardware. In addition to this technician assisted technical support, online technical support is available at Dell Support. Additional technical support options may be available for purchase.

Online Services You can learn about Dell products and services on the following websites:

- www.dell.com
- www.dell.com/ap (Asian/Pacific countries only)
- www.dell.com/jp (Japan only)
- www.euro.dell.com (Europe only)
- www.dell.com/la (Latin American and Caribbean countries)
- www.dell.ca (Canada only)

You can access Dell Support through the following websites and e-mail addresses:
Warranty and Return Policy

Dell Inc. ("Dell") manufactures its hardware products from parts and components that are new or equivalent to new in accordance with industry-standard practices. For information about the Dell warranty for your printer, see www.dell.com/support.

Recycling Information

It is recommended that customers dispose of their used computer hardware, monitors, printers, and other peripherals in an environmentally sound manner. Potential methods include reuse of parts or whole products and recycling of products, components, and/or materials.

For specific information on Dell's worldwide recycling programs, see www.dell.com/recycle.

Contacting Dell

You can access Support for Home at dell.com/support. Select your region, enter the Service Tag of your printer and click Submit to access help tools and information.

You can contact Dell electronically using the following addresses:

- World Wide Web www.dell.com
  - www.dell.com/ap (Asian/Pacific countries only)
  - www.dell.com/jp (Japan only)
  - www.euro.dell.com (Europe only)
  - www.dell.com/la (Latin American and Caribbean countries)
  - www.dell.ca (Canada only)
- Anonymous file transfer protocol (FTP)
  ftp.dell.com
  Log in as user: "anonymous", and use your e-mail address as your password.
- Electronic Support Service
  mobile_support@us.dell.com
  support@us.dell.com
la-techsupport@dell.com (Latin America and Caribbean countries only)
apsupport@dell.com (Asian/Pacific countries only)
support.jp.dell.com (Japan only)
support.euro.dell.com (Europe only)
• Electronic Quote Service apmarketing@dell.com (Asian/Pacific countries only)
sales_canada@dell.com (Canada only)
Additional documents for Important Information

SAFETY: Laser Printer

Internal laser radiation
Max. Radiation Power: 25mW
Wave Length: 770 - 800 nm
Laser Class: Class 3B

SAFETY: General Safety

• Ventilate well during extended operation or mass copying. It may affect the office air environment due to odor such as ozone in a poorly ventilated room. Provide proper ventilation to ensure the comfortable and safe environment.
• This equipment is also designed for IT power system with phase to phase voltage 230V. (For Norway Only).

FCC Part68 comment,

• If your home has specially wired alarm equipment connected to the telephone line, ensure the installation of this equipment does not disable your alarm equipment. If you have questions about what will disable alarm equipment, call your telephone company or a qualified installer.

Information regarding recycled paper

• Recycled paper is of the same quality of paper made from original forest sources. Standards governing modern recycled paper ensure that it meets the highest quality requirements for different printing processes. The imaging equipment supplied by the VA signatories is suitable for using with recycled paper meeting the EN 12281:2002 standard.
• Purchasing recycled paper saves natural resources and promotes the circular economy. Paper is made using cellulose fibres from wood. Collecting and recycling paper extends the life of fibres over multiple life cycles making the best use of the resources.
• The recycled paper production process is shorter. The fibres have already been processed; so less water, chemicals and energy are used.
• Paper recycling has the benefit of saving carbon by diverting paper products from alternative disposal routes such as landfill and incineration. Landfill waste emits methane gas which has a powerful greenhouse effect.

Requisite for R&TTE

€
Additional information for installation

If user can’t install Page Manager properly, below message is shown.
“The OCR software must be installed to use this feature.
Before installing, ensure that your computer has access to the internet.
To install, click the PageManager (OCR) button."
Glossary

This is a comprehensive list of features and terms that appear in Dell manuals. Availability of these features depends on the model you purchased.

A

Ad-Hoc Mode
The mode of operation in a wireless network, in which all devices (machines and computers) are connected without an access point/router.

Address Book
Names and numbers you have stored for easy dialing.

Address Book List
A listing of names and numbers stored in the Address Book memory, in alphabetical order.

ADF (Automatic Document Feeder)
The document can be placed in the ADF and scanned one page at a time automatically.

AES
Advanced Encryption Standard (AES) is the Wi-Fi®-authorized strong encryption standard.

AOSS™
AirStation One-Touch Secure System (AOSS™) is a system provided by Buffalo Technology. AOSS™ allows you to configure a secure wireless connection with the push of a button.

APIPA
If you do not assign an IP address manually (using the control panel [for LCD models] of the machine) or automatically (using a DHCP, BOOTP, or RARP server), the Automatic Private IP Addressing (APIPA) protocol will automatically assign an IP address from the range 169.254.1.0 to 169.254.254.255.

ARP
Address Resolution Protocol (ARP) performs mapping of an IP address to a MAC address in a TCP/IP network.

Authentication
Most wireless networks use some kind of security settings. These security settings define the authentication (how the device identifies itself to the network) and encryption (how the data is encrypted as it is sent on the network). If you do not correctly specify these options when you are configuring your Dell wireless machine, it will not be able to connect to the wireless network. Therefore, care must be taken when configuring these options.

Authentication Methods for a Personal Wireless Network
A personal wireless network is a small network (such as a home wireless network) without IEEE 802.1x support.

• Open system
  Wireless devices are allowed to access the network without any authentication.

• Shared key
  A secret pre-determined key is shared by all devices that will access the wireless network. The Dell wireless machine uses the WEP key as the pre-determined key.

• WPA-PSK/WPA-2-PSK
  Enables a Wi-Fi Protected Access® Pre-shared key (WPA-PSK/WPA2-PSK), which enables the Dell wireless machine to associate with access points using TKIP for WPA-PSK or AES for WPA-PSK and WPA2-PSK
Auto Reduction
Reduces the size of incoming faxes.

Automatic Fax Transmission
Sending a fax without picking up the handset of the external telephone or pressing Hook.

Automatic Redial
A feature that enables your machine to redial the last fax number after five minutes if the fax did not go through because the line was busy.

Backup Print
Your machine prints a copy of every fax that is received and stored in memory. This is a safety feature so you will not lose messages during a power failure.

Beeper Volume
Volume setting for the sound when you press a key or make an error.

BOOTP
The Bootstrap Protocol (BOOTP) is a network protocol used by a network client to obtain an IP Address from a configuration server.

NOTE: To use BOOTP, contact your network administrator.

Broadcasting
The ability to send the same fax message to more than one location.

Caller ID
A service purchased from the telephone company that lets you see the number (or name) of the party calling you.

Cancel Job
Cancels a programmed print job and clears it from the machine’s memory.

Channels
Wireless networks use channels. Each wireless channel is on a different frequency. There are up to 14 different channels that can be used when using a wireless network. However, in many countries the number of channels available is restricted.

CNG Tones
The special tones (beeps) sent by fax machines during automatic transmission to tell the receiving machine that a fax machine is calling.

Coding Method
Method of coding the information contained in the document. All fax machines must use a minimum standard of Modified Huffman (MH). Your machine is capable of greater compression methods, Modified Read (MR), Modified Modified Read (MMR) and JBIG, if the receiving machine has the same capability.

Communication Error (or Comm. Error)
An error during fax sending or receiving, usually caused by line noise or static.

Compatibility Group
The ability of one fax unit to communicate with another. Compatibility is assured between ITU-T Groups.

Contrast
Setting to compensate for dark or light documents, by making faxes or copies of dark documents lighter and light documents darker.

Custom Raw Port
Custom raw port is a commonly used printing protocol on a TCP/IP network that enables interactive data transmission. Default is Port 9100.

D

Delayed Fax
Sends your fax at a specified later time that day.

Density
Changing the Density makes the whole image lighter or darker.

DHCP
The Dynamic Host Configuration Protocol (DHCP) is a network protocol that is used to configure network devices so that they can communicate on an IP Network.

NOTE: To use DHCP, contact your network administrator.

Digital Signature
A Digital Signature is a value computed with a cryptographic algorithm and appended to a data object in such a way that any recipient of the data can use the signature to verify the data's origin and integrity.

Distinctive Ring
This feature is available only in the USA and Canada.
A subscriber service purchased from the telephone company that gives you another telephone number on an existing telephone line. The Dell machine uses the new number to simulate a dedicated fax line.

DNS Client
The Dell print server supports the Domain Name System (DNS) client feature. This feature allows the print server to communicate with other devices using its DNS name.

DNS Server
The Domain Name System (DNS) is a technology to manage the names of web sites and internet domains. A DNS server allows your computer to automatically find its IP address.

Dual Access
Your machine can scan outgoing faxes or scheduled jobs into memory at the same time it is sending a fax or receiving or printing an incoming fax.

E

Easy Receive
Enables your machine to respond to CNG tones if you interrupt a fax call by answering it.

ECM (Error Correction Mode)
Detects errors during fax transmission and resends the pages of the fax that had an error.

Encryption
Most wireless networks use some kind of security settings. These security settings define the authentication (how
the device identifies itself to the network) and encryption (how the data is encrypted as it is sent on the network). If you do not correctly specify these options when you are configuring your Dell wireless machine, it will not be able to connect to the wireless network. Therefore, care must be taken when configuring these options.

**Encryption Methods for a Personal Wireless Network**
A personal wireless network is a small network (such as a home wireless network) without IEEE 802.1x support.

- **None**
  No encryption method is used.

- **WEP**
  When using Wired Equivalent Privacy (WEP) the data is transmitted and received with a secured key.

- **TKIP**
  Temporal Key Integrity Protocol (TKIP) provides per-packet key mixing a message integrity check and rekeying mechanism.

- **AES**
  Advanced Encryption Standard (AES) provides stronger data protection using a symmetric-key encryption.

**NOTE:** IEEE 802.11n does not support either WEP or TKIP as an encryption method.

**NOTE:** To connect to your wireless network using IEEE 802.11n, we recommend selecting AES.

**Extension Telephone**
A telephone on the fax number that is plugged into a separate telephone wall jack.

**External Telephone**
A telephone that is plugged into the EXT jack of your machine.

**F**

**F/T Ring Time**
The length of time that the Dell machine pseudo/double-rings (when the Receive Mode setting is Fax/Tel) to notify you to pick up a voice call that it answered.

**Fax Forwarding**
Sends a fax received into the memory to another pre-programmed fax number.

**Fax Journal**
Lists information about the last 200 incoming and outgoing faxes. TX means Transmit. RX means Receive.

**Fax Receive Code (Fax/Tel Mode Only)**
Press this code (*51) when you answer a fax call on an extension or external telephone.

**Fax Storage**
You can store faxes in the memory.

**Fax Tones**
The signals sent by sending and receiving fax machines while communicating information.

**Fax/Tel**
You can receive faxes and telephone calls. Do not use this mode if you are using a telephone answering device (TAD).

**Fine Resolution**
Resolution is $203 \times 196$ dpi. It is used for small print and graphs.
FTP
The File Transfer Protocol (FTP) allows the Dell machine to scan black and white or color documents directly to an FTP server located locally on your network or on the Internet.

G
Gateway
A gateway is a network point that acts as an entrance to another network and sends data transmitted via the network to an exact destination. The router knows where to direct data that arrives at the gateway. If a destination is located on an external network, the router transmits data to the external network. If your network communicates with other networks, you may need to configure the Gateway IP address. If you do not know the Gateway IP address, then contact your Network Administrator.

Gray Scale
The shades of gray available for copying and faxing photographs.

Group Number
A combination of Address Book numbers that are stored in Address Book for Broadcasting.

H
HTTP (Web Server)
Hypertext Transfer Protocol (HTTP) is used to transmit the data between a web server and a web browser. The Dell print server is equipped with a built-in web server that allows you to monitor its status or change some of its configuration settings using a web browser.

I
Infrastructure Mode
The mode of operation in a wireless network, in which all devices (machines and computers) are connected via an access point/router.

IP Address
An Internet Protocol (IP) address is a series of numbers that identifies each device connected to a network. An IP address consists of four numbers separated by dots. Each number is between 0 and 255.
Example: In a small network, you would normally change the final number.
192.168.1.1
192.168.1.2
192.168.1.3
How the IP address is assigned to your print server:
If you have a DHCP/BOOTP/RARP server in your network, the print server will automatically obtain its IP address from that server.

NOTE: On smaller networks, the DHCP server may also be the Router.
If you do not have a DHCP/BOOTP/RARP server, the Automatic Private IP Addressing (APIPA) protocol will automatically assign an IP address from the range 169.254.1.0 to 169.254.254.255.

IPP
The Internet Printing Protocol (IPP Version 1.0) allows you to print documents directly to any accessible machine via the Internet.

**IPv6**
IPv6 is the next generation Internet protocol.

**J**

**Journal Period**
The pre-programmed time period between automatically printed Fax Journal Reports. You can print the Fax Journal on demand without interrupting the cycle.

**L**

**LLMNR**
The Link-Local Multicast Name Resolution (LLMNR) protocol resolves the names of neighboring computers, if the network does not have a Domain Name System (DNS) server. The LLMNR Responder feature works in both the IPv4 or IPv6 environment when using a computer that has the LLMNR Sender feature, such as Windows Vista® and Windows® 7.

**LPD**
Line Printer Daemon (LPD or LPR) protocol is a commonly-used printing protocol on a TCP/IP network, mainly for UNIX®-based operating systems.

**M**

**MAC Address**
The MAC Address (Ethernet Address) is a unique number assigned for the machine's network interface. You can check your machine's MAC Address on the Dell machine's control panel and in the Network Configuration Report.

**Manual Fax**
When you press Hook to hear the receiving fax machine answer before you press Fax Start to begin transmission.

**MDN**
The Message Disposition Notification (MDN) field of the control panel menu requests the status of the E-mail message after delivery through the Send Mail Transfer Protocol (SMTP) transport system. Once the message has arrived at the receiver, this data is used when the machine or user reads or prints the received E-mail.
For example, if the message is opened for reading or is printed, the receiver sends back a notification to the original sending machine or user.

**NOTE:** The receiver must support the MDN field to be able to send a notification report, otherwise the request will be ignored.

**mDNS**
Multicase DNS (mDNS) allows the Dell print server to automatically configure itself to work in an OS X Simple Network Configuration system.

**Memory Receive**
Receives faxes into the machine's memory when the machine is out of paper.
NetBIOS Name Resolution
Network Basic Input/Output System (NetBIOS) name resolution enables you to obtain the IP address of the other device using its NetBIOS name during the network connection.

Network Configuration Report
The Network Configuration Report prints a report listing the current network configuration, including the network print server settings.

Network Connection Repair Tool
The Network Connection Repair Tool is a program Dell provides to correct the driver's settings so that they match the machine's network settings. To use the Network Connection Repair Tool, ask your network administrator.

Network Key
The Network Key is a password, which is used when the data is encrypted or decrypted. The Network Key is also described as the Password, Security Key, or Encryption Key. The table shows the number of characters of the key to use for each setting.

Open system/Shared key with WEP
This key is a 64-bit or a 128-bit value that must be entered in an ASCII or hexadecimal format.

<table>
<thead>
<tr>
<th>ASCII</th>
<th>Hexadecimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>64 (40) bit</td>
<td>Uses five text characters. For example, &quot;WSLAN&quot; (case-sensitive).</td>
</tr>
<tr>
<td>128 (104) bit</td>
<td>Uses 13 text characters. For example, &quot;Wirelesscomms&quot; (case-sensitive).</td>
</tr>
<tr>
<td>128 (104) bit</td>
<td>Uses 13 text characters. For example, &quot;Wirelesscomms&quot; (case-sensitive).</td>
</tr>
</tbody>
</table>

WPA-PSK/WPA2-PSK and TKIP or AES
Uses a Pre-Shared Key (PSK) that is eight or more characters in length, up to a maximum of 63 characters.

Network PC-FAX
Use Network PC-FAX to send a file from your computer as a fax.

Network Shared Printing
Network Shared Printing is a type of printing in a network shared environment. In a network shared environment, each computer sends data via a server or print server.

Node Name
The Node Name is a machine name on the network. This name is often referred to as a NetBIOS name; it will be the name that is registered by the WINS server on your network. Dell recommends the name "DELLxxxxxx" (where "xxxxxx" is the first six digits of your machine's MAC address / ethernet address.)

OCR (Optical Character Recognition)
Dell software application converts an image of text to text you can edit.

Open System
Open System is one of the network authentication methods. Under open system authentication, any wireless devices are allowed to access the network without requiring a WEP key.

**Out of Paper Reception**
Receives faxes into the machine's memory when the machine is out of paper.

**Overseas Mode**
Makes temporary changes to the fax tones to accommodate noise and static on overseas telephone lines.

**P**

**Paging**
This feature is available only in the USA and Canada.
This feature enables your machine to call your cell phone or pager when a fax is received into its memory.

**Pause**
Allows you to place a delay in the dialing sequence while you are dialing or while you are storing Address Book numbers. Press Pause on the LCD as many times as needed for longer pauses.

**Peer-to-Peer**
Peer-to-Peer is a type of printing in a peer-to-peer environment. In a peer-to-peer environment, each computer sends and receives data directly to and from each device. There is no central server controlling access or machine sharing.

**Photo resolution (B&W only)**
A resolution setting that uses varying shades of gray for the best representation of photographs.

**Protocols**
Protocols are the standardized sets of rules for transmitting data on a network. Protocols allow users to gain access to network-connected resources. The print server used on your Dell machine supports the Transmission Control Protocol/Internet Protocol (TCP/IP) protocol.

**Pulse**
This feature is not available in some countries.
A form of rotary dialing on a telephone line.

**R**

**RARP**
Reverse Address Resolution Protocol (RARP) finds the logical address for a machine that knows only its physical address.

**NOTE:** To use RARP, contact your network administrator.

**Real Time Transmission**
When memory is full, you can send faxes in real time.

**Remaining Jobs**
You can check which programmed fax jobs are waiting in the memory and cancel the jobs individually.

**Remote Access Code**
Your own four-digit code (– – –*) that allows you to call and access your machine from a remote location.

**Remote Activation Code (Fax/Tel Mode only)**
Press this code (*51) when you answer a fax call on an extension or external telephone.

**Remote Deactivation Code (Fax/Tel Mode only)**
When the machine answers a voice call, it fast double-rings. You can pick up at an extension or external telephone by pressing this code (#51).

**Remote Retrieval Access**
The ability to access your machine remotely from a touch tone telephone.

**Resolution**
The number of vertical and horizontal lines per inch.

**Ring Delay**
The number of rings before the machine answers in Fax Only and Fax/Tel modes.

**Ring Volume**
Volume setting for the machine’s ring.

**S**

**Scanning**
The process of sending an electronic image of a paper document into your computer.

**Search**
An alphabetical electronic listing of stored Address Book and Group numbers.

**Settings Tables**
At-a-glance instructions that show all the settings and options that are available for setting up your machine.

**SMTP Client**
Simple Mail Transfer Protocol (SMTP) client is used to send emails via the Internet or Intranet.

**SMTP-AUTH**
SMTP Authentication (SMTP-AUTH) expands SMTP (the Internet email sending protocol) to include an authentication method that ensures the true identity of the sender is known.

**SNMP**
The Simple Network Management Protocol (SNMP) is used to manage network devices including computers, routers and Dell network-ready machines. The Dell print server supports SNMPv1, SNMPv2c and SNMPv3.

**SNMPv3**
Simple Network Management Protocol version 3 (SNMPv3) provides user authentication and data encryption to manage network devices securely.

**SNTP**
The Simple Network Time Protocol (SNTP) is used to synchronize computer clocks on a TCP/IP network. You can configure the SNTP settings using Web Based Management.

**SSID**
Each wireless network has its own unique network name and it is technically referred to as a Service Set Identifier (SSID). The SSID is a 32-byte or less value and is assigned to the access point. The wireless network devices you want to associate to the wireless network should match the access point. The access point and wireless network devices regularly send wireless packets (referred to as beacons), which contain the SSID information. When your wireless network device receives a beacon, you can identify the wireless network that is close enough for the radio waves to reach your device.

**Standard resolution**
203 × 98 dpi (black and white). 203 × 196 dpi (color). It is used for regular sized text and the quickest transmission.

**Station ID**
The stored information that appears on the top of faxed pages. It includes the sender’s name and fax number.

**Status Monitor**
The Status Monitor utility is a configurable utility for Macintosh users to monitor the status of one or more devices, allowing you to get immediate notification when there is a problem, for example, when the machine runs out of paper or jams.

**Subnet Mask**
A subnet mask allows you to identify which part of an IP address is used as the network address and which part is used as the host address.

In the following example, the last segment of the IP address is known as the host address and the first three segments are the network address.

Example: Computer 1 can talk to Computer 2

- Computer 1
  - IP Address: 192.168.1.2
  - Subnet Mask: 255.255.255.0
- Computer 2
  - IP Address: 192.168.1.3
  - Subnet Mask: 255.255.255.0

**NOTE:** 0 denotes that there is no limit to communication at this part of the address.

**Super Fine resolution (B&W only)**
203 × 392 dpi. Best for very small print and line art.

T

**TAD (Telephone Answering Device)**
You can connect an external device or answering machine to the EXT. jack of your machine.

**TCP/IP**
Transmission Control Protocol/Internet Protocol (TCP/IP) is the most popular set of protocols used for communication, such as Internet and email. This protocol can be used in almost all operating systems, including Windows®, Windows Server®, OS X and Linux®.

**Telephone Answer Code (Fax/Tel Mode only)**
When the machine answers a voice call, it pseudo/double-rings. You can pick up at an extension telephone by pressing this code (#51).

**Temporary Settings**
You can choose certain options for each fax transmission and copy without changing the default settings.

**TKIP**
Temporal Key Integrity Protocol (TKIP) is one of the encryption methods adopted by WPA™ to be used in a wireless network. TKIP provides per-packet key mixing, a message integrity check and rekeying mechanism.

**Tone**
This feature is not available in some countries.

A form of dialing on the telephone line used for Touch Tone telephones.
Transmission
The process of sending faxes over the telephone lines from your machine to the receiving fax machine.

Transmission Verification Report
A report for each transmission, that shows its date, time and number.

U

User Settings List
A printed report that shows the current settings of the machine.

V

Vertical Pairing
Vertical Pairing is a technology for Windows® that allows your Vertical Pairing-supported wireless machine to connect to your Infrastructure network using the PIN Method of Wi-Fi Protected Setup™ and the Web Services feature. It also enables printer driver installation from the printer icon in the Add a device screen.

W

Web Based Management
A standard Web Browser can be used to manage your machine using the Hyper Text Transfer Protocol (HTTP). You can perform the function listed or get the following information from a machine on your network using a web browser:

• Machine status information
• Change Fax configuration items, such as General Setup, Address Book settings and Remote Fax (Dell E515dn/ Dell E515dw)
• Change network settings, such as TCP/IP information
• Configure Store Print Log to Network
• Configure Scan to FTP
• Software version information of the machine and print server
• Change network and machine configuration details

NOTE: In order to use Web Based Management, you must use the TCP/IP protocol on your network and have a valid IP address programmed into the print server and your computer.

Web Services
The Web Services protocol enables Windows Vista®, Windows® 7, or Windows® 8 users to install the drivers used for printing and scanning by right-clicking on the machine icon in the Network folder. Web Services also lets you check the current status of the machine from your computer.

WEP
Wired Equivalent Privacy (WEP) is one of the encryption methods used in a wireless network. When using WEP, the data is transmitted and received with a secure key.

Wi-Fi Direct
Wi-Fi Direct is one of the wireless configuration methods developed by the Wi-Fi Alliance®.
Windows® Internet Name Service (WINS) is an information-providing service for NetBIOS name resolution. It consolidates an IP address and a NetBIOS name that is in the local network.

**WINS Server**
Windows® Internet Name Service (WINS) Server maps IP addresses to computer names (NetBIOS names) in a Windows® network.

**WLAN Report**
The WLAN Report prints your machine’s wireless status report. If the wireless connection fails, check the error code on the printed report.

**WPA-PSK/WPA2-PSK Authentication Method**
WPA-PSK/WPA2-PSK authentication method enables a Wi-Fi Protected Access® Pre-shared key (WPA-PSK/WPA2-PSK), which enables the Dell wireless machine to associate with access points using TKIP for WPA-PSK or AES for WPA-PSK and WPA2-PSK (WPA-Personal).

**WPS**
Wi-Fi Protected Setup™ (WPS) is a standard that allows setup of secured wireless network. WPS was created by the Wi-Fi Alliance® in 2007.

**X**

**Xmit Report (Transmission Verification Report)**
A listing for each transmission, that shows its date, time and number.
INDEX

A

About Using TX Lock  233
Additional Dialing Operations  160
Additional Receiving Operations  147
Adjust the Copy Contrast  122
Adjust the Copy Density (Brightness)  123
Advanced Network Features  214
Advanced Printing Methods  65
Appendix  341
Applicable Models  21
Auto Continue  90
Available Services  222

B

Basic Printing Methods  51
Before Printing  51
Before Scanning  95
Before You Use Your Dell Machine  21

C

Caller ID  168
Cancel a Print Job  89
Change 2-Sided Print Settings  90
Change the Default Print Settings  75
Change the Printer Emulation Mode  89
Clean the Machine  300
Configure Network Scanning for Macintosh  97
Configure Network Scanning for Windows®  95
Contacting Dell  349
ControlCenter  243
Control Panel Overview  25
Copy 119
Copy a Document 119
Copy Both Sides of an ID Card onto One Page 126
Copy on Both Sides of the Paper (2-sided Copy) 128
Copy Option 120

Definitions of Notes 21
Dell Printer Hub 30
Dell Technical Support Policy 348
Dial and Store Fax Numbers 155
Distinctive Ring 166
Document Jams 267

Enlarge or Reduce Copied Images 122
Environmental Information Notice 348
Error and Maintenance Messages 263
Error Mail 215
Ethernet (Wired Network Only) 229
External and Extension Telephones 171
External TAD (Telephone Answering Device) 169

Fax 133
Fax Reports 173

General Settings 315

How to Dial 155
How to Store Numbers 161
I
Important Note 22
Improve the Print Quality 279
Introduction to Your Dell Machine 25

L
Learn to Use Network Management Utilities 195
Load Documents 45
Load Paper 33
Locate the Machine’s Network Settings 197
Lock the Machine Settings 233

M
MAC Address 229
Machine Information 285
Machine Settings 315
Make N in 1 Copies Using the Page Layout Feature 123
Memory Receive (Remote Fax) Options 150

N
Network 191
Network Menu on the Dell Control Panel 227
Network Problems 255
Network Reset 230

O
Other Problems 261

P
Paper Handling 33
Paper Jams 268
Paper Settings 42
PC-FAX 174
PC-FAX for Macintosh  186
PC-FAX for Windows®  174
Print  51
Print a Document  76
Print a Fax Journal  174
Print a List of Printer Settings  91
Print a Transmission Verification Report  173
Printing Problems  250
Print Reports  325
Print the Internal Font List  91
PS Printer Driver (PostScript® 3™ language emulation)  87
PS Printer Driver (PostScript® 3™ Language Emulation)  75

R
Receive a Fax  143
Receive Mode Settings  144
Remote Retrieval  152
Replace Supplies  291
Restore Printer Factory Settings  90
Routine Maintenance  291

S
Scan  95
Scan from Your Computer (Macintosh)  104
Scan from Your Computer (Windows®)  104
Scan to E-mail  230
Scan to FTP  230
Scan Using ControlCenter  104
Security  233
Security Protocols  237
Select a Print Profile  73
Send a Fax  133
Set Print Options  77
Set to Default  230
Setup Relay 230
Setup Wizard (Wireless Network Only) 229
Sort Copies 125
Specifications 341

T
TCP/IP 192, 227
Telephone and Fax Problems 251
Telephone Services and External Devices 165
Test Print 91
Troubleshooting 249

U
Unscannable and Unprintable Areas 44
Using Special Paper 44

V
Voice Mail 165
Voice Operations 157

W
Warranty and Return Policy 349
Wi-Fi Direct 230
Wired Enable (Wired Network Only) 230
Wired Status 229
WLAN Enable (Wireless Network Only) 230
WLAN Status (Wireless Network Only) 229
WPS/AOSS™ (Wireless Network Only) 229
WPS w/PIN Code (Wireless Network Only) 229